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Welcome to

There’s no better way to express your creativity than through 
fantasy art. If you’re tired of airbrushing, retouching, or being bound 
by reality, it can be great to let your imagination run wild, and in this 

book we will show you some of the best tips and techniques to help you take 
your art to the next level. Whether you use Photoshop, Painter, PaintTool SAI, 
ArtRage or any other number of creative programs, we have something for 
you within these 260 pages. From adding dramatic lighting and using layer 

masks to painting sprawling sci-fi  cityscapes and mythical beasts, you’ll 
discover plenty of inspiration to help you with your projects. There’s expert 

advice from industry professionals on how to design manga and steampunk, 
and even guides on how to produce amazing artwork on your iPad. So put 

your creative hat on and delve into the magical world of fantasy art.

®
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Concept and planning
There is nothing more daunting than staring at a blank canvas with no idea of where to start. 
When constructing any conceptual landscape work, thorough planning is essential to the visual 
development of the piece. But are there any proven methods for getting going on a project,, a perfect 
method of planning that will guarantee the success of a piece? Portuguese artist Andreas Rocha, an 
up-and-coming favourite in the gaming and editorial arenas, cites motivation and research as key 
elements in his workfl ow, but he also suggests getting the basics down fi rst: “Without research, the 
initial concept can lead to failure. I would think it is best to fi rst think briefl y about what you want to 
portray, just the general guidelines.” This helps you to fi nd that balance between what your imagination 
would like to achieve and keeping a sense of realism in the piece. 

Rocha admits to a preference of using specialist books over the internet when in these early research 
stages. “For instance, you want to use some Art Nouveau motifs in a fantastic castle,” he explains. “You 
can fi nd examples on the internet, but specialised books will give you much better quality images taken 
by professional photographers, all condensed into one handy resource. If you opt for the internet, you 
will almost certainly not get the best photos and you will lose time fi ltering the results.” 

Despite this, the world wide web does hold some benefi ts according to Rocha: “On the other hand, 
the internet displays its content in digital format, which is great for organisational purposes. Keeping 

things organised will transform your initial painting 
process into a combination of fl uid, dynamic 
actions where there is no time for interruption.” 

Rocha endorses the advantages of stock 
photography to help speed up the workfl ow in 
digital applications such as Photoshop and other 
painter programs. “Photographs can really be 
helpful in the conceptualising process,” he 
explains. “Photos not only contain information 
about an object, but they also show us how the 
object interacts with its surroundings and this can 
be important in portraying the object realistically.” 
He does warn artists not to become too reliant on 
photos, though, if you want to maintain some 
individuality in your work: “Photos should be used 
as a complement. They should not dictate what 

8  Fantasy Art Genius Guide

Fantasy and sci-fi  concept painting is one of 
the biggest sub-genres of digital art, and in 
order to be successful in this area, it pays 

to learn the rules of planning, composition and 
application. Artists who master this type of artwork will 
fi nd their skills essential in the movie, videogame and 
entertainment industries, where the need to convey 
places and objects that don’t yet exist is common.

Over these pages, we will be looking at the work of 
four amazing artists who have created awe-inspiring 
artworks on the digital canvas, from the likes of Martin 

Bland’s tech-macabre cyber cityscapes to Andreas 
Rocha’s sci-fi  utopias. Dedication and practice count for 
much when achieving these styles, as well as natural 
artistic ability, but there are plenty of rules and methods 
that you can learn and apply to your artwork to improve 
your creations. We talk with some of the fantasy art 
industry’s top contributors and get them to reveal their 
top tips and tricks. Even if you’re not into fantasy 
landscapes, the advice here is relevant across all genres 
of digital art. So read on to start on your path toward 
better digital paintings.

Art We explore the rules 
of digital painting, 
from concept and 
composition through 
to tools and technique

FantasyThe rules of 
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Central element (tower) placed at 
third of layout (rule of thirds)

Low eye-level horizon; vanishing points off 
canvas – low dynamism leads to a calm setting

Mostly monochromatic; 
some hint of red (maybe 
fl ags) later turned into 
single light source

Background only hinted – 
overcast sky blurs detail

Home: “Homage to one of Lisbon’s most charismatic 
monuments: The Tower of Belém”

© Andreas Rocha

GENIUS GUIDE
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Fantasy

 Observation of the behaviour of 
nature (images stored in memory, 
others from photography) clouds, 

refl ections, atmosphere

 Contrast around main elements; 
surrounding low contrast/dark
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you are portraying. Conceptualisation has to 
involve the creative side of the brain.”

The value of good motivation and stock 
resources is in providing the ability to put down 
strong ideas in a simple basic language. 
Sketches and line work are fundamental in 
developing the conceptual composition, as 
Rocha explains: “Since they set the limits, you can 
quickly evaluate the content as things get defi ned 
very early on. Another advantage is that once the 
sketch is done, you can quickly add value 
underneath the line work by putting this layer in 
Multiply mode in Photoshop, above the value 
layer. Like this, the fi lling out of forms becomes a 
very quick process.”

Different artists have different processes when 
it comes to starting their images. New Zealand-
based concept artist Stefan Morrell voices his 
own opinion on the early stages of image 
creation. “For the initial development stages, I try 
to avoid colour. I’m always very concerned with 
values, and as such, black and white or muted 
colours are used more often. In later concept 
stages, it certainly becomes more important.” The 
artist, who is also a content creator for DAZ 3D, 
sanctions the use of digital media and its 
assistance in the pre-production stages. “In 
Photoshop, I mostly use the Chalk brush for 
roughing images out. It’s the ideal brush for 
quickly building up values and, when used with a 
graphics tablet, you can work very freely. The 
initial thumbnail process is more about values and 
shapes than anything else. I try to work with three 
values in sketches, dark for the foreground, 
mid-grey for the middle and a light grey for the 
background. These would also be the same 
values I work with when using COPIC graphic 
pens on paper.” 

Morrell also fi nds that digital software allows 
him to construct innovative compositions in a 
novel fashion, as he explains: “I have explored 
different techniques of overlaying many images to 
‘fi nd’ an image, but that tends to be quite a 
random affair. It’s great if you have no idea to 
begin with and just want to explore shapes; you 
simply overlay several images in the one 
Photoshop fi le and use the blending modes of 
each layer to randomly change the look of each 
layer. Finally, all the layers combined can come 
up with some fun ideas.”

Photos not only 
contain information 
about an object, but 
they also show us 
how the object 
interacts with its 
surroundings

10  Fantasy Art Genius Guide
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Simulated strokes 
Photoshop’s improved brush capacity has excelled 
the limits of concept painters, as Martin Bland reveals. 
“The brush engine is now massively powerful, and any 
number of effects can be applied with a few custom 
brushes. Take painting chain links, for example. It 
would have taken an age to do a few versions of the 
software back, but now, one custom brush and one 
sweep of said brush and you have a chain!”

Essential tools

Setting the mood 
Photoshop supplies a range of adjustment options 
to later enhance your colours. Variations, Hue/
Saturations and adjustment options such as 
Channel Mixer and Color Balance can enhance 
effects, as Sarel Theron explains. “Just as music 
helps build mood, colour can also help create a 
certain mood within a painting. A contrast between 
cooler and warmer hues can create impact as well 
as help to defi ne focal points. I tend to pick the kind 
of palette that best suits the subject, eg, warm 
brown tones for deserts and cool crisp blues for 
icy environments.”

Layered effects
Photoshop’s introduction of editable 
layer effects have been a real plus 
for producing multifaceted 
compositions, as Morrell explains. 
“In a production environment, 
photographed elements are 
essential. Something as simple as a 
photo of a stone wall can be 
overlaid onto a basic Photoshop 
drawing to give the appearance of a 
castle wall. Rapidly building up 
textures is where Photoshop comes 
in handy; it’s all about speed and 
ease of use.”

The Majestic: “Here I wanted to show off the height of the 
building, adding atmospheric perspective to the very top of the 

building so it almost blends into the sky”
© Stefan Morrell

District75: “With this 
image, I added dozens 
of photos of billboards 
and neon signs to add 
some life to the city”
© Stefan Morrell

GENIUS GUIDE
Fantasy Art

A guide to some of the features of 
Photoshop you need to master

Waterworld: “Again using values to separate 
areas of an image, and darker foreground 
areas frame the rest of the scene”© Stefan Morrell
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The focal point of the painting is the steam train 
and has been placed accordingly in one third 
across of the composition

The vanishing point is placed appropriately in 
the central section grid to draw the line of sight 
and accentuate perspective

The horizon is set on the horizontal line dividing 
the lower third of the photo from the upper 
two thirds. This allows the linear features in the 
photograph to fl ow between sections

Industrial City WIP:
“An industrial cityscape in a ‘steampunk’ setting. While it’s 

still a work in progress, it serves as a good example of 
how colour can create mood”

© Sarel Theron

12  Fantasy Art Genius Guide

Photoshop 
greatly adds to the 
fl exibility required 
of a concept artist. 
In minutes you 
can completely 
change the mood 
of an image

The rules of fantasy art
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Once you have the basic ideas down on 
paper, then it’s time to start thinking about 
building up the composition of your 
painting. Stefan Morrell uses 3D software to its 
full advantage, saying: “In the initial conceptual 
phase, I always work with some basic 
perspective lines and a horizon drawn out. When 
working with buildings or cityscapes in particular, 
this is very important. Getting your vanishing 
lines and correct perspective laid out in the initial 
stages will save a lot of pain down the road. This 
is not so important if your scene is pure 3D, but 
when working with something like a 2.5D matte 
painting, it’s an essential step to get right.” 

Once the composition has been realised and 
‘fl eshed’ out, be it line drawing or colour 
washing, the next logical creative step for a 
concept artist is to visually substantiate the 
scene and here modern digital software really 

excels – something that Morrell agrees with: “Using a program like Photoshop greatly adds to the 
fl exibility required of a concept artist. In a matter of minutes you can completely change the mood of an 
image. Embracing technology has helped my art grow in ways I could never have imagined, and it’s 
through tools like Photoshop that these ideas can be imagined.” 

Digital matte painter Sarel Theron also agrees with this attitude: “I would say that Photoshop has 
defi nitely advanced the possibilities of colour application. Adjustment layers and colour overlays enable 
the artist to make chromatic changes without permanently affecting the layers beneath.” This 
encourages experimentation, which in Theron’s opinion can only lead to better, vibrant artwork. 
Providing much of this himself, including high-end commercials, television productions and various 
pitches, Theron continues: “Clever use of scale can help to provide depth. Naturally, the further away 
the object is the smaller it appears. Often the challenge with fantasy landscapes is portraying the scale 
of objects that don’t exist in real life. This can best be achieved with the use of atmospheric perspective 
as well as juxtaposing real-life objects with the imaginary ones.” 

To Theron these are mere suggestions, believing art should be without any hard rules. However, 
there is one valuable exception that he sanctions: the rule of thirds. He explains: “Simply put, a canvas 
is divided up into thirds, both horizontally and vertically. The focal point of the painting is then placed 
either one third across or one third up or down the picture or where the lines intersect. Framing helps to 
prevent the viewer’s eye from leaving the canvas while also guiding it back in towards the focal point, 
and you can see that in any good photo.“

Perfect composition

Divide your canvas into thirds, horizontally and/or 
vertically, placing your important objects on them. Keep 

vanishing points off-centre for more interest

Sentinel bay (right): 
“Another fantasy-themed 

painting that demonstrates 
both the use of scale and 
atmospheric perspective”

© Sarel Theron

Fantasy Art Genius Guide  13
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Once the basic ideas have been put down and the composition is decided, it is time to start 
thinking about the lighting and colours that you are going to use in your images to help 
create atmosphere.

Sarel Theron talks about ‘atmospheric perspective’ in his images: “This defi nes our perception of 
objects as they recede into the distance. The further away the object gets, the lighter the tone becomes, 
while colours tend to cool and contrasts lessen. Air is not invisible as most people seem to think, and 
it’s important to take it into consideration when painting distant objects.” Here he observes another key 
factor in concept art production. The use of colour and lighting in an image is essential. This can be 
crucial in correctly portraying theme and obtaining an emotive response.

Theron agrees, saying: “Just as music builds mood, colour can also help create such within a 
painting. Contrast between cooler and warmer hues can create impact as well as help to defi ne focal 
points. I’m also aware that certain colours can produce certain feelings or emotions, although generally 
I tend to pick the kind of palette that best suits the subject, for example warm brown tones for deserts 
and cool crisp blues for ice environments.” He continues: “However, lighting is probably the most 
important aspect. It helps to describe the form, colour and texture of the landscape. A landscape artist 
does not outline shapes; he paints them as light defi nes them. Colour helps a lot with setting the overall 
mood and atmosphere and, as with light, can be used to defi ne focal points.”

The correct application in the creation of light gives a composition a pragmatic essence, as 
UK-based conceptual artist and tutorial provider Martin Bland explains: “Successful lighting and colour 
choices make the difference between something looking real and tangible to something that looks like 
a fl at 2D illustration. Conceptually, more often than not, you are asked to take an idea, and bring it to life.

Bland continues: “Without proper lighting there is no life, no spark to an image, no realism. In order to 
make people believe what they are seeing, you need to trick the eye into believability, which is all done 
by lighting and the creation of depth.” Addressing the application of paint to create light and colour, 
Bland exposes further practices to creating realism. “Even if you paint 99 per cent of your scene from 
scratch, an added texture or effect can make a huge difference to the end product. A well-placed 
texture overlay to age an area of metalwork, ground planes muddied up with a texture, overlaid and 
skewed into perspective to add to the believability and an Unsharp Mask on your fi nal-sized fl attened 

Create atmosphere

Terra Ariose: “This futuristic cityscape was aided by 
laying down custom brushes as a base to work from”

© Martin Bland

A balance between sharp edges and soft 
areas adds a lot of visual diversity as well as the 
impact of perspective 

Don’t be afraid to use colour, keeping it the 
same level of saturation and brightness 
throughout as the others in its plane 

Sharpening edges in the fi nal stages will make 
detailed areas ‘pop’

Utilise custom brushes to take some of the 
effort out of highly detailed areas

image to make detailed areas pop. Used subtly, 
these can add a lot to a fi nal image.”

Yet when practising concept art, the ‘end 
product’ goes beyond mere invention. 
Presentation is just as essential in delivering 
powerful visuals. Bland provided some 
authoritative fi nal thoughts when he commented, 
“It depends a lot on the image; if it is a very low 
contrast, darker image or a very light image, then 
you need to be careful and consider the 

background of where your image will be. If you 
put a dark image on a very light background it 
can lose detail, so a dark border or matting may 
be necessary to alleviate the effect.”

While the tips revealed over these pages are 
based on the creation of fantasy landscapes, they 
are just as relevant across any genre of art where 
composition and atmosphere are essential. 

14  Fantasy Art Genius Guide
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Lighting makes the 
difference between 
something looking real 
and something that 
looks fl at
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The Austringer: 
“722-705 BC – an 
Assyrian bas-relief found 
in the ruins at Khorsabad 
during the excavation of 
the palace of Sargon II 
(or Saragon II) has been 
claimed to depict 
falconry. It’s only fi tting 
that the tradition would 
go on way past our 
understanding”
© Martin Bland

Learn more
Throughout this feature we have gleaned some 
amazing advice from our four top artists. 
However, there are plenty of resources out 
there that can aid your learning further. Our 
artists reveal the places they turn to in order to 
continue their learning or gain inspiration. 
Martin Bland says: “A tricky question to answer 
as it is better to learn from a thousand sources 
than to stick to one. What I can add is, for 
concept art, seeing people’s raw unfi nished 
brushstrokes on quick sketches and paintings 
can teach you much more than any tutorial can. 
Picking apart strokes and seeing what made 
an image come together is the closest you can 
get to seeing into an artist’s soul, so speed-
paint threads are a massively important 
resource. There are a few very busy and useful 
threads at http://sijun.com/forums, CGTalk and 
ConceptArt.org forums.” 

Andreas Rocha also has a list of resources 
that he recommends for further learning: “I 
would say 3D Total’s excellent Digital Art 
Masters books and CGSociety’s brilliant 
D’Artiste series of books. I also strongly advise 
artists to build a library of inspirational works by 
other artists appearing on CGTalk.com and 
digitalartistdaily.com.”

Finally, Sarel Theron suggests: “Online 
community forums such as ConceptArt.org, 
MattePainting.org and CGSociety are great 
places to meet other artists, talk shop and have 
your work reviewed by peers. Even better is if 
you can get an internship at a post-production 
facility, such as ILM (Industrial Light and Magic). 
Finally, there is a lot to learn technique-wise 
from trade magazines such as Advanced 
Photoshop and Fantasy Artist.”

Lustral: “I wanted to bring a little beauty to a 

classic sci-fi  scene, so at fi rst glance, you see 

a sunset, although looking deeper you see a 

story unfold”
© Martin Bland
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Add effects to your portraits
Portrait

You need to 
think about the 
basics when 
painting portraits, 
such as lighting 
and skin tone 

18

38
Use layers to 
add subtle 
effects to 
portraits
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Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Bao Pham

Personal portfolio site
www.baophamart.com
Country USA
Software used Photoshop
Bao is a painter working 
with traditional and digital 
media. His digital work stays 
in the fantasy genre, dealing 
with fairytale imagery and 
occasionally gore. When 
working with traditional 
media he likes to draw from 
life and record as accurately 
as he can what he sees.

18  Fantasy Art Genius Guide
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Add 3D elements 
to paintings  

The purpose of this workshop is to show how, 
with a few simple processes, you can 
convincingly create the illusion of a tattoo 

coming alive. The goal is a simple one, but before reaching 
that point you should consider the context you want to create 
for the tattoo. What is the setting? Who is it on? And why is it 
coming alive?

Some pictures are story driven from the very beginning, 
but with others the story doesn’t really come to light until the 
very end. Have a bit of fun with the painting and go with the 
ideas that come to you to see where they lead. The subject 
matter is nothing serious and the desired effect is of course 

not a natural one. Basically, you are given free reign to play 
with it. This is my interpretation, one possible way that such 
an effect can be done. My advice would be to play around 
with the ideas presented here. See what works for you – and 
what doesn’t – and take it from there.

The brushes used for this are quite simple, a round Brush, 
a Chalk Brush, and a Splatter Brush. With fantasy painting 
and glowing effects, it’s easy to go all out and use any and 
all texture effects you can get your hands on, so remember 
to edit down. Make a painting and the effects can come 
afterwards. With a strong basic foundation, the fantasy 
aspects can really shine through.

Tempered  2010 Photoshop

Bao Pham Painter

The brushes used for this are quite simple, but with subtle 
texture effects the fantasy aspect really shines through

Start simple
Construct and prepare the shape of your fi gure

Shapes Start 
with a large brush 

and block in the shapes 
of the fi gure. The brush 
in this case is the Chalk 
brush with 5% Spacing, 
26% Flow, and Flow 
Jitter set to Pen Pressure. 
These settings give the 
brush a soft quality and a 
buttery effect, mimicking 
traditional brushes.

Choose a 
theme The overall 

theme is infl uenced by 
Chinese and Japanese 
culture. The dragon has 
the features of a snake 
but with a full mane, horns 
and whiskers. The fi gure 
is brightly lit against a dark 
background with a warm 
glow from the horizon.

01
03

Create a fantasy 
portrait with 3D images

Working
Progress

Step 02, Pose

Step 11, Gold cloth

Step 18, Structure first

Step 28, Sparks

Pose Work on the pose of the character. She needs to look a 
bit haughty and in control, with the dragon winding up her arm 

and into her hair. The dragon is the focus, so make sure the arm you’re 
going to tattoo is in the foreground of your design.

02
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Enhance your design
Work with light and shadow to add detail

Expression The 
woman’s expression 

is high and mighty, full of self 
importance. Make use of her 
features, narrow eyes, full lips, 
and raised eyebrows. Imagine 
how a model might express 
the emotions you want for 
your character.

Modify the costume Because the dragon is 
the main focus, the fi rst thought was to keep the areas 

around it bare and free of clutter. With further refl ections, it seems 
best to cover her up. Take this opportunity to add a little twist to 
the traditional garment with a gold breastplate.

Light the fi gure 
Until this point the 

light source has been kept 
intentionally vague. This 
allows changes to be made 
more easily. Establish a 
source now, with the light 
coming from the top right. 
The light is used to cast the 
dragon’s shadows onto the 
fi gure, enhancing the illusion 
that it is three-dimensional.

0604

10

Backstory As the painting progresses, the story of the character solidifi es. In my 
image, the woman is a sorceress who is very confi dent in her powers and the dragon is 

her pet. It lives on her skin and comes to life whenever called upon. You don’t need your image to 
communicate all of these details, but knowing it will help you to make design decisions confi dently. 

09

Be 
aware

When it is clear what the 
focus of the painting is, it is 
easy to forget the rest of the 
image. As you work, keep 
moving around the picture 
and add ideas when they 
come to you. Interesting or 
unusual details, however 
small, add an extra 
dimension to your images in 
terms of composition.

Cool the light By cooling the light on the fi gure, the 
contrast it creates with the warm colours behind help 

pull it into the foreground. One way to do this is to create a new 
Soft Light layer and brush a bright turquoise on areas lit by the 
light. Another is to create a new colour layer and change the 
colours directly, such as the areas around the hair where the red 
background still shows through.

05

Tweaks Make further changes to the light with a new 
Soft Light layer and move the fi gure slightly off-centre. 

By adding the detail of a right sleeve, you can create a triangular 
composition that is solid and grounded.

07

Secondary 
focus With the main 

ideas laid out, it’s time to shift 
the focus to the fi gure. The 
surface needs to be clearly 
defi ned before the tattoo can 
be convincingly applied.  

08
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Refi ne Refi ne the face and hair and pay attention to the shadows as the hair falls across 
your fi gure. When the structure has been refi ned, use a soft brush with 26% Flow to smooth 

out any undesired strokes. Alternate between the Eye Dropper and the brush and make use of the 
different sizes until reaching the desired smoothness.

Add interest 
Add more interest in 

the background to keep the 
eyes moving. Use abstract 
shapes for now and focus on 
the fl ow of the whole group. 
Later on, they will be shapes of 
butterfl ies and petals.

Gold cloth For the gold breastplate, I opted for a 
piece of gold cloth instead because it works better 

with the costume. With the metallic surface, it’s important to 
remember the warm refl ected light and the core shadow where 
two light sources meet. There is also a third plane above the 
chest where not much of the cool light would have reached.

11

13

14

Cooling layer The image still looks too warm, so 
go to Layers>New Fill Layer>Solid Color. Choose a 

turquoise blue and set the new layer to Soft Light. This cools 
down the whole image, so use the Layer mask created to 
bring back the warmth of the background. Having the effect on 
another layer allows you to refi ne the Opacity as well.

12

Hair Think of clumps of hair as ribbons and keep their 
shapes simple. Pay attention to how they interact with 

one another and use the surrounding skin colours to break up 
large shapes. Take advantage of the streaky brushstrokes to 
suggest strands of hair. The area with the dragon is kept vague 
for now and will be explored some more later on.

15

Dragon The dragon is kept on its own layer for easy 
access. As the painting progresses, small ideas have 

been added to it. Flakes of colour and gold have been added, 
just roughly at this stage. As it is quite dark, the colours will add 
more interest and really draw the eye. 

16
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Enter the dragon
Add texture and personality to the tattoo design

Dragon features The features of this dragon come from traditional Chinese and 
Japanese art. The major difference between this and Western depictions is the lack of 

wings. It is snake-like with a big mane that runs along its body, two horns and whiskers. These are 
only my ideas however, and the interpretation is up to you.

Textures Textures can be complex and as we are 
working on a small scale, it’s not particularly economical 

to spend too much time on it. Keep it simple, use a textured 
brush set to Color Dodge and brush a greenish yellow on the 
head of the dragon to add a gold feel.

Structure fi rst 
Just as with the fi gure, 

start with the structure of the 
dragon. Its head is similar to 
various lizards, though more 
narrow. Have numerous 
references images on hand  
but don’t stick to a particular 
one. It needs to look like 
a different creature, not a 
mixture of others.

17 18

20

Personality 
Add character to the 

dragon with human-like eyes 
and an on-edge expression. 
It has just come alive and is 
ready for action. A small detail, 
such as the butterfl y in its 
mouth, adds narrative.

19

Shadows Pay special attention to the shadow cast by 
the dragon. As it moves over a surface, make sure it fl ows 

along the curves of the body. As it passes over the hair, brush 
the shadow along with the fl ow of the shape. It’s a small, but 
convincing detail and will make all the difference.

22

The body Add legs to the dragon and have it crawl 
over her shoulder. Its feet are bird-like, suggesting the 

lightness and swiftness of the animal. The mane is kept dark 
to frame its face, but the mane on its back is a deeper gold to 
defi ne its body against the dark background. 

21 Tattoo To keep the 
fl at look of the tattoo, 

switch to the hard, Round 
Brush. This will help create 
clean graphic lines. Draw 
each scale and keep in mind 
that it is on a curved surface. 
Keep the colour lighter in value 
than the three-dimensional 
part of the dragon. The cloud 
motif adds graphic interest.

23
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Transition 
values With the 

three-dimensional dragon 
and its tattoo established, it’s 
time to merge the two. Think 
of it as a long balloon slowly 
infl ating as it lifts from the 
surface of the arm. The fi rst 
focus is on the two different 
values of the tattoo and its 
3D counterpart. Establish a 
gradient from the tattoo to the 
infl ated part of the body.  

Background shapes It’s time to defi ne the 
background shapes created earlier. Keep them simple 

and make them resemble fl ower petals and butterfl ies. Keep in 
mind the warm light from the horizon.

Transition scales Use the Round brush to draw the 
scales on the tattoo, but create a carved effect by adding 

dark shadow shapes rather than defi ning each individual scale. 
Brush on fl akes of bright colours to add highlights that enhance 
the separation of the tattoo and the real dragon.

24

25

27

Iridescence Add some interest to the body of the 
dragon by creating some iridescent scales. Indicate 

the dark of the shadows on the scales and, with the brush set 
to Color Dodge, brush on various neon colours to create the 
highlights. Use the fl akes of colours laid down much earlier to 
create layers of and unify the design.

26

Finish Flatten the image, duplicate the layer, set it to 
Color Dodge with 5% Opacity and apply a Gaussian Blur 

of 20. Duplicate this layer and set it to Overlay with 10% Opacity. 
This adds a subtle glow to the image. Flatten the image and 
duplicate the layer again, but this time set the Gaussian Blur at 3. 
Erase away the area of the fi gure, but keep the background. This 
will add a sense of depth to the image and help bring the fi gure 
out so that your three-dimensional effect will really shine. 

3029

Sparks Use an irregular Splatter brush to create the sparks rising into the air. Duplicate 
this layer adding a slight Motion Blur and set it to Color Dodge. Duplicate it again, add a 

Gaussian Blur and set it to Color Dodge to create the glow of the embers.

28
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Fire The warm light 
from the horizon has 

turned into a hot fl ame. Create 
a new Color Dodge layer and 
lightly brush on bright yellow 
wisps of fl ames. The fi re will 
add some rim lighting to the 
fi gure and the dragon as well.
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Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Drazenka Kimpel

Personal portfolio site
www.creativedust.com
Country USA
Software used Photoshop
I am a self-taught, freelance 
illustrator and graphic 
designer. I create 
illustrations infl uenced by 
18th and 19th Century art.

Source files
available

Custom brushes
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Classic portrait 
lighting techniques

Imagination isn’t the only key ingredient to 
successful illustration. There’s no room for 
ignorance when it comes to theories behind 

technique. Here we’ll discuss the importance of lighting in a 
portrait, how skin reacts to it, and illustrate relevant aspects. 

As we travel through time and revisit paintings created 
many years ago, bear in mind that artists in the past did 
not have the luxury of today’s modern innovations to aid 
them. Most of the paintings were done using natural 
lighting such as sun during the day and moonlight at night, 
with the exception of candle light to add a secondary light 
source. Even using natural light, we can achieve a myriad 
of effects, depending on the position of the light source.

Consider how Caravaggio used his light to create drama 
through the strong depth of shadows and bold directional 
light source. This technique was successfully used by 

many artists wanting to depict dramatic mythical and 
historical scenes, among other subjects. On the other 
hand, William Bouguereau used diffused ambient light in 
which his subjects were enveloped by light and bouncing 
hues from their surroundings, creating an ethereal, cheerful 
feel as oppose to a dramatic outcome.  

With the progression of technology things changed, and 
we can now add as many light sources as we want, and 
mimic natural light where there is none. but although the 
techniques changed, the principles have stayed the same. 

Today’s artists such as Marta Dahlig and Mélanie Delon 
have adapted some of those techniques and use them in 
digital media with great success. Mastering skin tones 
through lighting isn’t easy. It takes time and determination 
to understand the complexity of skin, so we can achieve 
the level of mastery of some of the great artists of our time.

Athena  2010 Photoshop

Drazenka Kimpel Freelance Illustrator and graphic designer

Here I’m using ambient lighting to accentuate the delicacy of 
skin and bringing out its natural glow

Learn to use portrait 
lighting successfully

Working
Progress

Step 05, Shading

First steps to lighting a portrait
A suitable background is important

Lighting Before 
we start, let’s see 

what happens to the subject 
under one directional light. 
Remember, a stronger light 
source will cast deeper 
shadow. Also, warmer light 
will create cooler shadow and 
vice versa. 

Skin tones Choose 
the palette carefully, 

considering the environment. 
Skin is a very complex organic 
substance. A little knowledge 
about what’s going on under 
the skin will help you determine 
how to tone it properly in any 
circumstances.

01 03

Step 09, Bounced hues

Step 22 Design

Step 26, Extras

Choosing the scene – background 
I’ve decided to place my character high in the sky among 

the clouds. Considering she is a goddess, clouds seem the 
right place to start. The clouds will be used as a stepping stone 
for light to bounce off of, as well as to give me the richness of 
hues down the road.

02
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Make the skin glow
The lighting and environment relationship, and their effect on the skin

Facial anatomy Bear in mind the way the human skull 
is formed – this will determine where to shade and how to 

contour the shapes the right way. Eye sockets will have deeper 
shadows as they are set more deeply, and nose, cheeks and chin 
will be exposed more, so hues will be lighter.

Shading Shading 
is important to achieve 

the feel of dimension as well 
as determine the light source. 
Skin will be lighter closer to 
the light source and darker 
in places further away. In this 
case, values aren’t as deep as 
they’d be in dark surroundings.

Developing the skin hues The character in this 
example has a light, porcelain-like complexion. To visualise 

this further, I added faint bluish-purple hues over her forehead, nose 
and a portion of her cheeks. In those areas skin is very thin, which 
will expose some of the blood vessels right beneath the surface.

Blending There are a few different ways to blend the colour, but I always use the same 
method – Spatter brush, with Opacity set to around 50%. Use the Color Picker to select 

adjoining colours and change them simultaneously while in the process of blending.

Eyes Eyes aren’t fl at surfaces. Think of them as a round 
ball, and paint them with darker edges and lighter around 

the centre. I used two-tone darker shades for the edges. I also 
used a very light violet hue over the eyeballs to make them glow.

04

05

06

07

08

Bounced hues The most prominent appearance 
of the bounced hues will be on the opposite side of the 

light source. So I paint some nice shades of pink, purple and 
orange hues on the side of her face shaded from the direct light. 
In addition, I add a layer of haze (layer mode set to Hard Light) to 
further the effect of daylight.

Skin highlights I decided that some of the residual 
lighting would be instrumental to highlight the right side 

of the character, considering the ambient lighting I chose for this 
exercise. So I panted some faint highlights along her chin, ear 
and a portion of her neck.

09

10

Use of 
reference 
material
Before you attempt to paint a 
portrait, or any other subject 
for that matter, it is advisable 
to build a library of reference 
materials. This is imperative if 
you want to stay true to a 
certain period, style or the 
likeness of a person. 
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Indulge your senses in the poetry of 
light through the Old Masters

The great 
illumination

Style
School

Art genres in 
a nutshell

Anne-Louis Girodet de Roussy-Trioson
Ossian Receiving the Ghosts of the French Heroes
Year: 1802
Location: National Museum Château de Malmaison
● This painting tells a great story. Even though there is so 
much going on, we can still keep the attention on the main 
subject through the path of light. The technique of circling 
the bodies with the bright washes of paint is something I 
love to use in my work as well.

Pierre-Paul Prud’hon
The Empress Josephine
Year: 1805
Location: Louvre 
Museum
● Here we see 
Napoleon’s consort, the 
Empress Josephine, 
reclining in the garden 
at Malmaison. The 
bounced red hues 
contrast with her pale 
skin, giving a dark 
warmth to the image 
which is quite unlike the 
other examples shown. 
Iconographically, the 
use of crimson signifi es 
her role as empress. 

Simon Vouet
The Allegory of Welth
Year: 2nd quarter of 17th C
Location: Louvre Museum
● What has attracted me to this 
painting is not only the story 
through the movement of 
colour and light, but the way 
the light illuminates the girl’s 
skin and transforms it into an 
almost translucent glowing 
mass. I wanted to use a similar 
colour palette in my painting, to 
accentuate the paleness and 
delicacy of the skin.

It’s hard to select just a few artist with the ability to transform 
the subjects of their paintings into three-dimensional, lifelike 
forms that breathe life and almost look touchable. To be able 
to use light to capture the essence and tell a story is truly a 
masterful skill. There’s something so lyrical about the way 
light travels through the strokes and reveals important details 
the artist wants to portray. Even after many years, these 
paintings are as fresh and alive as when they were painted.

The masters
Using portrait lighting – the master way

Anne-Louis Girodet de Roussy-Trioson

Hair Painting hair can be frustrating, especially when 
there is a certain style involved. The best way to tackle 

painting hair is in sections. As a fi rst step, I use big brushes (such 
as the Soft Round or Airbrush Hard Round brush) to block in the 
basic form of the hair. This may take many tries, but be persistent.

Details To tighten things up with the 
chest area, I’ve added a golden trim 

with the Greek key pattern to the white stola. 
Again, I’ve used the Pen tool to select the area 
with the pattern.

13

Pattern As a fi nishing touch I decided 
to place a golden swirl pattern on the 

blue wrap, to balance things up a bit. I carefully 
laid down the swirls to sit next to each other (not 
overlapping). Then I used Burn and Dodge to 
paint along the contour of the folds in the fabric.

14

15

Clothing Clothing items tell us about 
the person who is wearing them. My 

character is a Greek goddess, so I chose to 
paint a white stola draped over one of her 
shoulders, and a deep sky blue wrapped over 
her other shoulder. To paint the folds, I used the 
Soft Round brush with Opacity set to 100%.  

11 Styling I wanted to stay away from 
well-known designs of stolas, so added 

a sheer piece of fabric suspended from her 
shoulder. I used the Pen to select the area where 
I wanted the fabric, and the Soft Round Airbrush, 
Opacity 50%. I painted the edges fi rst, leaving the 
centre untouched to create a feel of transparency.

12

Hair texture 
Ancient Greek hairstyle 

has many folds, twists and 
curls. I pick one section at a 
time to paint in the fi ne hair 
strands, using a few shades 
lighter colour than the base, 
and a custom Bristle brush – 
but any dotted Spatter brush 
will do. Make sure you follow 
the form of each section to 
make it look believable.

16
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A real Greek goddess
Create the style of the period

Hair 
highlights Hair, 

just like skin, has many 
different hues. I gave my 
character an auburn hair 
colour – therefore the 
highlights will be light, 
reddish brown. On a 
separate layer, using the 
Bristle brush, paint in the 
highlights most exposed 
to the light. Blur the ends 
of the highlights and use 
the Dodge tool to brighten 
the highlights if needed.

Refl ective metals – basics Any highly polished 
metal surface will not only refl ect strong light but will 

pick up all the colours of the surrounding objects, and therefore 
we must be careful to include many bounced hues. The areas 
exposed to light will be very bright, almost glowing, but the ones in 
the shade will be very dark as a deep contrast.

Fine strands There are always some places where hair 
will get loose and strands will hang around the face. This is 

good to include as it creates a more realistic look to the portrait and 
adds liveliness to the whole picture. Use the Hard Round brush and 
randomly paint in the strands one by one. Do this with a very soft, 
fl uid motion.

Styling details Staying true to the period, as a fi nal step I add a hair ribbon to tie the 
hair in a fashionable style. This also adds to the overall richness and makes the whole 

image look more fi nished.

17

18

19

20 Palette of gold Our eye may perceive gold as yellow, but 
in truth it’s a mix of warm greens, yellows, orange and beige. 

The highlights are very bright yellow and white, and the shadows are 
mustard, green and brown. Midtones are the colours refl ected from 
other surfaces.

21

What 
are 

bounced 
hues?
Bounced hues are literally 
that: colours which have 
been bounced from one 
thing to another. In this case, 
a great example is the blue 
colour cast from Athena’s 
earring, which illuminates her 
neck and jawline. Coloured 
objects, particularly shiny or 
refl ective ones, cast their 
colours onto the surfaces 
around them, particularly 
under strong lighting. Making 
use of this is a great way to 
add both realism and tonal 
variation to a portrait piece. 
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Pattern Use references to help you pick the right kind of pattern, 
signifi cant to the period and character. I used the Greek Key pattern for the 

crown, the pattern of the shoulder fabric, and other ancient patterns to construct 
the pendant. I used the Pen tool to outline the patterns for a cleaner, sharper look.

23

Iconography Using certain cultural or historic motifs emphasises the details about 
the character, place and era that the painting is representing. Athena was a goddess of 

wisdom, strength and craft among other things, and for this reason I’ve painted a fl ying owl in 
the background to symbolise wisdom, which she was known to represent.

Texture I am a very keen user of textures, as I think they 
add more realism to a painting. Metals all have texture 

generated from wear and age, so a nice scratched metal texture 
would work well. I used photographic texture, which I converted 
into a custom texture brush (Opacity set to 50%) with the layer 
mode set to Overlay at 75% Opacity.

24

25

Design With the Hard Round brush, using some of the base colours from 
the palette, paint in the general shapes of the golden jewellery parts you 

want to include. It helps to generate some custom brushes for certain parts of the 
jewellery, such as the chain, to speed up the process. Be aware of the dimensions 
while you paint. Paint lights and darks accordingly.

22

Using certain cultural 
motifs emphasises the 
details about the place 
character, and era the 
painting’s representing
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Extras Adding more texture here and there is always a bonus when striving for realism in a painting. Here I’ve used 
some real photo texture for the lips to give them more life. Also, I’ve gone an extra step to paint in veins that may be 

visible in parts of the body where skin is very thin and pale.

Bounced hues Sometimes the colour of 
clothing can cast interesting hues on the skin 

depending on the type of fabric. The stronger the light, 
the stronger the bounced hues will be, and fabric with 
more sheen to it, eg silk and brocade, will bounce more 
colour. As our lighting is diffused, hues are very mild.

Refl ected lighting Refl ective materials 
such as gold, silver, bronze, etc will always 

bounce hues to the nearest surface. In this case, 
gold from the crown will cast some refl ective light 
on the forehead, and the shine of the earring will 
bounce off the chin bone. It is important to mention 
that colour will always be refl ected from the gems 
and stones. 

26

28

29

Custom skin texturing Even though fair, porcelain skin does not need too much texturing, 
for the sake of realism it’s good to add those natural bumps and blemishes. Use the Dotted brush 

with Spacing set to about 50% (or whatever suits your image). Adjust the layer blending modes and opacity 
settings for best results.

27

Importance 
of custom 

brushes
As a painter, you would always want to 
add something personal to your 
paintings. It’s a good idea to invest 
some time in developing a selection of 
your own custom brushes to help you 
do this. It’s a very rewarding process, 
and one which will help you grow as an 
artist as well.

Casting shadows Every object will cast shadow opposite its light source. This is a simple rule 
never to be ignored. The strength of the shadow will be determined by the strength of the light. Here I 

used very faint, blurred shadows.

30
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Take advantage of 
digital tools. Use the 
Pen wherever you need 
perfectly clear design.

A classic portrait
Behind the images

Background Lighting will greatly 
depend upon the background setting of 
the painting and vice versa. Open areas 
such as sky will have an abundance of 
bounced hues and a myriad of colours 
reflected around the subject.

1

Lighting An instrumental component 
to tackle right at the beginning and follow 
its direction all the way to the end. Make 
sure to always keep in mind the strength 
and differences between directional and 
bounced light sources.

2

Iconography Including historic 
or cultural motifs in the painting will 
symbolically and visually add meaning 
that directly relates to the image. In the 
portrait, it will identify the character and 
place it in the designated period of time.

3

Expression Portraits should always 
tell us about the mood and the story in 
some way. Facial expressions are one of 
the ways of telling the viewer about the 
state of mind our character is in, which 
adds to the resonance of an image. 

4

Details Details play a big part in visually 
narrating the story. Even the smallest 
detail can say something about the 
conditions and the time of the painting 
through texture or items hidden within 
the canvas. 

5

1

You can use the Smudge 
tool to blend the skin. 
Be careful not to over-
blend it and make it 
appear artificial.

2

3

4

5
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Creative
photomanipulation

A photomontage is created by taking two or 
more pictures and combining them into one. 
The term ‘photomanipulation’ covers a range of tricks 

carried out on the picture itself. 
In this tutorial we’ll be manipulating photos and looking at 

light, perspective and colour harmony. To create a 
successful manipulation, it’s important that your photos are 
in harmony with each other.

The history of doctoring photos dates back to the 1860s. 
Only a few decades after Niepce created the fi rst 
photograph in 1814, photos were already being manipulated. 
The fi rst ‘fake’ photo was created in 1840 using a 
photographic process by Frenchman Hippolyte Bayard.

The iconic portrait of US President Abraham Lincoln is a 
composite of Lincoln’s head and the Southern politician 
John Calhoun’s body.

Around 1910, photographic composites of different 
images were created by commercial photographic studios 
to bring family members together in one picture when they 
were not together in reality for the portrait session.

In 1982 National Geographic featured a digitally 
manipulated photograph on the cover of the magazine. The 
portrait image was originally a landscape photo of the 
Egyptian pyramids. National Geographic validated the 
manipulation by calling it the ‘retroactive repositioning of the 
photographer’. In other words, if the photographer had had a 
different angle when he shot the photo, the manipulated 
image is what it would have looked like.

The technique I use doesn’t end with combining images – 
I also add the painting process. Sometimes the image in 
your mind doesn’t transfer to the photos you’re working with, 
so you may need to add extra features to ‘close the gap’!

Rusty Robotic Geisha  2010 Photoshop

Aslı Yeniay Kizilay Graphic designer and digital artist

In this tutorial I will try to show you simple techniques to use in 
painting and photomanipulation

Create your own geisha 
girl artwork

Working
Progress

Step 04, Eyes

Bring out the face paint
Choose your colours

Painting Painting 
is very important in 

photomanipulation in order 
to create specifi c effects or 
features in an image. Here I am 
going to give you some easy 
techniques for painting.

Face painting First open the ‘geisha’ photo. In this 
step our mission is to paint a smooth geisha face and 

create a robotic look. For this process you can use the colours in 
step 2 or take a reference from the face.

01

03

Step 13, Hard rusty texture

Step 19 Adding flowers

Step 27, Flowers in her hair

Face painting 
colours The colours 

we choose for the face are 
also very important. They must 
be compatible with both the 
subject and the background. 
My advice is to start painting 
with light tones.

02
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Step-by-step: Drazenka Kimpel    Photoshop

Digital artists explain the 
techniques behind their 
amazing artwork
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Aslı Yeniay Kizilay

Personal portfolio site
wiksa.deviantart.com
Country Turkey
Software used Photoshop, 
Illustrator
I have been a graphic 
designer since 2003. I like 
to use dark, Gothic and 
fantasy styles.

Source files
available

Start photo
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Easy face painting techniques
Start with the eyes

Eyes Don’t forget that we’re painting a robotic geisha – so 
her eyes must be frozen and without any emotion. I chose 

blue, but you can use any colour you wish.

Eye make-up For eye make-up I researched geisha 
make-up style. My favourite colours are black and red for 

make-up – but you can use different colour combinations. I used 
a very high Brush Hardness for this part of the process.

Rusty look Now we want to try a rusty look for the skin. 
For this we can use a rusty stock image. Follow step 7 to 

change the colour settings. Our rusty image will then be greyscale, 
and the rusty texture will be available for the skin of the geisha’s face. 

Colour settings Sometimes the colour settings of the images should change. The 
purpose is to combine photo colour with background colour. There are many ways to do this, 

but my choice is the Hue/Saturation settings. 

Eyebrow light 
and shade In this 

step we’re painting eyebrow 
shadows and light, so our 
geisha’s eyes will be even 
more frozen and hard-looking! 
If you like, you can use the 
Dodge and Burn tools for the 
shadow and light effect.

04

05

06

07
08

Combining 
images One of the 

most important things for 
good photomanipulation is 
naturalness. Images that are 
on top of each other should 
have colour harmony, so play 
around with the layer blending 
mode settings. 

Finishing off the rusty look Finally, we need to 
choose the most appropriate layer blending mode for our 

rusty look – my choice was Multiply, with Layer Opacity at 60% 
for a natural look. 

09

10

Developing 
a style of 
your own
As you gain more and 
more experience, you will 
probably fi nd that you 
gradually begin to develop 
your own style. Take the time 
to search other artists’ work 
to give you some inspiration – 
but don’t forget to believe 
in yourself and your own 
unique ability! Share your 
experience with like-minded 
people, and you will fi nd it 
very rewarding. 
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Discover how artists approached 
manipulation without the camera

Alternate 
realities

Style
School

Art genres in 
a nutshell

Bernardo Bellotto ‘Canaletto’
Capriccio, Palace Stairs
Year: 1762
Location: Kunsthalle, Hamburg, Germany
● This painting is by the nephew of the artist we famously 
know as Canaletto, who carried on using the name after 
his uncle’s death. Taught by the original Canaletto, it’s 
likely that Bellotto had access to the camera obscura 
technique Canaletto used to create such accurate scenes.

Guiseppe 
Arcimboldo
Summer
Year: 1573
Location: Louvre, 
Paris, France
● Arcimboldo took a 
different and unique 
look at playing with 
visual reality. His 
allegorical portraits of 
the seasons were made 
up of incredibly detailed 
and well-observed fruit, 
fl owers and vegetables.  
Much of his work has 
been forgotten apart 
from these famous still-
life based images. 

Jan van Eyck
The Arnolfini Wedding
Year: 1434
Location: National Gallery, 
London, UK
● There are theories that van 
Eyck used primitive 
photographic technologies to 
capture the perspective and 
detail of this scene so 
fl awlessly. Many art historians 
suggest the use of a camera 
obscura and point to the 
mysterious object refl ected in 
the mirror behind the couple. 

In the history of art, the camera is a relatively recent 
invention. At less than 200 years old, it’s a baby when it 
comes to some of the techniques shown here. It’s theorised 
that artists from as far back as the 15th Century were using 
a camera obscura or camera lucida to draw physically 
accurate representations. And where there is accuracy, 
there is also the inevitable urge to play with it, and create 
something accurate-looking but utterly impossible...

The masters
Experimenting with visuals like a pro

Bernardo Bellotto ‘Canaletto’

The location of 
objects The location 

of objects is very important 
in photomanipulation. We 
need to be careful to choose 
the most appropriate position 
for the branches so they look 
natural and meaningful.

Hard rusty 
texture For the 

hardest rusty effect, we can 
use a grungy texture. Change 
the Saturation setting (hit 
Ctrl+U, then set Saturation to 
-100). Set the layer blending 
mode to Overlay. You can 
erase unneeded areas from 
your grungy stock image.

13

Adding features In Japanese culture we frequently 
see fl owers and trees, so I’m using fl owers and branches 

as added features in my work here. First I will show you how to 
paint branches.

14

15

Face shadow We use the 
Eyedropper tool for the face shadow, 

choosing the darkest area of skin on her face. 
We then use a smooth brush for painting 
shadows. If you wish, you can use the Burn tool 
for shadows in the main geisha image. For the 
darkest areas use the hardest brush.

11

Face light We need to create a clear 
light on the face for a robotic look. First we 

need a hard contour on the face, so we change 
our brush to the hardest setting. Now paint 
the shiniest area with the hardest brush. After 
painting, use the Erase tool with 30% Opacity for 
erasing the polished contour.

12

Painting branches After determining the 
location of branches, I start to add their shadows. I use 

two brushes for this. You can clear unnecessary areas from 
shadows with eraser Opacity set to around 30%.

16
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Hair and face accessories
Add a bit of fl ower power

Branch details Now we need to add details of the branches for a natural look. Here the 
colours are very important. Use dark green for shadow areas and light green for light areas.

Erase hair I will erase unnecessary areas of hair, 
because I do not need the fl owers in the original stock 

image. For erasing, I use the Clone Stamp tool. I’m taking texture 
from the background for erasing the fl owers from the photo.

Hair shadow In this step we will add shadow to the 
hair. We fi rst need to identify the section of hair shadow. 

For this I use the Burn tool. If you wish, you can use a soft round 
brush, but shadow colour must be darker than the base colour of 
the hair to look effective. 

Painting fl owers Draw and paint basic fl owers with 
a brush, making soft swirled shapes. I chose pink and 

purple, but of course you can use different fl ower colours.

Adding fl owers Here we’re adding fl owers on the 
face. I created a single fl ower then replicated it as both 

large and small. Also, you can rotate the fl owers in any direction.

17

18

19

20

23

Hair First create the shape and base colour of the hair. 
For the base shape I use a hard Splatter brush. Change 

the size of the Splatter brush for the edges of the hair.

22

Easy hair 
painting Many 

digital artists don’t like painting 
hair. The process may appear 
to be diffi cult and boring, but 
in fact it’s very easy. There are 
many ways of painting hair, 
so choose the easiest for you. 
This is my way.

21

Match 
your 

colours
Before you start compositing 
content from different photos, 
make sure you’ve matched 
up their hue, saturation and 
value as far as possible. If 
you’re painting over the 
photomanipulation base, 
then consider building the 
initial stages entirely in black 
and white. This allows you to 
build up the tonal values 
properly and then apply 
‘glazes’ of colour using layers 
set to the Color blending 
mode. This also makes 
colouring quicker too! 
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Final hair details 
Now we’ll do the detail 

of hair with highlights. For this 
I use a hard round brush set 
to Pen Pressure, with Brush 
Size at 1-2 points for adding 
details. The colour will change 
according to the light.

Intensifying the 
background  

Atmosphere is very important 
for photomanipulation and 
painting. In this image the 
background must be fairly 
dark, so to intensify it I fi rst 
fl atten all layers and then copy 
the layer. Now I change the 
Level settings on the top layer to 
increase the black.

Adding petals To add falling petals, select a light 
pink. I used the same soft round brush used in the 

previous steps. When you’re fi nished painting the petals, add 
some blur by going to Filter>Blur>Gaussian Blur and changing 
the setting to 10 pixels.

Hair sides In this step we’ll add details to the sides of the hair, again using the Splatter 
brush. Set Brush Size to 3-4 points and start to add detail with the base colour of the hair.

Adding some light Now we must add some details 
to the hair. These should also show the hair’s light areas. 

I add midtones of blue using a soft round brush, and remove the 
ends of the hair.

24

25

26

28

29

Flowers in her hair We’ll now add branches and fl owers to the hair. We’ll use the 
same principles as for the branches and fl ower paintings in the previous steps.27

Burn 
and 

Dodge
Most Photoshoppers eschew 
the Dodge and Burn tools as 
unprofessional but there are 
uses for them, as long as 
you’ve got a light hand and a 
gentle touch. They’re 
particularly useful in 
photomanipulations for 
adding fi nal details to the hair, 
eyebrows and eyelashes, but 
should be avoided on skin. 

Final step We’ve now added all the missing details. 
Sometimes you can skip some of the details – it depends 

on the image. I always look to the light and shadow, and for this I 
use the Dodge and Burn tools.

30

GENIUS GUIDE
Fantasy Art

Fantasy Art Genius Guide  37

032-037_FAGG_01   37 05/07/2012   10:22

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


38  Fantasy Art Genius Guide

Portrait

038-041_FAGG_01.indd   38 05/07/2012   10:23

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Use filters 
creatively
Deadly  2010 Photoshop CS4

Francisco Perez Illustrator

Learn how to take advantage of several 
fi lters for some nice subtle effects  

Digital artists explain the 
techniques behind their 
amazing artwork
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Francisco Perez

Personal portfolio site
www.pac23.com
Country United States
Software used Photoshop
Pac23 makes use of his 
graffi ti, video game and 
music infl uences in most of 
his art. From robots to fl ying 
pandas, to drumming 
vultures, to girls with tattoos, 
he adds his own colourful 
fl air to each of his pieces.
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Using fi lters in Photoshop may be a little tricky, because you 
don’t want the image to reek of Photoshop. That will make your 
illustration look as though it has been created by an amateur 

Photoshop user. When I fi rst started using Photoshop in my early teens, I 
remember using every fi lter available to me because I thought they were 
‘cool’. I then realised that my images looked like something anybody could 
have created through a simple click of a button. As I became more familiar 
with the program, I started using the fi lters in a different way – not using 
them as the main focus of my image, but rather as a tool to enhance the 
illustrations. I found that the best approach is to mix certain fi lters along with 
layer styles in order to get the most out of the effect I am trying to create.

Vintage martial arts movie posters inspired this illustration. We have a 
lovely but deadly katana-wielding female character. The actual character is 
detailed, while the simple background maintains certain 2D Asian style 
minimal shapes. Adding a few fi lters to the background really made a 
difference, and actually made the foreground character pop out even more. 

Reds and oranges are the predominant colours used, while a light yellow 
along with a dark brown was used to create some contrast between 
elements and to bring them together as well. A sunset setting with a simple 
background along with warm colours is what I had in mind the whole time 
that I was working on this. I wanted the viewer to feel the heat coming from 
this illustration! And a white border can always add that poster/postcard feel, 
if that’s what you’re trying to achieve. 

I start by sketching out the character very loosely. I use a 9x12 Wacom 
Intuos3 tablet (in case you were wondering). Once I’m happy with the pose 

Source files
available

Unfi ltered artwork
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and layout, I start erasing some lines while going over 
other ones. 

One of my favourite effects that’s really easy to 
achieve is the subtle ‘glow’ you can get from your line 
art. Sometimes line art just looks too boring, and this 
defi nitely gives it some life. Make a copy of the line art 
and set it to Multiply at around 50% Opacity. Now 
apply a Gaussian Blur at around 4 pixels or less, and 
you’ll see the smudged-out look the line art gets. This 
doesn’t always work obviously, as it depends on what 
type of illustration you’re working on. If you’re going 
for a squeaky clean look, stay away from this effect 
and try using the Sharpen effect instead.

Another fi lter I used was the Sketch>Halftone 
Pattern fi lter. It gives you the option of applying lines, 
dots or circle patterns. I believe this works best on 
gradients, and keep in mind that it will utilise the 
foreground and background colours that are currently 
picked. That’s the fi lter I used for the mountains to 
create some sort of ‘fog’ and introduce depth to the 
image. Fading horizontal lines remind me of old Art 
Deco style illustrations. 

The clouds looked very cartoon-like, and this 
created a nice contrast against the detailed 

foreground character. The effect even made it appear 
as though she were standing in front of some sort of 
wallpaper. The clouds felt a little too fl at once I drew 
them, so that’s when I decided to add the Graphic 
Pen fi lter. The layer was set to Screen, and this 
defi nitely gave a sort of ‘fl uffy’ look and it separated 
the clouds from the solid coloured shapes that were 
in the background. 

I even played around with the mountains in the 
background, by making the ones in front a solid 
colour and the ones behind set to a Pin Light layer 
style. I made a copy and dropped the opacity, then 
moved them to the side slightly, which gave a nice 
offset print effect. 

I then felt that the sky was too plain, so I added 
another Halftone Pattern fi lter set to Dots – and that 
effect always works if you’re trying to pull off a 
vintage-looking poster.

The sun’s refl ection on the water was intentionally 
made to look detailed but very crude at the same 
time. Gaussian Blur and Motion Blur were the only 
two fi lters that I used to obtain that effect. 

I also used a Gaussian Blur effect on the highlights 
that are on the foreground character – but very 
slightly. When I fi rst drew the highlights they looked 
too sharp compared to the rest of the character’s 
style. That’s the one element that connects the 
background with the foreground, because you can 
see yellow in the sky, the water and the character. The 
designs on the character’s sleeves are just doodles 
set to Screen at a very low opacity. 

I always think that very subtle, intricate details add 
a lot to an image. It’s something that many viewers 
may not catch the fi rst time they look at the 
illustration, but once they do, it’s also something that 
makes them say, “Wow, the artist went to the trouble 

Initial sketch This was 
done on a separate layer 

with an Airbrush Pen Opacity Flow 
brush. I used a dark red for the 
sketch and set the layer to Multiply.

Glow Copied the line art layer and applied a 
Gaussian Blur to give a subtle glow; same for the 

sun, and added water and white border around the image.

Reflection 
Sun reflection 

in the water was made 
with the Wave filter to 
give a ripple effect. 
Added mountains in 
the background to 
give some depth.

Colours Flat colours in the layer underneath the line art. Since the line 
art is set to Multiply, the colours blend nicely with the art on top.
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A look at other work by 
Francisco Perez

1-2-3
2004, Photoshop
● Pic of my girlfriend based on a photo I 
took. I thought the angle of the sun and 
her stance would make a nice drawing.

Dead Astronaut
2010, Photoshop
● Based on an idea I’d had for a while 
but didn’t know how to approach. I was 
happy once I came up with this layout.

Vulture
2010, Photoshop
● I’m a big Dave Grohl fan and this is a 
homage to Them Crooked Vultures. I’ve 
always been fascinated by drums!
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of adding something so minimal that some people 
won’t even notice!” 

Some of the fi lters that I fi nd myself using over 
and over again are the Blur fi lters. They can be your 
best friends if you use them correctly. I always 
recommend using them in a very subtle way, and 
even combining them. There are many times when 
people ask me how I created a certain look or style in 
my illustrations, and when I explain to them that I 
used ‘x’ fi lter with ‘y’ fi lter, they always say, “Ahhh, so 
that’s how you do it!”

Everything is fairly simple, and if you are familiar 
with the program then you know that there are many 
different ways to attain the same effect. I also added 
the Noise fi lter to the main elements in the illustration 
to give it that printed, aged look. From the start I knew 
that I was going to add an orange layer on top set to 
Color, and that I was going to use a folded paper with 
a creases layer set to Overlay. These two things were 
always going to be the icing on the cake that would 
bring the whole image together in creating the look I 
was going for. 

Remember too that fi lters don’t have to be applied 
to the whole image in a blanket effect. They make the 
most visual impact when they are used to pick out 
some key areas and fade others into the background. 
Use the Freehand Selection tool and make sure you 
have set Select>Feather to at least fi ve pixels’ worth 
of bleed, depending on the area you’re fi ltering and 
the effect you’re using. This will then ensure that the 
area or object you are applying the effect to will still 
fade realistically around the edges. And also try to 
avoid the run-of-the-mill oil-painting style fi lter at 
all costs. Nothing else makes a digital image look 
less professional!

Defi ne shape This will be the sun’s refl ection. I 
use a fl at coloured oval under the sun as the defi ned 

shape; I’ll distort to make it look like it’s refl ecting in the water. 

01

Build up 
filter effects

Build up fi lter effects to achieve 
the look you want

Wave fi lter Play with the Number of Generators, 
Wavelength, Amplitude, Scale. Copy the layer, set to 

Screen, apply a subtle Gaussian Blur and stretch to the sides.

02

Distortion I used the Rectangular Marquee to 
select areas of the refl ection and move them to the 

sides. Added some lines (Line tool) to break up the waves.

03

Motion Blur Apply Motion Blur at 0 degrees to 
the refl ection to make it look like calm water with little 

movement. This blurs the side edges, giving the right look.

04
Retro I added a Halftone Pattern 
filter set to lines on the mountains 

to give a retro look. Also added some 
designs on the sleeves of the kimono.
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Preview 
settings

Don’t just use fi lters on their 
default settings, that’s a 
surefi re way of looking like a 
smudge artist. Use 
Photoshop’s Preview function 
to see what happens when 
you adjust levels of colour, 
saturation, special effects etc. 
And remember that fi lters 
don’t have to be applied to 
the whole image area too! 

The character looks very clean and light, 
so it’s not really ‘popping’ and it blends 
with the background. Make a copy of the 
line art and apply a Gaussian Blur to give 
it more of a ‘messy’ smudged look. Now 
darken the flat colours and apply the Add 
Noise filter. This gives it a grainy, vintage 
look. It definitely helps to separate the 
character from the background.

Give the character a new look
A couple of fi lters will do the trick

After

Before

Nice vintage I added a paper texture 
with folds as the top layer and set it to 

Overlay. This makes the entire image look older – 
like a vintage movie poster.

Screen Added clouds to the 
background set to Screen using 

the same brush as before. Also highlights 
on the character, again set to Screen.

Bring it together I added a 
Graphic Pen filter to the clouds 

and applied an orange layer set to Color 
on top of everything. This brings all the 
elements together.
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Rough block outline to 
fi nished masterpiece

Working
Progress

Step 02, Two to three colours

Step 11, Double checking

Step 19, Finalise anatomy

Step 29, Dust
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Working with colours can be a diffi cult 
process. The task of knowing where to start can 
sometimes be a little bit overwhelming, but having a 

basic understanding of the primary colours and their 
complements will help ease you into the process, and 
make the correct decisions. 

Just like learning to walk before you can run, it is 
imperative to have a core understanding of value, hue and 
chroma. In short, hue refers to the colour itself, chroma is 
the measure of its saturation or vividness, and value is the 
measure of its lightness and darkness as it moves from 
white to black. Familiarise yourself with this concept by 
experimenting with the colour wheel. Choose blue as the 
dominant colour, add its complementary colour yellow/
orange, then add its adjacent colour blue-purple and shift 
the value towards white to get a pinkish colour. This is the 
basic palette and the start of this painting. 

Start with a simple, almost monochromatic palette to 
make the task less daunting. This also puts the focus on 
the anatomy and composition of the painting and prevents 
you from being overwhelmed by the colour spectrum. 
Once the structure has been established, then it is a matter 
of shifting each colour to its adjacent to add interest to the 
starting palette. From this point on, it is important to 
remember not to stray too far from the spectrum chosen or 
create confusion visually. 

It is too easy to go from clear to cloudy, to muddy 
colours. To keep their clarity and vibrancy you must look 
past the colours themselves and think of their complement 
and adjacent colours, and how they play against each 
other. This tutorial will help, breaking down the process and 
peeling off the layers that make up a vibrant and luminous 
painting. So let’s get started and look at building up a 
painting with neon colours

Blush Dust 2010 Photoshop

Bao Pham Painter

Learn how to use and maintain vibrant and luminous colours 
in your digitally painted portraitsDigital artists explain the 

techniques behind their 
amazing artwork
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Bao Pham

Personal portfolio site
www.baophamart.com
Country USA
Software used Photoshop
Bao is a painter working 
with traditional and digital 
media. His digital work stays 
in the fantasy genre and the 
occasional gore. When 
working with traditional 
media, he likes to work from 
life and record as accurately 
as he can what he sees.

Keep it simple
Start with a simple but strong foundation

The idea The painting starts with an idea of a 
girl with blue hair and bright eyes. The dominant 

colour is sky blue and the secondary colour is a dusty 
pinkish fl esh with a variation of a darker value of each 
colour. With a big chalk brush, lay down the general 
shape of the fi gure with her pink fl esh and blue hair 
against a dark background.

Colour outside 
the line Loosely 

indicate the eye sockets, 
the shadow under the nose, 
and the lips. Think of them 
not as features, but shapes 
on a curved plane. Let the 
brushstrokes move into each 
other to create mid-range 
colours to pick from.

01

03

Two to three colours Start with a couple to three colours 
as a base to build on. It minimises the thinking process and 

shifts the focus to the anatomy and shape of the fi gure as it relates to 
the background.

02

Add neon colours 
to portraits
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Colour and form solidify
Form and colour come together to realise the idea

Shape breakdown Break down the larger shapes to form the structure of her face. 
Pick colours that have been laid down and use them to add shadows. Brushstrokes are put 

in wildly, but intentionally vary from distinct shapes to very soft gradation.

Juxtapose light and dark Play with the 
juxtaposition of light against dark. Contrast her pale skin 

against the dark upper background and her dark dress against 
the brightly lit lower background. This brings the fi gure out from 
the background and adds depth to the image.

Introduce the complement Experiment by 
adding a complement. Red is replaced by yellow using 

Image>Adjustments>Selective Color. The dress and the design 
is further explored using the complementary colour.

Composition strength Use the hair to frame 
the fi gure and to add movement to the image. The 

face is tilted up to indicate it’s on a higher plane to add to the 
perspective of the image. A soft round brush is used to quickly 
and broadly indicate soft shadows on the face.

Add warmth 
The fi gure has so far 

been painted with the three 
colours that were put down at 
the beginning. To add more 
warmth to the face, use a 
medium saturated pink and 
faintly add touches to the 
cheeks, nose and lips.

04

05

06

07

09

Be a designer Have a little fun with the costume by 
using odd shapes and breaking it up into fl ying pieces. 

Use it to add visual interest and create a lifting motion in the 
fi gure and the image.

08

Refi ne anatomy 
Make simple changes 

to the anatomy of the fi gure by 
fi rst making a selection of the 
area that needs to be moved, 
then use Cmd/Ctrl+Shift+C 
to copy all parts of every layer. 
Paste the compiled image 
using Cmd/Ctrl+Shift+V and 
move it where it needs to go.

10
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Use shadows 
Darken the edges of 

the image by creating a new 
Overlay layer and adding a 
soft gradient of dark blue. This 
sets the lower part of the body 
back and moves the focus 
to the face. It is the same as 
setting the fi gure in shadow 
and it should take on some of 
the blue of the background.

Double checking Continue work on the anatomy and design, while 
keeping the image zoomed out to prevent the addition of unnecessary details. 

Make sure all the features are aligned on the same perspective. Move the body back to 
extend the neck and add tension to the fi gure.

11

12

Going back The yellow wasn’t adding much 
warmth to the painting, so it is shifted back to the 

pink in the original sketch by using Layer>New Adjustment 
Layer>Selective Color. This keeps the adjustment on a different 
layer and the original can be brought back again using the mask 
created with it.

15
Everything in its place Up until this 
point, the image has been painted as if it was 

one layer. With everything coming together to form 
this more extensive sketch, it’s time to prepare it for 
the next step. I’ve cut out the pieces of feather and 
butterfl y and pasted them into a new layer. This will 
make changing them easier later on.

16

Bao Pham’s other 
amazing paintings

Enoki
2010, Photoshop
● This was done as a commission 
portrait of a client’s character. The 
colours were all there in the reference 
image, so it was only a matter of how to 
use them in a realistic way.

Nature Boy
2009, Photoshop
● This image was a product of several 
previous images I’ve created. They 
were cut up, stretched, and overlaid on 
top of each other until an image 
appeared and I took it and ran with it. 

Pearl
2009-2010, Photoshop
● This was a limited palette painting in 
blue. Keeping the colours subtle was a 
challenge, but the limited palette really 
shines when a complement is added in 
the right places.

Soften the features Zoom into the face and use a medium sized chalk 
brush to refi ne and soften the features. Lift the brow and part the lips slightly 

to add some sensuality to the face. The lower lip is brightened with a slightly more 
saturated colour, while staying close to its value.

14

Liquify To move the 
features around on a 

small scale, use Filter>Liquify. 
Use the Move tool to move the 
eyes into alignment. Before 
doing this, make sure all the 
layers are combined and 
duplicated using Ctrl+Shift+C 
(PC) or Cmd+Shift+C 
(Mac) and Ctrl+Shift+V or 
Cmd+Shift+C.

13
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Time for fun
The foundations have been set, and now it’s time to build and decorate

Cloudy First, turn the butterfl y layer off and out of the way. I’ve decided that the dress will 
be sheer as it wraps around her shoulder. To suggest the texture of the fabric pick a darker 

value and slightly saturated variation of the skin tone and gently brush it on with a soft broad stroke. 
The warmer colour will contrast nicely with the cool skin tone.

Smooth The focus now is on the anatomy of the fi gure 
and it should be fi nalised. When smoothing skin tones, 

use a large soft round brush and pick from the surrounding 
colours. Gently airbrush the surface while maintaining some 
of the brushwork underneath. For smaller areas, use smaller 
brushes to maintain the edges between the forms.

Finalise anatomy The right arm needs some 
special attention, so with some references on hand, I 

make the correction. At the same time, I work on refi ning the 
facial features by picking colours from the surrounding area.

Sheer Add in strips of saturated blues to indicate where 
the fabric is folded. It looks too pink now, and the blue 

of the fabric needs to come back. Once again, use a large soft 
brush to gently brush on a very saturated blue, pressing harder 
where the fabric concentrates on the chest. Add more strips of 
blue to bring back the folds.

17

18

19

20

Hair Move onto the 
hair and start breaking 

down the large shape. Think 
of it as ribbons moving against 
and into one another, twisting 
and curling as they pass 
through each other. Use dark 
shapes to accentuate the 
shadows and to suggest the 
separation of the layers.

21

Bright eyes On the same Overlay layer, brighten the 
eyes using bright blues and turquoises. To contrast with 

the blue of the eyes, brush on some violets, pinks, and yellow. 
Vary the colours to get the effect you desire. The brightness and 
saturation of the colours brings the focus to the eyes and draws 
the audience in.

23

More hair Work 
with a large brush to 

‘comb’ out the ribbons of hair, 
and then decrease the brush 
size to breakdown the larger 
shapes. Create a new Overlay 
layer and brush on a mass of 
dark blue to set some of the 
hair back. Also, use a bright 
blue-green colour to pull 
some of the front hair forward. 

22
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Tweaking the fi gure With the fi gure almost 
fi nished, go back and examine the alignment and 

anatomy of the fi gure. Use the Liquify tool again to realign the 
eyes and the lips, and fi nish off the fi gure.

Glow Once the painting is fi nished, fl atten it and make 
a duplicate layer. Set it to Screen and apply a Gaussian 

Blur set around 20 to create a glow. Lower the Opacity to keep it 
subtle. Duplicate the Screen layer and set it to Overlay to deepen 
the colours. This also helps tie everything together.

The secondary character With the fi gure 
fi nished, it’s time to fl esh out the butterfl ies. Keep in mind 

the general movement of the group and how it can add to the 
composition of the painting. Keep them on a separate layer so 
that they can be moved to work with the composition if needed.

Rearrange As you work on individual butterfl ies, it 
is easy to loose track of them as a group and that can 

create clutter. Take a step back and edit. Change a colour if it 
contrasts too much and remove it entirely if it’s too busy. 

24 26

28

30Dust Add some magic to the painting by sprinkling 
dust around the butterfl y and on the fi gure. Once again, it 

adds visual interest, movement, and an otherworldly quality. Add 
in moderation and appropriately or it can cause confusion. 

29

Flapping leaves 
Think of the butterfl y 

as two triangular leaves 
attached to each other, 
fl apping in the wind. Start with 
the general shape, varying 
the moment that each one 
is in motion. Once that has 
been established, create the 
pattern using references, 
remembering to stray a little to 
keep the design unique.

27

Shadows
The colour and light of 
the background always 

fi nd their way onto an object. 
Using the colour of the 
background for the shadow is 
a good way to set the fi gure 
within the painting. Don’t be 
afraid to use pure colours for 
the shadows. As long as it is 
the right value, you can use 
any colour for the shadow.

Tweaking the 
design Add interest 

to the design of the dress by 
creating a pattern with the blue 
and orange. Reference the 
design after birds and butterfl y 
patterns to tie it in with the 
fl ying butterfl y imagery.

25
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Fantasy lighting
On The Scent  2010 Corel Painter X, Adobe Photoshop CS4

Kelley Harris Fantasy Illustrator

I will show you how to paint and illuminate an environment 
and character using expressive lighting techniques

Digital artists explain the 
techniques behind their 
amazing artwork
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Kelley Harris

Personal portfolio site
krhart.com
Country United States
Software used Painter X
The art I create usually tries 
to display a certain mood or 
emotion, often using light as 
the main method to convey 
these ideas. My interests 
focus around dark fantasy 
characters and creatures, 
sometimes moving into 
more surreal imagery.
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To illustrate a mood or a strong sense of 
dramatics in a concept or illustration, 
lighting is one of the more important 

features you can utilise to help achieve a 
captivating painting. You may follow traditional 
rules closely for accuracy, or you may bend and 
exaggerate these rules and allow yourself freedom to 
explore to your heart’s content. This is exactly what I’ll 
be showing you in this tutorial, using a painting of a 
ranger and her scouting familiar.

While wanting to exaggerate and go above and 
beyond traditional lighting in a painting, there are 
standard and set rules to follow for achieving a 
realistic lighting effect. Rim lighting, suffuse glows, 
light particles, refl ected light and shadow rules were 
adhered to, and in the most dramatic areas we bent 
them a little. However, there is a foundation of lighting 
fundamentals that were always kept in mind during 
the entire painting process.

Before we start, it’s good practice to set up lighting 
examples in your workspace. Prior to the painting 
being established, objects were observed under 
different lighting directions. Take into account how the 
light bounces off different surfaces and textures. 
What colour is the light? What colour is the surface? 
How do these objects and light interact with things 
underneath them? Behind them?

Along the right side of the fi gure’s face, a warm, 
yellow-hued rim light is used to show the side of her 
face that would be directly in the line of light if we 
were to see her from the opposite direction. The 
same is applied to the sides of branches and twigs in 
the background. It’s important not to use rim light as 
an outline along elements, since planes and forms 
are not fl at – they bend and recede into the 
background. It shouldn’t be used as a sort of line art 
around a fi gure, as it can make three-dimensional 
shapes appear fl at and too stylised. We want the 
fi gure to remain the central focus of the painting. 

However, the background and left sides of the 
painting will need a little bit more attention as well to 
make the environment completely believable. There 
is water, a cooling element to such warm tones in 
the foreground. This causes cooler refl ections along 
the base of the limbs and on some of the leaves. 
Warm colours are also refl ected along the character 
– the brilliant red from her clothing and silver from 
the twin blades she carries. In order for all elements 
to mesh with one another and become believable, 
they need to interact with each other. They have 
to exist and refl ect, blend, and bounce colour in 
perfect harmony.

We’ll also discuss how to keep in mind your 
shadow placement, because it’s just as important as 
lighting placement. We need the character and object 
to have weight and substance, as they are illuminated 
in various intensities. The hair casts shadows, even 
though it is free-fl owing and weightless. The swords, 
feet and leaves shatter light, and add breaks and 
cool areas into the environment. Keep all the 
shadows cast in a similar direction, as well as your 
light, for continuity.

To get a very strong sense of atmosphere, we 
couple dramatic lighting with a charismatic character 

We need to add more elements 
of interest to the painting, but we 
aren’t sure where to place them 
and how they’ll be illuminated. 
One quick way is to create a new 
composite layer and paint the 
elements where you desire. Lock 
the Transparency of the layer, and 

airbrush shadows and lighting 
where desired on those elements 
only. You can use harder-edged 
brushes to add more highlights.

Lilies are growing haphazardly 
on some of the branches. The 
lily furthest away from the light is 
toned down with cooler colours.

Quick lighting technique
Integrate additional elements into the environment

AfterBefore

We take a quick look at 
Kelley’s other work

Remnants
2010, Corel Painter X
● I was having a lot of trouble getting 
ideas onto paper – the dreaded artists’ 
block. After a brief hiatus and mounting 
frustration, an image of forcing ideas 
into the open inspired this concept.

Vase And Necklace
2009, Corel Painter X
● I’ve done studies before and digital 
still-life, but nothing seriously detailed. I 
took advantage of track lighting at a 
friend’s house, and over a two-day 
period painted this in their kitchen.

Sleep Sentry
2010, Painter X, Photoshop CS4
● A long stint of bad dreams inspired 
this quick concept image. I joked to a 
friend about setting up a ‘dream 
security guard’ in my head and what 
he’d look like using twilight colours. 

Direction and placement Lighting direction 
and shadow placement is established at the start 

of the painting, along with the sketch. The figure, the cat 
and rough placement of major shapes can be seen.

The dark side Here we make the shadows as 
dark as possible without losing the shapes of the 

branches and figure. More intense highlights are added 
throughout, for lighting balance and concept continuity.
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Dodge When used sparingly, PS’s Dodge tool can 
create fantastic dappled light. On upper branches, 

add small areas of light using soft-edged brushes.

01

to create what turned out to be a painting with 
movement and colourful scenery. The character is 
slightly fl amboyant in her dress and personality, so 
the choice in lighting should follow suit to help 
accentuate the fi gure and overall mood of the 
painting. During a ranger’s adventures, many types of 
terrains are traversed, and many types of trails are 
followed and uncovered. In game settings and 
fantasy stories, rangers are described as fi nding their 
home in natural environments, and having respect for 
animals and nature because they live and move 
alongside them. 

To help push the illustration into a more believable 
natural environment, we have to add certain things 
that you normally wouldn’t think of if you were 
standing there yourself. Usually our attention isn’t 
focused on dust particles or how our eye perceives 
light as glowing or refl ected, so explaining this for the 
viewer is key. Additional small details such as 
illustrating humidity, debris and shedding fur seem 
commonplace, as the lighting placed upon them 
refl ects the rest of the environment.

Some paintings can speak for themselves, but 
here we wanted a few obvious clues combined with a 
little mystery of the concept. During the creation of 
the fi gure and additional elements of the forest, more 
surreal objects were placed along the fi gure and her 
companion to give her more than the feel of an 
ordinary ranger or scout. The idea of her having a 
familiar gave her a bit of mystery and fun. Imagine a 
ranger of some renown, someone who is so good at 
fi nding trails and following marks that she allows the 
people she is after to know she is around and on 
their tail. Maybe red moths start to show up on trees 
or in the air? It seems she would play a game with the 
mark, much like a cat would with its food. Maybe her 
companion is having as much fun as she is as he 
stalks alongside her. 

All these ideas were spawned during the painting 
stage. They’re fun to think of and can help inspire an 
artist to complete the painting and add a back-story 
for viewers.

Dappled 
lighting

Techniques for creating 
wonderful patterns of light

Soften edges The light edges were too harsh. 
Use the Airbrush tool at a low opacity to push the 

diffuse glow of the dappled light on the trees and fi gure.

02

Nucleus Using Dodge, add spots of light to the 
centre of each area of light, creating a ‘nucleus’ of 

the most intense light path as it hits branches and leaves.

03

Shadows Add an Overlay adjustment layer to 
place shadows alongside the most intense beams to 

magnify areas of light using contrast. Adjust opacity to suit.

04

Extras Areas of entry for the 
strongest points of light are added 

to the upper canopy of the forest and 
extend into the far background. Soft 
speckles are placed through the leaves.

Layer 
options

When you’re uncertain 
about a major element 
to be included in a painting, 
it’s best not to limit yourself 
when it comes to 
experimenting with options. 
Create multiple composite 
layers, and switch them on 
and off until you fi nd the 
direction you would like 
to take.

Final steps Colours and 
highlights are strengthened 

around the figure and her companion, and 
reflected light added under the branches. 
Water, moths and lilies add interest.
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Digital artists explain the 
techniques behind their 
amazing artwork
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Marta Dahlig

Personal portfolio site
blackeri.deviantart.com
Country Poland
Software used Painter, 
Photoshop
Marta is one of the world’s 
most well-known exponents 
of digital painting. She 
specialises in character 
images of fantasy female 
characters which are popular 
with digital art fans all over 
the world. 

Paint perfect skin in 
Painter & Photoshop 

Block in colour Colour blocking first shades onto the canvas can be 
done with practically any tool, as long as your strokes remain opaque. 

To start, prepare a sketch of a character 
you want to depict. Before you put in the 
colour, however, there are a few basic things 

that you should consider and decide on. Those 
elements are light source, colour palette and brushes. 
First, you should plan your light source, which will in 
turn dictate your palette. Stronger light sources will 
put the most emphasis on highlight and shadow 
hues, while softer lighting will accentuate midtones.

Aside from the actual strength, time of day will also 
infl uence your choices – hues will be much colder for 
scenes placed in a dawn setting, remaining warmer 
and darker in dusk compositions. If you are unsure 
about your skin painting, I would highly recommend 
going with a standard frontal daylight light source. 

After you decide on the light source, it is time to 
move onto composing your palette. There are several 
issues I would like to bring to your attention. First, 
remember that the hues of midtones, highlights and 
shadows that you choose should all differ from each 
other. It is also often a good idea to make highlights 
and shadows different in terms of colour polarity – if 
the highlight is a warm tone, like yellow or orange, you 

can try to make one of the shadow hues colder, for 
example green or blue. Another well known rule, that 
you should always keep in mind, is that you should 
never choose pure white and pure black for shading.

Last, when you choose colours, remember to 
always pick shades that are slightly more saturated 
than desired, as applying them on low opacity will 
drop their perceived saturation anyhow.

After you compose your palette, recreate a small 
version on a separate layer in the fi le with your sketch, 
so you can eye-drop it whenever you need a specifi c 
colour. Now, pick a brush you feel most comfortable 
with and put in the midtones and shadows according 
to the light source you defi ned in step 1, with the 
colours you chose in step 2. Since it’s the very 
beginning, it doesn’t really matter what brush you do 
it with, as long as the opacity is high and the edges 
remain solid. At this stage, the image won’t probably 
look too interesting, but this step is all about creating 
a basis which we will later detail and texture.

The last important issue you should decide on is 
which brushes to use throughout your painting 
process. While most effects can be recreated with 

In this tutorial I would like to explain the process of 
painting skin, as well as share some key tricks and tips

Revelation  2010 Painter, Photoshop

Marta Dahlig Character painter

Sketchy start A pencil sketch 
is a good way to start your image if 

you do not feel comfortable with blocking 
colours straight onto the canvas without 
any guideline. 
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Paint perfect skin in 
Painter & Photoshop 
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Ready 
for your 

close-up?
The most effi cient way to 
learn how to realistically 
paint any object is by simply 
looking at it and analysing 
its form and interaction with 
light. For learning texturing it 
also is a good idea to 
analyse macro 
photographs. Viewing such 
a picture up close lets you 
clearly see and eventually 
mimic the surface.

any tool, there are certain brushes that will help you 
create desired effects faster and easier. For the colour 
blocking stages and early blending, I would therefore 
recommend brushes with solid edges. Those can be 
custom Photoshop brushes or even personalised 
Painter Acrylics or Oils. Brushes with solid edges will 
create more texture, which is quite priceless for 
creating basic layers of skin, as they help to underline 
the structure of a painted object. 

Spattered brushes are great for latter stages of 
blending as, when used on a low opacity, they create 
a texture resembling the skin’s pores. Softer 
one-point brushes, such as the classic airbrush, are 
best for latter stages of colour enrichment, when you 
wish to slightly smooth up transitions or seamlessly 
introduce a new shade to an existing composition, 
like adding a blush to the cheeks. 

Once you know which tools to use on particular 
areas at particular times, pick a solid brush and use it 
on a low opacity (my settings vary between 15 and 
30% in Photoshop) on the areas that still need their 
shadows defi ned. Keeping in mind the structure, 
such as concavities and convexities of the depicted 
object, apply subtle shades that would underline their 
interaction with the light source. The most convex 
areas (marked with white arrows on the screenshot) 
should of course be most highlighted, whilst the most 
concave ought to be left darkest. Apply the colours 
gradually, eye-dropping the shades from your colour 
palette. If the colours start to look muddy, it means 
that the saturation of shades you picked in the colour 
composition stage was too low. If that happens, 
simply alter the palette by increasing colour saturation 
and continue shading.

Once the main shades are blocked in, you should 
start thinking about smoothing all the blocked areas.

Using lower opacity brushes should have made 
the basis somewhat smooth already, however special 
blending techniques will help you control the texture 
you created and use it as a means of adding extra 
realism to your painted skin. The fi rst stage of 

Choose a midtone Choosing a midtone will depend 
on the light source you plan. For standard scenes, it’s safest 

to go with a typical beige. 

01

Compose a skin 
colour palette

Learn how to choose colours 
for character painting 

Highlights and shadows When picking highlights 
and shadows, remember that their hue should differ from 

the hue of your midtone. 

02

Enrich your palette After you have chosen the 
highlight and shadow colours, eye drop them. With those 

colours selected, apply some strokes on top.

03

Finalise colour choices Review all the colours you 
created and choose the boldest combinations that strongly 

differ from each other. 

04

Choose your brushes Deciding on the brushes is a crucial step for skin painting, 
as each of the brushes performs best at various tasks.
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blending is using very low opacity solid brushes (5-
15%) and running them over the areas that need 
smoothing, while eye dropping colours. When the 
transitions look slightly smoother, you can change the 
brush to a softer airbrush or, preferably, a spattered 
brush and run with it over the same areas, still on a 
low opacity. The slight dots that the spattered brush 
creates are great for simulating skin pores, helping 
add to the realism.

Even though this process is often subconscious, 
the way you place your brushstrokes greatly affects 
the way your painted skin looks. Knowing which 
brushstroke motion to use at a specifi c moment can 
prove crucial for conveying realism. In character 
painting for example, round motions are most 
effective for depicting roundish surfaces, such as 
cheeks, chin or tips of the nose, while vertical or 
horizontal parallel strokes underline height or width 
respectively. For situations where you want to add 
depth to areas that might otherwise seem fl at (such 
as arms or stomach), you might want to blend with 
both vertical and horizontal strokes, while underlining 
the most convex areas with round motions.

When all the main tones are applied and smoothed 
together, is often the moment when the image is 
considered done. Having a decent-looking skin 
surface is great, but instead of fi nishing your work, 
you can begin a new stage of your workfl ow – the 
hardcore polishing phase. What you can take care of 
at this stage are the small hue variations found within 
the skin. Portraying them can boost the realism of 
your painting to a whole new level. That is great news 

Shadows Application of shadows and highlights should be done with great attention 
to detail. For best results apply colours on a low opacity, so you can control and alter the 

outcome as you progress throughout the image. 

Review your palette Truly realistic skin comes from 
combinations of many colours, so it’s absolutely crucial to 

keep reviewing your palette as you progress, applying additional 
colours if needed. 

Blending Blending is a vital part of the painting process, if you care for more realistic 
results. Unfortunately, it is rarely a good idea to rely on a program’s automatic blending 

tools (like Smudge). 
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Details Even the smallest of touches can have a tremendous effect on the final image. It’s therefore important to 
know which of the details are most worth investing time in.

considering that they are not hard to apply at all – what’s diffi cult is 
simply remembering to put them in place! Those tricks include the 
slight red tint on the earlobe, nose tip, chin, elbows, tips of the fi ngers, 
greenish tints on the insides of forearms, and slightly violet shades 
under the eyes. 

Once all shades are in place, all that’s left is to accentuate small 
physical nuances. Doing so will help you achieve a very believable 
skin surface. 

The most important, easy to be forgotten details within the face are 
the small highlights simulating folds outside the inner eye corner and 
above the upper eye lid as well as a tiny highlight on top of the nose 
and chin.

The last, often omitted element is veins, which will be covered in the 
following steps of this workshop. Veins are an excellent touch not only 
as enrichment of your skin’s surface, but also as means of conveying 
emotion and adding drama. Painting them can be a challenging task, 
but once you know the tricks it is just another means of achieving 
realism. To start, pick an airbrush and a turquoise colour to create 
lines simulating main veins. The strokes should not be too opaque – in 
fact, they should be barely visible. When the line is ready, dim its 
beginning and end strongly by using the airbrush with your midtone 

A selection of Marta 
Dahlig’s artwork 

The Fifth
2009, Photoshop and Painter
● A surreal personal image, in which I 
tried to plan the composition and 
stylisation to resemble Salvador Dali’s 
style. The image was created in Painter 
and Photoshop with a Wacom tablet in 
around 45-50 hours.

Captive
2008, Painter
● Image originally prepared for The 
Offi cial Corel Painter Magazine. The 
challenge for this project was to design 
a painting resembling a typical fashion 
shoot, yet with a considerable amount 
of emotion and tension. 

Judith
2009, Painter and Photoshop
● This image was an extreme 
challenge in realism and a take on a 
theme that I have found fascinating for 
many years. I faced a lot of technical 
diffi culties since the whole painting 
process was video-recorded. 

Different strokes The 
direction of your strokes is 

nearly as important as the brush you 
choose to paint them with. Knowing 
how to place and angle your strokes 
is yet another means of conveying 
realism when painting skin.

Veins are an 
excellent touch 
not only as 
enrichment of your 
skin’s surface, 
but also as means 
of conveying 
emotion and 
adding drama

56  Fantasy Art Genius Guide

Portrait

052-057_FAGG_01.indd   56 05/07/2012   10:33

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Naturalism The more convex the vein, the more 
dramatic your character will look. The most natural parts 

to add them are tops of hands, but veins also look effective 
when painted on foreheads, arms and legs.

Software 
fl exibility

While I am often asked to state 
which is better, both Photoshop 
and Painter have their 
unquestionable advantages. In 
modern times fl exibility is the 
best trait an artist can possess, 
and therefore having both of 
these programs in your arsenal 
is nearly mandatory for a career 
in the digital art industry.

convex the vein will seem, so be sure not to go 
overboard! Good places to paint veins are the 
forehead (to underline stress or thinness of skin), 
forearms and outer sides of hands.

After applying all of the polishing touches, you are 
basically done with your skin surface. It doesn’t mean, 
however, you cannot still experiment with it! If you still 
feel that you might have done something better, or 
that you are still lacking something, there is an easy 
way to spice up your skin surface. The Color Balance 
tool, both in Photoshop and Painter, offers possibilities 
for quickly manipulating the hues of your skin. It’s 
hard to believe how big a difference can it make if 
used correctly. This tool is most attractive to those 
who still feel slightly unsure about their colour choices, 
but can also be a great help for professionals for 
fi ne-tuning images.

Personally, I most often end up reducing Red from 
Highlights and increasing Blue from Shadows. The 
best results, however, come from simply playing with 
the tool, so just go ahead and give it a try! 

Veins Painting in the veins is great as an extra touch for character paintings. 
You should start with some airbrush strokes simulating vein shapes.

colour on top of it. This way the vein will slowly appear from under the skin, just to fade 
gently back into it. The last step to paint in the veins is to add a more opaque, slightly 
thinner line on top of the one you created in the previous step. 

In places where the vein is most convex, the colour should gradually become more 
opaque. In those convex parts, add a slight highlight on top of the vein and a small shadow 
according to the light source you chose for your painting. The bolder the shadow, the more 
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Digital artists explain the 
techniques behind their 
amazing artwork

A
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Paul Cartwright

Personal portfolio site
www.zero9studio.co.uk
Country UK
Software used Photoshop, 
Painter
I work primarily as a 
concept artist in the video 
games industry. I also work 
as a freelance illustrator 
whenever an interesting 
project comes up. I create 
images in many different 
styles, with characters and 
creatures being among my 
favourite things to paint.

Source files
available

Underpainting sketch
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Complete guide 
         to underpainting

Discover how layers of tone build up to 
create values, defi nition and colour 

Use coloured layers to 
build up vibrant art 

Working

Step 04, Sketch refinement

Step 12, Low opacity paint

Progress

Step 21, Dark edges

Step 27, Glazing stage two
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Girl with a Sapphire Earring… and a Rat 2011 Photoshop, Painter

Paul Cartwright Concept artist and illustrator 

I will show you how to make use of the basic principles of traditional 
underpainting to create a digital image using Photoshop and Painter

The importance of tonal values cannot be 
understated. The application of light and shadow 
to a painting is just about the most important thing 

to get right when it comes to creating an appealing image. 
Even the most beautifully composed paintings can fall fl at if 
their values are incorrect, so before thinking about adding 
colour it’s a good idea to get your greyscale base image 
looking tip-top fi rst. 

Many of the world’s greatest digital artists begin their 
creative process by painting in black and white, leaving it 
until later to apply colour washes by way of different layer 
modes. But this technique is by no means exclusive to the 
digital realm, or even present-day artists for that matter.

Painting in monotone and applying colour later on is an 
approach that dates way back to the 13th Century. The 
verdaccio and grisaille techniques were used to lay down a 
monotone underpainting to which colour would be applied. 
While grisaille uses grey tones made from mixing black 
and white, whereas verdaccio appears cooler due to the 
additional green pigment. The tint achieved when using 
verdaccio is widely believed to produce more accurate skin 
tones when the subsequent glazes are applied. 

For this tutorial I will loosely follow the same process 
used for a traditional oil painting to create a digital 
underpainting before adding colour, using verdaccio under 
my skin tones and grisaille under the rest of the image. 

First stages
Decide on a basic composition

The subject For the subject of this painting I have 
decided to portray a seated woman with a pet of some 

sort, and the image should be slightly stylised with an edgy feel 
to it. To keep with the aesthetic of a classical painting, I decide 
to take the approach of a traditional portrait. I gather reference 
images of relevant examples by Old Masters.

Loose sketches 
Working at a low-

resolution, I begin to rough out 
some basic compositions. 
The dark surroundings 
and pale skin tones of my 
reference images have 
steered me towards using a 
gothic-style woman for my 
subject. For some reason my 
scribbles take on the shape of 
a little rat, which I like.

Sketch refi nement I lower the opacity of my current 
layer and create a new one above it. I then trace over my 

loose sketch making slight adjustments here and there until I am 
happy with how things look. I keep the background very minimal 
as the fi gures are the focus and the background will be very dark 
when it comes to rendering it properly later on.

Top 
Smudge 

tool tips
Photoshop’s Smudge tool is 
often overlooked or dismissed, 
but it is defi nitely worth 
experimenting with as it makes 
a useful blender. Make sure 
Spacing is switched off in the 
Brushes palette to blend rather 
than push pixels around, and 
try using different brush tips for 
a more textured fi nish.

01

02

04

Compose the sketch With my subject decided 
upon I pick a basic round brush and begin to sketch out 

my fi gure in more detail. I’m still keeping it pretty loose. As I draw, 
I occasionally use the Lasso tool to chop and shift areas of my 
sketch that need nudging slightly for a better composition.

03

05 Imprimatura As I 
am trying to work in the 

traditional way, I need to begin 
my painting process with an 
imprimatura layer. This is a 
layer of paint that stains the 
canvas with a middle value as 
a starting point, usually in a 
burnt umber colour. On a new 
Multiply layer, I fi ll the canvas 
with a mid-brown tone.
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Canvas texture I now want to add some slight 
variations in tone and texture. As Painter can be a bit 

slow when blocking in large areas, I opt for a colour wash in 
Photoshop. I then overlay a photo of a canvas texture.

Cast shadows 
On a new Multiply layer 

above my line sketch I start 
blocking in cast shadows on 
my two fi gures. I make sure 
I don’t go too dark and try to 
keep my shadows consistent 
with a single light source 
coming from the top left.

Stylised touches 
Although my fi gures 

are drawn with some 
exaggerated proportions, I 
want to add a more stylised 
look to them. Still with the 
charcoal brush, I exaggerate 
the hair on both the girl and 
the rat. I want to create a link 
between the two characters 
by way of a similar hairstyle.

Surroundings Using a default charcoal brush I work 
over the image adding shadows and darkening down the 

surrounding area. My background will be vague and dim so as 
not to distract the viewer from the fi gures on the left.

06

07

08

09

Blend and tighten it up With the Eraser tool I go over the image and remove any 
rough edges and areas in direct light that have become obscured during the process so far. 

I then use the Smudge tool to blend some of the larger areas of shadow. For a nicer blend with the 
Smudge tool I use a soft round brush with Spacing unchecked.

10

Introducing three masters of underpainting 
What lies beneathStyle

School
Art genres in 

a nutshell

Artist: Adriaen van de Venne
Image: Altogether Too Stupid! Mid-17th Century
Owner: Palais des Beaux-Arts de Lille, France
● This genre painter of the Dutch Golden Age was 
famous for his engravings and grisailles of proverbs 
and popular expressions. This one is a satirical piece 
showing a peasant woman having her wits sharpened 
on a pedlar’s grindstone. The artist’s background in 
engraving is clearly visible in his use of chiaroscuro.
tinyurl.com/DA-Van-De-Venne

Artist: Adam Elsheimer
Image: Venus and Cupid Circa 1600
Owner: Kupferstichkabinett, Berlin, Germany
● This bruneille value study is done in pen and 
ink and makes use of hatching and other visible 
linework to express tonal values. Venetian painters 
such as Tintoretto and Veronese who created 
elaborate underpaintings infl uenced this German 
artist’s warm colour palette and use of midtones. 
tinyurl.com/DA-Elsheimer

Artist: Abraham Pether and Philip Reinagle
Image: Night-Blowing Cereus 1804
Owner: From the book The Temple of Flora
● Abraham Pether created engravings and 
backgrounds for botanical illustrations like this 
one of a Cereus fl ower. Famous as a painter of 
moonlights, he used a mysterious technique 
similar to the Dutch Dead Layer style, and 
probably learned from his patron Wright of 
Derby, layering up silver gilt and white gypsum to 
give subsequent glazes a supernatural glow. 
tinyurl.com/Reinagle-Pether

Grisaille palette 
The grisaille palette is 

made up of various shades of 
grey ranging from dark to light. 
To stick with tradition I make 
up a palette of nine shades, 
leaving out pure black and 
pure white. I then make up 
the same range with a tint 
of green. This will act as my 
verdaccio palette to use for 
underlying skin tones.

11
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Low opacity paint I copy my verdaccio tones onto a new layer so I can quickly select them by 
holding Alt. Using the same default charcoal as before, I lower my brush Opacity to 40% and start to 

paint lightly over the skin areas. 

12

Background 
wash I copy 

my grisaille palette to 
a new layer and select 
the darkest tone. With 
my brush at a fairly large 
size, I wash over the 
background to knock it 
back into shadow. Using 
vertical strokes on the 
walls while holding Shift 
gives a perfectly straight 
paint stroke that is handy 
for the background.

Bulk out the shadows One of the 
benefi ts of working digitally is that it’s a huge 

time saver. I’ve added a layer of paint to most of the 
image now, but rather than go over it again to bulk 
out the dark areas, I simply make a duplicate of my 
underlying brown wash layer. This is done via the 
drop-down menu on the Layers palette.

13

14

Solid shadows I now zoom out so I can see the entire canvas and 
use the darkest grey in my palette to block in the areas that are obscured 

by shadows. I set the brush to 100% Opacity, but outer the pressure of the strokes 
on my graphics tablet so my shadows retain a slight variation in tone, preventing 
these areas from looking too fl at.

15 Dark greys I pick the second darkest grey and paint into the 
background. Even though this shade of grey is only one along in the 

palette, when applied next to the darkest areas it defi nes the forms in the 
background clearly.

16
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Boost values When nearing the 
completion of an image, a good final step 
is to give the values a boost. Adding a little 
more strength to the light and shadow can 
bring a painting to life in the later stages. 
This is easily done with an Overlay layer.

5

Eyes Traditional portraits usually show 
the subject looking directly at the viewer, 
with the eyes and eyebrows being the facial 
features most responsible for conveying 
the subject’s emotion. It is therefore worth 
taking the time to make the eyes bold. 

4

Vague background elements For 
a scene with a figure as the main focus, it is 
not always necessary to work lots of detail 
into the surroundings. Working in silhouette 
with a slight colour wash gives the vague 
impression of plants in front of the window. 

3

Rim light A subtler secondary light 
source can help define the edges of 
figures and objects. The soft light coming 
from the windows on the right provide an 
opportunity to add some rim lighting and 
define the rat’s silhouette more clearly.

2

Light source Using a single light source 
is a good way to exaggerate facial features. 
This is also a convenient way to paint as 
it eliminates many of the complexities 
that arise when having to paint a subject 
affected by multiple sources.

1

A consistent style element 
such as hair colour 
creates a visual link 
between characters.

The application of light and shadow... is just 
about the most important thing to get right

Grey matter
Underpainting explained

1
2

3

4 5

Traditional 
features like 
the corset and 
leather chair 
echo the time 

period the image 
is inspired by.
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Adjustments After desaturating the 
background, I zoom out and notice that the 

image looks a bit wonky in certain areas. Back in 
Photoshop I use the Lasso tool to select parts to 
adjust using the Transform function (Ctrl/Cmd+T). 

19 Tidying up I make a custom brush that will simulate the effect of a coarse paintbrush by sketching 
dashed lines on a white background and using Edit>Defi ne Brush Preset. In the Brushes palette I go 

to the Texture options and give my new brush a canvas texture. I then use this to paint over the sharp edges left 
from the adjustments and blend them in.

Dark edges Using a very dark grey – almost black – I paint stronger shadows around 
the edges of the fi gure to defi ne the form more clearly and create a strong contrast 

between the dark surroundings and the paleness of the skin.

21

Paint the rat I turn my attention towards detailing the rat. 
Using the custom brush I created, I paint in the direction of 

the fur. This brush is ideal as the individual strands produce a hair-
like effect. I switch to the Smudge tool from time to time to soften the 
focus of certain areas.

22

20

Oil 
brush 

I dab my grisaille 
and verdaccio 
tones into the 
Mixer palette and 
select the Fine 
Feathering Oils 
brush. I make 
the paper texture 
the same as 
for my blender 
brush, create a 
custom palette 
so I can quickly 
switch between 
brushes and 
work on the face.

18

Into Painter I fl atten all of my layers now to continue in Painter. I 
pick the Just Add Water blender and, in the Papers palette, choose 

the Gessoed Canvas paper texture. I adjust the Size slider for this paper so 
the grain closely matches that of the previous imprimatura layer I created 
in Photoshop. I then start blending the tones of my image.

17
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Soften the skin To soften the skin I use the Smudge 
tool very lightly, with a spackled brush tip and Spacing 

disabled. These settings prevent the blending process from 
being too smooth, but retain the texture. Photoshop has many 
default brush tips that are also perfect for this.

Hazy light On a new layer I paint in some shafts 
of light coming through the windows and then use a 

Gaussian blur to soften the effect (Filter>Blur>Gaussian Blur). 
To add a suggestion of dust particles and a hazy effect, I add 
some slight monochromatic noise (Filter>Noise>Add noise).

Add colour For 
the fi rst colour glaze 

I create a Multiply layer and 
block in the base colours to 
all the elements in the scene. 
Using darker tones I paint in 
areas of the background to 
increase the shadows. 

Glazing stage two When the main blocks of colour 
are in, I go into more detail with the application. Where 

areas are darker I use more saturated, warmer tones, and for the 
lighter areas I use a less saturated colour with a cooler feel. I also 
introduce additional tonal elements to the fi gure’s hair.

23

27

26

24

Add the colour
Finish your portrait with the digital glaze

Blending pass       
I zoom out so I can 

see the image as a whole. 
Using the spackled Smudge 
tool, I work into areas of the 
background to soften out the 
parts that look particularly 
rough. This stage helps to 
create the overall look of 
blended oil paint.

25

Skin colour I pick 
a light pink colour and 

glaze over the green tinted 
skin of my fi gure. Once I have 
the skin blocked in, I pick 
a slightly darker and more 
saturated red and glaze the 
cheeks, tip of the nose, elbow 
and knuckles, as these areas 
of skin naturally tend to be 
redder in colour.

28

Opaque details I fl atten my layers once more and 
grab the canvas textured brush I made earlier on. I tidy 

up the image where required and also add highlights to the 
refl ective surfaces and elements such as the eyes. Somehow I 
realise I have overlooked the rat’s tail, so I paint one in, then add 
some rim lighting to edges, coming from the right.

29

Overlay To give 
the light in my image 

a bit of a boost I create an 
Overlay layer and use a soft 
round brush to lightly spray 
the windows and lightest 
parts of the scene. I then add 
some extra highlights where 
required and, as a fi nal touch, I 
overlay a slight cracked effect 
for an oil-painted look.

30Painter 
12

Using the Artist Surfaces 
textures from Photoshop’s 
Texture option in the Brushes 
palette is a quick way to give 
any brush a more traditional, 
organic-looking stroke effect. 
Painter 12 however sports the 
new Wet Oils brushes. These 
blend beautifully (they even 
have a Turps brush!) for 
realistic oil painting effects. 
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From manga to steampunk
Character

68   Mythological character art
72    Create classic anime characters
78    How to paint a steampunk 

fantasy
82   Paint manga
86   Metallic paint in ArtRage
90   Fantasy character

You don’t need to be a 
master painter to create 
beautiful fantasy characters, as 
these guides will show you
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Digital artists explain the 
techniques behind their 
amazing artwork
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Carlyn Beccia

Personal portfolio site
www.carlynbeccia.com
Country US
Software used Painter
Carlyn Beccia is an 
award-winning children’s-
book author and illustrator. 
A self-professed history 
geek, her illustrations refl ect 
her love for travel and 
cultural history. Her latest 
book, Digital Painting for the 
Complete Beginner, was 
released in April 2012.

Character
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Mythological 
character art

When we paint a mythological subject, it’s 
always worth looking back at the work of other 
artists who have approached it. John Singer 

Sargent was an Edwardian painter who adored 
mythological subjects. Sargent’s unique painting style 
inspired the creation of Painter’s Sargent brush, so in this 
tutorial I will aim to evoke the painting techniques he used, 
working with this brush and a muted palette to depict a 
character and story. 

As an ode to Sargent, I have chosen a subject he loved: 
Greek myth. My painting is of Arachne, who bragged of 
her weaving talents to the gods before Athene turned her 
into a spider in punishment for her hubris. As well as being 
guided by subject, I am going to take Sargent’s infl uence 
further, drawing from his most famous piece, Madame X, 
for aesthetic inspiration. This became Sargent’s most 
controversial painting and depicts a beautiful young 

woman with luminous pale skill starkly contrasted against a 
dark backdrop. The story goes that in May of 1884 Mme 
Avegno burst unannounced into Sargent’s cluttered studio 
apartment. Catching the twenty-eight-year old artist off 
guard, she let loose a tirade: “All Paris is making fun of my 
daughter. She is ruined”, and demanded that he remove 
the young woman’s portrait from the Paris Salon art show. 

Always uncomfortable around women, the young artist 
suddenly found the courage to defend his painting. 
“Nothing said about Madame Gautreau at the Salon was 
any worse than what the fashionable world had said of her 
already.” And he had a point. A long-time target of scandal 
sheets, Virginie Amelie Avegno Gautreau was no 
wallfl ower. As a celebrated socialite, Sargent pursued her 
for over a year trying to get his “unpaintable beauty” to sit 
for him. The resulting portrait with its anonymous title now 
resides in the Metropolitan Museum of Art, New York.

Madame Scandal 2012 Painter

Carlyn Beccia Children’s author, illustrator

Get to grips with Painter’s tools to build a 
mythological portrait in Sargent’s artistic style

Initial sketches
Get your linework and tones down

One sketch 
down Sargent 

is said to have done 
100 sketches before 
he began a piece, but 
I just do a few quick 
ones and decide which 
captures my story’s 
essence. I then scan 
my sketch into Painter.

Mixing a 
Sargent 

palette Sargent started 
his painting with a palette 
of lead white, rose madder, 
vermilion and bone black. 
To create a similar palette, 
open up Painter’s Mixer 
Palette, select the Apply 
Color tool (A) and create a 
string of warm tones. Mix 
with the Mixer Brush (B) 
and pick up colour with the 
Sample Color tool (C).

01

03

Re-create a scene 
from ancient myths

Working
Progress

Step 01, One sketch down

Step 04, Paint the midtones

Step 09, Paint hair

Step 12, Decorative details

Value study Before painting Madame X, Sargent studied 
Japanese prints and was most likely infl uenced by them. To create 

the fl at planes of colour found in these, I reduce my sketch to simple black 
and white shapes in the program. This step forces me to see which areas 
should recede and which should come forward. 

02
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Build the tones
Adapt brush settings and refi ne your colours

Paint the midtones Sargent believed that artists 
should get their midtones correct and then build up the 

shadows and highlights, and always began his midtones in a 
greyish colour study. In Painter I selected the Sargent brush from 
the Artists category and laid down thick strokes of paint. 

Add colour With my midtones in place, it is time to 
build colour into my value study. I add another layer to 

Painter and set its mode to Color. I then select shades of rose, 
bluish purple and yellow ochre, and painted into the skin. I keep 
each wash of colour on its own layer so I can lower its opacity. I 
remember to keep the thinnest area of the skin such as the eyes 
and around the mouth the bluest in tone.

Background boost Sargent always knew which 
parts of his painting to bring into sharper focus. For the 

moon, I needed a softer gradual blending and not the sharp 
strokes of the Sargent brush. I selected the Real Flat Oils brush 
found under the Oils category and increased the bleed to 50%.

Alabaster skin One of Madame X’s most striking 
features is her smooth, pale, statue-like skin. To apply 

paint in thinner glazes, I customise the Sargent brush to apply 
paint at a lower opacity and build it up.

04 06

07

08

Keep it straight 
Sargent advised to 

get “your lines precisely at 
their relative angles.” The 
straight diagonal lines of the 
loom are an important part 
of the narrative as well as a 
compositional device to frame 
the portrait. To paint with 
straight lines, I selected the 
Straight Lines Stroke tool.

05

Paint hair Sargent 
was a master at 

painting hair, so let the broad 
shapes of colour suggest the 
hair instead of painting each 
strand. At this point, I realised 
it was falling wrong and wasn’t 
communicating her sadness. 
I painted in more and draped it 
dramatically around her face, 
paying careful attention to 
where the light would hit.

09

The work, the woman and the artist that inspired him
Sargent’s Madame XStyle

School
Art genres in 

a nutshell

Artist: Antonio de 
La Gandara
Image: Portrait of Mme Pierre 
Gautreau 1898
Owner: Unknown
● Mme Avegno’s predictions of 
her daughter’s ruin proved false. 
On the contrary, Mme Gautreau 
went on to become a highly 
sought-after subject for artists 
such as Gustave Courtois, 
Mademoiselle Lucie Chatillon, 
and Antonio de La Gandara. 
We still do not know what she 
looked like in frontal view; every 
subsequent artist chose to paint 
her in profi le.
tinyurl.com/da-gandara

Artist: John Singer Sargent
Image: Madame X 1883-4
Owner: Metropolitan 
Museum of Art
● Sargent’s powdered, defi ant 
beauty in cameo-like profi le 
was painted with one strap 
falling from her shoulder. He 
later repainted Gautreau’s 
fallen strap and kept the portrait 
until 1917 when he sold it to 
the Metropolitan Museum of 
Art for £1,000. He requested 
the sitter remain anonymous 
and that the painting be known 
as Madame X. Mme Gautreau 
died that same year.
 tinyurl.com/da-madamex

Artist: Diego Velázquez
Image: Portrait of Juan Pareja 1650
Owner: Metropolitan Museum of Art
● We are taught at a young age not 
to copy other artist’s art, but even 
Sargent learned by copying Velázquez’s 
paintings. Copying a famous painting can 
increase your own awareness of colour, 
lighting techniques and composition. 
tinyurl.com/da-velazquez
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Decorative 
details Now 

I needed to make the 
decorative pattern on her chair 
look less more embedded. I 
selected the Detail Oil brush 
found in the Oils Brush 
category and painted over the 
pattern to make it look more 
like a wood-relief carving. 

Ode to Sargent 
Finally, I selected 

Sargent’s painting, Orestes 
Pursued by the Furies, and 
dragged it on top of Arachne’s 
unfi nished tapestry. I then 
selected the Transform tool 
(hidden underneath the 
Layer Adjuster tool) and, in 
the Property bar, selected 
the Distort option. I dragged 
the corner handles until it 
matched the angle of her 
tapestry and hit Enter.

Canvas texture The impasto effects can sometimes 
remove too much of the canvas texture. To bring some 

back, I selected the Square Hard Pastel brush from the Pastel 
Brush category and set the grain to less than 10%. I then 
selected different relief papers from Painter’s Paper library 
(Window>Paper Panels>Paper) and painted on a separate 
layer to add texture back in.

Clothes that move Sargent used 
very long, quick brushstrokes that gave 

a spontaneous feel to his sitter’s clothing and 
a sense of movement. To create the same 
variance in brushstroke, I selected the Sargent 
brush and increased the Jitter settings.

Zoom out Sargent would move 
back and forth from canvas to sitter to 

reassess his painting (so many times that he 
wore a path along his carpet). In digital painting, 
I often forget to zoom out. When I zoomed out, I 
realised that the hair needed to be brighter and 
the background needed to be darker to make a 
sharper contrast with her pale skin.

10

11

12

14

15

Add weight to paint In the later stages of his 
painting, Sargent built up thick paint with very little 

medium. To create impasto effects, I selected the Real Flat Oils 
brush found under the Oils category and, in the Impasto settings 
(Window>Brush Control Panel>Impasto), changed its Draw To 
method to Color and Depth. 

13

Get to grips with the settings and 
variants of this piece’s essential tool

Brush options

Understand the Sargent Brush
Sargent painted very quickly using thick brushes loaded 
with paint. The Sargent brush applies paint in a similar 
way by putting down heavy layers of colour with a little 
trail at the end to give it the look of paint applied quickly. 
You can change the shape of this trail by changing the 
Dab Profi le (Window>Brush Control Panel>Dab Profi le). 
To add more variance in this trail and the appearance of 
scraped paint, increase the Jitter. I prefer to keep the 
Grain at 100% to keep the paint thick.

Customise the Sargent brush
To paint in glazes, I created a thinner version of the 
Sargent brush. I changed the Stroke Method to Cover and 
the Subcategory to Softcover. In the Property bar, I set the 
Resaturation and Bleed to 100%, and kept the Jitter at 0. I 
then saved this variant by selecting Save Variant from the 
Painter Brushes drop-down menu.

Underlying colour
The Sargent brush uses the underlying paint and mixes it 
with your chosen colour. Because of this feature, you must 
paint on either the canvas layer or a layer containing paint. 
If there is nothing on the layer (or if it is transparent) then 
you will not see any colour being applied. 
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Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Schin Loong

Personal portfolio site
schin-art.com
Country Malaysia
Software used Painter, 
Photoshop
I secretly want to dress up 
as a magical girl and go 
beat up bad guys every 
night, but I just end up 
painting stuff. One day 
my time will come.
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Create classic 
anime characters

Anyone who knows anime knows something 
about the three stock characters. First off, 
there’s the cute, magical girl, the secret alter ego to 

an ordinary schoolgirl who stumbled into her vigilante life 
by a chance encounter. Second is her fl uffy sidekick, a 
cute creature who has come to protect, help and guide the 
magical girl to deliver justice and fi nd her one true love. 
And that just happens to be our third character, the hero, 
who fi nds himself intrigued by this cute newcomer despite 
his cool persona. 

Magical girls are very popular with teenagers who dream 
of love, loyalty and friends, and it’s easy to project 
themselves into a fantasy land where all this comes true. 
Colours should be brighter and more saturated to signify 
cheerfulness, sparkles should be everywhere, the hero 
should be handsome and suave, and, of course, hairstyles 
and costumes should be amazingly elaborate.

It’s the perfect time to exercise your imagination and 
practise character design. The classic magical girl has a 
costume that is extra special for when she transforms from 
her real-life persona, and this costume can be anything 
you want, but typical designs have elaborate styles with a 
fantasy edge such as wings, boots and, of course, ribbons. 
Not forgetting the all-important wand or sceptre! 

Her theme should extend to her newfound sidekick who 
is presumably from the same fantasy land she is, so keep 
their styles matching. Her sidekick should be cute and 
energetic and could be modelled after a real animal such 
as a rabbit or cat, or you can go wild and create something 
entirely new. Finally, the hero should be a little different from 
the magical girl. His personality should be more mature, 
perhaps more clever and commanding, and he would 
defi nitely prefer darker clothes that fi t his well-built abs 
instead of elaborate costumes. Let’s start the adventure... 

Magical Heart  2011 Painter, Photoshop

Schin Loong Fantasy illustrator, graphic artist

Inject some real personality into your art and harness the 
fun, magical elements of the anime style

Begin in simple style
Sketch the basics for three distinct personalities

Thumbnail 
poses First 

off, sketch out a few 
composition ideas. 
Keep it simple and 
brainstorm. Try to 
get the composition 
fl owing with energy 
and movement, as 
magical girls are 
very active!

Begin the 
handsome 

hero With her basic pose 
down, sketch out the hero 
and try to get his pose to 
complement hers. His 
expression should be 
more mature to reinforce 
his role as the clever 
and commanding one.

01
03

Build a narrative with 
colour and expression

Working
Progress

Step 02, Put on your best face

Step 08, Clean and prep

Step 13, Colour the clothes

Step 18, Sparkles

Put on your best face Manga faces are simple but very 
expressive, so start by sketching out the girl. The secret is to keep 
everything symmetrical and cute-looking. Try different poses for 

her based on the thumbnails in the previous step. Just experiment!  

02

Source files
available

Line art
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Perfect the line art
Get your sketch ready for digital painting

Magical costume Here’s the fun part, her magical 
girl costume! Think super fantasy cute. My heroine’s 

magic symbol is a winged heart and the theme is carried on 
with ribbons, hearts and wings. I also gave her cute cat ears 
and ponytails to reinforce her fun nature.

Design a powerful symbol In a separate fi le, design the wand on a fl at perspective 
so that it will be easier to manipulate. Without making it too elaborate, I added wings, a star 

and some fi ttings to keep it important and appropriately magical.

Complete and colour the line art Add a few 
more last-minute additions to the line art like hair strands 

and ribbons. Now, using the Hue/Saturation command in 
Photoshop, make the colour of the actual lines a little lighter so it 
is less harsh. I decided to go for a neutral light brown. 

New species Every magical girl should have a cute, 
cuddly and loyal sidekick. I made mine a bunny-dog 

hybrid. Don’t forget to sketch in the wand at this point. Look up 
royal sceptres for ideas and then incorporate her heart symbol. 

04

06

07

09

Refi ne and 
tweak the fi gure 

Add more detail to her clothes 
and refi ne the lines. I didn’t 
like how her legs looked 
so I edited them using the 
Transform tools in Photoshop 
and gave her some cute 
boots as well. We’re still at the 
experimental line art stage, so 
fi x whatever doesn’t look right.

05

Clean and prep Now the boring part, cleaning up. 
On a separate layer, very slowly clean up all the debris 

and create the line art to work on. Last-minute changes are 
made here and every line should be neat and free-fl owing.

08

Know 
your  

PS tools 
Use Photoshop to really 
maximise your painting’s 
potential. The fi lters, layer 
styles and blending modes 
are there to help you achieve 
the fi nal look you want, so 
learn the ins and outs of your 
tools. For this painting I used 
different blending modes and 
layer effects such as Color 
Dodge, Overlay and Outer 
Glow to really bring out the 
glimmer in this painting. Start 
with a basic colour and then 
go wild and see what fi nal 
outcomes can be achieved 
with experimentation.

Character
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Happy tones Now 
for her cuddly pal. I 

picked green tones to pick out 
the colours in the other two 
characters. Blend it very well 
so it looks clean and cute, and 
add small, simple details. 

Colour the clothes Be careful with the colours 
here, making sure they are clean and not muddy. I gave 

her a red skirt with cute orange trim to make her really pop out of 
the picture. Oh, and did you notice the cute hearts in her eyes?

Blend skin tones I like to start with 
the skin tone and face, and I also fi ll out 

her hair at this stage so it sets the theme colour. 
It is pink, of course. I gave her sparkly eyes and 
the all-important pink blush. The colouring 
should be clean and well-blended to contribute 
to her soft, young appearance. 

Set the mood with gradients 
Change the line art layer to Multiply, 

then start with a colour gradient on a separate 
one underneath. This should refl ect the overall 
mood you want to set for the painting. True to 
the magical girl heart theme, I chose a mix of 
sweet pastel pinks and blue.

10

11

13

14

Line art Sketch a basic face. The eyes should 
be large and symmetrical and the nose very small. 

Don’t be afraid to use Photoshop to adjust if needed.

01

Evolution of a 
manga face
From the sketching stage to 
the fi nal kawaii colours 

Cleanup On a separate layer, trace over the 
sketch to create cleaner lines. Take your time with 

every line, and if it’s not perfect just go back and redo it.

02

First colours Use a gradient to colour the face. 
A little blush adds to the cuteness and lip colour 

defi nes the mouth. A few highlights give the eyes sparkle.

03

Enhance the cute Stars on her cheeks and 
hearts in her eyes add a super cute element. White 

lines defi ne her hair and a glow gives an ethereal look.

04

Develop the hair Keep developing the hair with thin streaks and gradients so it looks 
fresh and clean. Keeping within the same colour theme, start on the other parts of her dress.

12
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Colour, blend and highlight
Finalise the tones and paint a background

Heroic colour scheme The hero should be 
simpler than the magical girl. His colours are darker but 

still fantasy-looking. To contrast him from the others, I gave him a 
dark purple tonal theme with fl ashy red fl ames for a bit of danger. 

Finish up the basic colours Make the wand bright and cheerful and make sure 
the colours pop out against the background. Clean up any other debris at this stage too.

Sparkles Now for 
some magic. Create 

some sparkles and graphical 
special effects to generate 
movement. I added white 
dots for freshness as well as 
texture on her clothes. Use 
layer effects such as Color 
Dodge and Overlay to create 
the magical look.

Little details 
I added more little 

details in her hair and adjusted 
the colours, giving some glow 
to her and the sidekick. Every 
little detail counts at this point 
so keep refi ning as needed. I 
also tweaked the composition 
slightly to make it look a touch 
more dynamic.

The magical fi nish I made some fi nal colour 
tweaks to really brighten the piece up. Once everything 

looks right, fl atten the layers, sign it and spread the love.

Set the scene Using the background gradient layer, create an environment for them to 
be in. A forest is ideal, as it will look like they’re out on an adventure. The clouds add to the 

scene, depicting a sunny day. The perfect setting for some magical shenanigans!

15

16

17

18

19

20
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Anime made easy
Key tips for an energetic scene

A happy face The face is the first thing 
the viewer will see, so it is important to get 
the expression right. Anime faces should 
be simple with huge eyes, tiny noses and 
an expressive mouth. Keep the colours 
simple and clean, and add highlights.

1

Experiment with your tools 
Photoshop is your friend, so utilise all its 
tools including layer styles and blending 
modes. I drew simple lines and hearts, 
but added Outer Glow to get a magical 
effect through the composition.

2

Less is more Hair can be tough to 
paint, but the trick is to paint it in clumps 
to begin with. Start with a flat colour then 
gently add areas of different tones with 
highlights and detail. Remember to keep 
everything neat, flowing and natural.

3

Magical costumes Little details 
in a character’s costume make a big 
difference. Trimmings and patterns can 
add to their personality and tell you more 
about them. Polka dots add a cute feel 
and lace edges suggest innocence.

4

Expressive eyes The eyes are so 
important in anime (that’s why they’re so 
big!), so the colours should be saturated. 
You can even add cute little graphics like 
hearts and stars in the iris for highlights, 
just don’t over clutter it.

5

Male features Subtle changes 
in angles and shapes can suggest a 
more masculine face. The hero has 
considerably smaller eyes to signify 
maturity, a longer nose, sharper jawline 
and thicker eyebrows as well.

6

1
3

2

4

5

6
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How to paint a 
steampunk fantasy  

There are probably as many kinds of 
steampunk as there are people who like this 
genre of science-fiction fantasy. To some 

people it means books, to others it may mean costumes 
(complete with obligatory brass goggles).

I associate it with books and comics I read when I was 
young, as well as more recent books and even films. I think 
my favourite book in this genre is The Warlord Of The Air by 
Michael Moorcock. I first heard the name in connection 
with the novel The Difference Engine by William Gibson 
and Bruce Sterling, another classic, but the grandfathers of 
steampunk are undoubtedly HG Wells and Jules Verne, 
and there were even a great number of books written in 
that genre before the phrase was coined.

It can be, and is, all of the things above, but at its heart 
it’s a genre that portrays Victorian-era technology as 
capable of doing things that in history took a lot longer 

such as huge airships, flying machines, computing 
devices or even things that still don’t exist like HG Wells’s 
famous time travelling machine.

It’s a lovely genre to create art for. You are limited only by 
what your imagination can come up with, yet you can still 
retain all the benefits of it being based in a historical or 
alternative history setting, such as researching costumes, 
hairstyles, architecture or the various clever things that 
were discovered or invented by the Victorians.

Corel Painter 12 is my program of choice when it comes 
to digital painting and almost all of its brush categories 
could be used in a steampunk painting. You might want 
the end result to look like a period oil or watercolour 
painting, for example. I’m going to be a wee bit 
unadventurous, though, and stick to my favourite brushes: 
the Real 2B Pencil, the Just Add Water Blender and Rob’s 
Basic (downloadable at tiny.cc/robsbrushes).

No Goggles 2012 Painter 

John Malcolm Freelance digital illustrator

The aim of this tutorial is to create a fantasy
steampunk piece complete with quirky robots Create a Victorian 

scene with a twist

Working
Progress

Step 03, Incorporate objects

Step 05, The robots

Step 10, Time for a step back

Step 13, Define with colour

Sketch out the scene
Begin your image in Painter

Start with 
things in 

perspective 
I created a canvas 
wider than needed 
and marked vanishing 
points for two-point 
perspective. To draw 
the grid I picked the 
Scratchboard tool. I hit 
V to draw straight lines. 
After completing each 
line I tapped V again to 
begin a new one then 
cropped my image.

Incorporate objects I began to 
add more objects to my scene, books on 

the bookshelves, shipping trunks and an old-
fashioned diver’s helmet. I had made a group for 
my perspective layers (Ctrl/Cmd+G) to enable me 
to turn them all on or off at once, which helped at 
this stage as I was relying on them less.

01

03

Time to draw Switching to 
Pencils>Real 2B Pencil, I started drawing 

simple shapes on a new layer. When I had the 
basics there, I reduced the opacity of this layer 
and began work on a new one. This was my 
process throughout the drawing stage. Each new 
layer refines the shapes and more detail is added.

02
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Digital artists explain the 
techniques behind their 
amazing artwork
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John Malcolm

Personal portfolio site
johnmalcolm1970.co.uk
Country UK
Software used Painter, 
Photoshop, ArtRage
Although working full-time 
for a local newspaper 
group, John has found his 
free time increasingly being 
taken up with digital art.
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Block in colour and refine tones
Use pencils and blenders to build up detail

 The heroine I’m better at drawing grotesque 
monsters than attractive women, so I used a photo 

reference image to begin work on my heroine. I researched 
Victorian hairstyles and hats, and decided that I’d have to adapt 
the model’s hair from the original photo slightly. As I’m not giving 
her the traditional goggles, I had to at least give her a hat.

More pencils I started a new layer, still working beneath the line drawing. I go over the 
whole image adding darker, shadowed areas. For this I use the Real 2B Pencil again. It’s a 

strange tool to be painting with, but I like how intuitive it is. I make fi ne lines with it but can also slowly 
build up areas using a style of mark making akin to crosshatching.

The robots I complete the drawing stage by doing 
the robots. One of the heroine’s companion robots is a 

griffi n, so I give her a falconry-style glove for holding him. With 
robots it’s easy to add lots of suggested detail – rivets, panels, 
screws, lights or whatever else you can think of.

The belt In this step you can see a close-up of an 
area I was working on before, and during, blending. On 

the left are the kind of marks I make with my pencil. Much of the 
work thereafter is done with the blender – I use it in a fairly heavy 
manner sometimes to push pixels around.

04

07

05

09

Blending With the whole canvas given the same 
treatment, it was time to start blending. I used two of 

Painter’s blenders: Just Add Water and Real Pointy Blender. I 
always blend on fresh layers with Pick Up Underlying 
Color checked. For general blending I use light, circular 
movements but to keep edges sharp where I need them I use 
heavy strokes parallel to the edge.

08

Time for some 
colour I created 

two new layers beneath the 
line art. The bottom one was 
fi lled with a neutral grey and, 
on the layer just beneath the 
pencil, I  added colour with the 
Rob’s Basic brush. I wasn’t  
interested in shadows or 
highlights – just the fl at tones.

06

 Dip into 
older 
fi les

It can be a very good idea to 
hang on to layered versions 
of older paintings. You can 
then reuse elements instead 
of having to reproduce them 
from scratch. I was stumped 
for ideas about what the 
wallpaper in this image could 
be like. I had a rummage 
through some older stuff and 
turned up a paisley pattern 
skull I’d created before that 
was perfect for the job.
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The dress Instead 
of the rather dull purple 

colour I’d gone with originally, 
I used a deep, red-wine 
hue. This was also set as an 
Overlay Layer. I then added 
some extra detail to it in stripes 
of a lighter colour.

Defi ne with colour The two robots were 
overlapping and had some very similar tones and 

colours, so I aimed to suggest a separation between them, 
pushing the larger robot back by reducing his saturation and 
shifting the colours in a cooler direction. The griffi n robot could 
then be brightened up a bit – especially his wing tips.

Pendant detail This was the stage for roaming about the image looking for things 
I’d missed. The pendant around the heroine’s neck had been neglected, so I added 

some detail to that. The changes in the last fi ve steps took a while to make, but this just shows the 
importance of taking the time to make small adjustments for the overall effect.

Lighting and light beams The whole 
background was still rather fl at. I added more shadows to 

it, helping to knock it back a bit. To add more interest I included 
some beams of light and brightened up areas where they hit 
the background. I made selections, used the Digital Airbrush, 
reduced the opacity and played with layer blending modes.

Complexion Even after researching Victorian 
clothing and hats, I’d forgotten that Victorian women 

didn’t tend to have suntans. I had also drifted fairly far off my 
reference. I cut and pasted the original face into my image, 
painted on top of that and blended with Just Add Water.

Time for a step back I repeated steps 8 and 9 many times until I felt my image was 
almost done – there were a few small tweaks and edits I wanted to make. It’s very easy to 

get tunnel vision when working so it’s always a good idea to seek someone else’s opinion.

10 11

12

13

14

15
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Paint manga

Draft outline I lower the opacity of the 
guidelines and make new layers above them 

to rough out the draft using different colours on 
different layers to avoid clashing. 

The fi rst thing that comes to mind when 
thinking about the word ‘manga’ is the 
generic perception of characters drawn 

with the weird facial proportions of big eyes, 
small noses and small mouths. Even so, it seems 
to have a law of attraction attached to it that overloads 
you with its cuteness and appeal so you just fi nd it 
hard to resist. The style itself is still constantly evolving 
and becoming more refi ned over the passage of time 
and more artists are discovering that the generic look 
is not the only way to do it.

Originally, the term manga was coined in Japan 
and is widely used to refer to Japanese comics. Over 
the years it has gained substantial popularity and has 
greatly infl uenced styles like Korea’s manhwa, 
Taiwan’s manhua and to some extent how many 
current day comics are drawn. Today, the term is 
more popularly used to identify a style that artists 

draw in. Let us begin the tutorial 
on how I created this original 
piece of illustration, drawn in a 
fun manga style.

Before starting on any new 
artwork, I usually do a few 
thumbnail sketches to help me 
decide what I really want. 
Sometimes, when I’m already 
pretty sure of what I want, I just 
jump straight in and start 
roughing out the illustration. 
This was the case for the image 
P-Pa-Panda, but stick to 
however you work best. I carry 
out the initial stages on a small 
canvas fi tting the screen at its 
full size, enlarging it gradually to 
add in more details depending 
on the need of the piece. 

P-Pa-Panda  2010 Photoshop CS2 and PaintTool SAI

Choo Kah Chun Illustrator

Details are not everything. A simple-looking painting can 
also look great with the proper methodsDigital artists explain the 

techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Choo Kah Chun

Personal portfolio site
kaizeru.deviantart.com
Country Malaysia
Software used Photoshop 
CS2 and PaintTool SAI
I’m a strong believer in 
diligence. I prefer to work 
with a varied portfolio and 
so I try not to limit myself to 
manga, choosing to explore 
different styles, drawing 
inspiration from many 
movements and artists.

Putting down guidelines before drawing might 
seem tedious but it is a very important step that 
should not be overlooked. It doesn’t have to be 
complicated, just make use of very basic shapes like 
ovals, squares, triangles and maybe some lines to 
show the perspective. Getting it right at the earlier 
stages would really help save a lot time and hassle 
trying to fi x it later. When I’m satisfi ed with the 
foundation, I move on to sketching out the details. 
Whilst working on the draft, I will often fl ip the canvas 
horizontally to do a check on the proportions which 
might look correct on one side, but not on the other, 
so this is a good trick to make sure.

Once I’m done with the draft, I enlarge the image 
to about 4000 pixels for the wider side while retaining 
300dpi resolution from the previous steps and save it 
as a new PSD fi le. Don’t hesitate to save multiple fi les 
for back-up purposes in case any fi les accidentally 
get corrupted along the way and you risk losing those 

Guidelines I begin by drawing a set of sketched 
guidelines. Keeping to simple shapes, I want to get 

the character elements and pose down.

Character
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precious hours of hard work. That heart-wrenching 
feeling could affect your drive to continue.

When I’m outlining, I usually work with a brush size 
of four or fi ve. There is no fi xed rule here as to what 
size to use, it really depends on how thick or thin you 
want the lines to be. Regarding the issue of how to 
get crisp, smooth lines, I usually make quick, long 
strokes across my tablet and combine one end of a 
stroke with another. Of course I need a few attempts 
to get it the way I want it and so Ctrl/Cmd+Z is my 
best friend. I then erase off any excess lines from the 
image and repeat the process until I’m done. 
Spending more time to work on the lines really pays 
off as manga style relies heavily on a good outline.

Next, I proceed to fi ll in the base colours. Before 
that, I turn my background colour light grey so as to 
be able to distinguish the areas that I have fi lled from 
those I haven’t. I make sure that there is only a single 
colour on each layer so it is easier for me to change 
the colour scheme if the need arises. The layers are 
labelled according to their functions to easily access 
the layer I want quickly and effi ciently. If you get stuck 
on where to start for the colour scheme, I suggest 
looking up some references and using the 
Eyedropper tool to pick colours from it.

After fi lling in the base colours, I would almost 
always focus on the skin, hair and eyes in no fi xed 
order. I switch between soft and hard brushes 
constantly to paint in the cast and form shadow 
areas. Most of the time how well the painting turns 
out depends on how these three areas are done. 
However I personally like to concentrate more on the 
eyes because in manga drawings the eyes are key to 
evoking characterisation and the stylised manga 

look. In successful images, the eyes alone are 
enough to convey a myriad of information like the 
emotion or situation that the character is in. 

Of course it doesn’t always work that way and 
sometimes I need to work on an overall basis to get a 
feel for the whole illustration. This is usually when I’m 
not feeling very confi dent with the colour scheme or 
how the picture will turn out. Working this way 
gradually puts my mind at ease as I get to picture 
how the fi nal piece will roughly look. Throughout this 
stage I would often do minor tweaks to the colours to 
fi nd the best possible match. At the end of the day it 
is always good to work in the way you are most 
comfortable with so that you can enjoy the process of 
painting your own illustrations and seeing the artwork 
from your imagination in front of you on the page. 
Once I’m done with the character, I move on to the 

background. I 
would usually 
have a vague 
idea of what 
background I 
want to do but it 
still takes some 
experimenting to 
match the picture 
well. In this 

More manga artwork 
from Choo Kah Chun

Art Nouveau Princess
2009, Photoshop CS2/PaintTool SAI
● I’m an avid fan of Vocaloid Hatsune 
Miku and Alphonse Mucha’s Art 
Nouveau style. I decided to draw 
something combining what I love and 
came up with my own take on it.

Look in the Mirror
2009, Photoshop CS2/PaintTool SAI
● This was an entry for one of Wacom’s 
contests and the concept was about 
looking into the mirror to fi nd evil lurking 
within. I usually enjoy painting my works in 
this dark, unsettling style.

Shaman of Peace
2010, PaintTool SAI
● This illustration was an experimental 
painting using a line-less style that was 
featured in the book Otacool 4. I was 
trying to portray a moment of peace 
during the shaman’s journey.

Lighting details For the next stage I add in the 
highlights to the skin to make it stand out, and work 

on the shadows for the hair and eyes.

Block the base I fill in the base colours in a 
medium tone, with each colour separated onto 

different, pixel-locked layers to avoid confusion. 

Gradients and glow I fill in a gradient tone for 
the background using two analogous colours of 

blue and purple. I also gave the character an outer glow.

Character
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Selection I select the hair with the Magic Wand 
tool. Filling in the colour at this stage would leave a 

fair amount of unfi lled areas next to the outline.

01

example, I used a graphical 
background. It is always a 
good idea to plan the 
background together with the 
draft and not leave it until the 
very end. In my case, I’m not 
really practising what I’m 
preaching so please do not 
follow in my footsteps.

Anyway, I settled for using a 
harmonious colour scheme of 
blue and purple for the 
background that matched the 
purplish hue of the character’s 
clothes and hair. The 
background needs some 
patterns, so for the time being I 
leave the illustration alone and 
create a new canvas about 
500 pixels wide. On the new 
canvas itself I start working on 
the design of the pattern that 
would be used behind the 
subject in my illustration.

When I’m done working on the design, I defi ne it as 
a pattern in Photoshop and tile it onto the 
background. The background is still rather empty so I 
grab some free-for-use patterns that you can fi nd on 
the internet and put those in together with what I just 
did. I tweak the opacity for the background and 
patterns until I’m completely satisfi ed that it won’t 
steal the limelight from my character. 

I revisit the background again and fi nd that it still 
feels a bit boring with the uniformed repetition of the 
patterns. Using the Rectangular Marquee tool, I make 
some barcode-like, inconsistent vertical blocks on the 
background to break the repetition. I also add in 
smaller strands of hair to the character to give it 
slightly more volume. Last but not least, I like to put in 
a barely noticeable signature on the illustration and 
try to make it part of the design.

That wraps up the whole process of working on a 
manga illustration. Do keep in mind that manga style 
is basically a form of simplifi cation in which the aim is 
to bring out the best points of a picture. It is fi ne to 
forget about cluttering details sometimes and keep it 
clean, simple and easy on the eyes. More importantly 
it must be able to captivate your audience almost 
immediately. I hope that this article has given you a 
better insight into how manga artwork is produced, 
that you can start applying what you have picked up 
from here and have fun while you’re at it! 

Quick and 
easy colour

Fill base colours in a jiffy with 
Photoshop’s Magic Wand tool

Expand the area I click on Select>Modify> 
Expand and expand the selection by three pixels, 

making sure that it doesn’t exceed the outline. 

02

Fill in the base Selecting the colour of my 
choice, I fi ll in the selected area. Inevitably, some 

areas will remain unfi lled even after expansion.

03

Final touches I deselect the selection and 
manually paint the small corners that were missed 

with a hard round brush. Now, wasn’t that easy? 

04

Background If the gradient tone 
seems too saturated it can draw 

attention away from the character or focus 
of your image. I decide to lighten it and tile 
in some patterns for the background.

Highlights are important especially when painting in a manga 
style. They give life to your images, as you can see in the 
example here. Before adding in the highlights the eye is devoid 
of life, but once it is done, we get a bubbly and cheery eye, full 
of personality. Be careful when applying highlights though! 
When used sparingly, they can do wonders for your pictures, 
while overuse can leave your images gaudy with too much 
glitter (unless of course that is what you were aiming for).

Breathe life into your work
It’s not magic, but it certainly feels like it

Before

Sign off Lastly, I take an overall 
look at the image and add in 

some finishing touches to the character 
and background. I did a little signature in 
between the bag and her legs too.

After
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Digital artists explain the 
techniques behind their 
amazing artwork
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Jon Hodgson

Personal portfolio site
www.jonhodgson.com
Country UK
Software used ArtRage, 
Painter, Photoshop
Jon Hodgson is a full time 
illustrator and part time art 
director living in Scotland.  
He works digitally, mostly in 
ArtRage Studio Pro.

Metallic 
paint in 
ArtRage

Despite its modest price and apparent 
accessibility, ArtRage has a lot of hidden 
features and aspects that are not often 

used by serious digital artists. One of the most 
overlooked of these features is the function of the 
Metallic slider.  

Found on the Color Picker, the Metallic slider 
changes the appearance of all tools in ArtRage. Due 
to its name it’s easy to think of it as something for the 
Sunday digital painter who wants to make day-glo 
metallic portraits of their pets, and of course there’s 
nothing wrong with doing precisely that. However, like 
so many of the features and tools in ArtRage, with a 
little lateral thought it can prove itself to be a useful 
tool for any serious artist’s tool box.

What the Metallic slider does in simple terms is 
increase how refl ective the colour that’s put down by 
the tool in use is. This is an artefact of the way 
ArtRage makes many of its marks; building a three 
dimensional model of a mark as you go along. By 
adjusting the slider you change how much light it is 
that the model refl ects. What this does to your image  
in practical terms is offer very rich colours, deeper 
shadows and glistening brush marks. If you can 
move away from visions of glitter glue and badly 
made collages then it has some powerful uses.

This metallic effect can be used all over an image. 
It makes for very strong colours and increases the 
feeling of an oily impasto. It also increases the take-
up of the canvas texture, as is to be expected with a 
more refl ective medium. Using it sparingly can add 
an extra dimension to a piece of work.  

Most pieces of art rely on contrasts to create their 
form. In terms of composition, light and shade, 
contrasts in colour and contrasts in shapes and sizes 

Metal Paints Metal Paints Metal  
2010 ArtRage Studio Pro

Jon Hodgson Illustrator and art director

Use the Metallic paint feature in 
ArtRage Studio Pro to create areas 
with a dramatically different feel
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break up the picture plane and create the image. This 
is also true in terms of material handling. Large brush 
marks contrast with small as rough, scratchy marks 
contrast with smooth, considered ones. And so it is 
we can use the Metallic slider to create a contrast in 
the look of the materials we’re using. This can be 
used as subtly or as outrageously as you desire. In 
this image the robot character is painted with 100% 
Metallic, in contrast to the background and 
surrounding details which are painted with non-
metallic paint. This extreme variance in a small area is 
just one way to make use of the feature, and 
experimentation will quickly throw up even more ways 
too. Certain elements painted in Metallic paint, 
scattered around the canvas, can be picked up by 
the eye and create rhythm and pattern.

This painting begins with a drawing in ArtRage 
using the Pencil tool. Any tool that makes a line is fi ne 
for this purpose. You can draw with an Oil brush high 
in Thinners or the Ink Pen tool just as readily.

Anything done at this point will not be visible in the 
fi nal image. When working digitally it is well worth 
taking advantage of the totally malleable qualities of 
the medium and working up a very rough thumbnail 
sketch on the canvas, then refi ning it step by step. It 
can be helpful to bring in some tone to show areas of 
light and shade. Generally speaking a midtone brown 
is the most versatile colour to use for this purpose. 
Working quite quickly, we build up an underpainting 
using washes of Watercolor on a tint layer. Generally 
the Watercolor preset Unclean Brush works well for 

this. Once the layer is full we fl atten it and make a 
new layer. Building up too many layers isn’t good for 
ArtRage’s performance, so in general keep fl attening 
as you go. Building in a variety of colour is helpful at 
this stage, with some cool and warm colours dotted 
around. Given that ArtRage really likes to pull colour 
up from the canvas, planning ahead and plotting in 
colour early is a good move.  

Once the whole canvas is toned, with the darks 
and lights in the right places and plenty of interesting 
marks to work on top of, it’s time to switch to some 
opaque media and get working with the Metallic 
slider. In this image, the oils are used with the Metallic 
slider at 100%. We use the Metallic Oil only on the 
robot itself – this will be the only area to use these rich 
strong colours. Everything else will be muted and 
non-metallic to emphasise the effect. Using dark, rich 
golden colours along with some reds, a further pass 
of underpainting goes in. The Metallic Oil is quite hard 
to control, so we have to take our time and make 
plenty of adjustments to the colours we pick. 

Making the colours lighter than we would normally 
choose can help us get the effect we want. Once the 
burnished deep undertones are in place it is a good 

Metallic colours blend slightly differently 
to non-metallics. Due to the stronger 
saturation, brighter highlights and deeper 
shadows created, colour mixing on the 
canvas can be challenging. It can feel like 
the first time you use oils in ArtRage, slightly 
out of control and slightly difficult, especially 
if you’re coming from a package like 

Photoshop which offers very high control. 
It is times like these when seeing this as a 
feature rather than a bug pays dividends for 
you. Strange colours are thrown up as light 
colours struggle to lie on top of dark when 
using a high percentage Metallic setting. 
This can provoke changes in the way you 
paint, and that is no bad thing.

A perfect foil for painterly images
What is it that makes metallic paint metallic?

Loose sketch The pencil in 
ArtRage is a marvellous digital 

drawing tool. Due to the flexibility and 
forgiving nature of digital media, you can 
start planning your image very loosely.

Textures Importing a real texture into your 
design whether scanned or photographed is an 

ideal way to add interest, keep one foot in real media and 
cover canvas real estate fast. You can even make specific 
paint textures for a given project if you want.

Underpainting Underpaint in metallic opaque 
oil paint. Using marks that follow the form helps the 

shape to appear more three-dimensional.

Character
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Sketch A simple line drawing midtoned with 
Watercolor. All the major details are here, but how 

detailed it needs to be depends on your painting style. 

01

idea to switch to non-metallic oils and work up the 
surrounding areas so that everything progresses 
simultaneously and we keep our tones at the right 
relative levels. If you work one area too far it can 
make for a bitty image. A big part of making the 
golden tones of our robot really pop will be the 
contrast with the cyan coloured window, and it is 
worth getting that colour in there about now so we 
can see how it looks while we work.

Next, a texture is imported as a new layer just to 
break everything up and add further visual interest. In 
this case it’s a photograph of a bronze statue in close 
up, which seems appropriate!

The next step is to return to the Metallic Oil paint 
and really work on the details and the midtones of the 
metal areas, pushing more towards yellows, golds 
and mid-oranges and leaving the darker areas 
showing through in the shadows. This takes the 
longest single period of time, and it needs a lot of 
care to work with those slightly diffi cult metallic oils. 
You can hopefully see the build-up of deep metallic 
colour and texture that begins to appear. Because 
the marks are so shiny and really show off that 
impasto feel, you need to take care to have the marks 
follow the form of what they are supposed to be 
describing or they will look unrealistic.

A couple of passes of lighter colours in Metallic 
Oils are followed by a switch in tool. The Ink Pen tool 
at a high Opacity with zero Smoothing is used to add 
in some very sharp highlights of refl ected colour and 
shining gold. Because these need to appear as if 
they are lying on top of the metal body, non-metallic 
colour is used as it blends less and doesn’t have    
that push towards deep colours.

This is the main basis of creating the metallic 
appearance you see in the image. Additional passes 
of Metallic Oil are used to tighten up the smaller 
details as well as introducing a few more areas of 
refl ected warm orange and grey as a complement to 
it. From this point on, it is a case of adding as much 
detail as you like to fl esh out the scene. Or to put it 
another way, it’s all about polishing.

Painting with 
Metallics

Learn how Jon’s process makes 
the most of refl ective effects 

Set some colour Watercolor is used along 
with an imported texture to break up all the white 

space and provide some underlying neutral tones.

02

Opaque paint Highly metallic oranges and 
golds go in on the robot while fl atter, non-metallic, 

muted colours make the surrounding area. Vary the hues.

03

Polish Lighter, brighter tones go in with strongly 
metallic paint. A further pass of non-metallic 

highlights are added on top for maximum brightness.

04

Rim light On this close-up of 
the head of our robot, the main 

focus, the variety of golden colours can be 
seen in the second pass of metallic colour 
with the opaque highlights sitting on top. 
Getting that rim lighting right is crucial as it 
makes for a believable image.

Reflections Attention to details 
like the reflected green foliage 

is another important point to observe. 
Metallic surfaces appear shiny because 
they reflect light and colour and that 
includes the scene around them. 

What it 
doesn’t 

say on the tin
What adding more Metallic 
effects won’t do is paint metal for 
you. You can’t push the slider up 
and suddenly paint perfect 
chrome. You have to do all the 
work in picking the right colours 
and applying the right tone to 
your image. The metallic effect is 
designed to make the digital paint 
look metallic – not what is painted 
with it.

GENIUS GUIDE
Fantasy Art

Fantasy Art Genius Guide  89

086-089_FAGG_01.indd   89 05/07/2012   10:54

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Source files
available

Custom skin pores brush 
Custom scratch brush 
Colour palette 
Scanned decorated paper

Character
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Jeffery M. De 
Guznan
Personal portfolio site
http://theartofjeffmd.com
Country Philippines
Software used Photoshop, 
Maya, 3ds Max
Jeffery works for Lucasart in 
Singapore, and has worked 
on fi lms such as Iron Man 2 
and The Avengers.
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Using references At the start we don’t 
need solid references. Even if they are just 

parts of an image and may be small, like helmets, 
armours, costumes, etc, we will not be completely 
using them in any way. They will just be used as a 
reference to give us an idea for the new character 
design that we have in mind. 

Painting silhouette Start off with 4 x 
5-inch canvas at 72dpi. From the images we 

gathered, loosely paint your character’s silhouette 
from combinations you fi nd interesting. Making 
something new should always be at the front of your 
mind. It is important that we paint the fi gure and a 
costume of shapes that are recognisable even at this 
early stage. Choose a grey at 50% to paint it with. 

Sketch over Increase the document size 
to 8 x 11 inches, still at 72dpi. On another layer, 

outline the female fi gure fi rst, then loosely sketch 
over a costume design based on the silhouette and 
references. Don’t think of details yet, as we should 
fi rst draw the general shape of armour parts and how 
they would fi t the fi gure well.

Fantasy character

The female fi gure’s 
outline needs to be 
made as close to 
precision as possible 
because this will dictate 
the overall armour 
design, and most 
importantly, avoid a bad 
fi t with the fi nal image. 
This is an entirely new 
pose that we created. It 
is helpful to have a 
decent grasp of 
anatomy when drawing 
the female fi gure. If 
you’re after another 
way, you may take a 
photo of yourself or a 
friend re-creating the 
new pose that we 
made, using the same 
lighting if possible. Use 
whichever method that 
would work both better 
and faster for you.

To pose 
or not to 
pose?

Zhetri  2008 Photoshop

Jeffrey M. De Guzman aka ‘Jeff MD’ Digital painter and concept artist

Take inspiration from Asian warriors and European knights

Build your character
Get some inspiration

You don’t need to be a master painter to create 
beautiful fantasy characters. A good knowledge 
of lighting is the most important thing when creating 

an image. Observe everything that surrounds you. See 
how a light reacts with a certain object, how shadows fall 
on an environment and how dark an object will be in a 
given light. This knowledge will put the idea that you have 
when painting into shape and turn it into reality. Also, you 
just need to push the imagination to create something 
new out of what has already been made, making it 
original and eye-catching. Feed your mind with stunning 
artwork and creations. Continue to be inspired, as it’s 
easy to create beautiful concepts when you’re in this 
state of mind.

In this tutorial you will learn how to design armour, taking 
inspiration from Asian warriors and European knights, 
combining them to create a fantastic new look. You will 
also be given a different perspective to using references, 
learning how to make good use of something without 
completely copying it. You will also learn how to create 
your own custom brushes for use as textures. The vast 
amount of Photoshop tricks and techniques that we will be 
sharing with you will be a big help in creating this kind of 
artwork with ease. We won’t need fancy brushes as 
everything will be done using Photoshop’s default 
collection, but do bear in mind that you will need extra 
patience in creating a crisp and detailed artwork as it takes 
quite a long time to complete.

01
02

03
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Adding colours After creating our 
desired colour palette, add a new layer on top 

of our greyscale image, with the layer set to Color. 
We can pick colours from our palette by pressing Alt 
then releasing it to go back to the Brush tool. Paint 
the colours you want for the image, then merge both 
layers. Repeat this procedure if you want to add more 
colours to it, or alternatively you could also set the 
layer to Soft Light or Overlay. 

Character
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 Let there be light! Go to 
Filter>Render>Lighting Effects and set the 

Style to Default and the ‘Light type’ to Spotlight. 
Rotate by grabbing the tip of the lever arm to put the 
light source at the upper-left corner of the image 
from a 45-degree angle, so it appears as though 
it’s coming from behind her. This gives a good light 
direction reference that will aid us better when blocking 
out shapes.

04

Dodge and Burn Set your Dodge and 
Burn tools to Highlights and Exposure to 

12%, using the default Photoshop Chalk brush with 
the Other Dynamics box checked and set to Pen 
Pressure. Also take note that we will be using the 
Chalk brush for the majority of the painting; use it 
as well for your brush. Use the Dodge tool to give 
highlights and the Burn tool for the shadows.

05

 Shape references Are you having a 
hard time knowing how to light a certain part? 

We shall break it into different pieces and apply the 
Gradient Fill tool as a different style to quickly do it for 
us. It shall be created in the same light source with a 
secondary light that we will add later on.

06

 Painting grey We now have a general 
idea what our image  would look like. Merge 

your sketch layers and the character layer. Use the 
Brush tool set to Pen Pressure, with Opacity and 
Flow at 100%. We will now enhance the shapes and 
paint it further. It is better to work in greyscale as we 
don’t have to worry about colour values. This will 
help us concentrate more in defi ning and painting the 
entire character.

07

Cut and face The face should be the 
most interesting part of the image. We 

couldn’t fi nd the right expression as a reference, so 
instead we mixed and matched parts of the face from 
different images that we found. With this approach, 
we didn’t have to worry that the face we painted 
would look like someone else’s. Take note that the 
light source from each image are different. We must 
consider this when we transfer it to our character.

08

09
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We mixed and matched parts 
of the face from different images 
that we found

Create a new 200 x 200px fi le. Paint speckles with 
a 20% grey, soft, round-edged brush, then go 
to Edit>Defi ne Brush Preset and name it ‘Base_
skin_brush’. Go to the Brush tab and apply these 
settings: Scatter = 450%, Control Pen Pressure = 
check both axes, Brush Count = 3, Count Jitter = 
98%, Control = Off. Under Shape Dynamics, set 
Angle Jitter = 100%, Roundness Jitter = 72%  and 
Minimum Roundness = 25%. Set Color Dynamics 
to Foreground = 11%, Hue Jitter = 11%, Brightness 
= 11%, Purity = 0%.

Ctrl/right-click and select Create New Preset 
From This Brush. You will then need to name it 
‘Skin_pores_brush’. There will be two skin pores 
brushes in your selection – delete the fi rst as it’s no 
longer needed.

Custom brush 
for skin pores
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Textured background Adding texture 
will make the background interesting. Use the 

default Maple Leaf brush, check the Other Dynamics 
box on the Brush tab and on its settings, set Opacity 
Jitter to Pen Pressure with the Brush Spacing at 
10. Now paint like crazy! Switch between different 
colours from your palette to create harmony with your 
foreground image.

10

Sculpt-painting details Notice that 
simply emphasising the shadowed parts and 

the highlights lends volume to the image, giving you 
that 3D look. Highlights give images the bump and 
shadows lend thickness to them. There’s no need to 
sketch into a new layer to create the design, just let 
your imagination sculpt away to get new ideas. 

13

Cloth Use a soft round-edged brush when 
painting cloth as it gives a soft feel to it. Shift 

between the Dodge and Burn tool to emphasise 
highlights and shadows. Make sure to use the same 
brush and setting you used with the main painting 
brush for this. 

15

Saving as a different version As you 
progress with your image, it is best to save a 

new version by changing the fi lename. For example, 
‘character_01’, ‘character_02’ and so on. This is 
helpful for us to go back to the previous version in 
case we end up messing up our work. 

14

Layer management and image 
resize It would be better to work with as 

few layers as we can. A maximum of four layers 
is advisable: the background, character image, 
hair and weapon. Then resize the image to 
300dpi resolution with the Scale Styles, Constrain 
Proportions and Resample Image boxes checked. 
This will increase your resolution size to 2,000 x 
3,000px, which is enough to add details.

11

Making scales Create a new layer and 
draw guidelines as shown in the screenshot. 

Your vertical and horizontal lines must conform to 
the overall shape of the image. Set your guidelines 
layer’s Opacity to 30%. Go back to the main image 
layer and start painting dark colour just outside the 
scales’ guidelines to create shadows.

12
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Painting hair Using the default Spatter 
59 brush set to Pen Pressure, fi rst paint the 

entire volume of how you want the hair to be with a 
big brush size. Gradually reduce your brush size and 
change colours to paint the hair into smaller groups. 
Once you’re happy with the arrangement, reduce the 
brush to 2 pixels and paint some individual strands to 
make it look more natural.

A quick fl ip We must not forget to regularly 
fl ip our canvas horizontally. This gives us a 

fresh eye with our image and could easily determine 
errors we have made. What looks good on the other 
side might not work as well when fl ipped.

Skin pores brush test Create a new 
fi le and fi ll it with your base  skin colour. We 

must experiment with our new brush before applying 
it to our character. This is the outcome of the brush 
choosing different colours for it. Use a Background 
Color of either blue or green to have a better output in 
the Color Dynamics settings to better blend with the 
skin colours.

Detailing the skin Skin, like cloth, needs 
to have soft feel to it. Use a soft round-edged 

brush, also set to Pen Pressure. Pick a colour from 
the skin palette and paint directly to your character 
layer. Texture the skin using our custom skin pores 
brush. Add a new layer above it and set to Overlay. 
Add pores to the parts where it bulges more.

Getting lippy First paint the base lips as 
seen in the illustration. Get a close-up picture 

of a lip and turn it to greyscale. Cut and fi t to the base 
lips. Set the layer to Soft Light then merge the layers.

Flipping the canvas horizontally 
gives us a fresh eye

Adding textures to the armour For 
a realistic look to the armour, add scratches 

to it. Add a new layer and set it to Overlay. Using 
our custom brush scratches, add bright colours to 
parts that the light refl ects more, and dark colours to 
shadowed areas. Erase unwanted areas. Reduce 
the layer Opacity to 50%, then merge the layers.

Character
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19

Creating custom brush scratches 
Open a fi le sized 200 x 200px. With a hard 

round-edged brush, make random lines. Hold Shift 
to make perfect vertical and horizontal lines. Erase 
portions of these lines and create as a brush. In the 
Brush tab, set to Shape Dynamics with Angle Jitter at 
48% and Brush Spacing at 68%. Ctrl/right-click and 
select New Icon to create a new preset.

21

22

20

17 18

090-095_FAGG_01.indd   94 05/07/2012   10:57

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Creating a refl ective sword On a 
separate layer, fi rst paint the shape of the 

sword, then sculpt-paint to give volume and details 
to it. When done, duplicate the sword layer (Cmd/
Ctrl+J). Go to Filter>Sketch>Chrome, setting Detail 
to ten and Smoothness to zero, then press OK. Set 
the layer to Multiply at 30% Opacity then merge with 
the base sword layer.

Adding more details to the scales 
The scales look fl at, so add a few more details 

to them. Create a New Layer Set and add a new layer. 
Draw one simple detail for the scales and fi t it into 
one. Duplicate the layer (Cmd/Ctrl+J) and using the 
Free Transform, fi t it to another and repeat the same 
procedure with the rest. Merge the layer set folder. 
Set it to Overlay and merge with the image.

Background 
overlays To make 

the background look more 
interesting, we scanned in 
some paper decorated with 
bamboo trees. Add it on top 
of your background layer, 
set it to Multiply and reduce 
the Opacity to 50%.

Semidesaturated look Rather than 
going to the Saturation slider and reducing 

the saturation, it would be better to add a new layer 
fi lled with a soft, desaturated gold colour (R = 152, 
G = 118, B = 68), then set the layer to Color at a layer 
Opacity of 30%. Merge the layers to fi nish.
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Cloth details and textures Again add 
a new layer. Draw simple fl ower patterns then 

set the layer to Soft Light with Opacity at 35% and 
Fill 100%. Add another layer and add textures using 
the default Scattered Maple Leaves brush set to Soft 
Light. Merge all three layers.

23 24

26

Finishing touches Now we are happy with our image so it’s 
time to fl atten all the layers. Start fi lling in and making touch-ups to 

any of the areas that need refi ning. Add little details to the hair and highlights 
to the armour.

27

28

25

Quick 
tip

It is best to assign shortcut 
keys for functions that we 
regularly use. For example, 
we have set Cmd/Ctrl+. for 
Flip Canvas Horizontally 
and Cmd/Ctrl+/ for the 
Brightness/Contrast sliders. 
Shortcuts help us work 
more effi ciently.
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Compose magical scenes
Concept

Try to come 
up with a few 
compositions 
that are strong 
enough to 
take further 
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Secrets of good 
concept art

Build the environment With characters out 
of the way, the environment can be laid out much 

more easily. Remember that a convincing environment 
can have unrealistic colours, as long as you keep them 
consistent with one another. The buildings should all 
follow from the same perspective point.

When creating a character, perhaps for 
a game or for a 3D model in general, it’s 
vital to make the illustration interesting 

for the viewer. Having a character in mid-action 
instead of simply standing motionless in the middle 
of the canvas can make them much more dynamic 
and appealing.

Diagonals can work extremely well to bring an 
image that seems static and fl at to life. Seeing 
something with a bit more perspective in a horizon 
line that goes beyond the horizontal is generally a 
great experiment for any artist. Far too often, a 
designer will get caught up in creating an image 
that’s too simple in its composition. While characters 
do not need to constantly be in motion, their stance 
and position need some nuances to encourage the 
viewer to keep looking, or indeed to grab them in the 
fi rst place. I believe concept art can be created with 
the ‘draw it until you fi nd it’ rule. I keep sketching until I 
come up with a few compositions that are strong 
enough to try and take into further development. 
When you have a few roughed out, you might even 
go back to your original sketch, but at least you’ll 
know you’ve tried a few options and different 
elements of those could potentially work together.

The Kite Flyer  2010 Photoshop

Kim Herbst Illustrator

Create a character whose personality is revealed by their 
pose and their interaction with the environmentDigital artists explain the 

techniques behind their 
amazing artwork
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Kim Herbst

Personal portfolio site
www.kimherbst.com
Country USA
Software used Photoshop
Kim is a freelance illustrator 
based in San Francisco, 
CA, originally hailing from 
the East Coast. Her 
illustrations have been 
described as an organic 
graphic novel style. Her 
work has been featured in a 
variety of art blogs and 
magazines. She has 
experience in game art, 
children’s books and 
editorial publishing.

For concept art, I like to make a short story in my 
head. Writing down a paragraph can sometimes help 
to motivate how the image will turn out. The stories 
rarely have a beginning or an end. It is a quick 
snapshot into a character’s realm, and I’m not given 
any answers to what else might be going on in the 
background. I do not know why this kid is by himself, 
why he owns a kite or how he befriended a robot.

I am eager to show a small moment in the boy’s 
life and that it is possible to fi nd happiness in a not-
so-great home. The world, for this illustration, is not a 
stable one: dilapidated buildings, broken windows, 
no wildlife or any living foliage. It’s not a happy place, 
but to have something that stands out among all of 
this can evoke a very poignant feeling. It gives an 

Placement Make sure the characters are placed 
effectively on the background. You can already get 

a grasp of the world that this boy and robot live in.

Concept
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underlying concept to drive the viewer to fi gure out 
what is happening in the image.

Lighting is extremely important when creating a 
conceptual piece. With proper lighting, the viewer can 
gain the correct mood for a scene in a fi lm, or a video 
game. This starts with a colour scheme. You want to 
convey that this is a precise moment in time so 
choosing day or night is always a good start.

For this piece, it is a dismal day. The light source 
comes from the sky, and is mottled with clouds. Your 
imagination can take the concept even further: 
perhaps the natural sun has burned out in this world 
and has been replaced by artifi cial light. Either way, 
the light should have a natural feel and hit objects 
accordingly. Bear in mind that the lighting and 
colours of the background can actually add to the 
personality of the character(s).

When sketching out characters, really consider 
how you want them to look by the end. The condition 
of their clothes, the material they are made of, the 
world they live in, what they have been through, how 
they react to their world, and so on. I usually create 
multiple thumbnails of clothing designs to see what 
would fi t best. Research is key when creating 
conceptual images. For the background, I have 
referred to images of WWII, with bombed buildings 
and abandoned towns for my environment. It might 
seem reminiscent to a viewer if they can recollect 
something they have seen elsewhere, in photos, or 
even a memory. It becomes much more believable 
when an artist bases their idea on something that 
exists/existed and builds from that initial concept.

Always look at references for positioning objects in 
your image, whether they are quick snapshots of 
yourself, a friend or buildings, etc. Even the best 
artists can’t conjure up what a really specifi c object 
looks like from their minds. You can choose to 
emulate different types of domestic archways for 
doors or look at some 18th-Century churches 

instead, so long as you feel it all comes together to 
make a great fi nal product. Keep the fundamentals in 
mind as you apply colours. Placing objects far off in 
the background will obviously require less detail and 
less saturation in colour. Objects in the foreground 
receive greater attention to detail, more contrast in 
lighting and more colour saturation.

When my character is fl eshed out in my mind, I 
generally think of the atmosphere of my character’s 
surroundings. If it is cold, the character should be 
dressed appropriately and the colours of the 
background should follow suit with a cooler palette.

For this illustration, I wanted to convey a world that 
seems to have some saving graces, even while 
looking so desolate. For me, this is done best with 
the interaction between two characters instead of just 
one: a boy, who may or may not need the aid of a 
mechanical automaton, is attempting to fl y a kite. It’s 
a small, entertaining recreation and he seems 
oblivious to his current surroundings, a theme seen 
with many children, but countered slightly as he has 
no fellow human companionship.

A lot of other choices were considered with just 
these two characters. Because of their interaction, the 

When you fill in more of the image, you may 
consider changing your illustration’s concept. 
Taking elements off the canvas while creating 
the image can help you focus on the story 
you’re trying to express. The boy’s facial 
expression suggests that he’s mischievous, 
but it doesn’t seem to have the same impact 
without a secondary character.

The Kite Flyer
It’s much easier to create a setting with a solid sketch

After
Before

We look at some of Kim 
Herbst’s other artwork

Duck ’n’ Cover
2009, Photoshop
● Featured in EXPOSÉ 8, this 
illustration shows a deep-seated 
personal fear of mine – imagining 
exactly how small I’d feel if I had to deal 
with a monster the size of Godzilla.

We’re Gonna Need a Bigger 
Rucksack
2009, Photoshop
● Featured in the Autumn Society’s 8-
Bit & Beyond Video Games Art show, 
this Zelda illustration asks the question 
many videogamers might ponder: how 
did Link really lug all his items around?

Buried
2009, Photoshop
● Used as a self-promotional image, 
this illustration seems to be a favourite 
because every person can relate to 
feeling overwhelmed, whether by 
emotion or… origami birds.

Rain or shine Reflect on other scene elements 
such as the weather. It could be raining, about to 

rain or just finished raining. The air changes in each of 
these states and will also affect your character’s mood.

Erase lines Clean up any remaining sketch 
lines on your characters. The weight you give them 

should be reflected in their clothing (or the material they’re 
made of, in the case of the robot). Their anatomy, even if 
cartoony, should be immediately readable to the viewer.

Concept
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Point A to B With a sketch, the artist should 
keep dynamic composition in mind. The eye 

should fl ow from one point of the scene to another.

01

design should refl ect their relationship. If the robot is 
to be seen as a companion, I felt it needed similar 
features to the boy. The robot’s build is bipedal and 
has a face versus having, say, wheels as a base and 
long, robotic tentacles for arms; this would make the 
scene feel much more menacing!

This robot appears to be friendly, even if a bit 
bumbling and over-enthusiastic. He shows a bit of 
rust and wear on his metal frame to fi t in with the rest 
of the environment, maybe from hanging out in the 
moisture of the mist too long. The boy has some old-
fashioned clothing that was a throwback to the early 
1900s since I referenced the buildings from that era, 
like his hat, for example. I changed a few elements of 
his shoes, however, to signify that this realm is 
obviously not our own.

The kite is made up almost entirely of paper, 
having considered what materials this boy would 
have readily available to him. If it were steam-
powered and mechanical, the concept would lay 
more heavily in technology, and not the lack of it as 
so clearly depicted in this image. Consider your 
options for props and then narrow them down to fi t 
your theme. Laying down some rules for your make-
believe world enables you to answer any questions in 
the back of your mind more quickly. I can say, there’s 
gravity, so the characters won’t be fl oating around idly 
in the space I have created. There are buildings so it 
is safe to say there was a civilisation at some point. If I 
had chosen to place more people in the background, 
the mystery of whether this boy is one of the only 
survivors of some calamity is easily answered. The 
possibilities are endless unless you give yourself the 
necessary limitations.

A lot of concept art stems from the question, 
“Wouldn’t it be cool if…” and continues on to 
whatever your mind can conjure. Having an idea is 
great, but expanding on to develop a whole new 
world is even better. Lastly, always be fl exible with 
your artwork; if your theme doesn’t seem to be fi tting 
the character or environment you set out to create, 
experiment with other props and styles for your piece.

Develop
the scene

Set the rules for your world 
before you begin to draw it

Plan ahead In the early stages consider other 
objects you may want to include. Random pieces 

of rubble, vehicles and wildlife are a few possibilities.

02

Keep it real Textures should be used 
believably. For background elements, consider the 

distance and atmosphere to make sure nothing jars.

03

Blend in Characters should belong to their 
environment, with correct shadows etc. Stylistically, 

the kite, robot and clothes should look contemporaneous.

04

Colour time Experiment with 
colour variations if you think you’re 

pushing a particular shade too far. For 
instance, if the environment’s too blue, 
your warm-toned character might clash.

Light right Proper lighting from 
a certain direction and foreground 

elements can tie a concept together. The 
buildings are faint in the background, while 
the boy and the robot are more saturated.

Master 
your craft

If you’re stumped for composition 
when creating concept art, I 
highly recommend browsing 
paintings by the Old Masters for 
the general placement of 
objects. Or try taking photos of 
your everyday life and creating 
numerous thumbnail sketches, 
overlaying various shapes or 
characters on top.
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Design decorative 
backgrounds 

Backgrounds are an important and interesting 
way of adding life and depth to your 
portraiture. By creating something that your 

subject can contrast with you can add beautiful decorative 
elements or simply frame your portraits to lead the eye 
better. Backgrounds can be stylish in their own right and 
convey a meaning and context that simply cannot be 
portrayed by the subject alone.

Using a strong background can be especially effective 
when you weave it into the subject so that there is no clear 
separation between the two. A background that interacts 
with its foreground elements can give the whole image 
more of a feeling of movement and life. This kind of detail 
can reflect the personality of the character that you are 
drawing or their lifestyle and way of being. In this tutorial, I 
will reference the great artist Alphonse Mucha to give my 
portrait a classic and unique feeling. 

Mucha is one of the definitive graphic designers of Art 
Nouveau in the late 19th Century, and he used female 
figures to express a wide range of concepts. His work was, 
and still is, both desirable and commercial with his 
trademark clean lines and repeated patterns, the key 
elements that give his work such a distinct atmosphere. 

We will learn how to take these techniques into the digital 
age and combine elements in a fast and effective way to 
give you complete control over your final image. We will 
use digitally created elements such as patterns and original 
textures that will give the hand-drawn feel that is needed to 
create the painterly style associated with this period and 
Mucha in particular. Referencing classic styles and artists 
is good practice; examining what they created and how 
they did it enables us to understand that even nowadays 
illustrators and artists can learn from the past and gain 
insights that will help their work remain fresh.

Femme Fatale  2011 Photoshop

Natsuki Otani Illustrator

Build exciting compositions for your portraits 
using complex decorative backgrounds

Create a decorative background
Give your subject an Art Nouveau twist

Research your image Try to find 
images that inspire you. You can choose 

elements of a drawing like patterns, things you intend 
to draw in the image like flowers or even just references 
for the colour scheme. I like to choose a variety of 
references to give my drawing a good start point. 

01

Evoke Mucha with 
pattern and texture

Working
Progress

Step 02, Design in rough

Step 05, Scan your image

Step 12, Repeat the shape 

Step 14, Inky hair

Design in rough When sketching, try to make the big 
decisions about layout and composition. It is easy to change, alter, 

add or remove elements at this stage so make sure you are happy with 
your layout and have a good idea of your final image. 

02

Source files
available

Line Art

Concept

102  Fantasy Art Genius Guide

102-107_FAGG_01.indd   102 05/07/2012   11:18

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Digital artists explain the 
techniques behind their 
amazing artwork
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Natsuki Otani

Personal portfolio site
www.natsukiotani.co.uk
Country Japan
Software used Photoshop
I’m a Tokyo-born illustrator 
and love to use colour in my 
work, especially inks. I 
create dreamlike visuals that 
are both life affi rming and 
tragic. If I can make people 
smile with my work then I 
have succeeded.

GENIUS GUIDE
Fantasy Art

Fantasy Art Genius Guide  103

102-107_FAGG_01.indd   103 05/07/2012   11:18

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Scan, texture and shape
Import your drawing and develop the background

Line drawing Bring together the things you have designed in rough to create your line 
drawing. You can do this digitally if you prefer, but I created mine by hand. The girl will be 

part of a highly decorative fi nal image so I kept the lines as clean as possible.

Think about the 
composition 

Now decide where to put the 
background that you made 
using the Shape tools. Guides 
are helpful when you are trying 
to make something with a 
sharp, precise feel. 

Prepare your 
textures You can 

make your image unique by 
creating your own textures to 
use. This will give a personal 
touch, and the textures 
you make can be useful for 
creating your own brushes 
too. You can make textures 
digitally as well using the 
Smudge tool and custom 
brushes to layer colour. 

Scan your image 
When scanning your 

image make sure to use a high 
resolution (300dpi minimum). 
I fi nd it best to turn off any 
colour correction and anti-
scratch settings, as they tend 
to interfere with the tone.

03

04

05

08

Clean your image As my image is hand drawn, I need to clean it up. Create a black 
background to help you see the marks, delete any you come across and use the Clone 

Stamp tool to repair any damage to your original image. 

07

Sharpen and cut out Open the scan and create 
a new Levels adjustment layer. Change the values until 

you have created the sharpest image possible with the most 
contrast. Use the Magic Wand tool to select the blank area, 
then Ctrl/Cmd+Shift+I to invert your selection. Copy and 
paste into a new layer on your main canvas. 

06

Make 
digital 

stamps
After creating an element that 
you want to keep, like our 
fl ower bunch for example, 
you can turn them into a 
stamp by simply selecting the 
shape layer and choosing 
Defi ne Custom Shape from 
the Edit menu. After you have 
named your shape it will be 
available from the Custom 
Shape menu. 
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Textured 
background Now 

add the textured background 
of the image by setting the 
layer option to Multiply, 
creating a vector mask on the 
Background layer and using 
the Brush tool with pure black 
to hide all the areas where you 
do not want the background 
to show through.

Repeat the shape Use guides to divide up your 
halo to make placing your fl owers easier, then copy and 

paste your design. To make it less repetitive, you can use the Flip 
layer option from the Edit menu. When you are happy with their 
placement you can combine them into one layer. 

Add a pattern Make a simple 
pattern on a different layer; I chose a 

chequerboard-style texture. Use the Magic 
Wand to create a selection of your frame and, 
with the selection still active, go to the pattern 
layer and cut it out with the selection shape. 

Make the frames To make a 
frame, select the Pen tool set to Paths. 

The frame should be drawn using Shift to 
make the lines straight. Once you join up the 
path, right-click, select Stroke Path and use the 
Pencil option. This will select your current Brush 
settings and paint it along your path.

09

10

12

13

Flower halo Draw a rough design to fl esh out the halo with decoration (I decided on a 
fl ower pattern). First use the Pen tool to trace over the design and then remove the internal 

shapes of the fl owers by using the Subtract From Shape Area option.

11

Alphonse Mucha has real depth in 
his work so let’s take a closer look 

Mucha’s 
unique style 

Style
School

Art genres in 
a nutshell

Artist: Alphonse Mucha
Title: Job
Year: 1896
Location/Owner: Austrian Museum of Applied Arts/ 
Contemporary Art
● In this picture the hair is almost working as the 
decoration and background. It is not a pattern but falls 
somewhere in between, following the curves and 
becoming a part of the theme. I wanted to take inspiration 
from this technique for the hair in my own image. 
tinyurl.com/mucha-job

Artist: Alphonse 
Mucha
Title: Salome
Year: 1897
Location/Owner: 
Private collection 
● The irregular repeated 
patterns of this image 
gave me inspiration for 
my composition. I like 
that while the shapes in 
the background are 
simple, they give a 
sense of movement and 
the idea that they could 
represent music. 
tinyurl.com/
mucha-salome

Artist: Alphonse Mucha
Title: Monaco Monte Carlo
Year: 1897
Location/Owner: Private 
collection
● This image contains a strong 
halo motif. On fi rst viewing it 
appears to be a repeated 
pattern but on closer inspection 
it has slightly different 
constructions and tonal values. 
The image is very strong and 
helps to give the subject not 
only prominence but also a 
mystical and mysterious air. 
tinyurl.com/mucha-monaco

There is something immediately eye-catching about 
Mucha’s work. The vast majority of people are familiar 
with it but not necessarily the artist, and his work remains 
distinctive and timeless. He was a pioneer of a glamorous, 
commercial style and his work remains intensely relevant 
today. Mucha brings the viewer into his image with an ever-
increasing level of detail that appears hypnotic and gives 
his subjects depth and context. 

The masters
Out with the old, in with the Nouveau

Artist: Alphonse Mucha
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Finalise the tones
Colour the hair and complete the setting

Inky hair Import an ink texture for the hair into a new 
layer then use the Magic Wand to select the rough area 

you want to apply it to. With the selection active, switch to the 
texture layer and copy and paste. Set the layer to Multiply.

Isolate the hair 
Using the same 

technique as with step 13, 
create a vector mask of the 
layer and use a black brush to 
clean the mask revealing the 
image wherever you do not 
want the hair colour to show 
through. Remember to leave 
her eyelashes and eyebrows 
for consistency. 

Matte and shade This is the stage where you bring all the elements of the image 
together using matte colours to emphasise the various parts. Make sure you add the colour 

carefully, taking time to get the best result, but feel free to alter the hue and saturation of the image. 

Mask other elements Use vector masks as with 
the earlier steps to create the other elements, painting 

pure black where you want to hide the image. This is where you 
can be really creative, making sure all the elements interact the 
way you want, to give a sense of movement and integration. 

14

Star symbols 
Make a new layer and 

choose the Shape tool. You 
can fi nd the Polygon tool 
in the Geometry options. 
Uncheck Indent Sides and 
enter a percentage. Choose 
the number of sides you want 
and you can create a variety 
of star symbols, so fi nd your 
favourite one. 

Place shapes 
and texture Place 

the stars until you are happy 
with the composition. Open 
the ink texture, place it below 
the symbol layer and then set 
the blending mode to Screen. 
You can now see the ink 
texture on the symbols. Create 
a blank layer below the layers 
and merge them together, 
setting this to Multiply. 

Last adjustments This is the point where you 
should give the image its fi nal adjustments. You can 

perfect it by changing the hue or level and opacity of the layers. 
Use adjustment layers to do this and keep your original settings.

18

19

20

15

16

17
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Nouveau riche
The glamour of Mucha

Facial expression While this is a 
tutorial about using the background to 
reinforce the strength of your work, the 
face will always be the focal point of any 
portrait so take care to make sure that you 
have a strong and engaging expression.

1

Decorative hair While you may 
worry about each strand, it is important to 
consider how the hair falls as a whole as 
to work in a stylised concept it has to have 
a harmony of form and direction that gives 
the image distinctiveness and balance. 

2

Halo effect With the halo it is important 
to get a balance between a repetitive 
element that gives consistency and 
creating a unique feel. I used the same 
element but placed it differently and used 
varying colours to offset the repetition. 

3

Create a frame Making complex 
shapes is usually the preserve of 
Illustrator, but there are ways to stay in 
Photoshop. The Stroke Fill feature on 
paths, for example, enables a range of 
shape manipulating techniques.

4

Simple patterns These can be made 
in a number of ways, but make sure they 
do not detract from your image. They 
should act as a complement to the theme 
and mood. Simple patterns can be made 
with the Clone Stamp or custom brushes. 

5

Background colour The pattern 
and shapes are really important, so the 
colour should not come to the fore. I’m 
using subtle hues that will give depth. The 
colour needs to be faded, otherwise the 
amount of elements would not work.

6

1

2

3
4

5

6
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Fantasy art 
             on the iPad 

For many years I’ve been waiting for the day I 
would be able to carry around my oil paints like 
a sketchbook. With my first laptop I thought I would 

be painting during long flights. But I soon discovered 
balancing a laptop and a graphics tablet in a confined 
space is not fun. I then switched to a Modbook. That 
worked great on a plane but it was still too heavy to carry 
around on a daily basis.

Don’t worry, though, there is a happy ending to this 
story. My dream of a magic oil painting studio is here. 
Though the iPad lacks pressure sensitivity and is limited to 
the file size it can create, it is powerful, completely portable 
and actually faster than my first Windows 98 laptop. I get 
around the lack of a provided stylus by using any of the 

numerous rubber-tipped styli that are available. I don’t care 
for the sponge-tipped options as I find they don’t have the 
right amount of friction. I attach the stylus to a pencil 
extender from an art store to make it longer like a 
paintbrush and use a fingerless glove to avoid any 
accidental marks.

To make up for the lack of pressure sensitivity on the 
iPad, the ArtStudio app enables you to adjust how thin a 
line begins and ends. Surprisingly, this feature works rather 
well for my style. If an iPad painting app does not have this 
feature, it is almost impossible for me to use productively.

So there you go. A painting studio as light as a 
sketchbook, great for working in the cafe, a figure painting 
session or just waiting in line. 

Daybreak  2011 ArtStudio

Kari Christensen Illustrator, concept artist and traditional painter

This tutorial will focus on how you can create a detailed fantasy 
painting on the iPad with the ArtStudio app

Paint on the iPad
Set down tonal values and line art

Reference and colour study After 
sketching from my head, I create a reference. 

I am always trying to improve my lighting and figure 
painting, and any resource that does that is invaluable. 
I also make colour studies. Without these I would start 
painting in circles trying out different combinations, 
which can be bad if I have a deadline. 

01

Build a magical scene 
within a mobile app

Working
Progress

Step 02, Line art

Step 05, Refine with blend modes

Step 10, Rock photo texture

Step 14, Final fixes and pattern

Line art To do the sketch I 
use the largest resolution I can 

get on the iPad in ArtStudio which is 
2,048 x 2,048px. I find anything smaller 
starts showing pixels in my lines. I am 
going for a basic outline drawing that I 
will soon cover up with brushstrokes.

02

Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Kari Christensen

Personal portfolio site
karichristensen.com
Country US
Software used Everything 
from Photoshop and 
ZBrush to ArtStudio 
and real media
I have been a full time 
freelance artist for almost 
ten years. I have done 
illustration and concept art 
for games, publishing and 
film. I currently live in New 
York City with my wife 
Cambria Evans who is 
also an artist.
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Create custom brushes
Add detail and texture with ArtStudio’s tools

Block in colour I make the image smaller at 1,024 x 
768px. I don’t need that much detail at this stage as I will 

be covering my line art and the iPad brushes cover more of the 
image at that size. Referencing my initial colour comp, I block in 
the basic shapes. I’m painting into a new layer with the Airbrush 
tool and Incremental Mark Application turned off. 

Fix errors with selection Zooming in and out on the small screen of the iPad, I’ll 
sometimes render something up close and it will be out of proportion when I zoom out. 

Here I noticed the eye was off so I selected and nudged it. I also mirror the image occasionally to 
look for errors.

Refi ne with blend modes I use 
Overlay mode to bring out light areas and 

Multiply to darken values. Once I am happy I will 
switch to the Paintbrush and the Mixer Brush tool, 
similar to the Mixer Brush in Photoshop. I often repeat 
these steps going from transparent colour to opaque 
and then back.

03

05

06

Lighting effects First I fi ll 
a blank layer with a colour that 

refl ects the ambient light of the piece. I 
choose blue then multiply the layer and 
create a mask. I paint with black into the 
mask and the lighter values of the lower 
layer come through to create hits of light. 

04

Get equipped for 
painting on your iPad

Wearing fi ngerless gloves when working on your iPad is a 
great tip. It means that when you lean the heel of your hand on 
the screen (which will inevitably happen from time to time) you 
won’t accidentally make any marks on your canvas.
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Rock photo texture I mask out a photo of a rock on a new layer then make the 
photo layer’s Opacity about 30% so it blends with the painting marks. The hyper control 

of digital is also its weakness. I like to add photo textures or scanned brushstrokes to bring in 
organic marks. Masks make this process very fast and intuitive.

Tighten smaller details At this point I’m feeling 
confi dent about the overall colour and values so I start 

really zooming in and rendering smaller details like the dragon 
scales. This part can take a lot of patience.

Sky, wings and rock The custom 
brush is adding some life to the rock so I zoom 

into the faces and add detail. I also use a custom 
brush and a very soft airbrush on the sky. I add a 
photo texture overlay on the wings and here I realise 
the rock still needs more texture to match them.

09

1110

Opaque 
painting At 
this point, Overlay 
and Multiply 
layers are too 
transparent, 
so I start laying 
down some 
opaque paint. I 
use the Airbrush 
for subtle 
gradations and 
the Paintbrush 
for more solid 
marks. Make 
sure the biggest 
range of 
contrast is in the 
foreground.

Custom brushes If I 
continue completely with the 

Airbrush and Paintbrush I will get very 
boring marks. Luckily ArtStudio has 
custom brushes. I use a photo texture 
for a brush and add an organic feeling 
to the rock.

07

08
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Add contrast and saturation The colour looks a little disjointed and dull. A 
good colour scheme leads the eye through the painting but I’ve got a big blob of red that 

is the girl and my eye stops there. I add more red to the dragon in an overlay layer to give a sense 
of unity. 

Final fi xes and pattern 
The hair and rock are too bright so I use a Saturation layer to grey them down. I overlay 

some blue on the sword to create a refl ection and mask out a pattern of stars I imported to add 
interest to the fabric. I paint on the girl’s face until I’m happy with my main focal area.

Emphasise bright lighting Thinking about the 
direction my light is coming from, I zoom in and start 

tightening the edges of the dragon. In sunlight detail gets washed 
out where the light hits, especially if you focus on the shadows. I 
want more of that effect, so I paint with white into an overlay layer.

12

14

13

Scratch details I’m resolving the fi nal details and 
getting some feedback. One idea is to add scratch marks. 

The claw is an important area because it is alone on a large shape. 
I also needed to paint over a piece of skin that was on the left wing 
but not the right. These are little things but in a detailed fantasy 
painting they are important.

15
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Hierarchy of detail A detailed fantasy piece can require a 
massive amount of work. If you have a clear idea of your focal 
points and where you want to lead the eye, you can begin with 
your focus and work from there. Spend the most time on these 
areas and the other pieces will fall into place.

1

Tap into your soul When you are working on a character, 
think about which of the elements that you are rendering are 
unique to you. It does not matter if it is part of the dragon, a 
person or a tree. A fantasy world comes to life when it is a 
mirror for the artist and what they want to express.

2

Realism Work from your imagination but look outward. 
Fantasy art is a fun balance between the unreal and real. You 
can tap into more convincing work when you increase your 
understanding of light, perspective and anatomy. Every day 
brings a new opportunity to observe and gain insight.

3

Little details I like to improvise as I go, letting the 
individual piece take me where it will. If there are little details 
that I feel like adding as I am painting I go with it and see 
how they work. It is these finer touches that can add layers of 
meaning and interest to the painting. 

4 iPad limitations The most difficult limitation for me on the 
iPad is the resolution; staying within 2,048 x 2,048px requires 
planning. I measure what is possible by how big I have to paint 
for a head to be in focus. If the head is too small it becomes 
pixelated and can be difficult to work with. 

5

Mobile art Key tips and techniques

A detailed fantasy piece can require a 

points and where you want to lead the eye, you can begin with 
your focus and work from there. Spend the most time on these 

When you are working on a character, 

Key tips and techniques

1

2

3
4

5
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Digital artists explain the 
techniques behind their 
amazing artwork

A
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Abigail Daker

Personal portfolio site
www.abigaildaker.com
Country Cyprus
Software used Photoshop, 
InDesign
I use art as a way of 
depicting the aspects of the 
world I fi nd most fascinating. 
My work refl ects my interest 
in the landscape and the 
way in which human 
geography interacts with 
physical geography.

Source files
available

Line Art
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Antique 
effects  

A good way to start drawing a fantasy 
map is to use a real map as a reference 
point. Maps of imagined places work 

best when the environment is believable-looking, 
so the more realistic the layout of the different 
topographical elements, the more engaging the 
fi nal image will be.

I looked at Google Earth to try and fi nd a good bit 
of landscape to use as a guide. I eventually decided 
to use a remote location near the White Sea in 
Russia. This area is not somewhere that is instantly 
recognisable to most people and the landscape 
contains all of the elements that I wish to add to my 
drawing; rivers, mountains and several inlets in the 
coastline. In addition, the place names in this region 
will give me plenty of inspiration for the more 
imaginative aspects of the map. 

The fi rst step is to sketch out a rough bit of terrain 
and decide where to place the land and sea. I want 
this map to be detailed but still easy to read, so it’s 
important to have a few calmer, less-detailed areas. 
Large spans of water are a great way to break up a 
design and stop it from becoming too busy. I also 
wanted to add a compass of some sort so I pencilled 
in a couple of ideas for where this could go. 

Once the rough layout is decided it’s time to sketch 
the land edges in more detail and defi ne where the 
land meets the water and the exact shape of the 
coastline. The next step is to decide how the map 
should read. Fantasy topography should absorb the 
viewer, tell its own story and really bring them into the 
fantasy world, so I added two small fi gures in the 
foreground of this map, looking across the land, and 
decided on two or three possible routes they could 
take to different parts. As I had used a section of 
landscape in northern Europe as my guide, I decided 
to base these two fi gures around Norse dwarves. By 
basing the fi gures on a mythology associated with 
this part of the world, the overall effect of the map 
should be more convincing. 

The Lands Beyond Mount 
Arghuangelsk 2012 Photoshop

Abigail Daker Illustrator

This tutorial will show you how to 
design a map of a fantasy land with 
aged, antique effects
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Now it is time to add more details to the landscape. 
This part of the map design is probably the most fun 
as with a fantasy map, you have a lot of freedom to 
use your imagination and add mysterious and 
intriguing topographical features. 

I started by drawing in the terrain in more detail. At 
this point you can refer back to the landscape you 
were using as a guide. I added hills and mountains 
fi rst, drawing fairly simple shapes to indicate these.  
Fantasy maps suit a hand-drawn style, so while it’s 
not essential to draw every single mountain, tree or 
building individually, I would suggest you create 
several different versions of any symbols you plan to 
repeat and stagger these around the map rather than 
repeating the same symbol each time. Towards the 
edges, I used perspective on the foreground 
elements to make the image more pictorial than 
referential. Fantasy maps work best when they 
contain strong illustrative elements.

After I’d drawn in the hills and mountains, I started 
to sketch areas of woodland and farmland and to 
build towns. As I was working on the sketch I 
pencilled in place names and descriptions of what 
creatures I imagined would inhabit the various places. 
I lifted obscure and interesting place names from the 
area of the White Sea I was using as my guide. 

Once the pencil sketch is completed, it should be 
scanned. If you are planning to draw it using 
Photoshop, paste the scan into your document page 
and start a new layer to draw onto. If you are planning 
to use pen and ink and draw by hand, then it will be 
useful to have the scanned copy of your initial 
drawing to refer to later. 

Change the hue Flatten your illustration 
and go to Image>Adjustments>Hue/Saturation. 

Uncheck Colorize, set Hue to -32 and Saturation to -58.

01

Use effective 
adjustments

Tweak your colours with the 
Hue/Saturation command

Adjust the layer mode Set the adjusted 
layer to Multiply. Duplicate this layer and change it 

to Normal mode, then Image>Adjustments>Desaturate.

02

Reveal colour Set the Opacity of the 
desaturated layer to 35%. Select the Eraser and 

choose the Spatter brush. Now erase sections of this layer.

03

Erase more Duplicate the desaturated layer 
and repeat step 3 so that the overall image starts to 

look faded, then adjust the Opacity to about 50%. 

04

First sketch Start with a detailed pencil sketch of the map that defines the main features of the 
landscape and includes notes of potential place names and village locations. 

Landscape details Build up your sketch to 
include simple shapes for the different features of 

the landscape and show perspective in the foreground.

Grid 
guide

If you fi nd a blank page 
intimidating, start by 
drawing a grid on your 
page. I always divide each 
side into thirds and make a 
grid of nine rectangles on 
my page. This acts as a 
guide to balance the 
composition of the piece. 

Colour When colouring your 
map you should use a limited 

colour palette and soft, watercolour 
techniques with the stronger colours 
around the important features of the map.
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Use a narrow pen size to draw out your map. 
Because it needs plenty of detail it will look best when 
drawn using a fi ne nib or pen. I use a Rotring .25 
Rapidograph pen for hand-drawn maps and a 3px or 
4px line for drawing in Photoshop. I would also 
recommend working on a page size proportionally 
larger than your fi nal image needs to be as this 
makes adding tiny details much easier.

When the line drawing is complete, it is time to 
colour it. As our page needs to look aged and 
antique, I kept to a limited colour palette; blue for the 
sea and distant mountains and yellow ochre and olive 
green for the land. Watercolours are a good way to 
colour a map that needs to look old and worn.  

To paint in Photoshop, scan the line drawing and 
place it on your document page. Set the layer style to 
Multiply and start a new layer. Drag this layer below 
your pen and ink version and paint in the image 
below the line drawing. Start with light, translucent 
washes and build up the colour around the more 
important details in the image. Once the map is 
painted, try out a few layer effects to alter the 
colours a little (the effects I used are outlined in 
the step by step on the facing page). 

This is a good stage to start adding in the place 
names. Caslon Antique Italic is a great font to use for 
fantasy-style maps and there are plenty of terrifi c 
antique fonts available for download online. Once the 
map is labelled, start a new layer and add a 
compass. If you prefer, you could design a title shield 
or add latitude lines if you feel they would work better. 
I’d always recommend creating your own set of stock 
compass and border designs for use within illustrated 
projects like this one as it can help to fi nish off a 
piece. A simple compass can be made quite easily in 
Photoshop with the Ellipse and Line tools. Make the 
compass quite large so you have plenty of space to 
arrange and resize it on your page once it’s fi nished.

Paste the compass into your document and 
arrange it to fi t in with your map design. Set the layer 
mode to Soft Light and try duplicating the compass 
layer and then fading each one a little so that you 
have a subtle effect which doesn’t interrupt your main 
image too much. Check that the place names don’t 

xxxxxx AIgnisse el utat. 
Voloboreet alit incilit verat, quisim 

zzriureet alit, verosto commodo lutpat 
ipit luptat, si blam, quat. Duip essendre 
corperat ad dit lutat facilist facilisl

A beautiful way to finish off an 
antique-style map is by adding 
torn edges. There are plenty of free 
paper textures available online or 
you could scan some torn paper. 
Open the paper texture file, Select 
All>Copy and paste it onto your 
document. Set the blend mode 
to Multiply and line up the edges 
so they fit with the edges of your 
document. Choose the Eraser tool 
with a Heavy Scatter Flow tip and 
set the Opacity to about 60%. Erase 
sections of the paper texture and 
repeat each step until you have a 
faded, torn effect across the image.

Add aged effects to your map
Layer torn paper textures over your drawing to create a vintage look

bisect the compass lines and rearrange any 
elements that cross over too much.

Finally, add some texture to your map. Flatten all 
the layers and start a new one. Select the Paint 
Bucket tool and set the Fill to Pattern. Choose one of 
the Artist Surfaces – Parchment is a good one – and 
fi ll the new layer with this pattern. Set the layer mode 
to Overlay and the Opacity to 50%. Then choose the 
Eraser tool again and, still using a scattered brush, 
erase sections of the texture. Flatten the layers and 
fi nish off by adding some torn paper textures to make 
your map look tattered and aged.

Texture overlay 
Torn paper textures 

were layered over the finished 
image and partially erased to 
create a worn, used effect with 
folds and tears in it.

Duplicate for effect Copy and adjust the coloured map several times in order to fade and 
enhance sections of colour. This helps create a more aged effect.

Work 
on a 

large scale
Work on a document 
proportionally larger than 
your fi nal page size, this 
way you can add details 
far more easily than if you 
worked at actual size. 
Drawings which have been 
scaled down look elegant 
too, as the lines of the 
drawing will become fi ner 
and more delicate.
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Pro matte 
painting

Creating photoreal fantasy environments can be fun, but the 
process involves many a technique that you’ll need to master.

Some digital artists use only photos and then paint over to create 
their mattes, whereas others use solely 3D software. Both methods have 
their pros and cons. With a purely 2D approach, using just photos can be 
tricky; factors to consider when pulling imagery together are perspective, 
lighting and image resolution. On the other hand, simply using 3D renders 
makes it more diffi cult to get photoreal results straight out of the box when 
rendered. This route entails knowing how to tweak rendering values and how 
to set up lifelike materials.

In this tutorial we’ll show you how to combine photos and 3D renders for 
the best results. We’ll also be making use of Photoshop’s key fi lters and 
default brushes, as well as offering some insight into how to enhance a 
dull 3D render to give it more life. A basic knowledge of any 3D software 

will help you to pick up this process quicker, though we 
have three render passes included on the disc for the 3D 

uninitiated to play with.
We encourage you to develop your own concept and apply the 

techniques in this masterclass so you end up with an image you can 
truly call your own. This guide isn’t about magical tricks and one-click 
solutions. Rather, we’re giving you the foundations so you can make 

render passes work for you, use photos effectively and push your 
compositing skills to the next level.

Source files
available

Landscape reference images
3D render passes

Concept
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Jeffrey M. De Guzman aka ‘Jeff MD’ Digital painter and concept artist

In this tutorial we’ll show you how to combine photos 
and 3D renders for the best results
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Digital artists explain the 
techniques behind their 
amazing artwork
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Jeffery M. De 
Guznan
Personal portfolio site
http://theartofjeffmd.com
Country Philippines
Software used Photoshop, 
Maya, 3ds Max
Jeffery works for Lucasart in 
Singapore, and has worked 
on fi lms such as Iron Man 2 
and The Avengers.
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 Render passes A beauty pass, colour ID pass (optional) and depth pass are all we need, as we’ll be 
making the majority of elements within Photoshop. Although having more passes gives us greater control 

over renders, we’ll keep things simple and use photos to enhance what the renders lack. Make sure all your 
renders are the same size with alphas.

 Set up render passes In Photoshop, 
open all three render passes. Drag the depth 

pass over the beauty pass, while holding Cmd/
Ctrl+Shift so they will perfectly line up on top of your 
main image. Repeat with the colour ID pass and 
drag it over to the beauty pass window. Rename this 
window to your project fi le name PSD. Now turn off 
visibility layers of the depth and colour ID passes for 
the moment.

 Block out in 3D Just like painting or 
sketching, fi rst block out the general shapes 

and sizes, and map the layout. This will help to 
re-create your 2D concept faster. The advantage of 
blocking things out in 3D is that you can quickly amend 
your concept to help refi ne the fi nal composition. For 
instance, you can experiment with aspects like image 
views, angles and lighting.

 Make textures We only need low-detail 
textures for now, like those shown in the 

screenshot – just the basics to help us determine 
the shape, the feel and the perspective. Later, we 
will enhance textures with photo stock in our 
Photoshop composite so don’t dwell too long on 
this step. Throw in your textures and create your own 
texture map in Photoshop.

Concept
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Create your scene
Kick off the design work

 Concept It’s always best to kick off any project with a rough concept. This will serve as your guide and 
help you to make artistic decisions faster later on. There’s no need to create an exceptionally well-drawn 

or painted concept – all you need are good suggestions of shapes, lighting and atmosphere. You can also use 
photo references, mixing and matching them until you have a solid base to work from.

01

02

03

05

04

Just like painting or 
sketching, fi rst block 
out the general 
shapes and sizes,and 
map the layout
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 Beauty pass In the Channels tab, locate 
the alpha layer and Cmd/Ctrl-click the layer 

to create an instant selection. Go back to the Layers 
palette, hold Cmd/Ctrl+Shift+I to invert the selection 
and press Cmd/Ctrl+J to duplicate or extract the 
selected area to another layer. Apply a Color Balance 
adjustment layer on top with a clipping mask, subtly 
pushing Highlights toward yellow and Shadows 
toward blue; this will add more colour contrast to the 
fl at renders. Experiment with other adjustment layers 
and tweak colours as you see fi t.

 Depth map Turn the visibility of the depth layer back on. In the extracted beauty pass layer, 
press Cmd/Ctrl+Shift, click the layer, Cmd/Ctrl+Shift+I to invert selection then delete to remove the 

background image. Change the blend mode from Normal to Lighten and drop Opacity to 20%. Add a Levels 
adjustment layer above the depth map. As you play around with the sliders, you will see how the depth and haze 
of each element is affected.

 Colour ID We said this pass was optional, 
but it removes the burden of making the same 

selections. Since the renders assigned each piece in 
different colours as desired, it is easy for us to select a 
part of the image without tediously following the shape. 
All we need to do is use the Magic Wand tool to get the 
area we want.

 Add a sky The 
sky is one of the 

most important parts of this 
image, as it will determine 
the overall colour value, 
brightness and general 
mood. Make sure that 
you choose a sky that 
will work with the image’s 
composition rather than 
overpower it. Also ensure 
that you get the correct 
lighting direction and time 
of day to match your beauty 
pass render. Insert the sky 
below the beauty pass layer.

 Grade the depth pass Now add a 
Color Balance adjustment layer with a clipping 

mask to the depth pass layer. Adjust the Shadows 
values for Blue and Cyan to the colour of the blue sky, 
but more intense. Change the Highlights values for 
Yellow and Red to the same values as the bright points 
of the clouds, but slightly more subtle in intensity. For 
the Midtones, just add hints of yellow.

 Colour grade the sky Duplicate the 
sky layer and drag it on top of the depth pass 

layer. Press Cmd/Ctrl+Shift+G to create a clipping 
mask. Go to Filter>Blur>Gaussian Blur and apply an 
80px value. Change the blending mode to Soft Light, 
Overlay or Color so that the colouring of the sky will 
also infl uence your depth pass.

Building your own image library is a 
must for every matte painter. Whether 
it’s a shot of a simple lamppost, 
foliage, water, or more extreme 
landscapes, they will all come in 
handy for some project sooner or 
later. Try to carry a camera with you at 
all times so that you can easily take a 
snapshot of things for current projects 
as well as future reference. It’s often 
stressed how important it is to see 
things from a camera’s perspective. 
By doing these simple steps, you will 
learn a lot of things through frequent 
practice and be able to translate them 
into your matte paintings.

GENIUS GUIDE
Fantasy Art

Fantasy Art Genius Guide  121

06

08

10 11

09

07

Quick 
Tip

Image 
Library

It’s a good habit to use 
adjustment layers to 
make changes to your 
images. These give you 
more control when 
tweaking the colour 
values, brightness and 
levels without actually 
making changes to the 
original image. With this 
approach, you can 
always go back to any 
adjustment layer and 
fi ne-tune things too.
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 Mountain makeover This is where we 
give the mountain some character. Since ours 

has no real shape, we need to add some cliff edges, 
cracks and strata effects. Don’t add loads of images 
to every part; you just need them here and there to 
add interesting focal points.

 Time to refl ect For the window 
refl ection, using any part of the sky image, 

select a portion with the Marquee tool and duplicate. 
Reduce the layer Opacity to 60-65%. Add a layer 
mask and fi ll with black then paint inside the layer 
mask with a white brush to reveal the image. You may 
also need to fi ne-tune the refl ection by adjusting its 
contrast and saturation to get that refl ected quality 
using Hue/Saturation and Curves layers.

 Rock textures Source some rock 
textures and place over the mountain render 

pass (you can use the beauty and colour ID passes 
to help isolate the selection of the mountain with the 
Magic Wand tool, then use the selection as a mask). 
Scale down the texture, twist, skew or rotate to match 
the perspective of the mountain. Lower its black 
values using Curves or Levels to match the depth/
haze already in place.

 Going 
green Using 

photos, populate your 
environment with trees 
and plants, colour 
correcting them to 
match the overall scene. 
It would be best to have 
the same lighting in the 
original photos as much 
as possible, but if not we 
can simply relight them.

 Relight the scenery Relighting works 
well for an image that is fl atly lit or has no 

direct key light. Duplicate the image, press Cmd/
Ctrl+B to alter the Color Balance and use Curves 
(Cmd/Ctrl+M) to adjust the brightness of the tree 
and rock imagery based on the colour of the sky’s 
key light. Add a layer mask and fi ll it with black. 
Now, with a white standard brush, reveal the lit 
area gradually.

 More textures To quickly give renders a 
photoreal look, you need to comp photos into 

your image. Since the renders weren’t edited much, 
we need to support them with proper texture overlays 
to give a more realistic feel to every material. Cut and 
paste photos of closely matched images and then 
scale to fi t the original rendered image, setting the 
blend mode to Soft Light. Lower Opacity to 20% or 
until you feel blending is seamless.

It’s recommended that you understand the basics 
of photography when creating this kind of artwork. It 
can easily be spotted if a matte painting looks more 
like a photomontage. We must always try to ‘see’ 
the composition from the camera’s point of view, 
not just with our eyes. There are a lot of things that 
photograph differently under different conditions 
and focal settings. Try to experiment, take a lot of 
photos and understand the characteristics of an 
image when shot at various times of day. This may 
be a bit technical, but it is a key factor in making our 
fi nal matte painting look like the real deal.

Concept
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Since the renders 
weren’t edited much, 
we need to support 
them with proper 
texture overlays for
a more realistic feel

Photography 101
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 Enhance details The tiny details count, even though sometimes we might think they are not 
necessary. In fact, these are the parts that send a signal to the viewer’s brain and subtle hints to their 

eyes that they are looking at a real-life image as opposed to a painting. Roof gutters, door jambs, window 
frames, smoke and refl ections are just some of the things you should be paying attention to here. Simply add 
photos of these elements and blend as in previous steps.

 Light blooms Once a shiny object is 
hit by light, a subtle glow is captured in a 

photograph. These bright spots need to be painted 
in and/or enhanced on existing stock. Add a new 
layer on top of all the layers we have set to Screen. 
Get a standard soft-edged brush and set Flow to 
20%. Colour pick the brightest highlight colour in the 
image then lightly begin to work in these blooms.

 Blur edges Once you’re happy with the 
image, save, fl atten it then save as a new copy 

(just in case you want to go back to previous work 
and make adjustments). Next select the Blur tool 
and lower the Flow to 10%. Lightly blur the edges 
of elements – all those sharp edges of cutout trees, 
roofs, cliffs, etc. Overly sharp edges are one of the 
biggest giveaways that images have been comped 
together when it comes to matte-painted artwork.

 Well and truly framed Adding framing 
elements, such as branches or hints of 

architecture, can really help pull the viewer into 
the scene. They can also add to the composition, 
making viewers focus more on the factory in this 
case. Since these are often foreground elements, 
it’s best to use a photo at a higher resolution, with 
accurate lighting and a similar viewing angle. Grab 
your cameras, go out and start stocking up framing 
elements for your image library.

 Colour overlay Get a photo of an 
environment or landscape that closely 

matches your image, ie the lighting, colour and time 
of day. We need to extract the qualities and mood 
present in the photo and bring them in to our creation. 
Next place a new layer at the top of the stack and 
apply a 70px Gaussian Blur. Set to Soft Light then 
lower Opacity to 10-15%. You’ll see a big difference 
when you toggle this blurred image layer on/off.

 Chromatic aberration This is a 
prominent quality you’ll see in most photos. 

Study a photograph and you will see that the edges 
have blue and red light fringing. We can emulate this 
fl aw in Photoshop; just go to Filter>Distort>Lens 
Correction. Set Chromatic Aberration values to Fix 
Red/Cyan Fringe +5 and Fix Blue/Yellow Fringe -5.

 Film grain To add the fi nal touch, we need a subtle hint of fi lm grain. 
Add a new layer, use the Marquee tool and roughly make a region an 

eighth the size of the entire image and fi ll it with white. Go to Filter> Noise>Add 
Noise and set Amount to 18%; also check Uniform and Monochromatic. Press 
Cmd/Ctrl+T to scale up the layer to the entire width of the image. Set the layer to 
Multiply blending mode then reduce Opacity to 10%.

Practise memorising 
keyboard shortcuts, as 
knowing the basic quick 
commands gives you 
fl exibility and speed 
when working. Let one 
hand do the drawing 
and the other work on 
the keyboard.
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Draw a fantasy
fairy-tale scene

Sketch Keep all the elements 
separate from each other. After 

scanning in your line drawing, adjust the 
levels to get a stronger contrast.

Palette Decide on a colour 
palette before starting your 

illustration, even if you decide to change it 
later. Look at images in books and online.

Colour Colour by selecting with 
the Polygonal Lasso tool and filling 

it on a new layer. This is then multiplied.

This tutorial will guide you through the 
process of creating a magical, evocative 
and beautiful fairy-tale illustration, loosely 

inspired by the soft and harmonious colour 
shades and natural lines popularised through 
Art Nouveau design.

Art Nouveau as a decorative style was inspired by 
natural forms and structures and botanical infl uences 
are present as well as curved lines and femininity. 

The focus of this image will be a princess-like girl 
with a young fawn beside her; the two friends looking 
out at us the viewer within a delicate border.

To get inspired I can only suggest you take some 
time to really look at images and posters of this art 
style. Take in the shapes and colourways, and start 
thinking about building your palette before you start.

There are some really good resources on the 
internet, for example the website www.colourlovers.
com that has palettes and patterns available ready 
for use. If you want to do it yourself, start saving some 
images and pick out the colours to build your own 
array of swatches that you can then save in 
Photoshop for this project. Don’t worry too much 
about this being fi nal, it will probably change again as 
you continue working, but at least you have a guide 
to start off with. Since this image is inspired by Art 
Nouveau, the colours I picked were in harmony with 
each other as the point really isn’t to create a stark 
contrast, but to stay quite muted and natural. For this 

Epiphany & Petrichor 2012 Photoshop

Sandra Dieckmann Freelance illustrator

In this tutorial I will show you how to create a beautiful and 
evocative fairy-tale illustration in Photoshop

tutorial I will be applying soft greens, greys and golds, 
with some touches of pink and brown as well as 
darker teal colours in selected areas. 

Search for image references before you start 
sketching your characters and make sure you have 
the right to use them. It is not always okay to just pull 
something off a Google Images search. Be clever 
about it and collage different photographs together to 
create the image you have in mind. If you want to use 
a complete photograph as a reference, you can fi nd 
heaps of free stock-image sites online. 

Start by drawing the outlines of your main 
characters. Keep these separate to anything else you 
want to put into the background as it will make it 
much easier for you when colouring your image later.

In fact, separate everything, as working with a 
digital collage keeps your composition as well as 
your colour choices fl exible. The fi rst thing I tackle 
when illustrating is the faces. When the person or 
animal has eyes they can seem to come alive and 
look at you, which creates a connection and drives 

Blending 
layers

A wonderful way to work with 
tones and textures are the 
extremely underrated and simple 
technique of blending layers. I 
mostly use Multiply and Screen to 
reach the desired effect. Often 
the edges of the layers overlap in 
their opacity, creating great 
shadows and more depth.

Source files
available

Line art, palette
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Draw a fantasy
fairy-tale scene

Digital artists explain the 
techniques behind their 
amazing artwork
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Sandra Dieckmann

Personal portfolio site
sandradieckmann.com
Country Germany
Software used Photoshop
I’m a freelance illustrator 
living and working in East 
London. My work mainly 
revolves around nature and 
wildlife, and is inspired by all 
that touches me personally.
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you to complete them to the best of your ability. Make 
friends with your illustration for the best results!

After scanning in the image it’s really important to 
keep the original drawing safe. Duplicate the layer 
and maybe even duplicate it again before you start 
adjusting levels, brightness and contrast. Adjusting 
these will enable you to use the Magic Wand to cut 
out any excess white around the drawing. If it is in 
pencil and the lines aren’t strong enough, you can go 
to Image>Adjustments>Threshold and turn this up to 
about 200. Now select the white space around it and 
move back to the layer below (where your original line 
drawing sits) and cut out the excess white on there. 

Before I coloured my princess for this tutorial I 
made sure she looked strong and beautiful at the 
sketching stage and added soft pink tones to her 
cheeks, nose and mouth with a dry brush. You can 
Multiply that layer and adjust it as desired.

Begin to colour your image by adding another layer 
and selecting all the areas of skin. Fill these on a new 
layer again and proceed as before by Multiplying and 
adjusting as you see fi t. The entire piece is coloured 
this way and you will end up with a lot of layers, so it 
really pays off to name them all to avoid searching for 
the right one. When I got to the stage of colouring her 
hair, I thought about a gust of wind making the hair fl y 
up. This image was supposed to stay light and 
feminine, so after colouring the hair I erased the tips 
by selecting a soft brush for the Eraser tool and 
adding a lighter and brighter brown with the Gradient 
tool. This makes the colour fade out towards the ends 

in a nice gradual way, and the same principal was 
later applied to the young deer’s fur. While working 
away you can make the process a little easier by 
adding a dark background layer that really shows off 
the edges of the items you are colouring. 

Both the deer and the girl’s dress were initially 
coloured in one hue and, step by step, little details 
were cut out or selected with the Polygonal Lasso 
tool and the brightness, contrast and hue shifted. 
You can get to these options via Image>Adjustments 
and then select what you want to change. 

To add depth and interest to the deer’s fur, I added 
a texture of crumpled brown paper, set the layer to 
Multiply and merged it with the other brown layers I 
applied to the drawing. You can create textures easily 
yourself by collecting papers, magazines or any other 
visual reference you come across, and building up an 
archive that will come in handy for future projects. 

Once that was done I concentrated on the light 
parts and spots on the fur by entering Quick Mask 
mode and inverting the selection. There I used a soft 
dry brush to mask the areas I wanted to highlight and 
returned to Standard Mode where I used a 
Brightness/Contrast layer and altered the sliders to 
achieve the desired hues.

Coming back to the girl, it is really important in the 
line drawing right at the beginning of this tutorial to 
add details like the little cap she is wearing with the 
headband and to draw as much detailed pattern on 
the dress as possible. These patterns and details will 
create a wonderful contrast to the much less busy 

Quick Mask mode To create 
highlights and shadows, enter the 

Quick Mask mode and select areas with 
a soft brush or the Polygonal Lasso tool. 
Once you exit that mode you can shift the 
hue and contrast.

The pattern on this dress is based on the natural flowing lines found in 
much of Art Nouveau design. First of all, I decided on the shape of the 
garment making sure it was curvy, feminine and had enough layers to 
really show it off after the pattern was applied. The idea for the pattern 
stems from extensive image research looking at posters and women’s 
clothing from this period. After drawing in the lines, the illustration 
was coloured step by step on different layers, multiplying these after 
selecting and filling in the areas with the Polygonal Lasso tool.

Apply a pattern Make your princess’s dress stand out from the rest
After

Before

Multiply for depth To give your illustration more depth and interest, copy your original 
line drawing and invert selected sections to colour by Multiplying a layer on top.

Add texture Fill your 
background, adding textures and 

colours that you can either set to the 
Multiply blend mode, or use Screen to 
create extra interest.

Concept
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Cheeky When colouring your line drawing, 
colour the cheeks, nose and mouth fi rst of all. Use 

a dry media brush on a new layer set to Multiply.

01

backdrop, which was drawn and scanned in separate 
parts after completing the main characters.

Considering we want this image to be harmonic 
and in keeping with an Art Nouveau style, we don’t 
want to create contrast by using colour, but can 
achieve that through the use of textures and pattern.

One fun step in making your drawing appear less 
fl at and more dynamic is to pick out certain areas as I 
have in the dress, for example, on a copy of the 
original line drawing and to follow Image>
Adjustments>Invert to turn the line drawing inside 
out. Screening and Multiplying colour on top of this 
can bring surprising effects that you might want to 
keep. Experiment and see what happens.

Once you are happy with your main characters, 
merge their layers together and move them into a 
new fi le on a fresh canvas to assemble, compose 
and colour your background elements.

For this image I have chosen to go with a soft and 
natural framed outline and fl owing, contour-esque 
lines throughout the stylised ground they are standing 
on, which was inspired by my research. As I coloured 
both deer and girl, I played with applying, Multiplying 
and Screening different textures, keeping in mind the 
muted palette I was working with and picking my 
colours out of the swatches saved.

I imported a few small details like the birds fl ying 
away into the sky, the trees in the foreground and the 
woodland in the background, as well as little dots in 
the sky to add even more depth to the image. 

Above the layer with the line drawing of the trees, I 
added an overlay of peach-textured paper and set 
the blend mode to Screen. Some of these trees are 
as they were sketched, and others are inverted to 
create the opposite effect with the only colour being 
on the line details against the textured fi ll.

Have another look at your piece as a whole, 
zooming out to 100%. Clean up any dirty bits, adjust 
hues and contrast, and then don’t forget to save your 
PSD. Flatten the image when you have no more 
changes to make and your perfect magical princess 
and deer illustration has come to life. 

Focus on 
the face

Essential steps in bringing your 
character illustration to life

Face Add a skin tone by selecting the face and 
fi lling on a new layer. Multiply it and adjust the hue 

and saturation. Select the eyes and cut them away.

02

Hair Colour the eyes and then the hair in the 
same fashion. Depending on your line drawing, 

this can be a bit tricky as there are lots of fi ne elements.

03

Highlights Use the Eraser to get rid of the hair 
tips that you coloured. Copy the old layer, select it 

and fi ll with a lighter shade using a radial gradient.

04

Detail Once you are happy with 
the composition and colour of your 

illustration, you can now start playing with 
little details to make your piece special.

Harmony Think about colour 
harmony and how, by introducing 

a subtle complementary hue in other 
objects, you can add depth to your image 
and really make it pop.

Flexibility
Keep all the elements of 
your illustration separate 

and you will save yourself a lot of 
time making mistakes and having 
to redo anything afterwards. 
Every single tree, plant, animal 
and person in my illustrations is 
separately scanned, coloured 
and saved, and then later digitally 
collaged together. This gives you 
fl exibility with your composition.
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Use PaintTool SAI
Afternoon Escapades  2012 PaintTool SAI

Anneliese Mak Illustrator

Breathing life into a two-dimensional image takes time 
and skill but what if that life is more than even we imagine…?

PaintTool SAI (or SAI) is a simple yet 
incredibly diverse and powerful 
drawing program with both painting 

and vector capabilities, created by 
Japanese developers SYSTEMAX. While this 
guide will focus only on the most basic, key 
features of the painting component, there are 
countless more treasures in this program that 
are not covered here and well worth further 
exploration if you have the time. SAI is flexible as 

– though it has a native file type – it is capable of 
working with and saving into all the common 
formats used in digital illustration, and that even 
includes PSDs. 

For those accustomed to working in 
Photoshop, the learning curve won’t be too 
steep, but upon opening the program it is 
immediately clear that it’s engineered more for 
the creation of illustrations compared to Adobe’s 
product which, of course, is also commonly 

used for photo-editing purposes. Preset drawing 
tools customised to emulate real media such as 
acrylics, crayons and markers as well as various 
canvas textures and vector lines can be 
effortlessly manipulated in terms of weight, 
colour and position. Also among some of SAI’s 
most useful tools in its impressive arsenal are its 
canvas functionalities that enable the user to 
effortlessly rotate and flip the current view with 
no waiting time, regardless of file size. Toggle 
transparency is yet another handy tool, the 
button for which can be found beneath the 
colour swatch. This turns your current tool into 
an eraser with identical settings. It is impossible 
to cover all the nifty features of this program in 
this short tutorial, but as stated before it is well 
worth discovering its capabilities and I certainly 
still have much to learn about it. For more 
information and answers to frequently asked 
questions from the developers, as well as a 
download of a 31-day trial and full-version 
purchase visit www.systemax.jp/en/sai.

Digital artists explain the 
techniques behind their 
amazing artwork
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Anneliese Mak

Personal portfolio site
twelvecandles.co.nr
Country Australia
Software used Photoshop, 
PaintTool SAI
While I have never studied 
art formally, nothing has 
ever taken me away from it 
for long. My love of 
illustration and animation 
has concocted my 
grandest, most far-flung 
dream of working in a studio 
team – perhaps even, with a 
large sum of luck, on 
Australian soil.

Flat colours can be placed using 
fills and even vectors to give 

you a strong base.
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Source files
available

Sketch
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Master this program 
for perfect digital art

Working
Progress

Step 01, Sketching

Step 05, Establish the mood

Step 09, Lighting

Step 13, Add effects

Hues, shades and tones 
can be controlled in RGB 

and HSV values. 

Illustration tools emulate a 
range of real media.
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3

4

5

1

6

Tweak highlights and hues with 
the intuitive colour wheel when 

working with lighting.

Painting tools offer a range of 
real-media looks, great for fur.

2
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The SAI 
interface
An introduction to 
the key functions

If you’re used to Photoshop, 
fi nding your way around 
PaintTool SAI shouldn’t present 
any problems. The majority of 
tools are stacked on the left, with 
further controls available at the top. 
A sidebar contains your Layers 
palette, Preview and Navigation 
areas. Next to your image, you’ll fi nd 
your main illustration tools. Colour is 
selected via a hue ring. Below that 
you’ll fi nd a Mixer palette, then 
brushes. For more info, visit 
tinyurl.com/DA-sai-wiki. 

1. Layer menu Basic layer controls, 
blend modes, opacity, transparency 
lock, layer clipping and texture options 
can all be selected here. Ctrl/right-
clicking selects the layer’s contents. 
Layer masks can also be used and the 
Eraser and Pen can paint on the mask.

2. Canvas tools Flipping the 
canvas (H) gives a fresh view of your 
work, and rotating the canvas can 
assist when drawing certain angles 
or drawing upside-down objects. The 
Stop (square) button returns the view 
to the default.

3. Colour tools The familiar colour 
wheel – the buttons above house 
different ways of picking (RGB and 
HSV), a colour mixer, a swatch panel 
and a scratchpad. This can be used 
mixing colours, and can be useful if 
you’re used to traditional media.

4. Drawing tools As with most 
drawing programs, extra tools can be 
downloaded. There is a huge amount 
of settings, my favourite of which is 
the Texture menu. Hotkeys can be 
configured by double-clicking the tool 
icon, or via Help>Config>Key Config.

5. Selection tools Rectangular 
Marquee (with layer transformation 
tools, also accessible via Ctrl/Cmd+T), 
Lasso and Magic Wand. Irregular 
selections can also be made, and that 
Shift does not need to be held while 
selecting areas with the Magic Wand.

6. Preview and navigation 
The Preview window is helpful for 
navigation or just for a very rough 
overview. Canvas zoom and rotation 
can be controlled and memory and 
keyboard usage are viewable in the 
bottom-right corner of the interface.

Sketching I start off with a rough 
sketch using the Pen tool and use a few 

layers to rearrange elements. Before working on 
the line art, I will flatten these into a single layer 
for the sake of organisation. I may scribble notes 
to myself and mark out areas to focus on later. 
Unlike Photoshop, the Background layer in SAI 
is transparent.

Begin the line art On a new layer, I use the Brush tool 
on Fine Flat and begin the line art after slightly lowering the 

opacity of the sketch. I alternate between the Brush and Pen for 
this stage. Try varying brush size according to distance from the 
camera, with thicker lines for objects that are closer.

01

02

Establish the mood Regardless of what program 
I’m working in, I like to rough in the background to indicate 

lighting and mood before I lay the colours. Some prefer to block in 
the fl at tones or even render the subjects completely fi rst, then use 
fi lters to marry it with the background, but I rather enjoy the process 
of colour picking.

05

Continue to ink More inking! I opt to hand-draw 
straight lines for a more organic feel. I create two copies of 

the vector layer and, flipping the canvas 90˚ for ease of use, start 
laying out the shapes with the Line tool as a guide.

03

Finish the lines This is the fi nal 
stage of my inking process for now. I go 

back over the lines, taking into account light 
source, depth and any textures that I will need to 
evoke. I thicken lines around objects and areas 
that will be in shadow, those that are closer to the 
viewer and the key focal points of the image. 

04

PaintTool process
Begin your SAI masterpiece with line and ink sketches
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Extra details On a few layers between the initial highlights and the fl at colours, I go 
back over with the Airbrush and Water, and add extra lighting and details as I see fi t. I 

also add another layer at the top for some rim lighting effects.

Lighting As the main light source here is behind the 
subject, I’ve chosen fl at colours that correspond to the 

shadowed areas, over which I can place highlights. On a new layer, 
I paint the subject highlights in lighter, more-saturated colours with 
the Pen. For large areas, I draw the outline and fi ll with the Paint 
Bucket tool set to Color Difference.

Background shadows This isn’t an absolute 
necessity in the process (I tend to work depending on how 

I feel and what will keep the piece cohesive), but I went with the 
Airbrush and Water tools to rough in some background shadows 
at this point.

08

10

09
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Lay fl at 
colours 

Now for the fl ats. 
It’s a simple joy 
for me to fi nd 
what emphasises 
certain areas while 
cohering with 
the background. 
I use the Magic 
Wand and 
Selection>Expand, 
trying to use as few 
layers as possible 
for the sake of 
saving space 
and memory. 

Shading With a large Airbrush, I lightly brush over each layer of the fl ats to establish a 
very rough, basic sense of lighting. This is where it comes in handy to have layers so that 

objects are not adjacent. This way I can use the Lasso to easily section off each element and 
leave others untouched, even when working with a cumbersome tool.

06

07
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Colour the lines I’m mostly satisfi ed with the contrast 
the black lines provide for the girl and the cat, but for 

background objects such as the window frame and the items on 
the bookshelf I pick a dark colour in the same hue as the object 
and paint over the lines with Opacity Lock on. I also do this for the 
creatures, to make them stand out a bit more.

Touch up At the very end, I may take the fi le back into Photoshop and make some minor adjustments. Here I’ve 
used adjustment layers, a layer on Soft Light and a very low opacity to add extra warmth around the window and a 

Multiply layer to add a slight vignette. Finally I save it out and the piece is ready for printing or display.

15

14

Refi ne the background For the background elements, I paint shadow and 
highlight details directly onto their respective layers, still with the Airbrush and Water 

tools. Try to keep focused on the larger picture rather than get carried away with the minute 
details of every single element, as they may end up distracting from the focal points.

Add effects What better way to make things look magical than glows and sparkles? 
Not entirely original, but it does work. On a new layer below the creatures’ line art I paint in 

some simple effects with the Water tool.

Wallpaper The wallpaper was mostly trial and error since 
it turns out interior design isn’t exactly my strong point! I used 

my previous vector layers to draw some straight lines and then the 
Marquee tool to fi ll areas before duplicating a small fl ower pattern.

11

13

12

Common 
mistakes

To make sure you don’t forget 
about focus and tonal contrast, try 
desaturating your image 
completely. Flip the canvas and 
take regular breaks so that you 
see the image with fresh eyes and 
avoid going off on a tangent. And 
use references! I had images of 
cats, cherry blossoms and metal 
pencil tins, and without them 
those elements would likely have 
turned out terribly.
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The golden rules 
of comic art 

Since childhood I have loved comics, 
especially the ones that featured swords and 
sorcery fantasy. Discovering the work of greats 

such as Frank Brunner, Richard Corbin, John and Marie 
Severin, Boris Vallejo and Frank Frazetta inspired me to 
choose art as my own career. No matter what style or 
medium an artist works in, a basic understanding of 
sequential art and text use can only broaden their outlook 
and is therefore worthy of study. Two excellent, authoritative 
sources on this subject are Comics and Sequential Art by 
Will Eisner and Classic Comics Illustrators: The Comics 
Journal Library.

 To prepare for a project like this, look at many Silver Age 
comics, particularly from the late Sixties and Seventies. 
Note that during this period text had moved far beyond the 
often-repetitive style of the Golden Age. Artists were 
gaining more creative freedom and the large-format 

Warren publications were taking the medium into new 
realms. It became standard practice that the shape and 
size of speech balloons themselves be as varied as the 
words contained within, often visually reflecting the 
emotions being expressed by the text.

Note also that the most interesting comic pages vary the 
size of the panels according to the needs of the script. Text 
size and styles change to illustrate the tone of voice or 
subtlety of thought. Keep in mind as you plan your palette 
that comics created in the pre-computer age did not have 
the advantages of today’s digital toolbox. Colours were 
often subdued and quite flat, without the gradient 
shading seen so frequently in modern graphic novels.

I created traditional pencil drawings on paper and 
scanned them into Photoshop to start this piece. I then 
manipulated their size and began working them into a 
panel layout I had prepared in Corel Painter.

Haunted Forest 2012 Painter, Photoshop

Kathy Ferrell Illustrator

This tutorial demonstrates various uses of text boxes, balloons 
and SFX to add authenticity to sequential art

Enhance your stories 
with these simple tips

Working
Progress

Step 01, Complete drawings

Step 04, Ink panels

Step 07, Begin colour

Step 10, The final panel

Cement your concept
Finalise the script and character placement 

Complete drawings I used traditional pencil and paper for this step, creating five 
individual drawings. The more complete the detail at this stage, the faster and easier the inking 

will be later. When finished, scan the drawings into Photoshop.

01

Create a page 
layout  Using 

Painter, create a new file 
choosing a smooth, hard 
paper. Create the file at 
50% of the final image. Hot 
Press gives a look nearly 
identical to the illustration 
board used in comics.

02
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Source files
available

Line art
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Digital artists explain the 
techniques behind their 
amazing artwork
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Kathy Ferrell

Personal portfolio site
cuposwank.carbon
made.com
Country US
Software used Painter, 
Photoshop
My most consistent 
influences are Warren 
comics, Art Nouveau, pulp 
paperbacks and gothic 
horror fiction.
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Bring in text and colour
Convey your characters’ emotions

Ink panels Set the sketch layer to 30% Opacity. Create a new layer for each inked panel, 
as well as a separate one for each text box or speech balloon. Using the Fine Point pen from 

the Brushes palette, ink the pencil sketches. Discard pencil layers as you go. 

Begin colour 
Create new layers for 

each panel as you add colour. 
Position these fi lls under the 
ink layers. Select pens from 
the Brushes palette, including 
Smooth Thick Round and 
Fine Point. Work from the 
back to the foreground, 
keeping in mind a cool 
forest at sundown. 

Add text Begin adding text to the various speech balloons, text boxes and thought 
bubbles. The Komika font was selected for this piece and the weight varied, especially in 

the third panel. The type in the thought bubbles becomes smaller to build apprehension.

Complete text Since panel fi ve depicts the climax 
of the action, several parts break the frame. The boldest 

and largest type is used and the character’s speech balloon 
is jagged to indicate a shout. The cat’s roar, while very bold, is 
crossed by the sword to give this panel a sense of depth.

04

05

06

07
Create fi relight 
Panel three is a good 

example of how effective the 
simple use of yellow and black 
can be in a colour scheme. 
Remember, it is now dark in 
the forest and the fi re is the 
only light source so features 
are simple and indistinct.

08

Arrange sketches Copy and paste the pencil 
sketches in, adjusting size as needed and arranging 

each drawing into its corresponding panel.

03
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Add SFX Panel four provides an opportunity to add 
freehand lettering for creepy sound effects. Choose 

red and use the Fine Point pen to hand-write the words on a 
separate layer. Now fi ll in the centres with yellow.

The fi nal panel Panel fi ve is the largest and most dramatic, so use several layers and 
take care with details. A simple background that suggests a large boulder adds tension. 

Our character’s back is to the wall. She must fi ght. Remember, the fi re will add a strong light from 
below. Notice the yellow added to her eyes. Check your work carefully, merge all layers and save.

09

10

Key techniques
The secrets of great comics

Draw daily Keep a sketchbook handy 
and experiment with different pencils 
and inks. Comics demand the particular 
skill of drawing the character in different 
scenarios. The more you practise, the 
more recognisable your style will be.

1

Think in sequence Aim for logical 
order in the arrangement of your layers. 
Think in terms of background, mid-
ground and foreground with ink outlines 
and text boxes positioned on the surface 
nearest the viewer.

2

Colour speaks Colour has a 
language in its own right. Cool shades of 
blue and green tell a reader that things are 
calm. As the action heats up, so should 
your colour choices. Shades of red create 
a visceral sensation for the reader. 

3

Key techniquesKey techniquesKey techniques

1

2

3
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Digital artists explain the 
techniques behind their 
amazing artwork
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Simeon Elson

Personal portfolio site
www.simeonelson.co.uk
Country Turkey
Software used Photoshop, 
Illustrator
Simeon is a freelance 
illustrator and graphic artist. 
He creates his work by 
fusing vectors with pixels, 
working mainly in 
Photoshop and Illustrator. 
He has worked on fl yers, 
posters, logos, websites 
and more.
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To create this particular 
style of editorial design, 
we must make use of 
both Photoshop and 
Illustrator. If you don’t 
currently have the latter 
app, then you can 
download a free 30-day 
trial directly from the 
Adobe website (www.
adobe.com) so that 
you can follow along 
with all of this 
workshop’s steps.

In particular, 
Illustrator’s Pen tool is 
an essential part of this 
tutorial, so take time to 
familiarise yourself with 
it. Draw some random 
abstract shapes to get 
used to the click-and-
drag motion needed to 
create accurate curves, 
and also make some 
shapes with sharp 
edges and corners, as 
this will help you learn 
how to produce more 
rigid elements.

Take time to learn the 
different elements of 
Illustrator’s Pen tool too: 
the Add Anchor Point 
tool, the Delete Anchor 
Point tool and the 
Convert Anchor Point 
tool, etc. The most 
important thing is to 
express yourself from 
the get-go by creating 
interesting shapes that 
are quite edgy and 
abstract to give you a 
striking and graphical 
end product.

Using 
Illustrator

Zombies are big business at the moment. There 
are horde upon horde of them in contemporary 
literature, cinema and videogames – including recent 

comic phenomena such as Marvel Zombies, DC’s Blackest 
Night and TV series The Walking Dead. Coinciding with 
these are the launches of the Red Dead Redemption, Dead 
Rising 2 and Left 4 Dead 2 videogames, among many 
others. So, what better subject to focus on when looking at 
how to grasp editorial styles?

In this tutorial, we set up a mock brief for international 
illustrator Simeon Elson, who shows you how to re-create an 
iconic and cinematic illustrative style, which engages 
viewers – one which is as gruesome as it is cool. We’ll reveal 

how to use Adobe Illustrator to create realistic graphical 
characters and, subsequently, Photoshop to add texture 
and work up the fi nal composition.

During this workshop you will learn how to master 
Illustrator’s Pen tool in a simple but highly effective way, as 
well as how to create dynamic visuals with powerful and 
intuitive Photoshop colour and layer effects.

We have used a wide variety of stock images from two 
texture sites, Fotolia and iStockphoto, so you will need to 
download these beforehand if you want to follow the tutorial 
exactly; however, for the most gratifying results, we 
recommend gathering your own zombie stock as originality 
is imperative to editorial design.

File preparation Open up the fi rst character in 
Illustrator (‘serious man rifl e’ from Fotolia), then change the 

mode to CMYK via File>Document Color Mode>CMYK. Double-
click on the photo in the Layers palette and name it ‘Reference’. 
Be sure to click the Lock tab, as we don’t want the image to move. 
Create a new layer and call it ‘Black Lines.

Skin tone Use the colour Eyedropper tool to 
select a fl esh colour – sometimes the colour may be 

too dull, so you might need to brighten it by tweaking values. 
Create a new layer and call it ‘Skin Base’, positioning just 
above the Reference layer, then draw out the fl esh areas.
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Zombie Takeover  2011 Photoshop

Simeon Elson Illustrator

You will learn how to master Illustrator’s Pen tool 
in a simple but highly effective way

Prepare yourself
Do the groundwork

01

Source files
available

Stock images

Design a movie poster

02
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Extend the rifl e Continue to add detail to the portrait, 
applying highlights, facial features and mixed skin tones – but 

keep each colour on separate layers. The gun has been cropped, so we 
need to top off the rifl e. Use the barrel as your reference guide to draw a 
small slanted rectangle.

Extend the rifl e 2 Choose the Direct 
Selection tool, pulling the top-right corner 

anchor point up slightly to create a diagonal angle. 
Finally, with the Ellipse tool, draw a thin oval shape, 
then angle it and position it at the top of the rifl e. Then 
add any fi nal detail to make the join seamless.

Blending colours Still with the 
Darker Contours layer active, open 

the Gradient palette, setting Type to Radial. 
Place the Darker Contours swatch at 0% 
and the Medium Contours swatch at 100%. 
Add another gradient slider at around 65%. 
Remove the Medium Contours swatch from 
the gradient and drag the swatch located at 
65% to 100%.

Blending 
continued 

Keep making the 100% 
location colour darker 
until you get an effective 
blend. Apply this 
technique to any other 
shape that you 
feel requires a more 
realistic contrast. You 
may fi nd in some cases 
the darker 0% location 
colour needs to be 
made lighter.

Accurate colour selection Next, let’s draw his eyes. Use the Eyedropper tool 
to pick the lightest part of the iris, then place it right next to the pupil. Adjust the colour 

until your selection matches your character’s natural eye colour. The iris consists of four or fi ve 
different shades so use this colour selection process to re-create them all.

Add detail Open a new layer and name it ‘Medium Contours’ for the midtone 
shadows of the character’s skin. Repeat this process to create the ‘Darker Contours’ 

layer. You should now start to see your character emerging. For a more realistic look we are now 
going to blend some areas of the face using gradients.

Concept
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Outlines Next select the Pen tool to draw the character’s 
deepest shadows. Before drawing each shape, set the Pen 

tool Opacity to 0% – this way you can see the shape you’re drawing 
and the photo below simultaneously. Try to create interesting 
abstract shapes.

03 04

05

07

08
09

06

Quick 
Tip

Experiment when using 
textures. Use different 
colours, Opacity settings 
and blending modes and go 
for it! Also, try mixing various 
blending modes together, 
for example Screen with 
Hard Light can give a great 
contrast in colours, although 
you will need to fi ddle about 
with the values to get the 
best results.
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Create the main zombie When illustrating the main zombie in the background (our reference is the ‘Zombie’ image from Fotolia), features such as the 
eyes (enlarge the pupils) and teeth need to be changed. As seen in this reference photo, features are more vampiric. For this illustration we’re going to use a 

more simplistic style with only a few colours, leaving the rest transparent. Repeat these Illustrator steps with as many characters as you want in your fi nal piece (see the 
links on the disc for the ones that we used).

Switch to Photoshop Now all of our 
characters have been created, it’s time to 

jump over to Photoshop. Create a new CMYK fi le 
and set your workspace to a multiple palette layout 
– meaning you can see your Color palette as well. 
Open a new layer and then use the Paint Bucket tool 
to fi ll it with a deep orange tone.

Texture the canvas We add in ‘old paper texture’ from iStockphoto (link on the disc). Stretch the 
texture so that it fi lls the page, then Edit>Transform> Rotate by 90 degrees clockwise. Set the blending 

mode to Linear Burn and Opacity to 67%. Open the main zombie image and the gunman. Create a new group 
and call it ‘Gunman Files’, placing the man inside it.

Wood texture Now we source a wood 
texture from CGTextures (‘WoodFine001’), 

rotate the image so it’s at a similar angle as the 
gun, then set the blending mode to Lighten and the 
Opacity to 48%. Select the gunman by pressing 
Cmd/Ctrl and clicking the layer’s thumbnail, then 
invert the selection (Cmd/Ctrl+Shift+I).

More texture 
Hit Delete to 

clear the selected area. 
Select the Eraser tool 
set to a 27px Brush (at 
90% Opacity). Erase 
remaining texture around 
the wood. Select the 
man and wood texture 
layers, then click the 
Link Layers icon so they 
move as one. We’re now 
going to use splatters to 
add a bit more edge to 
the gunman.
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Texture continued Duplicate this layer and then fl ip it vertically (Edit>Transform> Flip Vertical). 
Drag the duplicated layer to the bottom half of the page so that it fi ts seamlessly with no visible joining 

point. Follow the same process with another texture (we used Urban Dirty’s ‘glass frosted crack’ image), 
setting the blending mode to Soft Light at 51% Opacity and place this just below the main zombie.

Jeepers creepers Create a new layer placed below the 
main zombie layer. Select a light green colour and, with the 

Brush tool set to 34px, Hardness at 53%, 100% Opacity, colour in the 
zombie’s eyes. Add the ‘Urban Highway’ image (from iStockphoto), 
duplicate twice, setting the bottom duplicate to 100% Opacity and 
applying a Overlay blending mode.
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Add splatters Position 
the splatter so that it looks 

like zombie blood has splashed 
onto him. Then set the colour to red 
by double-clicking the layer and 
applying a Color Overlay. Use an 
inverted selection on the gunman 
to clear the excess splatter, then 
erase any unwanted areas. Repeat 
this process on other areas of 
the gunman. Use the Eraser set 
to 400px, 0% Hardness and 18% 
Opacity to reduce the prominence
of the splatters.

Work up the background Enhance 
the background by adding in a new texture 

(we use the ‘stone pebble’ texture from Urban Dirty). 
Place it just above the main zombie layer and stretch 
it so it fi ts across the top half of the page, setting 
Opacity to 40% and an Overlay blending mode. Add 
a layer mask and select the Gradient tool set to black-
white, and draw a small gradient starting just before 
the halfway vertical mark.

15

17

18

16 Quick 
Tip

Drawing stubble can be very 
tricky. Pick a tone or gradient 
similar to the gunman’s 
eyebrows. Use this colour to 
draw around the beard area, 
set Opacity to 70%, then add 
one or two hairs with a small 
brush to boost realism.
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Energy through colour Add another 
zombie and use an Eraser at 35% Opacity to 

fade out the bottom of the zombie. Duplicate your 
‘glass frosted crack’ texture again, placing it above 
the second zombie and changing the blending 
mode to Multiply. Place in a position where you get 
an interesting contrast, then clear the area around the 
second zombie. Set the Opacity of the texture to 74%.

The end is nigh Apply the same technique using the ‘zombie girl’ image from Fotolia to add more 
variation. Add splatters to increase contrast in the image. Colour the main zombie’s teeth and add a 

Stroke to the gunman to help him stand out. Colour the Stroke light yellow, set its blending mode to Screen, 
then choose an opacity that suits.

Enhance the colours Add a Radial 
gradient to the orange base layer and set the 

outer colour to a deep red and the inner colour to 
transparent. Change the blending mode to Linear 
Burn at 20% Opacity. Next, we add more two-tone 
zombies, and apply the ‘glass frosted crack’ texture 
for more grunge.

More elements Continue to build up 
more detail by duplicating the silhouettes and 

overlapping them. Use blending modes like Screen 
and Lighten, and reduce the opacity if needed. Also 
tweaking the positions of the characters can make 
all the difference. Create another splatter layer with a 
yellow Color Overlay set to Screen.

Finishing touches Lastly, we need a 
bit more dynamism. Use your splatter texture 

to add lighter areas around the zombies. Reduce 
opacity in places; also use a large, low-opacity 
Eraser to fade edges. After any fi nal compositional 
tweaks, we’re done.
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19 20

21

22

23

Our gunman has a mean look as he’s on a 
mission to blast every zombie in his 
hometown to pieces. We can enhance this 
emotion by adding textures and blood 
splatters. Use the ‘glass frosted crack’ 
texture, duplicating and placing it above the 
gunman’s face and shirt. Experiment with 
blending modes such as Multiply, Linear 
Burn and Darken for a grubby look.

Use the Eraser tool set to Brush mode, 
30% Opacity, with a soft edge and sized 
between 300-500px to carefully remove 
unwanted areas. Try not to overdo it to the 
point where the gunman is lost, but at the 
same time we want to inject a sense of 
chaos and commotion.

Also the gunman’s shirt starts as a blue/
green colour, but this is too bright. We 
could simply edit it in Photoshop using 
Hue/Saturation or a Color Balance 
adjustment, but with a vector illustration like 
this you would be hard pressed to do so 
without losing detail and sharpness. We 
can amend this in Illustrator by simply 
reducing every shape of the gunman’s 
shirt’s Cyan value by 5% and then saving it 
as a new fi le. Then position it in place of our 
previous gunman in our fi nal PSD fi le.

Add emotion

138-143_FAGG_01.indd   143 05/07/2012   15:17

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Manga illustration 
on the iPad

The advantage of the iPad is mobility. I like 
to work outside my studio and often carry a 
sketchbook with me, so now I also include the iPad 

in my bag. I can create designs with colour, tonal pieces or 
even rough paintings with it. When I get back to my studio I 
can then transfer those designs to my workstation and 
continue with them. That’s how the iPad has changed my 
workflow. Furthermore, I can work directly on the screen 
and that’s very intuitive. 

There is a downside, however, and for me it’s the 
accuracy of input. This is a particular problem when I try 
inking. I use a stylus, but even that’s not much help. The 
iPad’s screen also lacks the pressure sensitivity that you 
would get with a graphics tablet, and that is crucial for 
some artists. Hopefully these downsides will be improved 
in the next generations, the iPad 3 or maybe later, but 
for me it’s still an invaluable tool. 

So, is it possible to create an artwork entirely on the 
iPad? It doesn’t have the flexibility of a desktop application, 
and it might consume more time during some tasks, but 
yes, we can do it. I will show you in this tutorial how I 
created a manga piece entirely on my tablet.  

I used the SketchBook Pro, procreate and Photogene 
apps with an AluPen stylus on the iPad 2. SketchBook Pro 
is one of the best art apps out there, with high-quality tools 
and brushes built in. I mainly use this app for sketching 
and inking. As for procreate, it provides customisable, 
high-precision brushes and an advanced layer system. 
The user interface is also streamlined and amazingly fast 
so I usually use this app for painting. Finally, Photogene is 
for tweaking colour, brightness and contrast.

Note that you can’t work on a high-res canvas if you are 
working on a first generation iPad, but the process is still 
the same so you can follow the steps as normal.

Backstreet’s Den 2012 SketchBook Pro, procreate, Photogene

Patipat Asavasena Freelance illustrator

This tutorial demonstrates a method for creating a 
beautiful manga illustration entirely on the iPad

Thumbnail designs
Sketch a range of ideas to refine your concept

Go from concept to 
artwork in mobile apps

Working
Progress

Step 02, Concept sketch

Step 05, Create a colour script

Step 09, Paint the hair

Step 13, Minor details

Concept sketch I create a new blank canvas and 
use Pencil brush no.4 to quickly sketch the image. Don’t 

pay too much attention to the details here, just focus on the overall 
composition and draw loosely. I then export the image to procreate. 

02

Brainstorm ideas I usually start with a lot of 
thumbnail sketches to explore the given concept. 

I create a blank canvas in SketchBook Pro and use the 
Pencil tool. I choose one thumbnail as a guideline and 
draw a more detailed version.   

01

Concept
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Digital artists explain the 
techniques behind their 
amazing artwork
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Patipat Asavasena

Personal portfolio site
www.asuka111.net
Country Thailand
Software used Photoshop, 
SketchBook Pro
I moved away from a career 
in engineering because I 
love art and have been 
working as a professional 
artist for five years. My 
works have been strongly 
influenced by Japanese 
manga. Now I’m a freelance 
illustrator living in Thailand. 
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Colour and compose
Block in your tones and work on the details

Clean up the character I run procreate then 
create a new layer on top of the sketch. With a Normal 

brush at 1% Size and 60% Opacity I clean up the character. I 
fl ip the image horizontally to check for fl aws, for example in the 
alignment of the facial features, and fi x any I come across. 

Fix character proportion My character’s 
proportion was slightly off, with her body too short. I 

revised this by duplicating the layer and using the Erase tool to 
remove all areas except the character. I then used the Transform 
tool to make the adjustment. 

Draw the background I create another new layer for the background and loosely 
draw in the setting and the cats. How loose is loose? Just enough for me to know where 

they are and what they do. I will clean them up at a later stage. 

Create a colour 
script iPad painting 

apps don’t have the fl exibility 
of Photoshop, so a colour 
script reduces guesswork. 
I use a large brush and try 
various combinations, then 
pick the version I like most.

Into SketchBook 
Pro Export the image 

to Camera Roll then run the 
SketchBook Pro app and 
create a new high-res canvas 
(turning on high-res canvas in 
the Preference menu). Import 
the image via Layer>Import 
Photo. Finally, tap the Free 
Transform tool to resize the 
image to fi t the entire canvas.

03 04

05

06

08

Block simple colour I use the Paintbrush tool 
at 20% Opacity to block in some simple colour for the 

character, background details and cats. I slowly refi ne the overall 
elements but I don’t focus on any minor details yet. Remember 
to work from large to small-scale detail.  

Paint the hair I 
begin to refi ne the 

small details of the character’s 
hair. First, I use the Airbrush 
to blend the colours as it 
gives a soft feel. I then use 
the Paintbrush to paint the 
hairline. Finally I use the Pencil 
tool at 1.0 for the small details. 

07

09

Concept
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Revise the background When I looked at the 
overall image again I felt there was a problem in the 

composition. The details around the corners of the image look 
almost the same size; it’s dull and static. To fi x this I increase the 
size of the dark yellow sign and decrease the visibility of the top-
left one. I’m now satisfi ed with the overall composition.

Minor details This is the best step; I love to add a lot 
of small details into an image to make it look interesting. It 

can be hard with the iPad because of the restriction of resolution 
and the accuracy of input, but the end result is worth it.

Look for any 
improvement 

I check the overall image once 
again to see if there is anything 
that can be improved. This 
image looks fl at, so I repeat 
the method from step 8. I 
enlarge the bottom-right 
area a little bit to increase 
the depth of the image. 

Adjust the colour and contrast I export the 
picture to Camera Roll and then open it with Photogene. I 

increase Contrast to 0.05 and the Sharpen amount to 0.15 before 
exporting again into Camera Roll and it’s done.

Details I use the Paintbrush tool at 10% Opacity for blending skin tone around the facial 
area and the costume. For the small details like hands, the bag and her eyes, I use the 

Pencil tool to sketch additional details and the Ballpoint Pen tool at Size 1.0 to refi ne the hard edge.

Paint the cats I use a small brush to clean up the 
shape of these cats and the Pencil tool to paint the fur. I 

add different patterns to make them look more interesting.

10

12

11

13

14

15

Lock 
screen 

rotation
Sometimes the iPad 
accidentally rotates its screen 
while you’re painting. This 
can cause a lot of frustration 
and mistakes, which could 
harm your work. To lock the 
screen, double-tap the Home 
button and swipe your fi nger 
to the right on the Multitask 
bar. Tap the screen lock icon. 
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174

166

150   Painting captivating backgrounds
156   Construct a cityscape
162   Paint with sponge brushes
166   Combine fantasy and realism
174   Lighting with layer masks
178   Compose a spacescape

184   Manga street scene
188   Create fantasy worlds
194   Paint sci-fi  settings
198   Paint moonlight into scenes
206   Design destructive cityscapes
212   Paint fantasy scenes

Create huge fantasy worlds
Landscapes
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184

Landscapes
GENIUS GUIDE

Fantasy Art

Fantasy landscapes allow 
you to push light, colour, concept 
and perspective to extremes

206

178156
Compose a 

futuristic world 
in Painter and 

Photoshop
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Digital artists explain the 
techniques behind their 
amazing artwork
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Amber Hill

Personal portfolio site
vantid.deviantart.com
Country USA
Software used Painter X
Amber’s art education 
consists mostly of 
dissecting dead things and 
watching live ones. She 
specialises in fantasy wildlife 
art – fl ights of imagination 
inspired by the living and 
breathing world. Amber lives 
on the road, moving from 
place to place in pursuit of 
newness and wonder.

Landscapes
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Paint 
captivating 
backgrounds 
Zodiac Race 2010 Painter X

Amber Hill Fantasy wildlife illustrator

Learn to balance your subject and background while 
enriching your vision with symbols

When you look down into silence, you see no friend. 
When you lift your gaze to space, you hear no echo. It is like 
striking a single chord. It rings out, but there is no music’ – 

Lui Ji, Literature, a Rhapsody.
A well-painted background pulls the viewer deep into a scene. It 

fi lls the eyes and fi res up the imagination. Unfortunately, painting 
backgrounds daunts many artists. Where to start? How to pull it all 
together? Will it work?

Usually backgrounds end up unpainted, which is a shame 
because they can provide story, mood and support for the subject. 
The key is to plan ahead and break the composition down. 
Simplify the elements so subject and background can be treated 
as a single unit that work together to unify the piece as a solid 
composition with the added bonus of avoiding feeling 
overwhelmed halfway through the painting.

The three critters depicted here are endangered analogues of 
the goat, monkey and rooster in the race to fi nd a place in the 
Chinese zodiac myth. According to legend these three worked 
together to cross a river and won a place in the zodiac forever. 
Their endangered counterparts are: the Himalayan tahr, the golden 
snub-nosed monkey and Elliot’s pheasant, respectively, and they 
symbolise the global cooperative efforts of conservationists. 
Several other visual symbols are scattered throughout the 
illustration to support the recurring themes of friendship and 
cooperation. Chinese culture is rife with symbolism and signs for 
good fortune in art, architecture and even everyday routines. 
Objects, colours, numbers and more all fall into the complicated 
system of traditional Chinese beliefs.

These symbols have no meaning to those who are unaware of 
their auspicious nature. Indeed, all symbols are meaningless 
without the knowledge to identify and interpret them. However, 
many seem to be universal for mankind as a whole, such as the 
obvious symbols of friendship and uniting to overcome diffi cult 
obstacles together. We all also have our own personal symbols 
that can be incorporated into our work for unique touches. It 
requires some forethought, but it certainly adds some fun and a 
personal touch to any scene!

Create your own 
symbolic background

Working
Progress

Step 02, Take the best

Step 06, Create the underpainting

Step 14, Bring out the animals

Step 25, Add the final touches
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Plan it, build it
Start with a plan and a solid foundation

Nail it down Brainstorm and sketch little thumbnails. 
Use different media and tools, whether in a digital 

program or on paper. The variety keeps you fresh. Don’t get too 
involved and spend only a couple of minutes on each drawing. 
Divide the compositions into abstract designs of interlocking 
shapes and simplifi ed values of black and white.

01

Hiding 
symbols

The old study and practice of 
iconography used to involve 
inserting symbols into 
artwork. Famous examples 
include portraits of Queen 
Elizabeth I, who was painted 
with objects that symbolised 
military victories or personal 
qualities the court 
propaganda machine 
wanted to project. In this 
image, symbols from the I, 
Ching that represent the 
values of the subjects are 
hidden. Think about the 
subject you’re painting and 
what you want to say. What 
could you include?

Take the best Take your favourite thumbnail and develop it into a full sketch. Create a 
new document, create a new layer, grab your favourite sketching tool, and draw! Here we 

have our three heroes surveying the rapids before them. The animals are scaled to be visible in the 
image, but still small enough to convey the depth of the gorge around them.

Layer the lights Paint a patch of golden sunlight 
under the animals. This spotlighting effect helps draw the 

eye to the trio, and the blush of colour on the rise in the distance 
adds interest. Paint the sky with pale green-blue, and the distant 
mountain with desaturated purple. The rapids are painted with 
the blue of the sky and the browns pulled from the rocks.

Colour In the spirit 
of planning ahead, 

hash out colour studies on 
separate layers to see what 
works. The idea here is to have 
contrasting values that lead 
the eye through the piece. The 
animals have similar golden 
colour schemes. Gold/yellow 
is considered lucky in China.

Block in the darks Set the sketch layer to Multiply. 
Go to the canvas and Flood Fill (G) with a rich midtone 

brown. Push and pull values from the canvas. Select the Round 
Oil Pastel tool, make it big and smoosh in large swathes of dark 
browns and desaturated greeny browns on the rock walls. The 
negative space that remains shows a clear path for the eye to 
follow directly to our subject.

02

03

04

05

Work on rocks Use the strong lines in the rock 
to support your composition. While we don’t want the 

rocks to look unnatural, we can guide the eye with bold lines 
and angles. Rock faces are some of the best natural abstract 
designs an artist could hope for!

Create the underpainting Hide the sketch layer 
and continue blocking in the elements of the background. 

Look at references to see how the stone is layered. Draw in the 
large rock fi ssures with a purple-black tone. Add vegetation, 
some of which will be turned into mulberry trees later. Mulberry 
trees symbolise the divine tree that supports the sky, so add 
them around the top of the painting.

06

07

Landscapes
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Play with rock and paper From right to left 
shows the beginnings of some rock textures on to more 

developed stonework. Move the Grain slider to change how 
much paper texture shows in each stroke. Open the Papers 
Palette with Ctrl/Cmd+9 and play with the sliders and inverter 
until you’re satisfi ed. Use these techniques to get that rough 
texture on the rocks.

08

Paint green Creeping lines of vegetation add interest 
and life to the barren rock, as well as lines to guide the 

eye. Hardy plants grow in the cracks, symbolising determination. 
Many symbols, such as this, are anthropomorphisms of plants 
and animals just doing what they do.

09

More on rock 
texture Create 

more random textures to work 
with using the Tiny Spattery 
Airbrush in conjunction with 
the low-grain Round Oil Pastel 
tool. Your eye will start to 
notice the textures and you 
can easily follow the random 
patterns to create beautiful 
and believable rocks.

10

Hide the meaning Some of the more subtle symbols in this piece are the hexagrams 
– symbols used for divination. Hexagram Nine, which corresponds with the monkey’s 

number in the zodiac, can be interpreted to mean ‘taming the power of the small’. The rocks 
provide a subtle pattern to hide this divination code.

11
Shadows and light Begin refi ning sunlit ground 
beneath the tahr’s hooves. Alternating scallops of light 

and dark simulate the surface. Look at photos of rocks to get 
an idea of how to paint shadow and highlight shapes. Note the 
shadow on the right cast by the opposite wall of the canyon.

12

Paint details Once 
the forms are roughed 

in, use smaller brushes to 
refi ne the details and anatomy 
of the tahr. Etch light around 
his face to make him pop 
against the dark rock. The 
blue of the sky is refl ected in 
his dark fur.

15

Bounce and punch Continue detailing the rock 
surface. Paint saturated red-gold on the jutting rocks 

near the sunlit stone. This bounced light adds colourful realism 
to the rocks. Add more contrast to the roiling waters with smaller 
brush sizes. Use the square bracket keys to resize brushes on 
the fl y. Keep the perspective of the water in mind while working.

13

Bring out the animals Create a new layer. These 
animals are emerging from darkness into the light, so 

bathe them in bright, rich colours with shadows at the back 
end. Use a large brush and pull their forms with thick, gestural 
strokes. It is important that these guys have character and life. 
Follow the fl ow of the tahr’s long, luxurious fur with every stroke.

14
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Water works Create a new layer. Set the 
Feature of the Spattery Airbrush to 8 or 10. 

Make the brush large and paint a few gentle strokes. 
Erase the excess and any over-spatter. Now we have 
a rich source of natural textures to paint over. Drop 
the layer and emphasise or paint over the foam with 
the Soft Oil Pastel tool.

20

Refi ne the 
mulberries Select the 

Wet Oily Brush under Artist Oils 
and dab in suggestions of foliage 
over the underpainting. Work 
loosely to give the impression of 
leaves. Don’t get too detailed! 
We want most of the focus on our 
subject and the green leaves can 
attract too much attention.

Hide another symbol Do the same with the other bushes 
until they look fi lled out. Paint the sky showing through the top 

bush by pulling colour with the Eyedropper and applying single, fi rm 
dots in the mass of foliage. Select a desaturated red and paint a few 
mulberries. Hexagram Ten, for the pheasant, stands for ‘continuity’ and 
is worked into the scene as grass.

21

22

Build up the creatures Work in the markings 
and forms of the monkey and pheasant. Concentrate 

on nailing down the right expression and body language 
in each of the animals. Monkey is obviously talking to his 
friends while Pheasant leans his head back to listen. Monkey 
is also scary beyond all reason. Use the Detail Airbrush for 
some of the fi ner features.

Lost and found Not 
every edge of the subject 

needs to be clearly defi ned. 
Allow some of the edges to fade 
or blur into the background. This 
way, we can keep the viewer’s 
attention where we want it. 
Monkey is holding a peony, which 
symbolises riches and honour, 
and is an omen of good fortune.

Paint rapidly The frothy texture of the rapids is 
achieved by painting large blobs of yellow-white in 

random, loose squiggles with the Soft Oil Pastel tool. Then, 
use the Nervous Pen with Feature set to 20 and paint a cloud 
of jaggies over the blobs. Next, with a Tiny Spattery Airbrush, 
you can create spray-like foam.

Think of the light 
Keep in mind all light 

sources such as the sun and 
the sky bounce light from fur, 
feathers, horns or stone. Monkey 
has orange light on his face, 
and blue on his fur from his 
own refl ections. Pheasant has 
iridescent feathers that glitter 
under the sheen of his plumage. 
Create fur texture with small dabs 
of light colour over dark.

16

17

18

19

Landscapes
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Dissect an image
Art structure explored

Character interaction Tahr cranes 
forward to see, Pheasant leans closer to 
hear what Monkey has to say as he points. 
Even without obvious human expressions, 
we can connect with the subject and what 
they are doing.

5

Hexagrams Hexagrams are explained 
in the I Ching, or The Book of Changes. 
Each is made of two of the eight trigrams. 
The broken line is yin, and the solid line is 
yang. These forces play a significant role in 
Chinese spiritual culture.

4

Similar colours Tie your piece 
together with similar colours scattered 
around. For example, the animals share 
golds, the monkey has blue like the 
sky, and bounced light shows tones in 
unexpected places.

3

Water distortion Note how the rocks 
below the flow of the water are visible, 
but only as out-of-focus blobs. The dark 
dollops of colour create the illusion of fast-
running water over stone, which is perfect 
for this wild environment.

2

Atmospheric perspective Use a 
palette of cool colours and soft, undefined 
edges to create the illusion of depth in the 
scene. Remember objects in the distance 
do not have much detail. Moisture in the air 
blurs it out.

1

1

2

3

4

5
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And breathe A quick swipe of the brush lowered 
the cliff. Now the eye can enter the painting from above, 

follow the river down, and surprise – there are the animals! Now 
the painting works as a unit again.

24

Add the fi nal touches Spend 
time texturing the rest of the water, rocks, 

sky and distant mountain. The fi nal Hexagram 
Eight is for Goat, or tahr, and means ‘holding 
together’, so it is perhaps the most meaningful 
and relevant symbol for this whole piece.

25
Take a step back Never be afraid 
to change elements during the painting 

process. Even when an image is planned 
ahead, sometimes things don’t work. The sunlit 
cliff is causing a ping-pong effect. There is 
nowhere for the eye to rest and the painting is 
uncomfortable to look at.

23
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Research online and at 
libraries for inspiration 

and reference.

Flip your painting often 
for a fresh view.

Create the illusion of 
distance with soft 

edges and cool colours.
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Digital artists explain the 
techniques behind their 
amazing artwork
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Yap Kun Rong

Personal portfolio site
www.yapkunrong.net
Country Singapore 
(currently in Tokyo)
Software used Photoshop, 
Painter
I have been interested in 
visual arts since I was little 
and have been drawing and 
painting ever since. For work, 
I do concept art, usually 
designing environmental 
backgrounds, challenging 
forms and scales. Personally, 
I enjoy drawing and painting 
anything that delights me 
using both traditional and 
digital mediums.

Landscapes
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Construct 
a cityscape

I wanted to create a place with futuristic architecture and 
form, something that seems possible in the near future

Harbour Front Lights  2010 Photoshop, Painter

Yap Kun Rong Concept artist, illustrator
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Line sketch Sketch the basic lines from perspectives to start building the image. I used the Line tool for 
sketching in this case. Lock this layer so you can refer back to it as you add more detail.

Greyscale tones Block in black and white 
tones to give the initial line sketch form and depth. 

Blocking should be done quickly with a huge brush, 
focusing only on the overall blocks.

Colour layer Colour is applied on its own layer 
over the greyscale image. Taking reference from 

a photograph and a bit of trial and error, a fairly realistic 
colour scheme can be reached.

This piece of work started as an 
experiment, playing with diverse 
environmental styles for my personal 

portfolio. When working for specifi c clients, I often 
have a brief for the visuals and design to meet their 
needs, so I always try to make time to work on 
personal concept projects. I fi nd working like that is a 
great way to discover and learn more about the 
existence of forms and the way they impact us.

My interest in architecture defi nitely played a part in 
the development of this piece. I’m amazed by 
impressive architecture and style as I feel a really 
successful design has the ability to surpass 
everything and create a mathematical kind of beauty. 
I wanted to create something in a fantasy vein that 
was engaging and believable, building simply on 
whatever visuals I pulled from my imagination.

I started this piece in Photoshop on a white 
canvas. Sometimes I start with pencil sketches and 
scan them in. I fi nd them much easier to control 
especially when drawing a combination of straight 
lines and curves. It really depends on what image I 
want to create whether I choose to start from scratch 
on the computer or on paper. I started it digitally as I 
wanted to keep to basic shapes and therefore the 
method of colour blocking would work well. In 

Photoshop, I opened a new fi le and started using the 
Line tool to build my basic shapes, keeping to a 
simple, three-point perspective.

Once the two vanishing points were fi xed, I went 
about creating blocks, erasing and adding when 
necessary. Digitally, erasing is the best advantage 
that I can imagine – it’s much harder to correct 
mistakes when you’re using traditional tools! The 
advantage of working digitally is that it really allows 
for many surprises, sometimes even resulting in 
giving your work that extra edge.

Once I fi nished the quick perspective lines, I saved 
it under a new layer and locked it. I usually keep this 
layer until the end, making it semi-opaque so that I 

More fantastic artwork 
from Yap Kun Rong

Floating World
2010, Photoshop
● In this piece I experimented with 
Japanese art, breaking down 
boundaries, perspectives and forms. 
It’s a mix of modern culture and 
traditional ideas that creates something 
different. I wanted it to look fl at and yet 
distinguishable at the same time.

Project Hephaestus
2010, Painter, Photoshop
● This was meant to be a poster for a 
personal project I was working on. I 
was trying to create different looking 
organic robots in an alternate world.

Bring Him Down
2010, Photoshop, Painter
● A scene depicting a confl ict with a 
robot gone out of control. I played with 
dynamic perspective to create tension 
and interest in the work.
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Use textures Effective use of textures expresses intended ideas and design in a much more 
efficient way. Here I used a window texture on my buildings.

Flat brushes I usually use a 
default brush squeezed flat. This 

is a personal preference as I like how you 
can get good control and end up with 
something much cleaner than using a 
round brush with the same settings.

Perspective 
and depth

The illusion of perspective can be 
created by understanding the rules 
and applying it to art. For example, the 
distance between each vertical bar on 
a railing should be the same, so if you 
have a railing stretching from the 
background to the foreground, the 
calculated placement of the vertical 
bars in that perspective will have a very 
huge impact in creating the illusion of 
depth. Using simple but golden rules 
like this, convincing depth and realism 
can be easily brought into your work.

can always fall back on it and not get carried away 
while working on the details. I created a new layer 
below it and started blocking in the tones in 
greyscale. Huge brushes are used for blocking in, 
and also some scattered soft brushes to simulate 
clouds. A pretty quick process for me, but 
nonetheless an important stage. Keeping things 
simple creates a good foundation for your image.

After blocking the tones in greyscale, I added a 
Color layer on top of it and slowly worked in the 
different hues. For colours, I took reference from 
photographs and mimicked the lighting conditions I 
wanted the painting to have. I had a clear picture in 
my mind how the scene would look in terms of light 
by using my photograph reference. The realistic 
orange sky contrasting against the building’s cool 
cyan tint gives a slick, modern look.

With the Color layer, I could apply colour onto the 
scene without changing its basic form. With 
experience and some trial and error, I came to a 
colour scheme that I was satisfi ed with.

After I had more or less fi xed the colour palette for 
my scene, I went on to add some details. I decided to 
start off with the windows as they would be a good 
indicator of the scale and let all the other less familiar 
objects be built proportional to their size.

Using textures from a photograph of offi ce 
windows, I manipulated them to fi t the perspective in 
my image. A lot of free textures and photos can be 
found on texture resource sites and it is always a 
good thing to have resources on hand. 

Using textures effi ciently, you can save a lot of time 
and express your design more purposefully. Here, I 
laid in the window textures using Hard Light, but it 
really depends on your particular scene which mode 
you want to use. I picked Hard Light mainly because I 
wanted a blue glow for the windows. Texture is 
especially useful in fantasy work as it evokes familiar 
images and makes the scene more believable. 

Duplicate the layer Here I wanted to create 
the refl ections of buildings on the water so I created 

a new layer and duplicated the image. 

01

Creating 
reflections

Evoke still water using layers to 
create a refl ection effect

Position the refl ection I went on to fl ip the 
layer vertically and then dragged it to the water level 

where it would meet the building.

02

“Fit” the refl ection Then I added a mask 
to the refl ected layer and carefully painted off the 

unwanted regions; a simple but effective tip.

03

Touch-up tones I did a little touch-up on the 
water. I added an Overlay layer and with a soft 

brush I painted in shadows and white highlights. 

04
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Photo enhancement I used a photograph of a dramatic sky to digitally enhance the colours 
and contrast of the work. At this stage it’s useful to experiment with different hues and styles.

Brush tip
When painting with 
patterns try switching your 
brush tip in the Size 
palette. This can cause the 
same pattern to give some 
very different result. Using 
a tip with a softer edge 
can create a lot more 
randomness when 
overlaying your strokes.

Dissect an image
Creating a fantastical city

Reflections I wanted it to be a harbour 
so there has to be water. I wanted 
something calm and tranquil to go with 
the curved building shapes. By using 
reflections I managed to suggest very still 
and calm water with no disturbance. 

5

Ballroom I chose this curved shape 
mainly because it is pleasing to the eye. 
It could be anything, perhaps a theatre 
or gallery space, or something not for 
recreational usage. The viewer can use 
their imagination on this one.

4

Wisps and domes Using circular 
disc-like forms I tried to create some open-
air parks where people can come out and 
take brief walks. I enjoy curves and I think 
the future might see a rise in an aesthetic of 
more rounded, curved structures. 

3

Clock I wanted the harbour to have a 
clock like large towns and cities often do. 
The image itself is quite ominous, but I 
used bright colours and tones to suggest 
simplicity and youth, showing that the 
harbour itself is young. 

2

Lined roof I was wondering what kind 
of roof design might be appealing (and 
possible) in the near future and I decided 
to go for a simple porch-looking structure, 
striped with the blue and green tones I have 
used throughout the image. 

1

Dissect an imageDissect an imageDissect an image

Create detail in Photoshop 
I slowly added more details in 

Photoshop using the pre-existing tones 
and colours, building forms and layers 
upon themselves. I still avoided very tiny 
details in this stage, taking it one step at a 
time and building the image.

Render in Painter I switched 
to Corel Painter here to take 

advantage of the Oil brush, a great tool for 
creating the clean, controlled strokes for 
this piece. Painter works really well when 
you’re using tiny brushes, and having 
crisp strokes of colours really adds to the 
definition of the artwork as a whole.

When I was more or less happy with the window 
texture, I started to work in detail on the buildings. 
With a default Hard Round brush, I fl attened it and 
changed the direction according to what I wanted to 
paint. This is a very personal preference. I have 
always liked fl at brushes as they can help you a lot in 
creating forms, and making the brushstrokes work in 
your favour saves time and effort.

After working on the details for some time, I like to 
zoom out to take a look. Everything seemed to be 
going well, but I decided that I wanted to create an 
even more intense colour palette before moving on to 
the fi ner details. I browsed through my folder of 
personal photographs and managed to come across 
a photo of a sunset sky with dramatic clouds that I 
thought would work well. With Hard Light mode, I 
pasted the whole photograph onto the painting. This 
created the effect of intensifi ed depth while keeping 
to my original colour theme. I played around with the 
Opacity as well as the Mask until I reached a stage 
where my original painting had obtained the extra 
glow or glint that I was aiming for.

With the added Hard Light clouds layer, I used the 
image as a base and started to render more details in 
Photoshop. Again, I used my favourite fl attened 
brushes to give a clean, fl at look. Slowly but surely it 
is possible to create convincing depth working within 
your fi xed colours and tones, colour-picking for 
highlights and shadows where necessary.

After some rendering work in Photoshop, I moved 
over to Corel Painter as I really wanted to make use of 
some of its brushes for the fi nal rendering. Using the 
Oils and Fine Camel brushes, it is possible to add 
fi ne strokes and lines which was very important for 
creating the clean, slick look I wanted for this piece.

Using a very tiny brush, I spent most of my time 
here rendering forms and playing with shapes and 
colours. I love the look of tiny details against huge 
negative space (like the clouds in this case) and I 
usually fi nd myself dedicating the most time to this 
stage, painting and erasing when necessary. 
Exploring visual placement of objects and 
concentrating on detail enhances an image by 
creating something fun and interesting for viewers. 

With the bulk of the details down, I then used a 
Round Blender brush to smooth out any rougher 
areas. Using a Blender as a fi nishing touch works 
well in painting clean objects, giving them a glowing 
quality. A lot of details at this stage are based on 
intuition as I didn’t really ‘design’ the work and was 
open to altering my techniques depending on what 
was required at a given moment. If I did have a 
design that included certain buildings or shops, 
initially I would have done the planning on paper 
before bringing in the colours. This design began with 
simple building blocks and thus I can work on the 
design and rendering freely even at the fi nal stage. 

Once I was really happy with all of the tiny details, I 
switched it back to Photoshop for some fi nishing 
touches. The reason for this is that Photoshop is very 
good at supporting large fi le sizes, so all of the 
possible manipulations towards the fi nal stages of a 

1
2

3
4

55
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Blending and touching-up 
Using Blender brushes in Painter, 

I blended off some of the rougher strokes 
and gave the buildings a very clean look. 
With time and patience, cleaning up a 
work can be simple and rewarding.

Final colour correction Finally, I bounced 
it back to Photoshop for a last adjustment and 

touch-up. I added cyan to part of the sky to tighten the 
image on the whole. Also I adjusted the Brightness and 
Contrast accordingly to give it a polished look.

piece are easier. I think taking advantage of each 
program’s strengths is a good way to work around 
issues and the more effi ciently you can work, the 
more effectively you can create. So back in 
Photoshop, I adjusted the Brightness and Contrast 
slightly and added an Overlay layer with which to do 
some specifi c colour fi nishing.

I added cool blue cyan to the top right hand corner 
of the sky to bring in focus as well as tighten up the 
whole painting. Last, I duplicated and fl ipped the 
image vertically to be used as we did before to show 
a refl ection in the calm water of the harbour. 

This piece of work took me three days, on and off. 
When you understand the rules of perspective, tone, 
colour and form, the canvas is really a place for the 
imagination to run wild. With a solid, basic idea, it all 
boils down to the creation and the free will to design, 
unrestricted by technical issues. 

The bridge is there to give the 
harbour a signifi cance and a 

form of connection to the 
foreground, and to continue the 
theme of water and tranquillity
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Paint with 
Sponge 
brushes

Painter delivers a huge raft of tool 
options with almost endless possibilities. 
Coming from a traditional background you 

might think that Painter’s digital watercolour 
alternatives would be the obvious choice for me, but 
that is not the case. Although I still think in terms of 
overlaid washes, I have warmed to a selection of the 
other brushes more than the named Watercolor 
variants. This is particularly true for introducing 
textural elements. You have more options and control 
than available with real media. Using chalks at 
variable grain settings, combined with paper textures 
and their controls is one method I like and have used 
in the past. In this short walk-through, I’m substituting 
the chalk for sponges to push it even further. We will 
be illustrating a brightly coloured jellyfi sh interacting 
with a playful mermaid.

Medusa is another word that can be used for 
jellyfi sh and got me thinking about the Greek 
mythological Gorgon, of the snakey hairdo fame – 
hence my composition Medusa Dance visually plays 
with that idea with the tentacles on her head.

The goal is to create a scene that incorporates 
dappled light, playing on and through glowing, 
gelatinous creatures drifting across a brightly 
coloured reef. The addition of the mermaid will add a 
magical element and some character interest, 
hopefully adding to the appeal for children. 

My preference is to use numerous layers, building 
up subtlety and depth as I would with real watercolour 
washes. This happens to be how I work and is one 
possible approach, making full use of digital editing.

The fi rst stop is to trawl (sorry about the fi shing 
pun) the internet for jellyfi sh and reef inspiration. This 
is a fantasy scene and the sketch, drawn straight in 
on the graphics tablet (in my case a Wacom Intuos3 
with a Round Tip pen at 35% Opacity), will refl ect 
source image infl uence rather than strict biological 
accuracy. Working at an initial 72dpi, I fl ood fi ll a blue 

Medusa Dance  2011 Painter

Nick Harris Children’s book illustrator

Add texture and interest to an 
underwater scene

Digital artists explain the 
techniques behind their 
amazing artwork

A
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Nick Harris 

Personal portfolio site
nickillus.com
Country UK
Software used ArtRage, 
SketchBook Pro,     
Painter, PhotoPlus X4, 
DrawPlus X4, PagePlus 
X5, WebPlus X4
20 years spent working in 
traditional watercolour 
illustration before going 
digital has meant that I still 
think in that way. The way I 
use various software tends 
to refl ect this background.
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base layer and sketch some forms on a few layers 
above. I block in different tonal areas on the base 
layer around the sketch to get an idea of highlights 
and shadows, then rough in solid white shapes to act 
as templates for my mermaid and jellyfi sh characters.

Adding several layers of varied blues (using the 
Multiply blend mode) enables me to bring lighting 
and form to the layers below. I refi ne the drawing and 
shapes continually as I go, adding and grouping a 
set of layers for pattern and tentacles on the mermaid 
fi gure. Use the Preserve Transparency option on the 
Layers palette to enable free brushstrokes on the 
opaque template layers. This gives you a controlled 
addition of textural interest. Now it’s time to bring on 
the sponges. Their organic look will be perfect for 
coral. There are 13 variants loaded within Painter, and 
I select three to add to my custom palette.

During the image creation process, I use the plain 
Sponge at a large size on the base layer (with the 
basic paper at a reduced scale) to add blocky reef 
texture before scaling the image up to 300dpi. I work 
some interest into the blue layers using the Fine 
Sponge 60 variation with white, then add Overlay 
layers using various colours to accentuate lighting 

effects using the same brush, and then a Glazing 
Sponge for colour-zinging wash layers. Make sure to 
name and group the layers – or at least some of them  
– if you use a lot, otherwise you’ll spend half your time 
trying to remember which is which, make silly 
mistakes and ultimately waste precious time.

Switch the blue layers on and off to regularly check 
how the forms and textures are coming. Remember 
that they’re only there for lighting effects and it’s 
important to try and make the actual composition 
and drawing as good as you can. It’s easy to let them 
take over the colouring completely and lose out on 
the little details that can make all the difference. They 
should ultimately provide the underwater magic that 
we want for the fi nished image, just use with caution.

I build the image with a combination of translucent 
layers set to the Multiply or Overlay blend modes over 
other layers of solid colour, painted with either the 
Soft Oil Pastel (at 10% Opacity and 20% Grain) or the 
sponges (at different settings). By spacing the blue 
layers at various places in the stack, I can more easily 
control the overall lighting pattern in the scene, 

Each paper has a range of looks to 
offer, particularly if you adjust the 
scale and fine-tune the Grain setting 
on your dry media brush to use with 
it. The look will also be affected by the 
dpi of your image – you are likely to 
need a larger brush and paper scale 
at a higher dpi. These example stripes 

of orange on blue use just two papers 
(Basic Paper at the top, Fractals and 
Stone below). They represent 50%, 
200% and 350% paper scales and 
a mere 5% alteration in brush Grain 
from 10-15% with the Sponge. The 
range of effects you can get with such 
small changes is impressive.

Paper and grain settings
There’s gold dust in these features

Nick shares some more 
of his fantastic pieces

A New Hope
2009, ArtRage 
● This was created in response to the 
conceptart.org challenge with the 
theme ‘new born’. I got all pretentious 
and went for an image of famine.

Cheshire Cheesey Grin
2010, ArtRage
● Part of the frenzy of activities that 
sprung up about Alice in Wonderland 
last year. Couldn’t not stick my oar in. 

Dragon Web
2009, SketchBook Pro
● One of the 20 or so artworks, I did 
for Templar Publishing’s Drake’s 
Comprehensive Compendium of 
Dragonology. Quite a mouthful.

Jellyfish crowd I created the ring of little 
jellyfish to balance the composition more. This also 

enabled me to add more interesting lighting effects.

Dry sponges When working back into layers 
set to Multiply, the sponges are really great for 

introducing interest. This works best with the dry versions.

Base 
sketch 

Working over a blue 
base, I sketch the 
main shapes and 
block in colours on 
layers above. It’s 
good to get some 
sort of framework 
down quickly.
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Base layer Block in the shape of your jellyfi sh 
solidly to act as base tone. I chose a mid-range 

value because it’s easier to go lighter or darker on it. 

01

painting lighter areas into them with the pastel or 
sponges. The higher up the stack the layer is, the 
less saturated with blue it is likely to be, bringing it 
forward. Working this way is fl exible and forgiving.

I try to respond to what I think the image needs as I 
go, which sounds very vague of course, but does 
describe the process. For instance, in my case the 
composition is compromised by having to straddle 
the page-join of the magazine. I quickly decided 
about the mermaid and right-page jellyfi sh placement 
and blocked colour and tone accordingly. The other 
jellyfi sh were added later to help lead the eye round 
the picture, as was the brighter colouring at the top 
right. Blue and green were always going to be the 
dominant colours, so complementary oranges and 
yellows will provide the richest contrasts. Using a few 
papers and their settings in combination with the 
sponges enriches the surface more. If you haven’t 
explored these options already, I heartily encourage 
you to do so. Open up the Paper palette and see 
what difference changing the scale, contrast and 
brightness makes. Invert it and use a different colour. 

Play with the Grain setting of your chosen tool and 
explore to fi nd out how this works best with your 
particular style. I fi nd the Large Chalk and various Dry 
Sponges good. You may prefer something different. 
There are a lot of Painter compatible papers freely 
available, as well as ones to purchase. The extra 
ones I have stored came with The Painter 8 Wow! 
Book some years ago and have kept me going ever 
since. You can indeed make your own paper textures, 
as described in the manual. I have to admit to never 
having felt the need yet myself, though.

Paper and grain settings How to light 
your jellies

Go for a translucent gel effect 
with highlights and inner glow

Light Set your main light source and add 
appropriate shadows to describe some form. If you 

don’t do this, the fi nal effect may look rather fl at.

02

Add highlights Add crisp-edged highlights to 
the side facing the main light source that refl ect its 

colour. Bear in mind a softer light gives softer highlights.

03

Jellify Add a less pronounced but still positive 
glow inside the opposite edge of the object in a 

brighter version of the colour of the object itself.

04

Work the layers Turning off 
layers that make the image darker 

enables you to see the linework more 
clearly and therefore spot any areas 
particularly in need of tidying up.

Texture Though I like the way the 
lighting is going, the image at this 

stage still needs a lot more textural interest 
if I’m to make full use of the sponges.

Textural 
contrasts

When using textural effects, you 
can often emphasise those areas 
by having smooth contrasts 
nearby, in the same way that light 
and dark contrasts close to one 
another make more of an impact. 
Do be aware of this, however, 
within the context of the whole 
scene – you don’t want it to  seem 
out of place.
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Combine fantasy 
and realism

Create a realistic fantasy 
wildlife piece with textures 
and a natural setting

Digital artists explain the 
techniques behind their 
amazing artwork
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Amber Hill 

Personal portfolio site
vantid.deviantart.com
Country US
Software used Painter
Amber’s art education 
consists mostly of 
dissecting dead things and 
watching live ones. She 
specialises in fantasy wildlife 
art – fl ights of the 
imagination inspired by the 
living and breathing world. 
Amber lives on the road, 
moving from place to place 
in pursuit of wonder.   
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Place your mythical 
beast in a lifelike sene

Working
Progress

Step 01, Create a sketch

Step 06, Build up ground

Step 15, More leaf litter

Step 26, Begin creature textures
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Lords of Autumn 2011 Painter

Amber Hill Fantasy wildlife artist

Combine traditional wildlife painting techniques with elements 
drawn from mythology for a stunning image

Fantasy wildlife art is a fantastic new genre 
that combines traditional wildlife painting with 
ye olde beasts of lore. There have always been 

stories of creatures hiding from us just out of sight, and as 
we walk through the woods of today sometimes something 
will catch our eye and we wonder, was that the fl ick of a 
dragon’s wing? Did that fox I saw have an extra tail? We 
can take these moments and paint them as if they actually 
happened, with realistic lighting, close observation of 
anatomy and texture rendering, or we can hide the 
mysterious creatures in our art. Not every fantasy piece has 
to have the dragon bursting fl ames all over the place. 
Sometimes we can put them into a piece, almost 
camoufl aged, so that the viewer can have that same 
moment of “wait, is that a gryphon I see there?”

This piece was inspired by my own wanderings in the 
woods, where I often ‘see’ dragons and gryphons. When 
you have experienced a place for real you can put more of 
yourself – and more feeling – into the fi nished art. It’s this 
extra element that really ties the whole thing together and 
makes the fantastical into a plausible reality.

Landscapes
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Create a sketch 
Take a while to 

brainstorm. What is it you’d 
like to accomplish? The initial 
sketch of a gryphon leaping 
over a log is dynamic but 
not very subtle. To make a 
static pose more interesting, 
move the virtual camera (the 
viewpoint) around a bit. The 
camera pointed down creates 
a fun perspective.

01

Show a new 
perspective The 

higher angle creates a feeling 
as though we are hiking 
along, perhaps clambering 
over some rocks in the 
woods, when we see a bird 
of prey. Only it’s not, there is 
something wrong here. The 
back view of the gryphon 
makes the effect subtle.

Focus on anatomy Fantasy wildlife is nothing without real-life anatomy. Wings are an 
especially diffi cult aspect of a gryphon to get right, so to help you understand what’s going 

on underneath, check out the outline of a chicken wing. The shape is very similar, with joints in all 
the same spots. Also, look at feather groupings and cat hipbones for reference.

02

03

Seasonal colour Set the sketch layer to Multiply. If you accidentally sketched on the 
canvas fi rst, just hit Ctrl/Cmd+A, look for Select in the menu and then Float. Since this is to 

be an autumn scene, fl ood fi ll the canvas with a rich orange to serve as your base.

04

Separate the ground Grab a big opaque tool – 
Scratchboard Rake will do – and, with a lighter orange, 

chunk some rocks in. Use a Soft Airbrush to paint in the distant 
ambient light. Now we instantly have some sort of depth 
between fore, mid and background.

05
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Build up ground Use the Soft Airbrush to work 
more gold-yellow light into the background, lowering the 

opacity of the sketch layer if you need to. Use a Round Oil Pastel 
with 50% Grain to smoosh in the rocks. Use a desaturated yellow 
in the shadows and a pinkish yellow in the light.

06 Block it in Now start blocking everything else in. Be 
sure to work on the canvas under the tree layer, as the 

Round Oil Pastel will smear the digital paint. Use a lot of purples 
and dull pinks to blend into the orange.

08

Place the trees 
Create a new layer. The 

trees are fantastic for showing 
a dynamic three-point 
perspective angle without 
being too diffi cult to make look 
good, and naturally trees don’t 
look perfect anyway. Be sure 
you keep the angles in mind 
when you block them in with a 
rich, dark brown.

07

Lay of the land 
Suggest the shape 

of the hills beyond with more 
purple. Paint the sky patches 
at the top with a slightly dull 
but high value blue and begin 
texturing the rocks, making 
sure to follow the invisible lines 
of perspective with the cracks 
and striations you draw.

09

Paint the leaves Once the underpainting is all blocked 
in, start to paint leaves into the scene. Use a small brush and 

stipple various colours such as orange, yellow, brown, dark purple 
and light purple.

11 Rock out Create rock textures using a Chunky Oil Pastel with a low Grain setting. This 
enables Painter’s paper texture to show through and makes for fantastic rough textures. 

Paint blobs of moss and skate the stylus over the surfaces to generate random cracks and 
buckles. It’s controlled scribbling! Paint a hint of bounced light on the bottom.

12

Follow directions Further refi ne the contours of the 
land with more and more colour and experiment to fi nd 

which tones work best. Use the strokes of the brush to follow the 
angles or planes of the hills, as this will help build volume.

10
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Spatter textures The Variable Spatter airbrush generates random dots as if the paint were fl icked. Experiment with 
the various Spread, Flow and Features to fi nd which work best for you. This is a quick way to get an organic look. Lightly 

paint over, shade and highlight the spots that look best.

13

Landscapes
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Lighting
A scene like this is 
fi lled with a 

golden-orange glow that 
permeates the image. This is 
called ambient lighting. 
Bounced light is evident in 
places like the trunks of the 
tree and especially on the 
surfaces of the rocks that 
face the leaves.

166-173_FAGG_01.indd   170 05/07/2012   12:23

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Dissect an image
Key design elements

Feathers These feathers are rendered 
loosely, with broad strokes over the form; 
tight detail would ruin the effect. While tiny 
painted elements may not be desirable, 
things such as pockets of fallen leaves on 
the rocks are great to bring realism.

5

Colour scheme A fall scene has 
a marvellous colour scheme. Look for 
purples to complement the yellows and 
tie the piece together using the same 
colour palette throughout. This is not only 
rewarding, but helps with tricky choices.

4

Character Trees are each unique 
characters in the setting, and this should be 
brought out. They are beautiful and worth 
studying to get their forms down. Once you 
become familiar with the nature of trees, 
drawing and painting them is a joy.

3

Animal attitude Your critters should tell 
a story. This guy’s fluffed up head is saying 
something in gryphon body language, 
which just might be the same as bird 
language. People who know animals will 
identify with familiar behaviours.

2

Variable Spatter The thing about the 
Variable Spatter is that it is variable. If ever 
you are worried about overspray, create a 
temporary new layer. Erase the stray spots 
and then merge with your working layer to 
solve the problem straight away.

1

Dissect an imageDissect an imageDissect an image

More leaf litter Continue painting leaf litter and various 
sticks etched with pale purple on the forest fl oor. Use 

photos to see how leaves and fallen branches lie naturally. From 
this angle we are seeing the tops of the leaves as we paint them 
going up that hill. Add a fallen tree with moss, too. 

15

Begin the foliage On a new layer above the trees, paint vermilion dots with a Soft 
Detail airbrush set to a low opacity. Use reference photos of trees to get the grouping to 

look right. Trees have anatomy just like animals and people, after all.

17

The details This is a close-up to show how loose the strokes are for all the textures. 
Keep your brushes as large as possible for as long as possible and work from big to 

small. The leaves look like ground-up plastic, but from a distance they read as leaf litter. Work 
big, work loose, work happy!

16

Finish the 
rock Work 

over the entire rock, 
making sure that 
the horizontal and 
vertical lines look like 
they could converge 
to a vanishing 
point. Paint the 
beginnings of a dry 
creek under a fallen 
log with some of 
that dark purple, 
and use choppy 
strokes to suggest 
leaves further in the 
distance. 

14

13 2
5

4
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Treetops Smoosh more blobs of encircling gold and paint even smaller dots of 
brighter gold on top of the duller, darker colours. In the distance, add some of that sky 

colour from earlier. Erase around some of the leaf masses that are too big and blocky. 

Find satisfaction Now it’s getting hairy, but it’s really just layers of leaf dots layered on top of one 
another. Push and pull the colours and values. Did you paint over a tree trunk? Well just draw another 

one in! It looks complicated but it’s just fussing with the texture until it looks right. 

21

Use negative space Use temporary 
layers and Variable Spatter to make leaf 

sprays, then build on top of the random sprays. 
Erase what doesn’t look good. Start adding more 
colours with small dots and draw some twigs. Cut in 
bright sky windows that make the scene scintillate. 

22

23

Add more 
colour 

Now add a variety of 
colours. Layer dull 
gold, deep brown-
red and some purple 
shadows with the 
Round Oil Pastel. 
There is no trick 
to this other than 
paying attention 
to actual trees and 
giving a rough 
impression of the 
leaves and patterns.

Create more depth On the other side of the painting, 
smoosh in some blobs with dull gold, adding a few in front 

of the foreground trees. Even as mere leaf blobs, the painting 
acquires more depth. Paint a very dull green for the moss on top of 
the tree trunks. 

19

20

Climb the tree Paint more sprays with the same red, 
leaving those natural gaps from branches. Paint on the other 

side of the trees in the foreground to further enhance the feeling of 
depth, but keep it in perspective. 

18
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Complete the creature
Paint and texture your gryphon using real-world references

Tree trunks There are two different kinds of trees, so 
there are two styles of bark; one smooth and one rough. 

The forms overlap so we can see the top of each branch.

Tighten up the 
details Keep 

working the feathers and 
fur. Add patterns found on 
birds of prey and iridescence 
wherever you want. I prefer 
iridescence everywhere.

Begin creature textures Complete the beak with 
a rich, deep orange. Include colours from the sky on the 

highlights of the beak and, with an even darker brown-purple, 
block in the shadows of the head and the beginnings of feathers.

Wing forms While still referring to the sketch made 
earlier, block in the rest of the body and the wings, paying 

close attention to your references. Edge the feathers with a pale 
grey and make sure you don’t make them too uniform.

24

26

28

30

Start the beast 
Oh right, there’s a 

gryphon in this! Create a new 
layer and lay in a dark brown 
under the sketch. Using the 
Eyedropper tool, grab the 
gold hue from the leaves and 
paint the beak and eye.

25

A hint of cat The feline back is one of the aspects of this critter that tells us that 
something isn’t quite right. Keep in mind where the hipbones are and try to render them so 

you can still see the anatomy beneath, giving an edge of realism to the fantasy.

29

Stippling
Stippling is a 
technique where 

hundreds or thousands of dots 
create a complete image or 
texture. The advantage of 
stippling the leaves is that you 
are in control of the directional 
fl ow, which is hard to duplicate 
with a pre-made brush. It is 
worth the time it takes.

Highlights 
Once the dark 

shadows of the feathers are 
roughed in, a silvery yellow 
is used to make the feathers 
emerge. Use light pressure 
in the shadows with fi rmer 
pressure to carve out those 
highlights. Cut shadows back 
in as needed. 

27
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Source files
available

Sketch
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Lighting with 
layer masks

Initial sketch Tone thumbnails are excellent 
for working out composition and colour schemes, 

but you need to include some detail too. I usually produce 
about five or six of these rough drawings.

It is said that in London you’re never 
more than fi ve metres away from a rat. 
Similarly, in the world wide web-gallery of 

digital painting, you’re probably never more than two 
clicks away from a fantasy or sci-fi -themed image.

Unlike our mangy rodent neighbours, however, a 
well-executed fantasy painting can be an intriguing 
and beautiful thing, and they very often are.

It’s easy to see why an artist might be drawn to the 
world of fantasy illustration as the themes and alien 
landscapes enable us to push light, colour and 
perspective to extremes and, done properly, the 
results can be exciting and dramatic. These are the 
elements I’m interested in exploring in this tutorial.

A painting set in the future or on another world 
gives us the opportunity to invent strange forms and 
landscapes, or even new laws of physics. We can 
relax a little and not worry so much about 
reproducing nature in detail. A new white canvas 
becomes less of a threat and more of a platform for 
your imagination. However, we still need to pay close 
attention to how light affects the objects and colours 
in our scene, and getting this right is no mean feat. 
Hours of good work can be destroyed by adding 
last-minute details or editing. Who has never 
experienced the dread of trying to rectify a mistake 
that has completely changed the look of your piece 
only to discover that you have no more undoes? 

One solution is layer masks. These can be added 
at the end of the painting process so you can adjust 
the tones and values without fear of permanently 
damaging your artwork. These are a must-have 
addition to any digital artist’s toolset.

The Storm Below  2012 Painter, Photoshop, GroBoto

Joe Cummings Illustrator

This tutorial shows how lighting a sci-fi scene can be 
enhanced by the use of layer masks

The idea of this painting was to imagine a city of 
the future that sits on a cloud – who needs gravity? It 
is silhouetted against a tropical sun, but an 
approaching storm creates an appearance of 
extreme and contrasting lighting effects. For this work 
I will be spending most of my time in Painter 12 and, 
while this program can produce adequate layer 
masks and adjustments, I will be taking it into 
Photoshop towards the end to use its more 
comprehensive tools for the fi nal tweaks. 

I began, as always, by quickly blocking out some 
colour ideas using simple, rough shapes. I wanted to 
use honey yellows for the sky to contrast with the 
deep blues and greens that I intended for the sea 
and storm. This made life a little easier regarding 
colour schemes, as I knew I could concentrate on a 
smaller section of the spectrum, leaving myself open 
to drop in some small, complementary-coloured 
elements later. It is often safer to limit the number of 
colour choices to avoid losing focus.

After producing a more detailed line drawing on a 
new layer I began designing my city, experimenting 
with domes, spires and glass towers. I also knew I 
wanted something protruding out of the sea, perhaps 
the remains of an earlier civilisation.

At this point I had intended to simply paint in 
geometric shapes and use custom brushes to add 
basic, undefi ned architectural features – the city was 
to be mostly in shadow after all. As I continued I 
realised that I could quickly produce a simple city of 

Go 3D If you have tools to make life easier, why 
not use them? I am far from expert with 3D apps 

but a little knowledge offers great rewards.

Digital artists explain the 
techniques behind their 
amazing artwork
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Joe Cummings

Personal portfolio site
cummingsillustration.com
Country UK
Software used Painter, 
Photoshop, Illustrator, 
SketchBook Pro
I have been a long-time 
traditional illustrator, 
producing a range of  
artwork for magazines and 
newspapers. I like to explore 
many different styles and 
media. For me, the 
abundance of digital 
drawing programs and 3D 
apps offers many more 
avenues for exploration.
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rounded shapes in GroBoto, a peculiar 3D-modelling 
program that has been lying idle on my hard drive for 
a couple of years. The inexpensive software works by 
dropping custom shapes onto a 3D canvas, which 
can then be manipulated into quite extraordinary, 
complicated and beautiful structures, and there is the 
added bonus of being able to manoeuvre a light 
source. It only took about 40 minutes to build a 
convincing city. This was excellent reference for 
working out structure and perspective.

I dropped a rendered image of the city into a new 
layer and began painting the background, clouds 
and seascape, working with each on their own layers.

Keeping the elements isolated this way is 
insurance for future alteration or deletion. I used a 
Captured Bristle Acrylic brush for roughing out, but 
for the majority of the painting I adapted a Soft Flat 
Oils brush to make it blend more with the surrounding 
colours. I changed the Dab Type to Circular, Method 
to Cover and the Subcategory to Soft Cover in the 
General tab of the Brushes panel. This gives a 
smooth, buttery oil that is excellent for blending. Keep 
the Bleed high and the Resaturation low, that way you 
will blend with light pressure and lay down more 
colour when it is increased. Using the city render as a 
guide, I added shadows and highlight detail. I placed 
a new layer above the city and started on the cloud. 
Clouds are tricky because they come in so many 

fl avours. For the foreground cloud effect I settled for a 
classic fl uffy caulifl ower, as it had to appear almost 
solid to support the city, but I left the background 
clouds more indistinct. The choppy sea was also 
challenging, but working methodically in layers can 
take away some of the strain.   

Lightning is always fun to paint and incredibly 
simple. Brush a bright yellow spidery trail with a small 
medium-hard brush, add some branching and then 
incorporate a stronger yellow over these with an 
airbrush to create a fl uorescence. Use the Glow 
brush from the FX category to paint over. It has an 
amazing ability to create the whitest of whites.

Shamelessly lifting from The Planet of the Apes 
(and a dozen other sci-fi  movies), I decide to add 
protruding spikes from the crown of the Statue of 
Liberty. The fallen monument is submerged under a 
dramatically raised sea level. Having the Extended 
version of Photoshop CS5 meant that I could open 
the painting there and import a simple 3D fi le of some 
spikes, placing it directly into the painting where I 
rotated and used them as a guide. 

There are many ways to produce sun rays, but I 
fi nd it quick and easy to fi rst draw a rectangle, add a 
Gaussian blur and transform the rectangle using 
Perspective Distort to make the ray. This produces a 
beam that is sharp at the focus with an increasing 
blur towards the end. Copying and rotating several of 

Layer masks can be used to make 
dramatic changes to your artwork 
or tweaks so subtle that only you 
would notice. The beauty is that you 
can always go back and edit them, 
a bit like having a reverse eraser.

These before and after images 
show how I had complete control 

over the sunbeams I added. Even if 
I decide to incorporate something 
else in the scene, I need only take a 
brush to my mask to account for the 
changes. Adding layers of colours 
and then masking parts enabled 
me to increase the dramatic 
appearance of the tropical lighting.

Use layer masks Mask your elements for non-destructive editing
After

Before

Brush tips Use Painter’s hard media (Chalks, Conte, 
Pastels) with different papers to produce strong textures. 

Push the Grain to 10 and scale the paper up and down.

Extended features Photoshop CS5 Extended’s 3D features are a little clumsy, but the 
ability to manoeuvre 3D objects within a 2D file saves enormous amounts of time.

New dimensions Once the 
object is placed correctly, it can 

be rasterised and taken back into Painter. 
Painting the sea lapping around the spikes 
merges them nicely into the scene.

Landscapes
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Simple beginnings Create a dark-to-light-
blue gradient and, on a new layer, paint sharp-

edged diamonds. Only one or two should dominate.

01

these gave me a template for god rays emanating 
from the sun. After spending a few hours refi ning and 
adding detail to the city, I reached the point where I 
could start to work with layer masks to develop the 
image further in separate sections. 

Layer masks enable you to adjust the opacity of 
the pixels on a layer while leaving it intact. Painting 
black on the mask hides the pixels, white reveals and 
shades of grey change the opacity, depending on the 
value of the grey. This is an especially useful feature 
when you are dealing with soft blurry elements like 
the sun rays; it is diffi cult to work on these directly 
without destroying the effect around them.

I opened the image in Photoshop and added a 
layer mask to the sunray. I then selected the mask 
and, in the document window, painted black where I 
wanted to hide the parts that would be obscured by 
the city and clouds. With a soft brush, I painted in 
grey (actually, I just reduced the opacity of the brush) 
to reduce the opacity in other areas and changed the 
layer mode to Overlay. This gave me convincing sun 
rays while retaining the ability to go back and alter 
them later should the need arise. 

After selecting the pixels of the cloud layer and 
overlaying a gradient on a new layer, I added another 
layer mask and once again painted blacks and greys 
to reveal the shadows on the cloud. To fi nish off, I 
used adjustment layers to edit the contents of the 
painting. These are similar to layer masks but enable 
you to alter the colour balance, levels, contrast and 
so on without actually changing the pixels 
permanently. If you open the Masks panel you will 
fi nd extra controls in the Adjustments tab. Be aware, 
however, that adjustment layers will not transfer back 
to Painter, the layer will simply be fl attened. 

Layer masks are ideal for making fi nal adjustments 
to your artwork and, being non-destructive, are 
reassuringly safe to use in artwork in which you have 
invested hours or even days of hard labour.

Sea painting 
for beginners

Rendering rough seas is not as 
daunting as you might think

Blue or green Between the background and 
the waves, airbrush a brighter green-blue towards 

the foreground then paint a lattice of smaller wave outlines.

02

Light tweaks Adjust the hue and contrast 
according to the light then look at reference images 

to see how foam on the top of water disperses.

03

Refl ections Go back to the airbrushed layer 
and paint in some of the sky colour at the horizon. 

Add in bright sunlight refl ections across the water.

04

Paint clouds Clouds are always 
tricky to get right. It is worthwhile 

studying lots of images and practising 
painting them. I try as much as possible to 
avoid soft edges.

Mask options Open the Masks 
panel to find extra layer-mask 

controls. In the Adjustments tab you 
will also find an extensive number of 
parameters to control adjustment layers.

Unmask 
your mask

When using masks it is always 
useful to see a before and after for 
comparison. Shift-clicking the mask 
thumbnail toggles it on and off and 
Alt/Opt-clicking the thumbnail shows 
the mask in the document window 
where you can see exactly what you 
are painting.
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Digital artists explain the 
techniques behind their 
amazing artwork
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Tobias Roetsch

Personal portfolio site
www.gtgraphics.de
Country Germany
Software used Photoshop
Roetsch has been focusing 
on space and science 
fi ction based images as 
long as he’s been doing art. 
Self-taught, he improves his 
skills step-by-step, with a lot 
of patience and effort.

Source files
available

Stock images

178-183_FAGG_01.indd   178 05/07/2012   12:30

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Compose a 
spacescape

In this tutorial we will learn how to create a 
moody extraterrestrial landscape. All you’ll need 
is Photoshop and a good source of photography. 

The best way to ensure you get the perfect shot is to take it 
yourself, therefore it’s very helpful to have a DSLR, ensuring 
high-resolution quality in your resources. To get the 
necessary inspiration for your project, just take a walk 
outside. Another option is to use the Google image search; 
by searching for ‘mountains’, for example, you’ll get a variety 
of shapes and ideas that will stimulate your imagination. If 

you don’t have a DSLR, you’ll need to use stock sites such 
as iStockphoto.com. In preparation for this tutorial you 
should collect or take photos of things that might be useful 
for detail.

The software basis for this tutorial is Photoshop CS5, but 
we have stuck to the core functions of the program available 
in older versions as well. A graphic tablet was also used for 
the painting parts but this is not necessarily needed. By the 
end of this tutorial you’ll discover the means to create realistic 
and futuristic looking scenes. 

The idea It helps to sketch out your idea before, so 
use a small hard circular brush for the outlines and a large 

soft brush to visualise the light setting. Find the right place for 
your light source at the start, then create a new 4,800 x 6,000 
pixels document.

Getting started Use a Linear Gradient (‘#000000’ 
to ‘#3e464d’) from bottom-right to top-left corners. For 

the foreground, we’re going to use the image ‘IMG_5642.jpg’. 
Add it to a new layer, fl ip the photo horizontally and rotate it by 
10-15 degrees.
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One step beyond
Start to build your extraterrestrial landscape

01

Turn your fantasy 
world into a reality

Working
Progress

Step 04: Piece the scene together

Step 09: Bring in the sky

Step 19 Adding flowers

02

Wayfarer  2011 Photoshop

Tobias Roetsch Digital artist

 By the end of this tutorial you’ll discover the means to create 
realistic and futuristic looking scenes
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Make it fi t The 
landscape is still 

not right because some 
snow and mountains 
are absent from the 
photo due to its angle. 
Mountains can again be 
remedied with the Clone 
Stamp tool. Simply paint 
in the snow in the left 
and right bottom corners 
using a medium-sized 
soft round brush at 60% 
Opacity. To get the right 
colour, Opt/Alt-click and 
chose the one you need 
from another part of the 
photo. A texture brush 
or the Clone Stamp tool 
helps you to make the 
snow look more realistic.

Dust and haze The landscape is still looking very clean; a dirty look 
will help improve its realism. First we have to add haze on a new layer. It’s 

up to you to paint it or to use cloud stocks. If you paint it, use a white soft round 
brush at a low opacity, creating distant haze. Adjust the layer opacity and use 
some circular light blue gradients for the foreground, then play with opacity again. 
Add another layer and paint over the snow parts with a white brush. Set the layer 
to Color blending mode.

Background mountains To add draw more attention to the 
background, we’re going to add some extra mountains. Build them 

using the ‘IMG_6402.jpg’ and ‘IMG_6417.jpg’ images on the disc, cutting away 
unnecessary areas. Layer these by using single parts of the given photos. Once 
you’re pleased with your arrangement, work on the transitions. Adjust the colours 
by using Color Balance (Cmd/Ctrl+B). For the transitions of your crops, take the 
Healing Brush tool (J) and fi x the edges.

Light the 
mountain To 

change the lighting, Cmd/
Ctrl-click the mountain 
layer thumbnail to make a 
selection. On a new layer, 
add a black-to-transparent 
Linear Gradient from right 
to left. For highlights, copy 
the mountain layer and 
apply a Brightness/Contrast 
adjustment with Brightness 
at 45 and Contrast to 10 
(tick Legacy). Delete 
everything but the left edge 
of this layer. Add haze, as in
Step 5, using colours 
from the highlights of the 
foreground mountains.

Landscapes
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Undesired elements We only need 
the landscape section of the photo, as we’re 

creating our own heaven later. For this kind of task, 
the Pen tool (P) set to Paths is a good choice. Just 
follow the mountain outline, make a soft selection 
(Select>Modify>Feather Radius of 1 or 2 pixels) and 
cut off the sky portion of the image. Now we’re going 
to remove the buildings, so zoom in to 200% and use 
the Clone Stamp tool (S). Sample the verge between 
the snow and the mountains to use with the tool.

03

05 06

07

04

Quick 
tip

Landscapes are naturally 
formed. That means they’re 
not perfect and always 
include some dust, dirt or 
smoke. This factor is quite 
important, as applying 
realistic effects will make the 
difference between a 
standard and a good image. 
Work with blurred extra layers 
at a low opacity. The subtler 
they are, the better.
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Heaven postwork Duplicate your cloud 
layers and merge them – select the layers you want 

to merge and press Cmd/Ctrl+E. Apply a Gaussian Blur 
with a 30px Radius. Some details should be visible, but 
subtle. Transform (Cmd/Ctrl+T) this layer up to 125-150% 
of its original size and move it behind the other cloud layers. 
Duplicate the cloud layers individually and use Gaussian 
Blur. Set their Opacity to 25% in to soften the whole scene.

Planet textures Now we’re going to 
create a planet in a separate document. In 

this case we’re going to go with a 4,500 x 4,500px 
new document size. The fi rst thing that you need is a 
good texture. Cgtextures.com has good images for 
this kind of task – we’ve applied the ‘SoilSand0165’ 
image. Add it to your planet document on a new 
layer. Duplicate and rotate it by 180°. Rearrange it so 
it’s nearly a square. Merge both texture layers and 
erase the hard edges with the Clone tool (S) where 
both parts meet each other.

Add the shape Activate the Elliptical Marquee tool (M) and make a circular selection from top-left 
to bottom-right. Crop parts you don’t need. Make a selection of the layer and apply Filter>Distort>

Spherize at 100%, Normal mode, twice. Create a new black circle shape layer of the same size. Add a vector 
mask to this layer and apply a black-to-transparent Gradient tool (G) to delete shadow on the planet’s dayside, 
creating shadow to the right.

When you have fi nished your fi rst planet, adding a 
second one is always a good idea to help improve the 
feeling of scale and to give more depth to the sci-fi  
landscape. Just repeat the steps and size down the 
new planet to 10% of your original one

Vibrant heaven Start 
by using a Linear Gradient 

(colour ‘#b19a82’ to transparent) 
from the snow horizon to the top 
of your highest peak on a new 
layer below your mountain layers. 
Open ‘IMG_1755.jpg’, which will 
serve as our cloud layer. Copy 
it in to a new layer and select 
Edit>Transform>Warp. Change 
the look to a more dynamic 
orientation (as in the screenshot). 
Now remove all the undesired image 
elements, as we only need the clouds 
themselves. Adjust the clouds’ colour 
saturation and darken some of the 
brighter clouds with the Burn tool 
(O). Repeat this with ‘IMG_1765.jpg’, 
although you have to fl ip this image 
vertically beforehand.

GENIUS GUIDE
Fantasy Art

Fantasy Art Genius Guide  181

08

10

11

09

Planet effects
Use Distort fi lters and textures to create new worlds
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Snowfl akes Now 
to add snowfl akes in 

the foreground. Create a new 
layer above everything else, 
take a 2px hard round brush 
and make some random 
dots. Press Cmd/Ctrl+T and 
transform it up to 400-500%. 
Duplicate the snowfl ake layer, 
transform its size by 125-
150% and set the Opacity 
between 50-75%, then rotate 
it. Now merge both layers 
(Cmd/Ctrl+E) and repeat.

More 
mountains Now 

add more mountains. Open 
one of the mountain stocks 
from the disc and add it to 
the scene on a new layer 
below the other mountains. 
To make it fi t into your 
scene, adjust the lighting – 
press Cmd/Ctrl+U and set 
Lightness to +40. Change 
Hue to a more yellow/red 
tonality and use the Lasso 
tool (L) and cut off parts. 
Now add a Gaussian Blur of 
a 1-2px Radius.

Landscapes
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Final planetary action Create a new black circle 
above the shadow. Apply a light blue Inner Glow layer style, 

set to Screen, 250px and Source set to Edge. Also apply a same 
colour Outer Glow with the Size at 55px and Range of 50%. Add 
a white Stroke of 6px Size. Set the entire layer to Screen blending 
mode. Create a new group (Cmd/Ctrl+G); this is needed to delete 
unnecessary parts. Add another mask to the group and use the 
Gradient tool (G) as before. 

Integration into the scene You can now change the colours, etc, but basically 
you are fi nished with your planet, so now add the planet group to your scene right above 

your background layer. Adjust its colour setting and improve the shadows in order to make it 
perfectly fi t into your scene. A second planet is always a good idea to improve the feeling of 
scale and to give more depth. Just repeat the steps and size down the new planet to 10% of 
your original one.

12

13

14

15

Additional Elements
Use colour effects and additional stock to complete your scene

Finding 
textures

A planet is a good addition to 
your pictures and makes a 
normal landscape scene look 
epic immediately.

Unfortunately, the Spherize 
Filter in Photoshop causes 
quality loss, especially on the 
planet’s edges. To avoid this, 
it’s useful to work with a 3D 
program. You only need 
basic knowledge for that 
because all you have to do is 
to create a sphere and add 
the prepared texture. A good 
place besides cgtextures.
com is actually the NASA 
homepage. There are 
thousands of high-quality 
photos that can be used. 
However, follow this copyright 
link closely for information: 
www.nasa.gov/audience/
formedia/features/MP_
Photo_Guidelines.html.

178-183_FAGG_01.indd   182 05/07/2012   12:30

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Have some fun! It’s up to you to add further elements to the image. 
For example, you can add a single house, some people, an old, dead 

and frozen tree or some kind of vehicle. Keep in mind not to overdo it. In this case 
it’s better to go with one additional element at the most. There are already a lot of 
details provided in the scene and the eye of the watcher only needs some focal 
points to follow. This is your scene, so have fun and add in your own elements as 
you wish.

Stars As we have darker parts above the clouds, stars would be a good 
addition to the scene. Add a new layer just above your background layer 

and create a black square shape. Rasterize it, select the shape and add a Lens 
Flare as shown in the example. Select the layer again and apply a Radial Blur, 
setting both Spin and Zoom to 100%. Size it down to 15% for larger stars. Set 
the blending mode to Color Dodge. Duplicate this layer over and over again, 
changing the size and colour as you wish.

Final 
adjustments 

Before you start the 
fi nal tweaks, add 
another layer above 
everything else and 
add more shadows 
to the foreground 
by using the Linear 
Gradient tool (G). Set 
this layer to Soft Light 
and change Opacity to 
50%. For this image, the 
adjustment layers we 
used are Color Balance, 
Hue/Saturation and 
contrast layers (Levels 
or Curves). Place them 
at the top of your layer 
structure and play with 
the settings to get your 
desired fi nish. 
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Manga
street
scene

A good street scene is about choosing an 
interesting viewpoint and capturing life. 
It’s about the stories embedded in the image. 

You should try to observe everything around you 
carefully and you will see there is a lot happening. For 
example, if you are in the downtown area, you will see 
people who are rushing to their businesses, hear the 
noise from cars on the street, see the sunlight that 
reflects onto the skyscraper buildings, smell lovely 
scents from the bakery shop nearby and so on. Every 
detail creates a lively scene. Another important thing 
is perspective, which sounds so scary, especially for 
amateur artists. However, it’s necessary knowledge 
for drawing any scenery and I highly recommend that 
you practise it.

The best way to capture the crowd of people, 
noise, colour or any other detail is visiting the actual 
location. You have to use all of your senses; sight, 
hearing, smell, touch and taste to collect the raw data 
around you. Unseen things, like a scent or noise, are 
exclusive to the actual location. These greatly help 
you to thoroughly portray your impression in your 
image. You’ll never realise those feelings if you only 
do research with a book or web search, so let’s get 
outside and seek some inspiration!

You can sharpen your observation skills by drawing 
and you’ll find your visual awareness increases every 
time you do it. After you do this for a while, you will be 
surprised how many details you overlooked before as 
you start getting better at noticing the finer details of 
everyday life. Finally you will able to see things 
differently from the average viewer and create an 
interesting viewpoint for your image. I often carry my 
little sketchbook with me and use it whenever 
possible. I draw everything that catches my attention 
in order to practise my observational skills.

Wandering in the 
Market Street 2012 Photoshop

Patipat Asavasena Illustrator 

This painting tutorial aims to 
achieve the lively richness of a 
market street scene

Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Patipat Asavasena

Personal portfolio site
www.asuka111.net
Country Thailand
Software used Photoshop
I shifted away from a career 
in engineering to be an artist 
and have been working as a 
professional artist now for 
fi ve happy years. My art is 
strongly infl uenced by 
Japanese manga. I’m a full 
time freelance illustrator 
living in Thailand. 

Landscapes
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Source files
available

Sketch
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Location, location, location
Hit the street you want to illustrate to collect ideas

Gather the data I begin with a trip to visit a crowded 
street market in the downtown area in Bangkok. I keep 

wandering around there as much as possible and looking 
for any inspiration. I also capture interesting subjects with my 
camera and write ideas in my sketchbook. 

01 Thumbnail sketch I lay out all my images from the previous step as a reference then 
start to sketch a rough thumbnail on A5 size paper (148 x 210mm) with a 2B pencil. Using 

small paper forces me to think in terms of the big picture and not the details.

Fix perspective I scan my thumbnail and import it into Photoshop. I expand the 
canvas both to the left and right side, establishing the horizontal line for the perspective grid. 

To do this, I create a new layer called Grid and use the Line tool to draw my lines of perspective. 
Now I create another layer called Rough Sketch and redraw the building to match the perspective.

02

03

Refi ne sketch After I crop out the expanded canvas 
area, I decrease the Opacity of the Rough Sketch layer 

to 20%. I create a new layer called Refi ne Sketch and use a 
4px Hard Round brush for adding more details to the image, 
especially the main characters.

Ink time I merge all of the layers together then resize 
the image to A3 at 300dpi (7,017 x 4,961px). I decrease 

the Opacity value of the Refi ne Sketch layer until it fades into light 
grey and then create a new layer for inking called Line Art. I use a 
Hard Round brush for this stage of the linework.

04

05

Landscapes
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Main character layer I create 
a new layer at the top called Main 

Character and use the Lasso tool to select the 
area. You can add to the selection by holding 
down Shift and dragging, but if you want to 
subtract it, hold down Alt/Opt instead. I then 
select Edit>Fill and fl ood with a solid colour. 

07

Paint the character I lock the 
layer’s transparency before painting to 

prevent the colour bleeding outside the area. 
You can do this by clicking the icon in the layer 
window. I now use a Hard Round brush to 
paint the characters. I also import the colour 
reference sheet into the new layer so I can 
quickly sample the hues from it.

08

Experiment with colour Since I work with quite high-resolution images, it would 
be more effi cient if I think about the colour palette that I’m going to use early on. I duplicate 

the current image via Image>Duplicate and resize it to a lower resolution. I then experiment with 
various colour schemes before settling on one. I’ll now build this up in detail on the high-res fi le. 

06

Paint the background I use a 
Flat Curve Thin Stiff Bristles brush to 

paint the background. Begin with a large tip to 
paint the basic shapes but decrease the size 
when working on smaller detail. Now select 
the Mixer Brush tool with the Moist, Heavy Mix 
preset and start blending the colour. Be careful 
not to overblend anything, because the image 
will lose brushstroke detail.

09

Final touch I create a new layer 
at the top called Overpainting and 

then brush over everything. I enjoy adding 
more details and cleaning up the image until 
I think I’m done, then I fl atten all the layers. 
Finally, I add some brightness and contrast 
adjustments with the Curves command from 
Image>Adjustments>Curves. 

10

We take a look at three inspiring 
examples from the canon

The best in 
scenic art 

Style
School

Art genres in 
a nutshell

Artist: Adolf Friedrich Erdmann von Menzel
Title: Laying out the March Dead
Date: 1848
Location/Owner: Hamburger Kunsthalle
● Although this is an incomplete painting, Adolf Friedrich 
Erdmann von Menzel did a good job at portraying lives 
and telling a story. As you can see, there is a lot of variation 
and detail in the crowd. It tells the unfortunate story of the 
March Revolution in 1848.
tinyurl.com/DA-Menzel

Artist: Claude Monet
Title: Boulevard des 
Capucines
Date: 1873
Location/Owner: 
Nelson-Atkins 
Museum of Art
● In this painting, 
Claude Monet hasn’t 
refi ned the small details, 
but he was able to 
capture the environment 
of the city scene really 
well. The soft and fuzzy 
brushstrokes give a 
hazy feeling and 
movement to the 
crowds of people.
tinyurl.com/
DA-Monet

Artist: Georges Seurat
Title: Bathers at Asnières
Date: 1884
Location/Owner: National 
Gallery, London
● The impression of light is well 
illustrated in this painting, 
especially the refl ection in the 
water. This adds to the more 
relaxed feel of this image. 
Although the foreground is 
crowded, these sleepy people 
are lazing in the sun and the 
painting gives an impression of 
quiet, peace and tranqullity 
thanks to the colours used.  
tinyurl.com/DA-bathers

Painting scenery is all about how we feel towards the 
things around us, and it’s unique to each individual person 
because we all have different cultures, impressions, 
experiences and thoughts. If we want to accurately capture 
any city or town, we might use a camera to do it in a split 
second. However, it doesn’t have an opinion or a response 
to the view. We do. These are some examples from the 
history of art that capture the spirit of their scenes.

The masters
Three classic crowded images 

Artist: Adolf Friedrich Erdmann von Menzel
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Digital artists explain the 
techniques behind their 
amazing artwork
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Jennifer Cirpici

Personal portfolio site
www.breakingcanvas.com
Country Netherlands
Software used Photoshop
Jennifer is a self-taught 
graphic designer and 
illustrator from the 
Netherlands. She studied 
graphic design last year, 
has worked for several 
big agencies like Saatchi 
& Saatchi and Leo 
Burnett, and is currently 
a freelance artist.

Source files
available

Photo pack
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Create fantasy 
worlds

What you will learn in this tutorial are several 
basic but essential techniques like blending, 
colouring and painting over a scene comprising 

multiple photos. This workshop is fundamentally inspired 
by the lush mountainous scenery in the movie Avatar. The 
Zhangjiajie Mountains, located in China, inspired the makers 
of Avatar to create the fl oating Hallelujah Mountains; they 
also inspired us and we used stock imagery of this range to 
create this artwork. We’ll go into how you can combine real 
and painted elements (the essence of matte painting) in 

depth, while keeping things easy to follow along. We’ll also 
look at how you can blend stock easily and how essential 
colouring is when it comes to setting an atmosphere. This 
guide will not only help you to create these Avatar-esque 
fl oating mountains, but also to improve your future 
photomanipulations. Unlike the scenes created for the fi lm, 
we will only be using Photoshop to achieve these effects. We 
recommend, however, that you look up inspiring Avatar 
scenes fi rst, or better still, (re)watch the movie to get a few 
ideas for the composition.

Get your head in the clouds First fi nd some 
mountain stock. The sky is white in our image and we 

want to add some clouds. We search for good sky photos, 
paste them over the landscape, then blend using layer masks 
as well as Overlay, Multiply and Normal modes.

Bring in some colour For a green tint, create 
a new layer fi lled with ‘#f6f6e5’ and set to Multiply. 

Next, create a new layer set to Multiply, but fi ll this with a bluish 
gradient at 36% Opacity. Use Curves to up the contrast and 
tweak the greens in Color Balance.
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Fantasy World  2011 Photoshop

Jennifer Cirpici Illustrator and graphic designer

 This workshop is fundamentally inspired by the lush 
mountainous scenery in the movie Avatar

Create a lush environment
Manage your stock, colours and blending

01

Turn your fantasy world 
into a reality

Working
Progress

Step 01: Develop a mountainscape

Step 08: Apply shadows and accents

Step 17: Use mist to blend02
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Floating mountains With the help of CGTextures
(www.cgtextures.com), we source some free landscape 

stock images and blend them together to produce a mountain, 
reminiscent of those in Avatar. This is very much a matter of 
artistic licence so you will have to decide on the scale, shape 
and which materials constitute your mountain when you come to 
constructing it. As previously demonstrated, use layer masks to 
bring elements together, as this will help to blend effectively using 
black and white brushes. Further, make sure that when you are 
using these brushes you are working with a low Flow value as this 
will also help with blending.

Gradient shading Select the fl oating mountain 
and, with a black-to-transparent gradient, create a 

shadow at the bottom of the scene, fading out towards the top 
of the image. Lower the Opacity to 28% and repeat this step. 
Select parts of the mountains from the background and paste 
into the bottom to give it more texture. We’ll go into more depth 
with this in a moment. At this stage, we feel we’re not quite 
there yet with the composition, so to give it a fresh look, we go 
to Edit>Transform>Flip Horizontal.

More depth and highlights To create depth 
and highlights we use a small hard brush, painting 

with black where we want to generate a bit more shadow. We 
set this layer to Soft Light blending and lower the Opacity to 
around 70% with the brush Flow at 70% too. We follow the 
same process with a white hard brush, this time creating 
highlights with the layer set to Overlay. We use this technique 
with all our photomanipulation projects to great effect.

Landscapes
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Mountains and birds We now add in some mountains from another stock 
photo. Set the layer’s blending mode to Multiply with an Opacity of 68%, then make 

the mountains a little greyer so that they all blend well together. Blur the mountains with a 
5% Gaussian Blur fi lter because they are further away and this will create a greater sense of 
depth. Finally, fi nd some nice bird images and paste them into the composition, using the 
Edit>Transform options to match the scene’s perspective and scale.

Quick 
Tip

You may fi nd that you get 
stuck sometimes, and lose 
inspiration or motivation to 
continue with your artwork. 
Some of the best solutions 
are to either sleep on it, take 
a couple of steps back from 
your screen or, as we did in 
this tutorial, just change the 
perspective by fl ipping
it horizontally.

03

04

05

06
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Add some plants In Avatar, the fl oating islands have long vine-like plants to help people move 
from one ‘island’ to another; we’re also creating these in our scene. Take a hard brush and draw some 

simple lines to get the basic plant forms from one mountain to another. Then, with a green colour, add more 
lines over the fi rst set and then a fi nal group of lines in a lighter tone for shading. You can also set some of the 
lines to Overlay.

Mountain vegetation We are now 
going to add some shady plants at the 

bottom of the scene and around the base of the 
fl oating mountain. You can do this very simply by 
taking the hard brush again and, with a grey colour, 
drawing in plants that are hanging down. The trick is 
that they don’t have to look exactly like plants when 
zoomed in, but when you zoom out they should look 
like the silhouettes of trees/shrubs etc. You only have 
to make these plants as complicated as you want to.

Add some clouds To add realism to the fl oating 
mountain and to establish its signifi cant scale and airborne 

position, we add in some clouds, placing them around the bottom 
of the mountain. Render the clouds with channels, put them on a 
new layer, invert (Cmd/Ctrl+I), select the black parts (the clouds) 
with the Magic Wand tool and erase the rest. Blur the clouds with 
Filter>Motion Blur to lend them a greater sense of movement.

Shadows, 
accents and 

eerie mist As this 
project goes on, and the 
more that you work on the 
mountain, the more likely 
you are to notice that it 
requires a bit more of this 
and a bit more of that as 
you work. At this stage, we 
decide that it needs more 
shadows and highlights. 
Repeat Step 6 and go 
into more detail using a 
smaller brush; it’s time-
consuming work, but this 
effort will pay dividends 
when it comes to the fi nal 
result. To generate a mist 
effect, take a soft brush, 
sample the colour from 
the background with the 
Eyedropper tool, and 
brush over the mountain 
and background, 
before switching to Soft 
Light blending.
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Make the fantastical real
The secret is in the details
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Rainbow effect Waterfalls often have a rainbow due to light refracting through the moving water. 
Create a rainbow with your hard brush, as per the screenshot, lowering the Opacity to 80%. Change 

the layer to Soft Light and apply a slight Gaussian Blur, so that the rainbow doesn’t draw too much attention. 
With the soft brush set to Soft Light, add a little more mist coming off the waterfall.

Waterfall details With the soft brush 
sized around 500px, we brush once more into 

the waterfall, but we lower Opacity to 28% and set 
blending to Soft Light. For details, zoom in and use 
a hard brush to make a couple of small strokes, then 
on a new layer, add a series of lines. If they look too 
hard, you can blur them a bit. Add vertical lines until 
satisfi ed then apply some smoky mist underneath 
the cascade.

Landscapes
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Additional highlights We come again to a point 
when we’re adding more highlights – you can never get 

enough of them! The more you have, the more detail you’ll have 
in your scene and the better it will look. We’re also adding a bit of 
green here and there with a hard brush. By doing this we are giving 
it a more digitally painted feeling, but don’t forget to make sure that 
everything blends well together, with no one area stealing the show.

Work on 
mountain 

edges Because 
we could never have 
rendered the rock in a 
way that made plants at 
the edges look good too, 
we need to add our own 
fl ora to the mountain 
edges. This will better 
blend the mountain into 
the sky and reduce that 
copy/paste feel. Again, 
you don’t have to paint 
the plants/leaves very 
realistically as they’re 
in the distance and 
shrouded by mist. 
Make sure not to use 
one colour – always 
add highlight/shadow 
tones too.

Splash out! Before 
making a waterfall, look up 

some reference to get an idea of the 
basic structure. As you will see, there 
isn’t too much detail in a waterfall – it’s 
basically a white sort of cloud. Take a 
soft brush at around 150px and brush 
in a thick line in white, then apply Soft 
Light blending at 25% Opacity. This 
is the start of the waterfall and shows 
how it’s fl oating. We now add a 
couple of fi ner lines either side of the 
waterfall to serve as edges.

We need to add our 
own fl ora to the mountain. 
This will better blend the 
mountain into the sky and 
reduce that copy/paste 
feel. You don’t have to 
paint the plants realistically 
as they’re in the distance 
and shrouded by mist

The final touches
Wrap up your fantasy world
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Mountain shadow Because it’s a fl oating mountain, we need to 
add its shadow to the area it’s fl oating over. We decided to put some 

shadow on the rocky column closest to it and on the ground, with the soft brush 
set to black at a lowered opacity. Make sure you never do just one shadow; for 
realism, apply several layers of shadow that becomes darker the closer it gets 
to the object. Don’t mess too much with the blending options when it comes to 
shadows, as they need to be almost fully black.

Anything you mist? As one of 
the fi nal steps, we are going to add 

yet more mist around the fl oating mountain 
and make the vegetation around the edges 
a little greener. We add more mist so that 
the mountain merges more seamlessly with 
everything else in the scene, plus it also gives 
a surreal and mysterious mood. Never make 
your mist too white though – instead use a 
colour in the same shade as the background, 
so give it a green tint here. Switch mist to Soft 
Light blending and set the Opacity to 30%.

Final touches Now you can play 
with Brightness/Contrast, Levels and 

Curves adjustment layers. What we also do to 
get focus in this artwork is to create a black-to-
white Radial gradient set to Soft Light and 30% 
Opacity. The white circle goes wherever you 
want to draw focus. Create a new layer, fi ll 
it with black and go to Filter>Noise>Add Noise 
(12.5% and Monochromatic). Set this layer to 
Soft Light and just 5% Opacity. Last but 
not least, wrap up the image with a Smart 
Sharpen fi lter.

We add more mist so that the 
mountain merges more seamlessly with 
everything else in the scene
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Quick 
Tip

When you digitally paint, you 
can use the Rotate View tool 
to navigate your whole 
screen. This way you can 
paint more detailed elements 
without having to turn your 
head. It makes everything 
much more comfortable.

Custom 
brushes

For this tutorial we didn’t just 
use Photoshop’s standard 
hard and soft brushes, but 
we also used a brush set 
from one of our favourite 
artists, Dan LuVisi, who is 
also known as ‘adonihs’. You 
can download the set for free 
from his deviantART gallery: 
http://tinyurl.com/adonihs. 
Do read the usage 
instructions before you use 
them though. LuVisi is a great 
artist and this is a fantastic 
resource, so it’s defi nitely a 
must to download when 
working on a matte-painting 
project like this.

16

17

18
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Digital artists explain the 
techniques behind their 
amazing artwork
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Alexander 
‘miNze’ Thümler

Personal portfolio site
www.minzketchbook.com
Country Germany
Software used Painter, 
Photoshop, Google 
SketchUp
I’m currently a design 
student in Nuremberg, 
Germany and a freelance 
concept artist. I also do live 
paintings via online 
streaming. After graduating 
I will look for a job in the 
entertainment industry.

Landscapes
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Paint 
sci-fi 
settings

Corel Painter 12 includes a new tool as 
part of the set called Kaleidoscope 
painting. In my humble opinion, the 

Kaleidoscope tool is Corel’s most recent 
masterpiece. It’s not only able to provide up to 12 
axes of reflection but also offers the function to 
choose the axes’ angle, colour and the position of the 
source point. In general I am no friend of mirroring 
paintings because perfect symmetry is not something 
that really happens in nature, for example, perfectly 
mirrored faces do not look very natural and appear 
lifeless. The Kaleidoscope tool, however, avoids this 
problem. It doesn’t mirror the pixels you’re creating 
but the brush tracking itself, so if you’re using an 
asymmetric brush the kaleidoscopic painting won’t 
be symmetrical either, truly simulating what you are 
doing. There are millions of ways to use the tool from 
creating patterns, drawing portraits, designing 
vehicles, robots, monsters and weapons to just doing 
experimental live painting performances. I heartily 
recommend you get a copy and play around with it.

In this walkthrough I will show off the way I used the 
Kaleidoscope tool in my futuristic image to create the 
pattern that’s applied to the fish-like aircraft’s surface. 
In my image the kaleidoscope effect lends the vehicle 
a metallic, almost armoured look, contrasting 
beautifully with the natural elements such as the rocks 
and trees. Other artists have used this tool in different 
ways – the Painter 12 box, for example, features 
artwork by Andrew Jones which uses the 
Kaleidoscope painting tool to create dense and 
textured patterns. It can be used to create abstracts, 
or with Painter’s Pattern Pen tools to create and place 
motifs for fabric, décor and other image elements. 
Let’s take a look at how it works and how you can 
use it like I have to get you started. 

Ancient Home 2012 Painter, Photoshop

Alexander ‘miNze’ Thümler Digital painter

My goal was to paint a very 
atmospheric alien world and use 
Painter’s Kaleidoscope tool to create 
a unique pattern for a sci-fi vehicle

Use the Kaleidoscope 
tool for futuristic art

Working
Progress

Step 01, Sketch your imagination

Step 04, Spaceship design

Step 08, Paint with scales

Step 10, Last details
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Source files
available

Sketch
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Design the basic elements
Begin your scene and colour composition

Landscapes
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Sketch your imagination There are two different ways I start off with a painting. 
The fi rst is having an idea and developing an image in my mind. I make sketches and 

thumbnails of my painting concept and try to stick to it when I’m working. The second is just having 
an idea, starting off and seeing what comes out. For this image I created a sketch fi rst.

01

Ground the canvas Grounding is a very important 
step in my process because I’m afraid of blank, white 

pages, just as almost every artist is! The best way to start the 
painting is to erase that endless white space of nothing just by 
fi lling the canvas with basic tones.

02

Environmental shapes I used the Selection 
tool to bring in some basic shapes like the rocks in the 

foreground and the clouds in the sky. I also played around with 
blend modes like Multiply and Overlay to create contrast.

03

Spaceship design My task was to create a vehicle 
that’s covered with kaleidoscope patterns and I thought 

a lot about how this vehicle should look and how I would apply 
symmetrical patterns to it. I came up with the idea of designing a 
fi sh-like aircraft that’s covered with modern, stylised scales.

04

Include a story Besides bringing in details like rocks and leaves, and working out the 
atmosphere and lighting of the scene, it’s very important to create some kind of story to 

make it easy for the beholder to get into the painting. This image shows the story of a couple 
discovering the town they used to live in before the apocalypse.

05
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More inspiring artwork 
from miNze’s portfolio

Sci-Fi Atelier
2011, Painter, Google SketchUp
● One day I asked my best friend 
during a workshop in Berlin to give me 
a spontaneous task I could deal with. 
His task was ‘Sci-Fi atelier’. I started 
doing a simple SketchUp model and 
worked over it in Painter.

Bird Collage
2010, Painter
● This is a painting I did for my 
girlfriend for her birthday. I used photo 
references and painted each bird on its 
own layer with the Pattern Chalk brush.

Resting Birds
2012, Painter
● This is a painting I did via live stream. 
It’s one of the pieces where I started off 
with absolutely no idea what I was 
going to paint. I just listened to the 
music and watched the painting 
evolving itself.
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Keep it simple There are many different ways to use Painter’s 
Kaleidoscope tool. You’re free to use a total of 12 axes of refl ection to create 

your painting. For my fi sh-scale pattern I decided to use a horizontal and a vertical axis 
only. I kept the basic structure simple to avoid overfi lling the aircraft’s body.

06

Texture effects 
I covered the fi sh 

vehicle’s body with the pattern 
texture completely then I 
simply painted on the orange 
structures while preserving 
their transparency. This made 
the pattern look like a shiny net 
on a high-tech nano suit.

Last details In the fi nal step I increased the size of the vehicle and boosted 
some contrast to offset it a little more from the rocks in the background. I also 

added a few details and dropped the tree on the left to improve the composition.

10

09

Paint with scales When the pattern was complete I was able to use Painter’s Pattern Chalk to apply it onto 
the surface of the aircraft just by painting dynamic strokes on a separate layer. As the pattern didn’t really fi t the 

form of the vehicle straightaway, I warped it using Painter and Photoshop’s Transform tools. 

08

Create 
structures I didn’t 

want to apply every single 
scale to the vehicle’s surface, 
so I decided to create a 
seamless pattern texture and 
started to copy and position 
them. While creating the 
pattern, it is very important 
to make sure that all of the 
scales are arranged exactly, 
otherwise the texture will 
contain fractures.

07
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Paint 
moonlight 
into fantasy 
scenes

Digital artists explain the 
techniques behind their 
amazing artwork
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Amber Hill

Personal portfolio site
vantid.deviantart.com
Country US
Software used Painter
Amber’s art education 
consists mostly of 
dissecting dead things and 
watching live ones. She 
specialises in fantasy wildlife 
art – fl ights of imagination 
inspired by the living and 
breathing world. Amber lives 
on the road, moving from 
place to place in pursuit of 
newness and wonder. 

There are few things in life that can evoke more 
of a sense of loneliness and contemplation than 
the soft susurration of wavelets lapping a sandy 

shore under the stark glow of the moon. Moonlight calls 
to the artist, arousing a desire to capture that ethereal glow in 
pigment or pixels, and many classical pieces of work are an 
answer to that call. It’s almost instinctual.

The human eye cannot see much colour in moonlight, 
mostly shape and movement, so the moonlit landscape is 
drained of tones. Blues and silvers dominate with a few 
warmer colours here and there. Moonlight seems to fi ll every 
nook and cranny of the scene except for areas of stark, black 
shadow where no detail can be seen. Even when the moon is 
not full, she shows beauty in the form of earthshine, a unique 
lighting phenomena where the moon is lit from refl ected 
sunlight from the earth’s surface. 

A panoramic view is a fantastic way to illustrate a sweeping 
landscape empty of all but the viewer and one moon-struck 
individual, which, in this case, is a coyote. Even this old 
trickster can’t resist the enigmatic beauty of the full moon.

Coyote Beach 2011 Painter

Amber Hill Fantasy wildlife illustrator

Learn to create textures fi lled with 
the magical light of a full moon riding 
high in a glowing star fi eld

Landscapes
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Valuable values Before you start the painting proper, take 
the time to work out some composition thumbnails. Once you 

have a sketch you like, rough in your values. A good greyscale is vital for a 
moonlit piece because the value changes are so sudden.

Wash the sky Paint the sky a deep, violet blue 
with the Soft Airbrush tool. Toggle the value map, 

making sure it’s set to Multiply, and use the Eyedropper 
tool (Alt/Opt) to grab some even darker purples to paint 
into the sky. Use the different tones to create a gentle 
gradient that lightens near the moon.

01

03

Set the tone 
Create a new layer 

and sketch using your 
thumbnail as a guide and 
set this layer to Multiply. 
Flood fi ll the canvas layer 
with purple-blue to create 
the mood of the piece.

02

Source files
available

Value study
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Start the basic shapes
Block in your seascape, shadows and highlights

Rough in the 
tide Using the same 

colours as the sky, block in 
the shore and rocks. Notice 
how the refl ection appears 
slightly shorter than the 
actual rock. This is because 
the perspective is not level. 
Paint lighter values along the 
bottom where the water froths 
against distant edges. 

Create space 
Striations in the sand 

give the landscape a sense 
of movement and openness. 
Cut the lighter value sand 
streaks above the refl ected 
rock and see how realism is 
instantly achieved, even at this 
rough stage. Now begin to 
develop rock textures.

Create harmony The coyote’s face is pointed 
toward the moon so his eye is barely visible and won’t 

have much detail at this angle. Select the canvas layer again 
and paint more beach streaks with the Soft Airbrush, varying the 
opacity as needed. Use some of the desaturated purples from 
the coyote in the sand for harmonious colour.

Coyote character Block in the coyote with the Round Oil Pastel. He’s in the way of 
the nice refl ection! Coyotes are jerks that way. His colours are rather muted in this light. The 

brown is actually a desaturated purple that appears more neutral due to the surrounding colours. 

Make waves Paint the fi rst signs of sea foam 
with the Round Oil Pastel using wide, gentle arcs 

and a pale grey-purple. Follow some of the sand streaks 
toward the horizon.

Rock it The rocks 
have a stark contrast 

of light and dark with very little 
detail in the shadow. Moonlit 
texture is jagged, with crooked 
shadows. Allow your hand to 
be random and you will start 
to see patterns in your strokes 
that you can refi ne into rock. 
The coyote seems to have 
picked up more fur texture, 
too. Sneaky.

Begin the 
surface The 

texture of the tide is a series 
of scalloped light values. 
As the leading edge rushes 
onto the beach, it has a 
modifi ed cylinder form and 
casts a defi nite shadow. 
Study reference photos to 
understand the tide. Paint the 
moon a light blue.

04

05

07

06

08

10

09
Compose 
with values

Large shapes of light or dark fi t 
together like pieces of a puzzle in 
composition, so direct the viewer’s eye 
with a path of light. Here, refl ected 
moonlight stabs through the piece to 
meet with sea foam that carries on to 
the coyote, around through the rocks 
and back to the moon.

Landscapes
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The key elements
Add water features and the moon’s refl ection

Think about form Refi ne the little wavelets in 
the background with dark purple. There is a concave 

area that is a trough between two very low, gentle waves. The 
ripples in the water defi ne the shape. In a moonlit piece, simple 
contrasts of dark against light are vital for creating shape.

Water work Not only are there lines of foam going 
in the direction of the waves, but foam crisscrosses and 

catches the light horizontally. These lines all aid in giving the 
water perspective and motion. Paint the large shadow of a swell 
that is close to the viewer.

Not too much detail Continue to refi ne the water. 
Develop shadows and highlights, but keep it simple, 

as the human eye cannot pick out very many value changes in 
moonlight. It should look like beaten metal in the background. 

Make a swell 
Begin to texture some 

of the points of the wavelets. 
Keep in mind that the swell 
is just a tube and that they 
should curve over that. Create 
a new layer and drop in some 
guidelines for the refl ection of 
the moon. Hold the Shift key 
for swift, clean lines.

Create fur Etch 
dark – almost black 

– textured Vs in the coyote’s 
neck to depict the shaggy fur 
and paint moonlight on the 
face where the ruff is turned 
away from us. Be sure your 
strokes follow the direction of 
the fur, even if it seems to be 
coming right at us. 

Begin the refl ection Drop in the beginnings of the moon’s refl ection on the water 
within these lines and then delete the layer you drew the guides on. Make sure that there is a 

break in the line of the refl ections where the swell is blocking the light. 

11

12

15

13

16

14

A night 
out

Take the time to go outside 
and observe the effects of 
moonlight fi rst hand. Study 
the shadows and the lack of 
detail within those areas. 
Refl ect on how the 
moonlight makes you feel 
and bring that back with you 
to your workspace.
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Refine the scene
Use selection tools and paint more detail

Swell surgery The original position of the swell seems 
wrong, so I use the Lasso tool (L) to select a section of it. 

Ctrl/Cmd serves to lift a chunk of the canvas and I drag it to where it 
looks better. Never be afraid to make a drastic change for the good 
of your painting.

Paint distant water The missing texture is quickly patched up with the Round Oil 
Pastel tool. Paint the water in the distant background using smaller brushes. Hold Shift for 

choppy horizontal strokes and alternate between dark and light values.

Create bubbles Foam needs bubbles, so paint dark 
dabs in the white water and draw bubbles with the light 

purple. Some are tucked inside the froth and are more round, 
while others sit like domes on the surface. The little bubbles have 
highlights from the moon and will make the painting seem alive.

Remember the fundamentals Complete the wave foam keeping perspective 
in mind. Although the lines are not perfectly parallel, they will begin to converge 

somewhat the further they are from shore.

17 18

19

20

Landscapes
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Observe how other artists have 
handled the subject of moonlit 
landscapes over water

By the light 
of the moon

Style
School

Art genres in 
a nutshell

Artist: Ando Hiroshige
Title: Full Moon Over a Mountain Landscape
Year: 1834
Location/Owner: From Eight Views of Omi print series
● Master ukiyo-e artist Ando Hiroshige, who is known for 
his beautiful landscapes, created many pieces that feature 
moonlight. The colour scheme is simple, but nonetheless 
it is powerful enough to throw us into the atmosphere of 
an Eastern nighttime, long ago. 
tinyurl.com/DA-ando-hiroshige

Artist: James Abbott 
McNeill Whistler
Title: Nocturne in Blue 
and Silver – Chelsea
Year: 1871
Location/Owner: 
Tate Gallery
● James Whistler was 
inspired by Hiroshige’s 
artwork and created 
delicately layered 
paintings of the Thames 
at night that also 
incorporate fl at areas of 
colour. This series of 
paintings is known as 
his Nocturnes. tinyurl.
com/DA-whistler

Artist: Joseph Wright 
of Derby
Title: Bridge Through a 
Cavern, Moonlight
Year: 1791
Location/Owner: Derby 
Museum and Art Gallery
● This painting takes on a 
warmer colour scheme than 
most moonlit scenes. However, 
the large areas of darkness and 
light source (that seems to 
come from everywhere not in 
shadow) tell us it’s the moon 
and not the sun in the sky. 
tinyurl.com/DA-wright

There are many ways to represent moonlight in art, 
however, all moonlit paintings share similarities. All have 
large areas of darkness, the disc of the moon prominent 
in the composition and tonal harmony. Greys and blues 
dominate. Many artists strive to capture the eerie luminosity 
of moonlight to evoke feelings of unreality.

The masters
Three classic lunar portrayals

Artist: Ando Hiroshige
Title: Full Moon Over a Mountain Landscape

Render 
more 

fur Most of 
the coyote is in 
shadow so not 
much detail can 
be seen. Add 
more of that 
blue-black to 
develop the fur 
texture. Dabs of 
a slightly lighter 
blue create the 
illusion of fur 
clumps without 
having to 
worry too much 
about detail.

The coyote’s anatomy Time to get our coyote into shape. His anatomy is worked 
out and the planes of his face are properly arranged. It’s always helpful to have a sketch 

to refer to at this stage.

Bounce 
light Work 

around the body, 
adding scruff 
and fl uff. Only his 
topline is very well 
lit, which causes an 
effect known as rim 
lighting. Paint very 
faint bounce light 
on his sides where 
the moonlight is 
refl ected from 
the sand onto his 
lighter fur.

22

21

23
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Landscapes
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Change it up Vary the Feature slider just a bit for a more 
natural-looking sky. Create a dense line of stars where the 

Milky Way would be. Once you are happy, erase all the overspray 
and have a cleanup.

Paint the Milky Way On a new layer, lower the Opacity of the brush to 10% and 
paint the clusters of the Milky Way. Use the Eraser tool to cut out sections of cosmic dust 

to give it the look of a galaxy, then merge this with the star layer. 

Paint the stars Make the brush big and fl oofy, and spatter dots 
all over the sky with a light blue colour – so pale, in fact, that it is almost 

white. Change the opacity of the brush for varying effects and don’t worry about 
overspray right now.

27

28

26

Rim light 
Pick out the 

edges of fur with a 
small brush and a 
pale, silvery blue. 
Do so sparingly, 
though, as it’s easy 
to go overboard 
with this type of 
lighting, resulting 
in a fl at-looking, 
cardboard cutout 
of a subject.

The Variable Splatter tool Select the Variable Spatter airbrush 
tool to paint some stars. Create a new layer and test the look of the brush. 

Below are a couple of examples. The feature changes the size of the dots, so 
adjust as needed to best fi t your star size.

24

25
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Star fi re Create a new layer. Set the mode to Overlay and load a small, 10% Opacity Soft 
Airbrush with ice blue and gently glaze a few stars with a celestial glow. 

Underpainting Focus on fi nishing the moon’s 
refl ection – this is the underpainting for the special lighting 

effects to come. Blend the colours with a regular Oil Pastel.

Specular 
highlights Add all 

the specular highlights to the 
bubbles and then paint light 
spots on the foam where it 
catches the moon’s refl ection. 
Add more bubbles where 
needed, then dab on some 
shadows cast by the foam. 

Create overlay layers On the star glow layer, 
airbrush the moon with a light, peachy orange. Paint 

the moon’s refl ection, sea foam, rim light on the coyote and 
anywhere else you want to glow too. This warm colour will show 
through and lend an ethereal quality to the scene. 

Complete the moon Create one last layer and, 
with an ice blue airbrush, paint the cool blue moonlight 

we are all so familiar with on top of the peach overlay. 

Touch it up Create 
a new layer above 

this overlay. Eyedrop colours 
and paint in touch-ups where 
the colour seems too strong, 
break up the contour of the 
light to make the water dance 
then do the same on the 
coyote for extra fur texture.

Build sand texture Create a new layer, fl ick sand 
granules over the streaks and then lightly erase to push 

back the texture. Be careful not to overpower the soft forms of 
wet sand with too much crunchy, dry looking sand. Erase any 
overspray and drop the layer to the canvas.

29 30

32

33

34

35

31

Highlight and tone
Perfect your moonlight shade with overlay layers
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Design
destructive 
cityscapes

Landscapes

206  Fantasy Art Genius Guide

206-211_FAGG_01.indd   206 05/07/2012   12:38

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


This guide is all about manipulating subjects and scenery into an evocative digital matte painting. More 
specifi cally, you’ll discover how to create a post-apocalyptic world using a combination of photography, stock, 
Photoshop, a graphics tablet and your drawing skills.

The theme for this piece of work comes from Vitaly Alexius’s numerous urban-exploration trips, adventures with his wife, 
Meeshka, stock imagery from iStockphoto, as well as original photography shot by Alexius himself. His primary inspiration 
comes from his journeys across the abandoned cities of Siberia, where he was born and lived for much of his life. To shoot 
your own stock you will need either a basic point-and-shoot camera or a DSLR. When starting to create both original 
photomanipulations and digital paintings it is imperative to assemble a massive database of stock. This can be done by 
going out every day and taking photos of everything interesting you come across: buildings, clouds, rocks, trees, cars, etc. 
You can also use stock imagery from the internet for those more specifi c images that are tricky, or even impossible, to get.

Photoshop is the best software for digital photomanipulation since it handles brushes, layers and effects extremely 
smoothly – far better than any other program. The newer versions are the fastest when it comes to loading many layers, but 
you don’t need CS5 to complete this tutorial. You can emulate the scene that we have created here, but why not use your 
own stock and come up with your own truly unique apocalypse?

Courtesy of
iStockphoto
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techniques behind their 
amazing artwork
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Vitaly S Alexius

Personal portfolio site
http://vs.darkfolio.com
Country Toronto
Software used Photoshop, 
Illustrator
Using a graphics tablet and 
Photoshop, Vitaly creates 
digital paintings, graphic 
novels, CD covers and more.

Source files
available

Stock images

Awakening 2011 Photoshop

Vitaly S Alexius Illustrator

A great pile of rubble is pretty much essential for a post-
apocalyptic artwork! Rubble can be found and photographed on 
construction sites in any large city, though take care and ask 
permission beforehand if it’s on private land
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The survivors 
For the characters 

in the painting it is best 
to photograph friends or 
collaborate with professional 
models/photographers who 
can be found on sites like 
http://modelmayhem.com. 
These photos can be used as 
reference or put directly into the 
painting, depending on how 
fast the image has to be done 
and on how realistic or stylised 
the fi nal look needs to be.

Find the right background 
We begin by fi nding the perfect 

city backdrop for a post-apocalyptic, 
skyscraper-fi lled, decaying world (the 
iStockphoto ‘5489812’ image on the disc). 
Stock of cityscapes can be shot locally or, 
for something more specifi c, can be bought 
online. It’s important to purchase licensed 
stock, because copyright laws always apply.

Source the middleground Next, we use an already broken-down 
building from our own image library (on the disc). Perspective matching 

is important, though if you are creating a ruined landscape, the buildings will be 
tipping sideways and collapsing/twisting anyway, so a linear perspective needn’t 
apply. However, a sense of organised chaos is a must.

Foreground 
A great pile of 

rubble is pretty much 
essential for a post-
apocalyptic artwork! 
Rubble can be found 
and photographed on 
construction sites in 
any large city, though 
take care and ask 
permission beforehand 
if it’s on private land. 
Having a library of these 
sorts of images will 
come in handy for future 
projects too, so make 
sure you always have a 
camera on you, just in 
case you see anything 
while out and about.

Landscapes
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Bringing about the
end of the world

Working
Progress

Step 05: Pull together the stock

Step 11: Match the contrast

Step 18: Lighting with blend modes

Apocalypse now
Transform stock into a stunning scene of destruction

01 02

03

04

Having a library 
of images will come 
in handy for future 
projects too, so 
make sure you 
always have a 
camera on you, just 
in case you see 
anything while out 
and about
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Put it together 
Open all of the 

photographs in Photoshop. 
Create a new fi le, setting image 
Width and Height to something 
over 3,000px (in fact, you can 
pick any desired size; as long 
as it’s more than this resolution, 
you can later print and exhibit 
it anywhere). Also set the 
Resolution to 300dpi. Tool basics Using the Lasso tool, you 

can now crop, cut and paste the found 
background, middleground, foreground and 
character images all into a single fi le. The selections 
do not have to be overly neat at this stage, as 
edges will be refi ned in upcoming steps. To select 
additional items with the Lasso tool, simply hold 
down the Shift key while using it. On the other hand, if 
you want to take things away from the selection, hold 
the Opt/Alt key.

Layers The Layers dialog is a godsend for 
photomanipulation projects and, as you’d 

expect, extremely useful for managing layers. (To see 
the Layers palette if you can’t already, go to Window> 
Layers.) By clicking on a specifi c layer in the Layers 
palette, give each one a recognisable name like 
‘Background city’, ‘Robot’ or ‘Happy cloud’, etc. It 
makes layer organisation a whole lot easier when the 
painting reaches upwards of 100 layers.

A little magic To copy the image to a new layer in its new fi le, simply hit Cmd/Ctrl+C to copy and 
then Cmd/Ctrl+V to paste. You can select and move layers around using the Move tool – found at 

the top of the main Tools bar. Unnecessary elements (such as the greenscreen behind the two models, for 
instance) can be selected using the Magic Wand tool and removed with a tap of the Delete key. Tidy up edges, 
if needed, with a small Eraser tool.

Colouring with layers Create a new layer using the New Layer button located at the bottom of 
the Layers palette. Next, set this to Color in the blending mode drop down. Fill the layer with a black 

colour using the Color Selection tool, which can be found at the base of the Tools bar, followed by the Paint 
Bucket tool.

Transform layers If it is needed, 
individual layers can be fl ipped upside 

down/sideways, scaled, rotated, warped, distorted, 
etc, using the comprehensive Edit>Transform 
menu. These options are fun to play with, but at the 
same time extremely useful for resizing layers and 
correcting perspective.
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Adjust contrast Select an 
individual layer and then head to 

Image>Adjustments>Brightness/Contrast to play 
with the tonal settings of each layer. Repeat with all 
until the contrast of each looks more striking. Try to 
keep the saturation/contrast fairly consistent across 
the various elements so it feels as if they belong 
together in the same scene. There are many useful 
and powerful adjustment options to play with in 
Photoshop that are often overlooked, so feel free to 
explore them throughout this tutorial.

Brush tool in depth Go to Window>Brushes to 
call up the Brushes dialog. This panel calls up many 

more possibilities and is great for tablet users, as it enables you 
to manipulate brush dynamics, pressure, angle, etc, to the nth 
degree. This menu takes a bit of experimentation to get used 
to, as instead of a real-world, solid paintbrush we are using 
a digital representation of a brush limited to specifi c options 
depending on the selection.

Shape Dynamics Clicking on Shape 
Dynamics in the Brushes menu gives you 

the option of controlling the brush via the Pen 
Pressure parameter; make sure that this option 
is selected. Enabling this integrates the tablet 
pressure (ie how hard the pen is pressed against 
the tablet surface) with brush thickness. Select 
the Smoothing parameter if you want smoother 
brushwork. Other options here make the brush more 
or less ‘jittery’. Experiment!

Smudge tool When an artist works with oil paints, the brush naturally smudges the paint across 
the surface of the canvas and each brushstroke blends into those beside it. To replicate this effect best 

in Photoshop, various custom brush shapes are used with the Smudge tool. Many varied custom brushes can 
be found via a quick Google search for free or can be purchased in packs online at a range of art sites, such as 
deviantART and CGTextures.

Using the Brush tool effi ciently requires a 
great deal of practice. Don’t be discouraged if 
the brushstrokes don’t come out perfect the 
fi rst time round

Landscapes
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Brushing up Using the Brush tool effi ciently requires a great deal of practice. Don’t be 
discouraged if the brushstrokes don’t come out perfect the fi rst time round. Mastery of the 

Brush tool comes only with years of experience. Use the Opacity parameter to vary your strokes for 
more diverse effects.

12

14

15

13

Quick 
Tip

Making the painting black 
and white from the beginning 
helps manage contrasts. 
Even before Photoshop 
existed, painting masters 
would kick off with a 
black-and-white sketch to 
help establish values, 
contrasts and shadows, 
before advancing to painting 
the scene in colour.
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Head in the clouds For more detail images of clouds and buildings are taken from the AP 
archives and iStockphoto. Using the Brush and Smudge tools, as before, they are re-painted to look 

more post-apocalyptic. Using the selection and Move tools, skyscrapers are slanted and placed behind other 
skyscrapers to develop depth.

Extra textures Rubble stock is inserted 
into the front of the painting, beneath the main 

characters to boost tactility. Various junk and debris 
is scattered on the road, which is a shot of a busy 
LA highway, while a collapsing bridge adds more 
drama. All of the textures are inserted and re-painted 
to make them look ruined. The Color layer at the top 
of the layer stack is used to give the scene consistent 
colours and a variety of large round colour brushes 
are applied for fi ner details.

Lighting effects New layers are painted 
with the Brush tool and set to the Screen 

blending mode to make dust clouds of light between 
buildings in the distance. The opacity of each layer is 
tweaked to perfection; take your time with this. Next, 
several more buildings are added to the painting to 
bulk out the city, and new layers are painted with a 
large brush set to Multiply blending to make specifi c 
parts of the picture even more dark and gloomy.

Mechanical suit Next, a number of 
textures which were shot in a metal scrap 

pile in Nova Scotia, Canada, are used to create 
the mechanical outfi t of the ‘robot’. Once these are 
imported, a great deal of work is done, carefully 
cropping them into the suit and painting many extra 
parts by hand to emphasise wear and tear. Use your 
own creative eye here to piece together the textures, 
always bearing the harsh environment in mind.

Final touches To wrap up 
this post-apocalyptic piece, 

an extra building is inserted into the 
background to fi ll a space above the 
kneeling robot fi gure. Last-minute 
details are painted in with the Brush tool 
here and there, such as extra shading 
on the foreground rubble and some fi ery 
glows cast by the fl ames in the distance. 
The painting now has many layers, each 
one named appropriately for greater 
ease if any post edits are required.
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The end is nigh
Apply fi nal touches to ‘ruin’ your image

Quick 
Tip

Use the Load Brushes option 
to install new brushes. Use 
the brush and Smudge 
method to smooth out all 
brushwork, zoom in and out 
lots by hitting the Cmd/Ctrl 
and ‘+/-’ keys. Cmd/Ctrl+Z is 
a lifesaver if you make a 
mistake and want to undo.
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Paint
fantasy
scenes

Not many realise that artists need to have 
a solid grasp of physics when creating a 
painting. After all, everything we see is a 

product of light bouncing off objects – a highly 
scientifi c concept – and when we paint we are merely 
trying to create the illusion of this effect in a 2D 
format. A better understanding of how light reacts in 
different situations and how light affects what we see 
will directly improve your work.

Every surface interacts differently with light. Water is 
one of the trickier substances to portray, and yet 
many artists still decide to take on the challenge. It is 
soothing and calming, but mysterious at the same 
time, and this contrasting, evocative nature is 
probably what attracts them. Not only does water 
behave in many different ways, but the fact that it is 
highly refl ective adds to what makes it so beautiful as 
well as so diffi cult to render realistically.

Before starting on an illustration, you should 
defi nitely research the topic and collect references. 
One thing that is always useful to bear in mind when 
you create any painting is that if it doesn’t look right, 
fi nd out why and change it, don’t just carry on hoping 
it will improve. With something as complex as water, 
following this rule of thumb will save you a lot of 
heartache. If it looks like water, you’ve succeeded – 
even if it doesn’t match your references exactly.

For this tutorial I will be painting a mermaid 
standing in a shallow rice paddy. She will be spinning 
and wielding a sword in front of some shocked kids 
who were quietly fi shing. The water effects that will be 
used in the artwork are splashing, caustic light 
refl ections, water refl ections and water ripples.

Whether the water plays a big part in the illustration 
or just works as a backdrop, the following tutorial will 
hopefully give you a good idea of how to approach 
painting water digitally and what to keep in mind.

Seeing Magenta 2012 Photoshop

Lili Ibrahim Concept artist and illustrator 

This tutorial will guide you through 
painting realistic water and how to 
achieve the look of refl ections

Realistically render a 
watery scene in PS

Working
Progress

Step 02, Sketch it out

Step 06, Prepare for effects

Step 10, Break the surface

Step 15, Final touches

Source files
available

Sketch

Landscapes
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Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Lili Ibrahim

Personal portfolio site
www.liliibrahim.com
Country UK
Software used Photoshop
I think I always knew I 
wanted to do art for a 
career. I moved to England 
from Sweden three years 
ago to study illustration and 
animation at university, and I 
haven’t looked back. 
Graduating in June, I’m 
currently looking for full time 
or freelance work.
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Colours On a separate layer I add colours, 
setting the blend mode to Color or Overlay. 

If you don’t have a clear idea of what to do with your 
colours, this stage can take a long time. Put each on 
a new layer so you can adjust them separately. 

04

Block out hues 
When values and colours 

are ready you can start blocking 
out the shapes a bit more. This 
is a very messy process and I 
recommend you keep it that way. 
The key is to not zoom in, but work 
on the whole image to make sure 
there aren’t any parts that get 
fi nished before the others. 

Prepare for effects A lot of water effects are added very 
late in the painting process. This grab shows the stage in the 

painting that I got to before I started working on the water. As you can tell, 
the fi gure is easy to read and there isn’t much noise in the water. 

05

06

Brainstorm Do not underestimate the power of a 
good brainstorm. Before you start on your illustration, 

always grab your sketchbook and throw down some 
thumbnails to give you a quick idea of what you are dealing 
with. At this stage, anything goes!

Values By putting down the basic values in greyscale I can colour it later without worrying 
about light and shadow. At this stage I have been thinking about some of the water’s 

attributes. Because water is highly refl ective, I have made it refl ect the bright sky. 

Sketch it out After 
settling on an idea and 

a composition, open a new 
document in Photoshop and start 
sketching it out. There is still room 
for adjustments, so don’t be too 
precious with your lines.

01

02

03
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Understand the image

Location Even though the background 
is simple to not distract from the character, 
detail can tell more about the location. I’ve 
included irrigation ridges seen in Eastern 
paddy fields, mountains and, of course, 
my startled characters.

5

Detail Little water speckles on the 
surface, along with lines of water running 
down, show that the tail has just been 
emerged from the water and is still wet. 
The slightly offset and faded part below the 
surface adds depth and perspective.

4

Movement Water is useful for conveying 
movement in a picture. Adding water 
spraying off of objects in motion lets the 
viewer know what direction they’ve come 
from and that they are moving fast! Great 
for our dynamic mermaid.

3

Colours You don’t want the colours to 
compete or overwhelm. Try to keep to one 
or two main hues. In this piece I’ve chosen 
pink as the eye catcher – the other colours 
are muted down and I have made sure they 
all look good next to it. 

2

Early ideas The reflections of the 
mountains and the two sitting characters 
are added to the piece in the early 
sketching stages because they have an 
impact on the overall composition and the 
values relating to the main figure.

1

1

Key techniques

2

34

5
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Refi ne the light Paint the squiggles on the parts 
of the mermaid that are close to the water surface. 

These will be the most obvious areas of caustic light as they are 
refl ected up from the water onto her tail.

08

Ripples Objects in water create 
ripples on the surface. By drawing a 

thicker line exactly where the object breaks the 
surface you show how the surface of the water 
grips tightly around the object.

09Caustic light Caustic light is 
created by light hitting the uneven 

surface of water and bouncing onto nearby 
objects. You can achieve this by painting the 
pattern on a layer set to Soft Light mode. 

07
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Work the details
Add splashes, ripples and refl ections

Break the surface To give the illusion of the 
mermaid spinning in the water, I’ve added some 

splashes where her fi n breaks the surface. These linger a bit 
to the right of the image, increasing the feeling of the mermaid 
spinning clockwise. The splashes are painted with a textured 
brush and the layer is set to Normal.

10

Keep rendering As soon as a part of the image looks neglected, I start working 
on it. At this stage the mermaid has had a lot of work done to her. To make her look 

convincing in the environment, I added some texture to her hips, which looks like refl ections of 
the water. The little fi ns covering her chest have had similar adjustments, but refl ect more of a 
green tone from the grass.

11

Don’t be 
precious

If something looks wrong, 
change it as soon as you see it. 
The more you wait the more 
diffi cult it will be to make tweaks. 
Don’t hesitate to copy and paste 
chunks of the image that you 
want to move in the early stages.

Background 
I decide to pay 

the background a bit 
more attention. Apart 
from the little kids 
fi shing, I also added a 
few more rice paddies 
in the distance. They 
all refl ect the sky and 
give a nice break in the 
dark background. 

12
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Background 
ripples 

Ripples on the water 
surface behind the 
mermaid aren’t 
complicated but make 
a big difference. Short, 
horizontal lines on a 
new layer will add depth 
to your water. Make a 
layer with light lines (set 
to Soft Light) and one 
with darker lines (set to 
Overlay). More ripples 
are added where the 
splashing water hits the 
surface to the right.

13

Final touches When all the details are in place, I save the fi le as a fl at copy (JPEG for instance) and 
make the fi nal adjustments on this version. Colours and values are tweaked to my preference and I also 

sharpen it a little to make it look super crisp. As a fi nal touch I added a grainy texture set to Overlay and a low 
opacity for a very subtle effect.

Refl ections A rougher water surface will 
not refl ect as accurately as a still one so bear 

this in mind. As the surface is relatively still in our 
painting, copying the refl ected objects is easy. Set 
the layer with the copied section to a mode that looks 
good (I used Overlay for the kids and Soft Light for 
the mermaid). Erase any parts that are unnecessary.

14

15
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220    Figurative fractals & Photoshop
224   Creating a hybrid portrait
230   Illustrate in monochrome
236   Scale in sci-fi  art
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246   Paint fur effects
250   Magical night painting

Bring mythical beasts to life
Creatures

Let feelings  
and improvisation 
appear on the 
screen and 
drive results
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Figurative fractals 
and Photoshop

Specks details Some of the specks details 
added, using a 21-pixel round soft brush, which is 

something that can be done last if preferred. This adds a 
note of realism as well as a sparkly look which suits the 
glowy style of these fractal-based organic designs. 

Fractal art is created using a program 
where mathematical formulae are entered 
and images are produced representing 

the calculation results as still images or 
animations. The images created are referred 
to as ‘fl ames’.

I fi nd fractals interesting as they echo certain 
patterns found in the natural world. However, when 
fi rst coming across the program Apophysis, I found 
myself fl ummoxed. I could see the shapes but 
couldn’t decipher what to do with them, or at fi rst how 
to progress further.

To begin I chose a few of the more interesting 
looking images gained from the ‘random batch’ 
settings and rendered/saved them as PNG fi les 
before taking them into Photoshop to see what might 
be done with them.

Secondly, I threw out any real input on the 
‘mathematical’ parts and relied at fi rst more on luck 
than intent. To an extent, I still do so.

Photoshop gave more range than Apophysis 
alone could provide for a complete novice such 

Finch  2010 Photoshop Elements, Apophysis 2.02

Gemma Hart Freelance artist

Tricks using ‘random batch’ fractals in combination with 
Photoshop to create images of fi gurative formDigital artists explain the 

techniques behind their 
amazing artwork
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Gemma Hart

Personal portfolio site
rockgem.deviantart.com
Country United Kingdom
Software used Photoshop, 
Apophysis 
I’m a Wolverhampton 
University graduate. I’ve 
been attempting to create 
since I can remember. Due 
to confi nes on time and 
space, my work developed 
more digitally. A friend 
introduced me to fractals, 
which I combine with PS.

as myself, and this began to steer me towards a 
different way of using fractal fl ames in a collage-
like format. I could see fi gurative shapes partially 
formed – the hint of a fl ower or a wing – but not the 
complete shape. 

Photoshop allowed me to combine fractals, giving 
me an advantage of being able to piece together 
simple forms to create complex shapes, and from 
that point develop pieces that are more fi gurative by 
editing out stray lines or repeating and rotating a 
single shape. It becomes possible to build up petals 
and leaf patterns, even animal and humanoid 
shapes, in a few layers or many, depending on how 
many pieces of fractal you choose to combine. 

Assemble Starting to assemble the bird shape, 
the body from one fractal, and wing construction 

from another pair of fractal parts, copy/pasting to assemble.

Shapes A completed branch and 
flower shape; shows first steps of 

copy/pasting to put the pieces together.

Creatures
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Assorted fractals 

220-223_FAGG_01.indd   221 05/07/2012   12:52

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


A lot I discovered can be gained with using what 
can be created from the random batch results. These 
in turn lead to the ‘Finch’ image being created.

The piece began life as seven individually rendered 
fractal fl ames that became a whole mainly through 
one of the simplest of Photoshop processes, the 
humble Copy and Paste. 

The initial idea for the piece stemmed from a 
random batch fractal that to me looked bird-like, so 
the intent became to make a complete bird and then 
a branch from fractal components. The bird already 
partially in hand, I turned my attention to creating the 
branch shape. 

Twig-like renders are quite easy to come by in 
random batches. You can either change the gradient 
to an appropriate colour at this stage or do this later 
in Photoshop with the Hue and Saturation tools.
I found something approximately branch-like and 
rendered it before opening a new blank document 
with a black background in Photoshop and pasting 
the render into it.

The simple process of constructing a branch 
shape came from copying and pasting with the 
occasional resize or the erasing of a stray line. Real 
branches are not the same width all along, so I 

wanted to show some degree of tapering out. The 
initial shape repeated seven times gave me a good 
approximation of a branch. If too many layers 
become a problem, you can always copy the merged 
layers into a new document.

I fi nd it easier to work horizontally when making 
branches, even if the fi nal image will run vertically. 
There is really no right or wrong way to work when 
putting a fractal collage together.

To make the branch more ‘branch-like’, details 
such as leaves and fl owers can play a big part – 
although I opted for just fl owers. Open a new blank 
document and choose a fractal shape that has a 
rough resemblance to a petal, then the steps are the 
same as for the branch-making process, repeating 
and rotating one shape. For fl owers with odd 
numbers of petals, for example, fi ve, use a pentagon 
shape drawn as a guide layer that can later be 
deleted. This helps keep the shapes evenly spaced. If 
you wish, more detail can be added, a second layer 
of petals or centre to the fl ower, with another fractal. 

In the image on the left it’s easy to see initial 
shape. On its own it might not look like anything, 
but in the same image it is shown how one piece 
is copied, repeated and rotated to build up 
a basic flower shape. The image on the right 
shows further development using a second 
fractal as the flower centre, making the shape 
more figuratively identifiable.

Photoshopping fractals
The two fractals need to be combined

Before

We look at some of 
Gemma’s other work

Hoot-hoot
2010, Photoshop Elements and 
Apophysis 2.02
● This little critter came about by 
accident – a piece that sort of made 
itself once it got started. Four separate  
fractal components were used.

Got This For You
2010, Photoshop Elements and 
Apophysis 2.02
● Created using parts of three fractals 
as a gift for a friend. Sometimes I like to 
clash textures with the fractals. Others, 
like this, make use of similar fractals.

Angelic
2010, Photoshop Elements and 
Apophysis 2.02
● I’ve often admired cemetery statues 
of angels – the carving and shapes are 
astounding. I decided to try creating 
one using fractals and Photoshop.

Variations tool Using the Photoshop Variations 
tool to add colour to the highlights of the image. 

In this case I opted for more of a green shade to suit both 
bird and branch, which harmonises colour in the image.

It’s already there The overall image is all there 
– all component shapes forming a figurative image 

together. Copy all the merged layers and paste into a new 
document before adding some colours.

No colour 
Remove the 

background layer 
from the pieces of 
the bird, then copy 
the merged layers  
ready to paste 
into the document 
containing the 
branch – no real 
colouring yet.

After

Creatures
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Play around First, just play with the settings in 
Apophysis, seeing what you can create. Anything 

interesting, render – it might be useful for another creation.

01

This can be coloured as you like with the Gradient 
tool in Apophysis or with the Hue and Saturation tools 
in Photoshop.

It would be time-consuming to create each fl ower 
this way, so again the Copy/Paste functions come into 
play in positioning the fl owers where desired along 
the branch. The only rule here is not to overcrowd.

When the pieces of branch and fl owers are placed 
together in a way that you’re happy with, copy the 
merged layers into a fresh document and close the 
old ones. This is not essential, but with more 
complicated pieces it helps eliminate some of the 
confusion that comes with many layers. 

Now back to the bird in this piece. This was 
created with three random batch fractals – two of 
these making the wings and tail, and one for the 
body. With wing shapes, you can usually make the 
whole shape as a render in Apophysis quite easily, 
but I found it more fun to have all the shapes I worked 
with generated by chance.

With the bird, I found it easier to put the shapes 
together before deciding on an overall colour. Copy 
the merged layers and paste twice into a new 
document, then use the Variation options to change 
the colour of the lighter areas on both upper and lower 
layers before using an Eraser tool to remove areas of 
the upper layer to show the lower layer through.

Copy and paste the merged layers into the 
document with your previously constructed branch 
image. Resize if needed and reposition. Any dark 
areas on layers that might overlap can be erased.

Lastly, fi nish off with extra details added with a 
Brush tool. A soft, round, 21-pixel brush was used to 
add the specks here and there, and a slightly sharper 
one was used to add the bird’s eye.

A border surrounding the overall image is the last 
thing added. I chose one of the colours found in the 
main image to contrast with the dark background.

Creating 
fractals

Most of the hard work is done 
by the software program!

Random batch fractal The second step is 
a random batch fractal image of roughly the shape 

you want, before rendering and taking it into Photoshop.

02

In PS To begin constructing the branch shape for 
the fi nished image, the shape is formed by copying 

and pasting the original, with some resizing and erasing.

03

Copy/paste Copy/paste all layers into a new 
document to reduce the number, then rotate the 

canvas so the branch shape is vertical. Tweak colours to suit.

04

Add a different colour Copy 
the image and paste before using 

the Variation tools to add a different colour 
to the new layer, before erasing certain 
areas to show the first layer’s colour.

Chance
I often fi nd it fun to 
leave part of the 

creativity to chance, letting 
that inspirational moment 
come to me. I fi nd myself in 
the habit of looking through 
random batch renders to see 
if any shape catches my eye 
– in this case the bird shape. 

Add a border Just to finish, 
pick one of the colours from the 

main body of the image and then add 
a thin border around the edges of the 
overall image.
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Digital artists explain the 
techniques behind their 
amazing artwork
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Alyssia Indermuehle

Personal portfolio site
www.3dcelebrity.com
Country Australia
Software used Photoshop, 
Painter, Maya
US-born Alyssia creates 2D 
and 3D digital art in a variety 
of programs. An animation 
specialist, she has worked 
for clients as diverse as the 
US Air Force and MTV. She 
relocated to Australia in 2005 
and took up freelancing. 
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Creating a
hybrid portrait

Flesh out the sketch I blocked in the colours 
underneath the Sketch layer. I then used the 

Artists>Sargent Brush and applied colour, keeping the 
paint loose and letting the strokes flow freely.

I have always thought there was 
something magical about the ability to 
capture true character in a portrait. In my 

experiments with portraiture, I began to imagine a 
combination of human and animal forms. All of us, at 
one point or another, have personifi ed the look or 
actions of an animal. I certainly know that I am guilty 
of attaching human emotions and personality traits to 
my own pets. It is not hard to imagine that a quick 
glance of disgust from your cat was for the latest food 
offering in his bowl, or that the big brown eyes of your 
dog were expressing true remorse for the ‘surprise’ 
she left you. It is these personifi cations of animals that 
make the blending of man and beast on canvas such 
a brilliant combination. In my hybrid creations, I have 
been able to express the inner personality and 
character of a subject that a traditional portrait 
sometimes fails to capture.

The idea for the George portrait came from my 
desire to pay homage to a person who was very 
close to me and recently passed away. Similar to his 
human counterpart, I wanted George to be a classic, 
handsome cat in a military =uniform and the feature 
through which I wanted to channel his inner human 
was his steely blue eyes. With the idea set, I moved 
on to the next stage of development: planning.

Planning is absolutely essential to the success of 
any artwork and, when creating a hybrid portrait, 
there are a few special items that need to be taken 
into consideration in addition to traditional portraiture 
concerns. For example, the fl ow of the cat’s head 
and neck into the proportions of the human body, the 
lighting on fur instead of skin and the posing of the 
‘model’. I have found that the best way to tackle these 
questions is to sketch, and sketch again, until I get 
the desired composition, lighting and proportions.

I always consider the direction of the light source 
from early on in the planning. One main light source – 
as used in many classical portraiture examples – 
allows for the dramatic depth and unity in my image 
that I desire. For the portrait of George, the light 
source is located above and to the viewer’s right.

Soft shading Colours built up as I added subtle 
highlights and shadows. I tried to keep the image 

soft at this point as I would add detailed shading later.

Learn how to create a portrait which is neither wholly 
human nor animal, but a powerful combination of the two

George – An Animal Portrait  2010 Painter & Photoshop

Alyssia G Indermuehle Digital artist

Build the foundations 
The beginning stages are very 

important in a hybrid portrait project. 
Planning is essential, which is why I began 
with a very detailed sketch of the feline 
character I wanted to create.
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Blending on a knife edge Using the Artists’ Oils>Dry Palette Knife, I blended the colours 
of the image together. With this tool I began to hone basic dynamics in the fur and cloth.

Build up paint I added highlights and 
additional paint to certain areas with the 

Artists>Sargent Brush and continued to blend using the 
Dry Palette Knife.

Colours allude to the mood of the portrait. The colour 
palette that I had in mind for this painting consisted of 
muted browns, greys and creams with one main 
colour as the focus. I chose a piercing sky blue/violet 
for his eyes and the sash across his chest to draw the 
viewer in and unify the image.

The portrait began with a simple sketch in Corel 
Painter on a layer above the Canvas base with a 
Pencil>2B Pencil, set to Black at 20% Opacity. The 
early sketch was very light and meant only to indicate 
the basic shapes. I named the layer ‘Sketch’.

Once I was satisfi ed with the composition of the 
character, I then moved on to using the Pen> 
Scratchboard tool. I often utilise the Scratchboard tool 
at varying sizes and opacities when laying down the 
foundations of a painting as it’s so fl exible.

I continued to build up detail until I had the exact 
character, layout and lighting I wanted for the fi nal 
painting all mapped out. In my workfl ow, the sketch 
acts as a comprehensive guide so I’m always very 
detailed with my early pen and pencil work.

Next I started blocking in the colour. On the base 
Canvas underneath the Sketch layer, I blocked in the 
colours of the portrait with the Artists>Sargent Brush. 
I often adjusted the Sketch layer’s Opacity to around 
50% while I added additional colour for better visibility 
of the Canvas layer.

Smooth it out With the Blenders>Real Stubby 
Blender, Water Rake and Coarse Oily Blender 30, 

I began to work on blending the colours of the image and 
smoothing the basic shapes.

Can’t 
draw? 

Combine 
digitally
If you’re new to freehand 
sketching, you can always 
utilise royalty-free or personal 
photographic examples of 
animals and humans, and 
digitally combine the images in 
Photoshop as a base 
reference. From this foundation 
you can draw over your 
combination until you’re more 
comfortable with sketching.

In the early stages of laying down colour, I 
attempted to keep tones fairly loose and built up the 
lighting in the base colours by using varying 
opacities. While I did hint at the lighting early on, I 
didn’t commit all the way to working in shadows, as 
these are best added as a fi nishing touch.

Once happy with the blocking in of the colours, I 
chose a variety of blenders to start mixing them 
together. My favourite blenders to work with are the 
Real Stubby Blender, Water Rake, Coarse Oily 
Blender 30 and Artists’ Oils>Dry Palette Knife. All of 
these were fantastic for moving the colours into the 
appropriate areas, while the Real Stubby Blender 
added a nice, smooth transition between 
neighbouring colours. I found as I went along that 
certain areas needed additional colour, so I applied 
more of the paint that was required with the 
Artists>Sargent Brush.

Creatures

226  Fantasy Art Genius Guide

224-229_FAGG_01.indd   226 05/07/2012   12:54

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Some other hybrid 
portraits by Alyssia 

Leopold – An Animal Portrait
2010, Painter and Photoshop
● Leopold is a romantic character from 
a dreamy era of days gone by. His 
gaze is gentle, magical and alluring, as 
if he were waiting for someone to 
bewitch his mind and steal his heart.

Etienne – An Animal Portrait
2010, Painter and Photoshop
● Etienne the man-goat. Stubborn and 
rigid, he’s also intelligent and crafty. 
Unfortunately, we have all worked with 
this character. He is the ‘animalisation’ 
of that annoying colleague.

Rudolph – An Animal Portrait
2010, Painter and Photoshop
● Rudolph is getting a little bit slow 
these days and his whiskers are turning 
grey. He is not that young spry pup he 
once was, but those gorgeous, big 
brown eyes will never change.

Refine the form I worked with the Artists’ Oils>Dry Palette Knife again to pull out and shape specific 
selections of the fur. I worked along the jawline paying close attention to the bone structure.

Subtle shadows On a new layer, I added 
a Digital Watercolor wash of dark brown. Then I 

removed colour from the highlighted areas with a Wet 
Eraser to leave only hints of transparent shadows.

Once I had the base colours of George working 
together, I wanted to add more detail to the 
brushstrokes and movement in the image. For this 
stage, I began to work solely with the Artists’ 
Oils>Dry Palette Knife. I was careful to work with the 
shapes of the bone structure and follow the fl ow of 
the clothing etc. I spent the majority of my time on 
this painting using the Dry Palette Knife, so this is a 
good opportunity to master the tool. After completing 
the base colours and brushwork, I opened a new 
separate layer above the Canvas layer for a 
watercolour wash. Using a Digital Watercolor>Wash 
Brush, I lightly placed where I wanted the shadows to 
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Finish the foundation First, I made sure my 
image was ready to receive detailed fur. This image 

of an ear has the basics laid out and has clean lines.

01

Easy digital 
fur effect

A brief introduction to creating 
realistic fur and hair

Add depth I utilised a variety of blenders and 
brushes to push, pull and manipulate the paint so 

the fur appeared to have depth and wasn’t fl at.

02

Fine details Once the basic shape was laid 
out, I added fi ne hairs, in both dark and light 

colours. I blurred and smudged them to appear softer.

03

Final touches I drew in full-strength hairs with 
bold strokes. I didn’t blend these hairs as they were 

intended to be in focus and to catch the viewer’s eye.

04

Precise highlights With the Chalk>Sharp 
Chalk, I sketched strategic hair strands on the lit 

side and darker, bolder strands on the shadowed side, 
making sure to vary the hair size for believability.

fall over my portrait, building up the depth as I went along. At 
this point, I turned the Sketch layer on and off to make sure I 
had the placement of my shadows correct; this brings realism 
to the image. I then used the Digital Watercolor>Wet Eraser to 
remove the wet paint from areas where it was not needed, at 
varying opacities for a painterly look. Next, I dried the 
watercolours by selecting Layers>Dry Digital Watercolor and 
dropped the layer onto the Canvas.

By this stage I had an image I was pleased with, but which 
still needed all-important details such as fur and highlights. 
For the shadows, I utilised the Pen> Scratchboard tool at a 
very small size and, at a similar size for the highlights, I used 
Chalk>Sharp Chalk. For the fur generally, I loosely sketched 
in where I wanted it to show but not in any great detail; the 
important thing was to hint at the fur, rather than draw it all. 
For example, along George’s jawline to the left, I sketched in 
dark, soft individual hairs and then smudged them outwards 
with the Blenders>Water Rake. To the right, on the lighter side 
of the portrait, I sketched in creamy light hairs, but only 
strategically blended certain hairs, leaving others to 
accentuate the shape in full strength. I wanted to keep the fur 
loose and soft, as opposed to busy and overworked.

Once I’d reached a point where I was happy with George 
and his background, I was ready to take the image into 
Photoshop and pull the portrait together as a whole. I 
removed the Sketch layer and dropped the remaining layers 
onto the Canvas, saving the portrait out as a PSD fi le.

In Photoshop I opened the image and created a duplicate 
layer of the Canvas layer and applied an Alpha mask to it. 
With the mask selected under Channels>Mask, I used a 
basic round brush and painted in the mask to include only the 

Creatures

228  Fantasy Art Genius Guide

224-229_FAGG_01.indd   228 05/07/2012   12:54

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


edge of the illustration in order to produce a soft 
vignette effect; this really pulls the image’s focus to 
George at the centre. This layer’s blending mode was 
set to Multiply and the Opacity was adjusted to a very 
light 25%.

Once complete, I merged the layers in Photoshop 
and again opened the image in Painter. At this stage, 
I added those fundamental fi nal touches that really 
pull the painting together.

I applied Effects>Surface Control>Apply Surface 
Texture>Image Luminance. I set the Amount very low 
at 25% and the Shine to 8%; this added a powerful 
emphasis to the brushstrokes on the surface and 
really made the painting pop! It is possible to achieve 
a similar effect when you are working in Photoshop 
by adding a Smart Sharpen fi lter, but I prefer to use 
Painter’s feature for the slightly more painterly fi nish 
it offers.

George was a beautiful adventure into the creation 
of a hybrid portrait. I am pretty sure his human 
inspiration would have enjoyed seeing himself 
transformed into such a cool cat!

Boost brushstrokes In Painter, I applied 
Effects>Surface Control>Apply Surface 

Texture>Image Luminance with the Amount at 25% and 
Shine at 8%. This added life by enhancing brushstrokes.

Time to 
Photoshop 

Once the main subject 
was painted, I opened 
the saved painting in 
Photoshop and created 
a mask of the cat on a 
new layer so I could work 
on the background.

Keep it 
simple

If you overwork the 
brushstrokes in your painting, 
you can easily make it look 
muddy, dull or messy. Have 
the brushwork hint at the 
overall shapes to accentuate 
the portrait.

shape of the cat and his human body. The purpose of adding a 
mask was I needed to apply images behind George and the 
separated layer contained only the cat, which would lend me 
greater fl exibility with placement of the background elements, as 
well as ensuring any adjustments were non-destructive.

To add some dynamism to the scene and generally a bit 
more life to the background, I used some custom brushes in 
either black or white to stamp out images on ten separate layers 
behind the masked layer. These custom brushes consisted of 
fl owers, antique letters and fl ourishes, but you can use whatever 
appeals to you. I either used Multiply or Soft Light for the 
blending mode at varying degrees of opacity to establish some 
depth and complexity within these background layers.

The last layer I created was positioned above all the others in 
the layer stack. With a very large airbrush, I painted around the 
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Digital artists explain the 
techniques behind their 
amazing artwork
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Amber Hill

Personal portfolio site
vantid.deviantart.com
Country USA
Software used Painter
Amber’s art education 
consists mostly of 
dissecting dead things and 
watching live ones. She 
specialises in fantasy wildlife 
art, fl ights of the imagination 
inspired by the living and 
breathing world. Amber lives 
on the road, moving from 
place to place in pursuit of 
newness and wonder.  
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Illustrate in 
monochrome

Delve into the surprising world of 
monochromatic colour schemes

Illustrate a vivid scene 
with a limited palette

Working
Progress

Step 01, Sketch it

Step 08, Begin the details

Step 18, Koi time

Step 23, Tilt
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Celestial Party 2011 Corel Painter X

Amber Hill Fantasy wildlife illustrator

The colour palette of this piece was inspired by the cobalt blue of traditional 
porcelain glazes. It lends an ethereal quality, as if bathed in fi ltered starlight

Monochrome: having one colour. It doesn’t 
sound very exciting, yet this sometimes neglected 
colour scheme is steeped in history and provides 

the artist with an easy way to express bold contrasts and 
lighting without becoming bogged down in fi ddly bits of 
colour theory.

Monochromatic paintings are not only black and white; 
any colour and its mixtures with black and white will do. A 
colour mixed with black is used as a shade and a colour 
mixed with white is a tint. It should also be noted that every 
colour, or hue, has its own value called a chromatic value. 
Yellow, for example, has a much higher chromatic value 
than blue, and they are comparable across the spectrum.

In both traditional and digital painting, monochromatic 
underpaintings are employed to set the stage for lighting 
and contrast and to defi ne tonal values and spot problem 
areas early on. A few common examples of 
monochromatic underpainting are grisaille, which is 
shades of grey, brunaille (brown), verdaille (green), and 
verdaccio (a green-grey also used for skin tones).

This piece is done in the digital analogue of cobalt blue, 
a rich natural pigment that has been used for centuries. 
Traditionally it was used in glassmaking, pigment for paints 
and a glaze for blue and white porcelain. It is by such 
pottery that this piece is inspired. The cobalt blue lends an 
ethereal quality, as if it’s bathed in fi ltered starlight.

Blue beginnings
Enjoy the freedom of a lack of colour

Sketch it In a new document, create a basic sketch. 
This twisty guy and his koi buddies were drawn with the 

Detail Airbrush tool. Set the layer mode to Multiply.

Find the colour 
Painter has a large 

collection of colours selected 
to match real media paints. Hit 
the shortcut Ctrl/Cmd+3 to 
show the Color Sets palette. 
Admire all those cool colours. 
Look for cobalt blue, grab it, 
and then fl ood fi ll the canvas 
with digital pigment.

Get to mixing The previous shortcut will toggle the 
Color Set on and off, and a similar shortcut, Ctrl/Cmd+2 

will bring up Painter’s lovely Mixer palette. Slather a swathe of 
cobalt blue in the Mixer window. Then, with both black and white, 
smoosh together the various tints and shadows that will be used 
in this piece. You may be surprised at the variety of different 
tones you can derive from just one hue. 

Mixer 
palette

Play with the colour mixer to 
see which hues work for 
monochromatic painting. Some 
shades are too dull or won’t fi t 
the mood of your piece. Be 
aware of Dirty Brush mode 
when mixing on the palette. 
Toggle it off or use the Clean 
Brush button after every stroke. 

Mash it A large 
round Oil Pastel 

with a high grain is good for 
blocking in the background. 
Use a large brush to lay in the 
darkness of the sky and select 
a paler blue and work part of 
the Milky Way. Use varying 
pen pressure to develop the 
rudimentary beginnings of 
stellar cloud formations.

01

02

03

04

05

Search the 
sky Select the Soft 

Airbrush tool. Look up some 
references of the Milky Way to 
understand how the masses 
or dark and light clouds pass 
in front of each other. Bump 
small nodes of light against 
the misty darks for maximum 
universal coolness.

06
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Place the critter Create a new layer, this time for 
the dragon. Select the round Oil Pastel brush again and 

smash in his form with pure cobalt blue to make him pop against 
the darkness behind. Use a smaller brush and a lighter tone to 
begin pulling some of the highlights from the form.

Begin the details 
Toggle the sketch 

layer on and off by clicking the 
eyeball to the left of the layer 
name. Render the fi ner details 
of the face with small brushes 
using black, white and some 
generous Eyedropper love for 
effi cient blending.

Tighten it up Not 
only are textures easier, 

but lighting is easier as well. 
Think about where the light is 
coming from and where the 
form will cast shadows, such 
as mounds of fur overlapping 
themselves. Add generous 
black or white to push or pull. 
At this point, the sketch layer 
isn’t needed as much.

Texture eyes Let’s give the back of his head some 
structure. Underpaint with cobalt blue, then etch the 

shadows with a dark blue and pop highlights. Instant textures! 
The monochromatic scheme makes texturing like this easy.

07

08

09

10

Keep going! This fellow is really beginning to look 
alive. Work on his wavy fur tendrils and the fl uff along 

his back. Give him scales on his legs and claws. Bird feet are a 
wonderful reference for dragon feet. Don’t get caught up in one 
area for too long though, keep the fl ow going. 

14

Stay rooted in reality Always remember that even 
though this fellow is fantasy, he should have believable 

anatomy. His body is based on an elongated dog with stocky 
muscles. All that chunk is painted with the usual pastel and then 
blended with our old friend Just Add Water.

11

Paint scales Scales are tricky, even in monochrome. 
This dragon’s scale pattern is loosely based on a koi with 

a bit of alligator and chicken feet for good measure. Start by 
painting under the sketch with blue, shade the lower plane and 
then highlight the top plane as shown. 

12

Give them sheen 
Paint the fi ner details 

of the scales with a smaller 
brush and fi rmer pressure. 
The contrast of dark and light 
gives the illusion of a hard, 
smooth surface that fl ows 
with the dragon’s body. Paint 
smaller scales at the joints.

13
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Reach for the 
stars Back to the sky 

for a bit. Make sure the canvas 
is selected! Grab the Just Add 
Water blender and smooth 
some of the cosmic vapours. 
Create a new layer and with 
the Tiny Spattery Airbrush 
tool, paint white stars. Play 
with the feature and brush size 
until they are just right. 

15

Clean it up Selectively erase the spatters that are too 
prominent or are not where you want them. Be gentle with 

your stylus and press and push some of the new star clusters 
back. Select the canvas and pick out a few stars to highlight with 
puffs with the Soft Airbrush tool to make the stellar bodies glow.

Sparkle Continue 
working over the sky, 

adding streaks of airbrush 
where needed. Avoid using 
gray in the sky to keep as 
much sparkle as possible in 
this monochromatic painting. 
Use an airbrush with a small 
feature value to scatter tiny 
stars and then merge the layer 
with the canvas.

16

17

Koi time Paint the 
koi in fl at blue then 

trace the line art from the 
sketch layer onto the fl ats. 
Draw the larger scales and the 
facial features, concentrating 
on the expression of the fi sh. 
Koi have cute faces. Since this 
is fantasy, push it further!

18
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Making waves
Key art features explained

Interesting lines This piece is based 
on a continuous curving line throughout 
the composition that is supported by the 
alternating dark and light values. Use 
the strong contrasts to your advantage, 
guiding the eye and showing details.

5

Critter stories The koi interacting 
with the dragon create a story. A dragon 
bursting forth from water is interesting 
enough, but toss in a few other critters 
and it makes the scene that much more 
interesting and engaging.

4

Blacks The black background makes the 
foreground pop as well as giving the whole 
scene a mysterious feel. Black is used to 
emphasise the pupils of the animals and 
sharpen details as well as being a key part 
of your colour palette for shades.

3

Curved shadows The deep shadows 
on the dragon give his body a believable 
curve of flesh and bone. Look at references 
of koi, other large scaled fish and reptiles 
to see how they move and how the scales 
shift and catch the light.

2

Celestial nonsense Have fun creating 
random lighting effects and extra sparkles. 
These guys are frolicking on the celestial 
plane so who knows what could happen! 
The stars scattered across the orb help 
bring it to the foreground of the image. 

1

1

2

3

5

Tilt If you have a tablet that supports Tilt, use the angled spatters to create the illusion of 
motion in the wave. If you don’t have Tilt, that’s okay! Just paint by dragging the stylus over 

the crest for motion lines. Erase over spatter. When the foam is complete, merge it with the canvas.

Fan fi ns Paint the fan of the fi n with fl uid strokes of 
white. Allow some of the blue to show through to give 

translucency. Dot the edge of the fi n with scintillating droplets of 
light. Build up the form of the face and shade the scales.

20

More scales In a 
manner very similar to 

the dragon scales, paint white 
over the fl at colour to begin 
building up scales. Give the 
edges hard lines of white for 
glitter and take your time. 

19

1

Finish with fi sh The fourth koi felt odd and hidden 
in the composition, so it was deleted. You can paint as 

many fi sh as you want though! Sharpen the details of the water 
with a small round Oil Pastel by fl icking the stylus back and forth 
in rapid, light motions. This blends all the underpainting and 
creates the undulating textures of a swelling wave.

23

Sharpen the 
splashes Sharpen 

the splashing water with 
smaller brush strokes. Keep 
the contrast of light against 
dark high for the look of 
translucent water. Use the 
Detail Airbrush tool to outline 
small circles of water and 
drips to simulate refl ections.

24

25

Keep it fl oaty 
It only takes a few lines 

of white to create the fi ns, so 
keep in mind less is more. Too 
much colour and the fi ns will 
lose their delicate look. Create 
belly scale texture by painting 
dots along the bottom of the 
koi and then gently paint over 
them just enough to blur.

21

Crest of a wave 
Create a new layer for 

the crest of the wave. Paint 
foam with the tiny Spattery 
Airbrush tool, similar to the 
stars. Move the Feature slider 
even higher for larger clots of 
paint. Erase the excess and 
paint over the spatters with the 
round Oil Pastel. 

22

2

34

5
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Digital artists explain the 
techniques behind their 
amazing artwork
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Rinehart Appiah

Personal portfolio site
www.r-appiah.com
Country UK
Software used Photoshop
UK-based concept artist 
Rinehart works in 
Photoshop to produce 
dramatic and painterly sci-fi 
and fantasy scenes, sharing 
his skill through tutorials.
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Scale in sci-fi art

Mayan-inspired Using a Hard 
Round brush, I begin to paint fine 

grooves and intricate patterns. The design 
is similar to Mayan carvings.

Sci-fi  artwork often uses scale to convey 
a sense of fear. It constantly challenges 
our feelings and forces us to imagine 

ourselves in situations that would never happen in 
reality, whether that’s a 100-foot giant ape scaling a 
tower, an alien mother ship that casts its shadow over 
a major city or fi ghting against a tidal wave looming 
over a famous landmark. 

On the fl ip side, scale can be used to put an 
audience in awe. For example, a super-tall beanstalk 
that winds its way through the clouds and beyond 
can make you feel breathless as it leaves you 
wondering how high it reaches. An incredibly small 
alien biped that lives its life inside a robotic human 
suit with tiny gears and motors can leave us feeling 
intrigued and captivated as we imagine what it would 
be like to be that small. Scale matters in imagery 
and it’s a useful tool that is perfect when trying to 
instil an emotional response with your audience.

Before I begin to paint my image, I always create a 
research folder fi lled with references helpful to the 
subject. With this done I begin to create my image by 
using thumbnails I have drawn. I still use traditional 
media at this stage simply because I like the organic 
feel of drawing with a pencil. The fi rst step in my 
process is to quickly establish perspective and 
composition. Once I select the one I feel best fi ts the 
brief, I scan it in at 300dpi. Using a Hard Round brush 
set to 63% Hardness, I quickly continue to rough out 
a dynamic pose. I want the robot to appear active 

Wake Up Call  2012 Photoshop

Rinehart Appiah Concept artist

 In this tutorial I will be designing a sci-fi scene with an ancient 
robot looming over a small town, using scale to evoke mood

and loom over the city. Once that’s decided I create 
an Overlay layer and, using the Airbrush tool, shade 
in grey values on the robot, keeping the primary light 
source on the left-hand side of the image.

Establishing a light source early in the process is 
important as it helps to stop confusing shades of light 
when the colouring process starts later on. 

I use the Airbrush tool with Hardness set to 100% 
and start to block in form and structure, pulling out 
interesting shapes that add to the overall form of the 
robot. I want the character to look strong and durable, 
as if it was built to last. For this I turn to my research 

Body work With the head starting to take shape, I begin to work on the body using a 
basic cube consistent with that of ancient biped statues.

Work 
with

Perspective
When creating an image with 
scale at its heart, the 
Perspective option can be 
helpful. Simply click 
Edit>Transform>Perspective. 
This will enable you to move 
and adjust your image in 
multiple perspectives by 
clicking on the corners or 
sides and dragging in or out.
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and notice that the most durable structures are ones 
that are thick, heavy and chunky as opposed to thin 
and light, so apply this to my design. Adding in 
details is now the next step and, starting with the 
background, I shade in the town at the bottom of the 
image and continue on to detail the hillside behind 
the houses. I create a new layer set to Color Dodge 
and fi ll it with black. Using an Airbrush set to white, I 
paint in lighting on the hard edges of the robot and 
the side of its head. I continue to improve upon the 
basic light values I had originally laid down. 

Now I begin to explore and develop the piece with 
colour. I create a new layer and set its blend mode to 
Overlay. This is a simple way to paint over my 
greyscale image without having to change the colour 
values of the underlying layer. Using cool hues like 
blue and purple, I start to paint over the robot keeping 
the darker colours at the bottom and the lighter on 
the top. Although the robot is huge, I want him to 
have a gentle look on his face, as this will force the 
audience to question the good or bad intentions of 
the character. To achieve this look, the face is kept 
simple and I draw a mouth with high peaks in the 
corner, mimicking a smile that employs a sense of 
innocence to contrast his intimidating size.

At this point I begin to introduce new colours, 
adding shades of green and yellow on the hillside 
and the tree growing from the robot’s shoulder. The 
focal point of this piece is the robot so I use a bright 
green and a Hard Round brush to highlight his eyes 
and chest. When rendering these values on his chest 
I paint elements of light refl ecting off the inner body 
and under the head. This creates small, eye-catching 
fl ashes of colour which will lead the viewer to the 
focus of the image; the robot’s face.

Next I fi nish off with the fi ne details on the town and 
body. I start by concentrating on the top half of the 
robot, detailing the face using a fi ne, hard brush, 
sharpening the edges and adding rust to the mouth 
and top of the head. On a new layer I select Multiply 
at 30% Opacity and paint in a shadow on the body.

Elements of the image now start to interact with the 
feeling of depth the shadows have created. The robot 
is the largest thing in this image, so to fully 
understand its size I paint in townspeople below 
running for their lives and add birds fl ying above to 

A tree often represents old age and longevity, the 
two elements that I’m incorporating in this image. I 
add interwoven roots that spread across the robot 
from the ground and then paint the tree growing on 
his shoulder. Before adding too much detail I step 
back, take a look at the silhouette and make the 
necessary changes to the composition. Next I create 
the plants and leaves using the Airbrush tool at 
50% Hardness. I then paint in the green foliage with 
different shades of green to achieve the look.

Trees Enhance the sense of size and ancient age AfterBefore

Discover the sci-fi  
worlds of Rinehart’s art

Earth Colossus
2011, Photoshop
● When creating this guy I constructed 
him from rock, interwoven with wood 
and vines. I wanted to give it the look of 
a Minotaur (from Jason And The 
Argonauts) but with a slight twist. 

Beast Hunter
2011, Photoshop
● This image depicts courage and 
facing your fears. I was inspired to 
create a tense scene of a battle 
between a beast and a skilled archer 
who has entered dangerous territory. 

Enslaved
2011, Photoshop
● In my vision of the future, I wanted 
this piece to capture the power and 
destructive force of nature, but also 
incorporate the vibrant colour and 
beauty of a strange new world.

Saturate for scale Large objects appear 
more saturated at the top depending on the 

angle. Using the Airbrush tool at 10% Opacity at the top 
of the image achieves the sense of scale. 

Build the basic town Blocking in a series of 
simple geometric shapes, I create a small town. 

I then throw in shades of green and purple to establish 
distance from the background.

Texture 
With the core 

design in place I 
start to airbrush in 
a reflective metallic 
texture and paint in 
rust on the shoulder 
and head, giving the 
look of erosion. 

Creatures
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Traditional thumbnails A range of 
thumbnails are drawn with different poses and 

angles. It’s important to have a choice and pick the best.   

01

enhance this sense of scale. Since this robot has 
been lying dormant nature has begun to take its 
course. To refl ect this I start to cover the robot with 
large vines and tree roots, intertwining and keeping 
them in fl ow with the robot’s body. Real roots get 
thinner the further down into the ground they go as 
they seek out water. I’ve drawn mine getting thinner 
as they go up, which works because they are being 
pulled up by something that was once under them.

To further tie the robot to its ancient origins, I paint 
Mayan symbols on parts of the body, erosion and 
dents using the Burn tool set to 20% Opacity. I paint 
on small dark marks followed by a crescent moon 
shape with the Dodge tool on the right-hand side of 
the mark. This creates a dent in the metal, keeping 
with the ancient look. The colour of metal tends to be 
dictated by the hue of its environment as it is so 
refl ective, so in this case it’s the bright blue sky. The 
robot is partly covered in rust and some parts are 
dull, which means that only the preserved areas of 
the robot are going to show such refl ection. Next the 
running crowd are given very saturated colour and 
the red sail of a windmill is added to gently break up 
the browns and greens, but not too bright that it 
might take the eye from the focal point. 

I create a new Soft Light layer and fi ll with green. 
The Opacity is then turned down to 6% balancing the 
image. The head needs to pop a little more, so I 
revisit it adding blue highlights on the left-hand side of 
the face and on top of the head. Finally I select the 
Eraser at 50% Opacity and I start to clean up all the 
unwanted patches that interfere with the image. After 
taking a step back I realise the image is slightly too 
dark, so I use the brightness and contrast controls via 
Image>Adjustments>Brightness/Contrast. I push up 
the Contrast slider to +14, creating that extra little bit 
of colour it needed. I use the Lasso tool to create two 
silhouettes of houses in the foreground.

When painting the foreground, the shades become 
darker while the background becomes lighter and 
more saturated. The selection is fi lled with black to 
fi nalise the impression of depth. 

Develop the 
character

How to render your central 
fi gure with intimidating scale

Greyscale blocking I create a greyscale 
image and keep the strong silhouette of the robot in 

the centre. I hold back on the detail and keep it loose.

02

Add colour Colour is layered on top of the 
greyscale. Establishing the sky tones early is a 

quick way to set the mood and lighting of the image.

03

Fine details I keep in mind that the focal 
point of this piece is the robot, so use small, eye-

catching fl ashes of colour to draw the viewer to it.

04

Battery power Painting the 
chest area green with a 40% 

Opacity Airbrush indicates the robot’s 
internal battery is working while drawing 
the eye closer to his face and body.

Colour 
balance

A good way to create or 
change the mood of your 
work is by using the Color 
Balance adjustment. Simply 
click Image>Adjustments>
Color Balance to access the 
Control sliders. This enables 
you to quickly go from warm 
to cool hues and you can 
also adjust shadows, 
midtones and highlights. 

Eye for detail With the image 
near completion, I add the finishing 

touches using texture on the roots and 
detail on the head. I choose a green hue 
for the eyes, in keeping with the chest.
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Master  Photoshop
brushes

Character concepts are big business, and 
fantasy types are extremely prominent. Within 
every commercial industry time equals money, and in 

this tutorial our CG artist shows you how to create quickly 
and successfully, using little more than the most basic of 
Photoshop tools. The techniques explored in this guide will 
show you how to develop quick concepts and evolve them. 

With most creature designs and illustrations it can 
become important to try to forget what we are designing, 

letting the improvisation and feeling of the shapes appearing 
on the screen drive us to results – unexpected or not. Try to 
empty your mind, don’t attempt to render something nice, 
instead just live the experience of doing something 
unknown. All you’re going to need is a tablet and Photoshop, 
perhaps two screens if possible, but that’s not completely 
necessary. Some options are explored in our boxouts that 
make this possible on one screen, for example, having 
separate views of your image at different zoom sizes.

The general look With the basic idea of a character 
in mind, don’t be afraid to keep conceptualising and 

evolving it. Do this with a simple round hard-edged brush, using 
greyscale to focus on shapes and design. It may seem vague 
but some interesting decisions have already taken place. 

Start in Photoshop From here we will be using 
the Lasso tool in freehand mode – very useful when 

creating general shapes and fi lling with brushes. It can produce 
unexpected forms quickly and its simplicity and speed give you 
freedom. The arm of the character has been rendered this way.

Creatures
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Build the base
Approach your concepts with simple Photoshop tools

01 02

Create dynamic and 
vivid concept art

Working
Progress

Step 01: The general look

Step 11: Colour wash

Step 16: Polish the details

Blind Invader  2011 Photoshop

David Munoz Velazquez Graphic designer and digital artist

The techniques explored in this guide will show you how to 
develop quick concepts and evolve them
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techniques behind their 
amazing artwork
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David Munoz 
Velazquez

Personal portfolio site
www.munozvelazquez.
com
Country Spain
Software used Photoshop
David Munoz Velazquez is a 
Spanish artist who studied 
graphic design, specialising 
in lighting and character 
pieces. He works at Kandor 
Graphics as an art director 
and digital sculptor.
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Head design decision For any character design, the 
head is an important element. The idea for this character is 

a bat-like creature that is blind and uses sound to see. It’s important 
to keep such concepts in mind, yet move in a creative direction 
where features aren’t all that obvious. This makes your concept 
more interesting and unique. This is accomplished by getting rid 
of evidence of animal skull elements from the face and blending 
the character’s costume with natural body shapes, achieving both 
peculiarity and elegance. 

Finishing facial touches 
When defi ning the head concept, 

it’s easy to make a design diffi cult to 
understand through poor facial structure. 
Applying an abstract look in your concept is 
interesting – as long as a mouth or eyes are 
recognisable the head and its features will 
become more understandable. Make sure 
you leave enough interpretive room for the 
viewer to decide, though. Not everyone will 
see the head in the same way as intentionally 
created, which creates interest. 

Body design Because the face 
is practically fi nished, it’s time to 

work on the rest of the character. Enlarge 
your canvas so it’s big enough to give you 
the freedom to experiment with anatomical 
shapes, building out your base character. 
Now you can explore radical shapes, 
such as drawing out longer elements 
and extending the original form. With 
Photoshop it takes no more than a second 
to add or remove space on the picture. 
Using the standard hard edged round 
brush, we are building a back structure and 
low cape to look like retracted wings.

Mechanical body parts Defi ne more form and posture by adding some cables 
and hinting at mechanical devices. You can always remove shapes that you’ve applied 

as well. This means using a lot of layers, but don’t worry as it will help you to recover anything 
made before on the image, using it as a new starting point. Cropping and duplicating shapes to 
build and blend then painting over them can help develop complex designs.

Flip image Horizontal Select Flip Canvas Horizontal 
(Image>Image Rotation) and keep adding elements, trying 

to add something for a weapon, avoiding the more obvious shapes 
that we are used to seeing. Think of it perhaps as a sonic weapon. 
Again, the Lasso tool is used everywhere and painted over with the 
round brush. As the general body takes shape, it is a good moment 
to resize parts to balance proportions. The head has been made 
bigger to recover the presence we felt it was at risk of losing.

Creatures
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Add elements 
and balance This 

image is starting to show 
how we can use the Lasso 
tool to great effect, shaping 
the fi gure and anatomy of 
our character. Still using this 
tool and a standard round 
brush, evolve some design 
elements and a rough idea 
for the left arm, creating 
a sense of depth and 
balancing the composition 
of the piece.

Quick 
Tip

Flipping your image 
horizontally is a
useful design tip. It gives a 
fresh eye to the overall image, 
making anything not wanted 
or weird obvious. For 
example, artists might try and 
fi ll the canvas but end up 
giving the character an odd 
posture. Hot key this function 
for maximum productivity.

03

04

07

06

08

05
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General shape design At this stage, understanding the general shape of your character is 
paramount – particularly the outline shape. Once you have taken care of the form and the composition, 

look at the character’s outline or perhaps block over in it black to view it as one entity. Is the shape dynamic 
enough? Of course the detail will enhance it but a strong form creates distinction.

Building parts Work in elements to make 
your fi gure even more interesting and keep 

one eye on building the concept into a fl ying winged 
creature (or hinting at it through visual elements). 
It doesn’t have to be literal, but rather suggestive 
through shape. We’ve fl eshed out defi ning 
elements on the closer hand and arm, justifying the 
perspective as well as throwing some shapes in to 
defi ne the lower part of a cape. This all alludes to the 
fi gure’s character and balances the proportions.

Colour wash By using a new layer set to Saturation, start playing with applied colours. These are subtle but can 
give an idea of which work and where the image is going tonally. The canvas has a scale correction found under 

Image>Canvas Size. It is not defi nitive but it is the fi rst general approach to a colour scheme and contrast balance. From 
here on we will be using colour palettes and playing with light and shade.

GENIUS GUIDE
Fantasy Art

Fantasy Art Genius Guide  243

Work with Tones
Apply saturated colour washes and in-image palettes

09

11

10

By using a new 
layer set to 
Saturation, start 
playing with applied 
colours. These are 
subtle but can give 
an idea of which 
work and where 
the image is going 
tonally
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Mechanical structures Add details to the back of 
the character, such as a mechanical device. Again fl ip the 

image constantly, using painted white highlights on top of shaded 
areas to suggest complex elements and metallic effects. We’ve 
also removed the back spikes that were placed to the front of the 
character to make it less confusing.

Work into elements Make the mechanical parts clearer and more prominent, and 
work on the outline of the fi gure by adding highlights. Some retouching of the head is 

applied to make it look more animalistic, suggesting teeth. Try to add elements such as particles 
fl oating or even ships in the distance to strengthen perspective.

Creatures
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Color Palette Flip the image horizontally again to get a new view of the design and make any 
changes. Create small dots on a separate layer to use as instant pickers of your key tones. They 

can also be very useful to paint out elements you now want to obscure, such as the background arm in our 
example image, which is now slightly less obvious. Do this on a new layer and simply stack it above the old 
one in the Layers palette.

13

15

Defi ne the Details As the image is 
created, everything evolves and changes. 

There is no previous line drawing to follow so we 
are fl exible. There is further work on light and shade 
applied and we work on details to make them clearer, 
defi ning shaders. The brush settings for almost the 
whole process is a round hard edged tip, set with 
Pen Pressure for both Opacity and Flow Jitter, 10% 
Spacing, and 100% Opacity and Flow.

12

14

Devil’s in the details
Apply mechanical elements and realise the fi nal form
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Polish the details Polish some details in the realised mechanical forms and other key 
elements, making the highlights more visible. As most of the other parts are set in shade, this will 

work to create a more believable metallic look. Again, the mouth and teeth styles are changed so as not 
to be too symmetrical or regular, avoiding obvious reference to teeth shapes and taking away some of the 
impact of the image. Select coloured dots, using the Eyedropper tool to pick a colour scheme from your 
image and create a makeshift tonal palette on a new layer.

Add to the background Copy your 
character and put it over the top of the layers so 

we can paint without affecting the design. Now start 
creating a background. Be it abstract, subtle or very 
detailed, this will help contextualise the character and 
make it easier to understand. Also, create a vignette to 
direct the viewer’s attention to the character, arranging 
some elements on the sides of the image to reinforce 
this. Try to fi nd a sense of depth through the background, 
but keep the foreground fairly simple, enabling the 
character grab more attention.

Adjust and 
fi lter Display 

everything together and 
make colour corrections 
on the background using 
Image>Adjustments>Selective 
Color, and Image>Adjustments 
>Photo Filter. Finish the details 
on the ground using textures and 
dirt brushes, and add a noisy, 
textured layer (such as a fl at 
metal image) set to the Overlay 
blending mode to create colour 
variation on certain parts such 
as the sky and low wings. The 
weapon is fi nished and there 
is no need for it to be pushed 
into the background, so now we 
want it to gain more presence 
and complement the character 
design. It’s always possible to 
keep detailing, but in our case 
the details were enough and 
showed everything we wanted 
to be visible.
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Use the Freehand 
Lasso tool to 

create a successful 
character design

Quick 
Tip

To show how powerful this tool can be, a quick 
character design has been made showing steps. If the 
Lasso tool has a hot key assigned and the Brush has 
one as well, it’s just a matter of how quickly you can 
draw and fi ll the shapes you have in mind. Using the 
Brush to enforce forms or visual guidelines that appear, 
keep drawing shapes with the Lasso and fi ll them 
quickly, leaving some transparency or gradients. 
Because of how improvisational and inspirational this 
technique can be, it’s not as important as the result. 
The concept can change until something we like 
appears and it might be a surprise even for us with 
shapes we may never have thought of. If you like it so 
far, create a new layer so you can get back and recover 
steps. By adding details and colour corrections it is 
possible to have an interesting design in no time. 

A very interesting option 
in Photoshop is the 
double window view. Go 
to Window>Arrange>
New Window for. This 
will duplicate the 
window, and everything 
you do on one will be 
instantly updated on 
the other.
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Paint fur 
effects 

Painter X’s Round Oil Pastel brush is 
great for simulating oil painting 
techniques for fur. In fact, I went the 

opposite way to many artists, moving from digital 
painting to oil painting and applying what I learned 
from Painter with actual paint. This tool is a bit smeary 
and translucent when light pressure is applied, and 
more opaque with more pressure. This makes for fine 
fur flow, as you can start with a firm hand and then 
trail off into wisps, or you can stab your tablet for 
chunky fur and later outline or deepen shadows 
around the fur clumps. This variety means you can 
contrast different effects within the same image 
without having to swap between tools.

Here we can compare the orderly volumes of the 
stone lion with the more natural fur forms of his 
inquisitive real-life counterpart. Both have organic 
shapes. Both look furry, even though one is a 
stylised, artificial version in the stone statue and one 
is the real natural deal. Different artists will interpret it 
in different ways, so take a look at other artist’s 
rendering of fur to see the wide variety of methods. 
The lion statue is based on Edwin Henry Landseer’s 
lion sculptures that sit in Trafalgar Square, London. 
The contrast between the two is a study in how 
simplified, sculpted fur has similar problems and 
solutions as fuzzed, rendered fur for the digital artist. 
By juxtaposing them we create an interesting 
comment on how individuals approach the challenge. 

Fur grows in definite patterns on an animal and the 
direction combined with the length of fur is critical to 
consider when painting the texture. Fur itself actually 
has many textures within it rather than just one. Short 
fur can be soft or coarse. Long fur can be silky or 
frizzy. And long fur doesn’t completely obscure the 
anatomy underneath. This lion’s luxurious mane 
breaks where the neck is stretched, and you can still 
see the shoulder beneath the piles of fluff. Unless an 
animal is all brushed out, fur naturally clumps 
together. Thinking of these clumps in larger and 
larger masses helps break down the otherwise 
difficult task of painting fur.

Arcane 2012 Painter

Amber Hill Fantasy wildlife illustrator

Learn how to break down 
complicated fur textures into large, 
easy-to-deal-with forms Contrast textures in 

your painterly images

Working
Progress

Step 01, Sketch forms

Step 03, Place the forms

Step 07, Luxurious locks

Step 10, Final details

Creatures

246  Fantasy Art Genius Guide

Source files
available

Sketch
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Digital artists explain the 
techniques behind their 
amazing artwork
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Amber Hill

Personal portfolio site
vantid.deviantart.com
Country US
Software used Painter
Amber’s art education 
consists mostly of 
dissecting dead things and 
watching live ones. She 
specialises in fantasy wildlife 
art – fl ights of imagination 
inspired by the living and 
breathing world. Amber lives 
on the road, moving from 
place to place in pursuit of 
newness and wonder.
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Note similarities The real lion has a 
similar underpainting. This fellow refl ects a lot 

of the surrounding green. His masses are blocked in 
similarly to the stone lion. Once the general masses 
are laid in with the Round Oil Pastel, select the Detail 
Airbrush and make it into a fi ne point. 

05

Place a clean 
sketch Toggle the 

sketch layer, change the opacity 
settings to where you can see 
dark brown on the lion layer 
beneath and follow your initial 
sketch. This way you have a clean 
base to work with, the way an 
acrylic painter would transfer line 
art on top of blocked-in forms.

Luxurious locks Render the mane with long, fl owing 
strokes. Use a photo reference to see how the fur lays. There are 

deep crevasses that cast shadows in the shape of wavy Vs. Use the 
power of digital paint to brush over dark values with light and vice versa.

06

07

Sketch forms Plan out the painting with a sketch 
on a new layer using your favourite drawing tool. It 

helps to have the basic shapes of the fur mapped out before 
colouring. Set the sketch layer to Multiply and sculpt with 
lines that follow the contours of body and mane. Lay in the 
background on the canvas before starting the lions.

Place the forms 
Sculpt the planes of the 

statue in chunky swathes. Keep 
value changes sudden and crisp 
before gradually blending round 
forms in the mane into smoother 
shapes. Fur should always be 
painted from large to small. If you 
jump in to detail too soon, you 
may lose sight of the whole.

Break it down Begin to break up the mane 
into smaller masses that still curve around the form. 

Strokes should follow the planes. Think of how and where 
each is facing. The top of the mane will refl ect the sky, the 
bottom will pick up some refl ected green or saturated gold 
light. Moss grows where the stone is deeply carved.

Drop in a 
background The 

colours and light of the scenery 
affect the palette of the lions. It’s 
easier to put the pieces together 
once the setting is in place by 
pulling sky, sun and bounce light 
from the surroundings. Rough 
in the statue with colours using 
the Eyedropper (Alt/Opt) from 
the ruins, applying the Round Oil 
Pastel tool on a new layer. 

01

02

03

04

Creatures
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Dissect an image
Art structure explored

Saturation A line of saturated colour 
under and next to the brightest values 
creates a beautiful glow. Take a look at 
colour from photos to get an idea of what to 
place where. Here, deep yellow and peach 
are painted over with white or gold.

5

Contrast More detail does not 
necessarily mean better fur. Focus on 
large forms and tonal gradations broken 
by textural contrasts. This contrast creates 
texture faster than hair rendering. However, 
small details should not be overlooked.

4

Atmospheric perspective Elements 
in the background are pushed back with 
a nearly transparent layer of pale blue. It 
cools down the greens, blurs the furthest 
columns and makes the foreground 
elements seem closer and crisp. 

3

Bounce light When strong sunlight 
hits the pale stone or grass, it bounces 
the colour back onto its surroundings. In 
shadow, this bounce light is saturated, 
which helps bring some planes forward 
and rounds out the forms.

2

The story Try to tell a story in your art. 
Here we have an enigmatic encounter 
between a lion and a magnificent statue 
that is surrounded by ruins yet mysteriously 
untouched. Both are similar and striking, 
and their duality plays against one another.

1

Dissect an imageDissect an imageDissect an image

1
2

3

4
5
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Keep rendering Continue etching fi ner details into 
the mane. Defi ne the larger clumps of fur with sharper 

lines without overdoing the detail. Select the Blender Bristle from 
the Artist’s Oils menu and paint thick swathes for the short fur 
that goes around the musculature of the lion.

09

Final details Grab the Round Oil 
Pastel. Check your references again 

for musculature and fur length. The paws are 
fuzzy, especially on the bottom and the belly fur 
is a mix of short fur textures and long. Suggest 
the soft fur of the inner thigh in shadow with 
light pressure on the stylus.

10
Colour temperatures Use short, 
choppy strokes for the fur on the face. 

The Round Oil Pastel will blend the colours 
depending on how fi rmly you press with the 
stylus. Place cool gold-green in the shadows, 
cooler purples in deep shadow and warm, 
saturated gold at the edge of shadow. Think of 
the overall rounded form like the lion statue.

08
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Enhance your subjects 
with fantasy lighting

Working
Progress

Step 01, Refine your idea

Step 05, Break it down

Step 12, Now for the magic

Step 15, Unify and add details
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250  Fantasy Art Genius Guide

250-255_FAGG_01.indd   250 05/07/2012   14:09

WorldMags.netWorldMags.net

WorldMags.net

http://worldmags.net/
http://worldmags.net/


Magical 
   night lighting

Digital artists explain the 
techniques behind their 
amazing artwork
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Anastasia 
Korochanskaya
Personal portfolio site
balaa.deviantart.com
Country US
Software used Photoshop
The aim of Anastasia’s art 
has always been to capture 
the ubiquitous beauty of 
nature while infusing it with 
the personal experience of 
divinity felt when looking into 
nature’s heart.

Persistence of Memory 2012 Photoshop

Anastasia Korochanskaya Freelance illustrator and designer

Learn to tell a story in your imagery using 
surreal light to guide the viewer’s eye
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Source files
available

Sketch, brushes 
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Several months ago while researching another 
painting, I came across some startling 
imagery of what is now thought to be a distinct 

subspecies of big cat, the Saharan cheetah. I was 
instantly transfi xed by the blurry black and white 
photographs of the esoteric cat. There was something 
haunting about the imagery, as if the animals themselves 
were apparitions of the desert, perhaps even memory itself. 
Imagery of diffusely glowing cheetahs traversing the 
serpentine spines of sand dunes under a canopy of 
slumbering stars haunted me with gnawing persistence. By 
chance I also later came across photos of Kolmanskop, a 
small town in the Namib Desert that is slowly being 
devoured by the sands. The two ideas swirled nebulously 
in my mind’s eye until the chance came to unite them and 
bring the imagery to life. 

In this painting, the cheetah serves as the primary 
source of light, deliberately guiding the viewer through the 
composition. The interior rooms are lit as well to suggest 
the cheetah has marked them in memory before she 
continues on, her tracks being erased behind her.

This tutorial aims to teach you to approach using light in 
non-traditional ways, such as treating light as an entity not 
always bound to a light-emitting source. For example, in 
this painting I have chosen to use my main subject, the 
cheetah, as the source of light. As we are trained to link 
light to very specifi c sources (the sun, a candle and so on), 
the artist can exploit this human perception to evoke an air 
of mystery and drama in their work. To accomplish this, we 
will use Photoshop’s powerful blend modes and a carefully 
mapped composition.

Creatures
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Refi ne your idea This is the most crucial stage of 
a painting. Even if you started with a strong idea, the fi rst 

step is always research. I will spend a day collecting references 
and inspirational images that help build upon the original idea.  
With my inspiration in hand, I work out a few sketches with 
markedly different approaches to the same idea.

Value study Light 
will tell the story of this 

image, so the composition 
should work around it. To test 
it out, I choose one image and 
do a quick value study of the 
sketch in Photoshop using a 
Soft Round airbrush on a layer 
set to Multiply. Using the ridge 
of the sand dune, I separate 
the light from shadow and 
lead the viewer’s eye from the 
cheetah to the doorway.

02

Paint in the base colours Leaving your image at a low resolution (72 dpi), duplicate 
the sketch layer and set it to Multiply. For the background, add a fl at blue colour base. 

Using the Soft Round brush, roughly paint in your forms, drawing from images to help with colour 
choices. I chose to use a pinkish silver light with more gold in the interior to create contrast.

03

Separate your 
elements With 

your basic colours roughed 
in, merge the visible layers 
to make a fl at image. Use 
the Polygonal Lasso tool to 
carefully separate the major 
elements of the image into 
their own layers; one for the 
sky, the sand, the wall and the 
cheetah. Lock transparency 
and resize to 300dpi.

04

Break it down Working from background to foreground, begin refi ning each layer fi rst by blocking in chunks with a large, 
soft transparent brush and working towards smaller, more opaque chalk brushes. I start with the wall, painting over sketch 

lines. Separate elements further as needed, giving elements such as the doorways their own layers. Do the same for the sand dunes 
and sky layers, using the sketch and value study as guides.

05

The story of light
Paint a realistic image using fantasy lighting 

01

Exploit human 
perception to 
evoke mystery
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Night paintings use the interplay of 
light and shadow to evoke mystery

Classical 
nighttime art

Style
School

Art genres in 
a nutshell

Artist: Paul Delaroche
Title: A Christian Martyr Drowned in the Tiber During 
the Reign of Diocletian
Year: 1855
Location/Owner: Louvre Museum
● This image uses stark darkness to lead the viewer’s eye 
from the pitch black on the top left to the drowned maiden. 
The translucent gold light seems to emanate from the 
fl oating halo suggesting a bittersweet resolution. You are 
left uncertain as to the intent of the onlooker.
tinyurl.com/da-martyr

Artist: Antonio de 
Correggio
Title: The Nativity
Year: 1528-1530 
Location/Owner: 
Gemäldegalerie Alte 
Meister
● A warm glow 
emanates from the 
sleeping newborn 
Christ, bathing both 
cherubs and shepherds 
in his effulgent light. The 
night is fi lled with 
promise and light, and 
the painting effectively 
conveys hope and 
adoration through the 
movement of light.
tinyurl.com/da-
nativity

Artist: Vincent van Gogh
Title: Cafe Terrace at Night
Year: 1888 
Location/Owner: Kröller-
Müller Museum
● Van Gogh’s use of rich, 
vibrant colours and expressive 
strokes seems to imply a sense 
of motion and bustling life in 
the image. The warm colours of 
the cafe against the deep azure 
blues invite the viewer to enter 
the scene without inhibition. 
tinyurl.com/da-cafe-terrace

Artists have long exploited our fears of the dark to lead our 
emotions into the mysterious coil of shadow.

Bright, warm colours juxtaposed against cool blues leave 
us with a more hopeful outlook on the night while paintings 
bathed in shadow with silver light may leave us unresolved 
and uncertain. Careful interplay of light and shadow weaves 
both nightmares and dreamscapes. Whatever the case, we 
are left at the artist’s mercy, alone in the dark.

The masters
Go over to the dark side

Artist: Paul Delaroche
Title: A Christian Martyr Drowned in the Tiber During 
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The sand dunes Sand dunes react uniquely to 
light. There is a line separating the light and shadow. 

The shadows taper and soften away from the peak. Use 
the chalk brush for the hard edges, the soft airbrush for 
the shadows and the Smudge Blender brush to soften the 
edges.

06

Desert texture 
To give the sand 

texture, add a layer over 
the sand and fi ll with the 
colour R126, G126, B126. 
Apply the Noise fi lter set 
to 400% then blur the 
layer several times and 
set it to Overlay. Lower 
the Opacity to around 9% 
and hey presto – sand! 
Add individual fl ecks of 
sand that catch the light on 
another Overlay layer with a 
custom sand brush.

07

The sky Since the walls are also blue, I decide to make the sky darker to push the walls 
forward. The stars are painted on their own layer with a custom brush. An Overlay layer is 

added over the stars and a few of them are accentuated with glows using the soft airbrush and a 
light blue colour.

08

Smudge 
Blender 

technique
Use the Blender brush in the 
included brush pack with the 
Smudge tool to gently merge 
areas of your painting (blending 
hard-edged lines into more 
diffuse, softer ones). Keep the 
Opacity low, under 10%, and 
apply varying pressures to 
increase or decrease the effect. 
Experiment to learn this brush’s 
capabilities.
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More fantastic scenes 
from Anastasia’s art

Dive
2012, Photoshop
● This piece was created without any 
foundation sketch and was simply a 
free exploration of a nebulous idea that 
thankfully took shape. Created using 
mainly a pressure-sensitive Hard 
Round brush.

Sands of Creation
2012, Photoshop
● This is a piece that breathed its own 
unequivocal meaning as it came to be; 
it became a demanding mistress, 
unrelenting and even cruel. But such is 
the way with some paintings.

Savuti
2012, Photoshop
● An exploratory painting for a graphic 
novel I hope to release in the future. 
The idea started with the desire to 
integrate star trails into the composition.

Creatures
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Paint fur Suggest fur clumps with the chalk brush, using the Eyedropper to pick colours. On a new layer, 
paint the spots, following the contours of the body. To suggest detail, add another layer over the top for 

individual fur strands and whiskers, but be careful not to overdetail the fur! 

The cheetah 
Establish the form 

of the cheetah using 
references to help with 
anatomy and lighting. As 
in the previous steps, start 
with a large soft brush and 
move to the chalk brush 
to break up the soft lines 
of the airbrush. Use the 
Smudge Blender to softly 
blend any unwanted hard 
edges. Outline her form 
with light to suggest she is 
the source of it.

09

10
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Texture touches and glow
Use standard brushes and blend modes 

Texture 
the wall 

Instead of painting 
in the texture of the 
wall by hand, I use 
examples sourced 
from cgtextures.
com. Finding several 
good plaster textures, 
I desaturate them by 
50% and paste above 
my wall with the layer 
set to Overlay. Lower 
the opacity until it 
blends naturally and 
use layer masks to 
remove any overfl ow. 
Repeat the process 
for other areas.

Light the cheetah As I want the cheetah to act as a source of light, she needs to glow. Using an Overlay layer and a 
light colour, I paint a corona around her body with the soft airbrush. I add several more Overlays to punch up her colour, 

introducing a touch of gold under her neck to lend warmth to the fi gure.

11

13

Now for the magic This is where the power of Photoshop’s blend modes 
comes into play. To paint the ethereal light I wanted, I use a multitude of Overlay 

layers. Using a Soft Round brush, I lightly paint in washes of light over anything I want to 
glow, starting with the sand and eyedropping existing colours from the painting. 

Emphasise shadows In the same way that I used Overlay layers to add glow and 
introduce extra light, Overlay layers can be used to deepen shadows and add vibrancy 

to existing colours. To lend more punch to the wall, I add an azure blue wash and push the outer 
edges into more shadow with a darker blue.

Unify and add details Continue to refi ne your main 
elements and add fi nishing touches. There are many free 

stock resources you can fi nd online to help. I use an adjustment 
layer and tweak the Curves to enhance the contrast of the image. 

12

14 15

Use the 
standard 

brush set
I work primarily with 
Photoshop’s standard brushes, 
limiting myself to six brushes if I 
can. While you can make or fi nd 
many custom brushes 
designed to paint pretty much 
anything, limit how many you 
use in a single painting. Using 
too many will give a muddy, 
unclear look to your piece. 
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